ADVANCED MANUAL

DUAL BAND TRANSCEIVER

ID-4100A
ID-4100E

INTRODUCTION
1

MEMORY OPERATION

2

SCAN OPERATION

3

PRIORITY WATCH

4

D-STAR OPERATION

5

GPS OPERATION

6

USING A microSD CARD

7

VOICE MEMORY

8

REPEATER AND DUPLEX OPERATIONS

9

MENU SCREEN

10 OTHER FUNCTIONS
This manual describes instructions for advanced features and
instructions.
See the Basic manual and the D-STAR guide that come with the
transceiver for precautions, installations, and basic operations.

11 OPTIONS
12 Bluetooth® OPERATION
13 UPDATING THE FIRMWARE
INDEX

Previous view

INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with Icom’ s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.
This product combines traditional analog technologies with the new digital technology, Digital Smart Technologies for
Amateur Radio (D-STAR), for a balanced package.

ABOUT THE CONSTRUCTION OF THE MANUAL

(As of April 2017)

You can use the following manuals to understand and operate this transceiver.
LLIf necessary, you can download a glossary of HAM radio terms from the Icom website.
Basic manual (Comes with the transceiver)

Advanced manual (This manual)

Instructions for the basic operations, precautions,
installation, and connections.

Instructions for advanced operations, as shown below.
••Memory operation <Advanced>*
••Scan operation <Advanced>*
••Priority watch operation
••D-STAR operation <Advanced>*
••GPS operation
••Using a microSD card
••Voice memory operation
••Repeater and duplex operations
••Menu screen <Advanced>*
••Other functions
••Options <Advanced>*
••Bluetooth operation
LLThis manual can be downloaded from the Icom
website.

D-STAR Guide (Comes with the transceiver)
Instructions for registering your call sign on a gateway
repeater, and the basic operations of D-STAR.
About the DV Gateway function (PDF type)
Instructions on the system requirements or operations
needed to use the DV Gateway function.
LLThe guide “About the DV Gateway function” can be
downloaded from the Icom website.

*The basic instructions are described on the Basic manual.

Icom, Icom Inc. and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the United Kingdom,
Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.
Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
The Bluetooth word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such marks by Icom Inc. is
under license. Other trademarks and trade names are those of their respective owners.
Android and the Android logo are trademarks of Google, Inc.
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.
Apple, iPad, and iPhone are trademarks of Apple Inc., registered in the U.S. and other countries.
App Store is a service mark of Apple Inc.
The iPhone trademark is used under license from AiPhone Co., Ltd.
Galaxy and Galaxy S are registered trademarks of Samsung Electronics Co., Ltd.
Google, the Google Logo, Google Play, the Google Play logo,
All other products or brands are registered trademarks or trademarks of their respective holders.
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Functions and features of Adobe® Acrobat® Reader®
The following functions and features can be used with Adobe® Acrobat® Reader®.
• Keyword search
Click “Find” (Ctrl+F) or “Advanced
Search” (Shift+Ctrl+F) in the Edit
menu to open the search screen.
This is convenient when searching for a particular word or phrase
in this manual.

• Find screen

• Advanced search screen

*The menu screen may differ,
depending on the Adobe® Acrobat®
Reader® version.

Click to open the find or search
screen or advanced search screen.

• Printing out the desired pages.
Click “Print” in the File menu, and then select the
paper size and page numbers you want to print.
*The printing setup may differ, depending on the
printer. Refer to your printer’s instruction manual
for details.
*Select "A4" size to print out the page in the original
manual size.

• Read Out Loud feature.
The Read Out Loud feature reads aloud the text in
this PDF.
Refer to the Adobe® Acrobat® Reader® Help for the
details.
(This feature may not be usable, depending on your
PC environment including the operating system.)

*The screen may differ, depending on the Adobe® Acrobat® Reader®
version.
iii
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Entering and editing text
To change the character type
1. When not selecting text, or an entered text is
selected, push [QUICK].
2. Rotate [DIAL] to select the character type, then
push [ï].

Controls used for text entry
[MENU]
Cancels

[DIAL] (Rotate)
Selects

[QUICK]

Selects the
character type

[ï]

Sets

[RX→CS]

[]

Character
Selectable characters
type
and symbols
A to Z, (space)
AB
a to z, (space)
ab
0 to 9, (space)
12

Clears

Cancels

[MW]

Moves the
cursor to the
Moves the
cursor to the left right

[MODE]

••To insert a text, move the cursor to a place to
enter, then rotate [DIAL].
••To clear a character, push [RX→CS].
••To consecutively clear characters, continuously
hold down [RX→CS].
••When the character type is “AB” or “ab,” and while
entering a character, push [QUICK] to convert
between upper case and lower case letters.

!”#

!"#$%&’()*+,-./:;<=
> ? @ [ \ ] ^ _ ` { | } ˜ (space)

Character
conversion
A/a
A/a
–
–

TIP: When the character type is “AB” or “ab,” and
while entering a character, push [QUICK] to convert
between upper case and lower case letters.

Push
[QUICK]

iv
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Entering and editing text (Continued)
DDUsable characters

The usable characters and symbols, and the maximum characters differ, depending on the item.
See the following list for details.
LLThe usable characters and symbols for each character type are described at the bottom of the page.
Category
Manage Memory

Item

Character type

Maximum
characters

Information

Reference

Memory name

[AB] [ab] [12] [!”#]

16

–

p. 1-10

Bank name

[AB] [ab] [12] [!”#]

16

–

p. 1-11

Program scan

Scan name

[AB] [ab] [12] [!”#]

16

–

p. 2-9

P-LINK

Scan Link name

[AB] [ab] [12] [!”#]

16

–

p. 9-20

My Station

TX Message

[AB] [ab] [12] [!”#]

20

–

p. 4-17

Unproto Address

[AB] [ab] [12] [!”#]

56

Normally 12 characters
(API410,DSTAR*)

The number of characters you
p. 5-16
can enter differs, depending on
p. 5-18
the data extension and altitude
p. 5-22
settings.

GPS TX Mode

Comment

[AB] [ab] [12] [!”#]

43

Object Name
Item Name

[AB] [ab] [12] [!”#]

9

GPS Message

[AB] [ab] [12] [!”#]

20

Repeater List

CS screen
My Call Sign
Your Call sign
GPS Memory
DR screen
DTMF Memory

–

p. 5-17

–

p. 5-26

Illegal characters:
/:;*<>
Illegal characters:
/:;*<>

Save Setting

[AB] [ab] [12] [!”#]

20

Export

[AB] [ab] [12] [!”#]

20

Device name

[AB] [ab] [12] [!”#]

8

Group name

[AB] [ab] [12] [!”#]

16

–

p. 4-41

Repeater name

[AB] [ab] [12] [!”#]

16

–

p. 4-34

Sub name

[AB] [ab] [12] [!”#]

8

–

p. 4-34

SD Card
Bluetooth Set

p. 5-15
p. 5-17
p. 5-21

Except for “ICOM BT-”

p. 6-4
p. 6-9
p. 9-72

Call sign

A to Z, 0 to 9, /, space

8

–

p. 4-34

GW Call sign

A to Z, 0 to 9, /, space

8

–

p. 4-34

UR

A to Z, 0 to 9, /, space

8

–

p. 9-41

R1

A to Z, 0 to 9, /, space

8

–

p. 9-41

R2

A to Z, 0 to 9, /, space

8

–

p. 9-41

Call sign
Name

A to Z, 0 to 9, /, space

12 (+1)

Includes “/” between the Call
sign and Memo field.
–

p. 9-47

[AB] [ab] [12] [!”#]

16

A to Z, 0 to 9, /, space

8

Memory name

[AB] [ab] [12] [!”#]

16

–

p. 5-27

Group name

[AB] [ab] [12] [!”#]

16

–

p. 5-30

A to Z, 0 to 9, /, space

8

–

p. 4-11

Direct Input (RPT) A to Z, 0 to 9, /, space

8

–

p. 4-12

24

–

p. 10-8

Call sign

Direct Input (UR)
DTMF code

0 to 9, A, B, C, D, *, #

[AB]: A to Z, (space)
[ab]: a to z, (space)
[12]: 0 to 9, (space)
[!”#]: ! " # $ % & ’ ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)

v

p. 4-43
p. 4-43
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Entering and editing text (Continued)
DDHow to enter

(Example: Entering “Calling” as a Memory name.)
1. Push [MW].
2. Rotate [DIAL] to select “Manage Memory,” then
push [ï].

8. Push [QUICK].
9. Select the character type, then push [ï].
		

		

10. R
 otate [DIAL] to select a character, then push [ï].
(Example: C)

••Displays the MANAGE MEMORY screen.

3. Select “Memory CH,” then push [ï].

		

		

LL Informatio
••To move the cursor forward, push [MW].
••To move the cursor backward, push [MODE].
••To insert a text, move the cursor to a place to enter,
then rotate [DIAL].
••To clear a character, push [RX→CS].
••To consecutively clear characters, continuously hold
down [RX→CS].
••When the character type is “AB” or “ab,” and while
entering a character, push [QUICK] to convert
between upper case and lower case letters.

4. S
 elect “ALL,” then push [ï].
		

••Displays the ALL screen.

5. Rotate [DIAL] to select the Memory channel to
enter a name, then push [QUICK].
		

11. R
 epeat step 8 ~ 10 to enter a name.
(Example: Calling)
		

6. Select “Edit,” then push [ï].
		

12. After entering, push [ï].
		

7. Select “NAME,” then push [ï].
		
13. Select “<<Overwrite>>,” then push [ï].
		

••The confirmation dialog “Overwrite?” is displayed.

14. Select <YES>, then push [ï].
		

••Enters the name entry mode.

••Beeps sound, and writes the entered name to the
channel.

vi
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MEMORY OPERATION

General description
The transceiver has a total of 1000 Memory channels
(100 channels in each of 26 memory banks, A ~ Z)
and two Call channels (C0/C1) each for the 144 and
430 MHz bands.
The Memory mode is useful to quickly select oftenused frequencies.

DDThe number of the Memory channel
Memory Channels

Descriptions

000 ~ 999 (Total of 1000)

Regular Memory channels.

C0/C1

Two Call channels (C0/C1) each for the 144 and 430 MHz bands.
Instantly recalls a specified frequency.

DDMemory channel content

The following information can be entered into the
Memory channels:
••Operating frequency
••Duplex direction (DUP+ or DUP–) and frequency
offset
••Memory name
••Scan skip setting
••Tuning step
••Operating mode
••Subaudible tone encoder, tone squelch or DTCS
squelch ON/OFF
••Subaudible tone frequency, tone squelch frequency
or DTCS code with polarity
••UR station call sign
••R1/R2 call signs
••Digital Call sign squelch or Digital code squelch ON/
OFF
••Digital code
••Memory bank
NOTE: Memory content may be accidentally
cleared by static electricity, electric transients,
and other causes. In addition, it may be cleared
by a malfunction, or during repairs. Therefore, we
recommend that you backup the memory content or
save it to a microSD card* or to a PC.
*User supplied
LLThe CS-4100 cloning software can also be used to
backup your memory data.

1-2
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MEMORY OPERATION

Manage Memory screen description
DDDisplaying the Manage Memory screen

The MANAGE MEMORY screen enables you to easily
manage the Memory or Call channel content.
••Displays the Memory or Call channel content.
••Easy to assign to a bank, and displays the bank
content.
••Easy to add, edit, copy, or clear the Memory
channels.

Manage Memory > Memory CH
1. Push [MENU].
2. R
 otate [DIAL] to select “Manage Memory,” then
push [ï].

		

DDTree view of the Manage Memory screen
Memory CH

••Displays the MANAGE MEMORY screen.
LLYou can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

ALL

3. Select “Memory CH,” then push [ï].
		

Bank A
A00
Manage
Memory

4. Select “ALL,” then push [ï].

A99

		

Bank Z
Call CH

C0 144

••Displays the ALL screen.

5. Select a channel, then push [ï].
		

C1 144
C0 430
C1 430

••Displays the Memory content.
LLRotate [DIAL] to select the page.

6. Push [MENU].

••Returns to the standby screen.

TIP: To edit, copy or clear the memory content.
1. Push [QUICK] in step 5.
2. Select “Edit,” “Copy” or “Clear,” then push [ï].
		

		 (Example: When selecting “Edit.”)

1-3
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MEMORY OPERATION

Selecting a Memory channel

Selecting a Call channel

In the Memory mode, you can select the Memory
channels by rotating [DIAL].

Two Call channels (C0/C1) are selectable in each of
the 144 and 430 MHz bands.
Factory default frequencies and operating modes are
entered into the Call channels. Change these to suit
your operating needs.

1. P
 ush [V/M] several times until you enter the
Memory mode.
		

1. Hold down [CALL] for 1 second.

••Enters the Call channel mode.
		
LLPushing [V/M] toggles between the VFO and Memory
modes.

2. Rotate [DIAL].

••Selects a Memory channel.
		

LLPushing [CALL] again cancels the Call channel
mode.

2. Rotate [DIAL].

••Selects a Call channel.
		
LLBlank channels are not selectable.

[DIAL]

[V/M]
[DIAL]

1-4
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MEMORY OPERATION

Writing to a Memory channel
After setting a frequency in the VFO mode, you can
write it to a selected channel or an automatically
selected blank channel.
Memory channels 002 to 999 are blank as the default.

DDWriting to a blank channel

DDWriting to the selected channel

Example: Writing 146.030 MHz into a blank channel.
1. Push [V/M] several times until you enter the VFO
mode.
2. Rotate [DIAL] to set 146.030 MHz.
3. Hold down [MW] for 1 second.
		

Example: Writing 146.030 MHz into Memory channel 18.
1. Push [V/M] several times until you enter the VFO
mode.
2. Rotate [DIAL] to select 146.030 MHz.
		

3. Push [MW].
4. Rotate [DIAL] to select “Write to New CH.”
		

••Beeps sound, and automatically writes into a blank
channel.
••Returns to the standby screen (VFO mode).

5. Rotate [DIAL] to select the Memory channel “018.”
		

LLIf you select a pre-entered channel, the previous
channel content will be overwritten.
LLThe Call channels are also selectable.

6. Push [MW].

••The confirmation dialog “Write to a blank channel?” is
displayed.

[

7. Select <YES>, then push [ï].
		

••Beeps sound, and writes into the selected Memory
channel.
••Returns to the standby screen (VFO mode).

1-5
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Writing to a Memory channel (Continued)

DDOverwriting to the selected channel

DDCopying Memory content to the VFO

Example: W
 riting 147.030 MHz into Memory channel
“018.”
1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the channel 18.

Example: Copying Memory channel “001” to the VFO.
1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the channel 1.

You can write a frequency into a pre-entered channel.

It is convenient when you want to operate on a
channel frequency near a Memory or Call channel.

		

		

Destination channel

3. Push [MW].
4. Rotate [DIAL] to select “Copy to VFO,” then push
[ï].

3. Push [V/M] to enter the VFO mode.
4. Rotate [DIAL] to set 147.030 MHz.
		

		

••The confirmation dialog “Copy to VFO?” is displayed.

5. Push [MW].
6. Rotate [DIAL] to select “Write to Selected CH,”
then push [ï].
		

5. Select <YES>, then push [ï].
		

••Beeps sound, and copies the selected Memory
content to the VFO.
••Returns to the standby screen (VFO mode).

7. Push [MW].

••The confirmation dialog “Overwrite?” is displayed.

8. Select <YES>, then push [ï].
		

[

••Beeps sound, and writes into the selected Memory
channel.
••Returns to the standby screen (VFO mode).

1-6

]

[DIAL] [V/M]

[MW]
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Writing to a Memory channel (Continued)

DDCopying Memory content to another Memory channel
You can copy the memory content to another Memory
channel.
Example: C
 opying Memory channel “018” to Memory
channel “019”.
Manage Memory > Memory CH

7. Select the destination channel, then push [ï].

1. Push [MENU].
2. Rotate [DIAL] to select “Manage Memory,” then
push [ï].
		

••Displays the MANAGE MEMORY screen.
LLYou can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

••Beeps sound, and copies to the destination channel.
LLIf you select a pre-entered channel, the previous
channel content will be overwritten.

3. Select “Memory CH,” then push [ï].
		

[MENU]

4. S
 elect “ALL,” then push [ï].
		

[

••Displays the ALL screen.

5. Rotate [DIAL] to select the Memory channel “018,”
then push [QUICK].
		

6. Select “Copy,” then push [ï].

••“DESTINATION” blinks at the top left of the screen.

1-7
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[DIAL]

[QUICK]
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Memory bank setting
The transceiver has a total of 26 banks (A ~ Z).
Regular memory channels 0 ~ 999 can be assigned
to any bank for easy memory management. Up to 100
channels can be assigned to a bank.
NOTE: The memory banks are only used to hold
memory channels. Therefore, if the original memory
channel content have been changed, the memory
bank content are also changed at the same time.

DDAssigning a memory channel to a memory bank
Example: Assigning Memory channel “000” to the
bank “A”.
Manage Memory > Memory CH

7. Select “BANK,” then push [ï].
		

1. Push [MENU].
2. Rotate [DIAL] to select “Manage Memory,” then
push [ï].

8. Select a bank to be assigned, then push [ï].
		

		

••Displays the MANAGE MEMORY screen.
LLYou can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

3. Select “Memory CH,” then push [ï].
		

9. Select “<<Overwrite>>,” then push [ï].
		

4. S
 elect “ALL,” then push [ï].
		

••The confirmation dialog “Overwrite?” is displayed.

10. Select <YES>, then push [ï].
		
••Displays the ALL screen.

5. Rotate [DIAL] to select the Memory channel to be
assigned to a bank, then push [QUICK].
		

••Beeps sound, and assigns the selected memory
channel to the bank.
[MENU]

6. Select “Edit,” then push [ï].
		

[

1-8
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[DIAL]

[QUICK]
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Memory bank setting (Continued)

DDDirectly writing into a memory bank

DDSelecting the Memory Bank mode

You can also write the memory content directly into
a memory bank channel. This way is a short cut to
creating a memory channel, and then assigning it to
a bank. In that case, the transceiver automatically
selects the lowest blank memory channel, to write.

When you select the Memory Bank mode, rotating
[DIAL] selects only the entered bank channels in the
selected bank.
1. P
 ush [V/M] several times until you enter the
Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push
[ï].

Example: Writing 146.030 MHz into Bank A.
1. Push [V/M] several times until you enter the VFO
mode.
2. Rotate [DIAL] to set 146.030 MHz.
3. Push [MW].
4. R
 otate [DIAL] to select “Write to New CH,” then
push [ï].
		

		

4. Select a bank, then push [ï].
		

5. Rotate [DIAL] to select a bank channel.
		
••Displays the WRITE screen.

5. Push [QUICK].
6. Select a bank, then push [ï].
		

LLOnly assigned bank channels are selectable.
LLTo return to the Memory mode, select “OFF” in step
4.

TIP: After step 5, you can write the displayed content
to the bank channel.
1. After step 5, push [V/M] to enter the VFO mode.
2. Set the frequency, then push [MW].
3. Rotate [DIAL] to select “Write to New CH,” then
push [ï].
		

7. Push [MW].

••The confirmation dialog “Write to a blank channel?” is
displayed.

8. Select <YES>, then push [ï].
		

••Beeps sound, and writes the memory content to the
bank channel.

TIP: On the WRITE screen, you can select other
channel by rotating [DIAL].
LLIf you select a pre-entered channel, the previous
channel content will be overwritten.
		

[
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Entering a Memory or Bank name
You can enter an alphanumeric name for each
Memory, including Call channels, and Banks.
Names can be a maximum of 16 characters.

DDEntering a Memory name

8. Enter a name of up to 16 characters.
(Example: Calling)

Manage Memory > Memory CH
1. Push [MENU].
2. Rotate [DIAL] to select “Manage Memory,” then
push [ï].

		

		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)

••Displays the MANAGE MEMORY screen.
LLYou can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

LLSee “Entering and editing text” for details. (p. iv)

9. After entering, push [ï].

3. Select “Memory CH,” then push [ï].

		

		

10. Select “<<Overwrite>>,” then push [ï].

4. S
 elect “ALL,” then push [ï].

		

		

••The confirmation dialog “Overwrite?” is displayed.

••Displays the ALL screen.

11. Select <YES>, then push [ï].

5. Rotate [DIAL] to select the Memory channel to
enter a name, then push [QUICK].

		

		

••Beeps sound, and writes the entered name to the
channel.

6. Select “Edit,” then push [ï].
		

[MENU]

7. Select “NAME,” then push [ï].
		
[

••Enters the name entry mode.
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Entering a Memory or Bank name (Continued)

DDEntering a Bank name
Manage Memory > Memory CH

[MENU]

1. Push [MENU].
2. Rotate [DIAL] to select “Manage Memory,” then
push [ï].

		

[

••Displays the MANAGE MEMORY screen.
LLYou can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

3. Select “Memory CH,” then push [ï].
		

4. S
 elect a bank group to enter a name, then push
[QUICK].
		

5. Select “Edit Name.”
		

••Enters the bank name entry mode.

6. Enter a bank name of up to 16 characters.
(Example: Contest)
		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

7. After entering, push [ï].
		

••Beeps sound, and writes the entered name to the
bank.
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Selecting a Memory name display

Clearing a Memory channel

The transceiver has two Memory name display types.

Entered memory content can be cleared.

1. Push [V/M] several times until you enter the
Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Display Type,” then push
[ï].

Manage Memory > Memory CH
1. Push [MENU].
2. Rotate [DIAL] to select “Manage Memory,” then
push [ï].
		

		

••Displays the MANAGE MEMORY screen.
LLYou can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

4. Select the display type, then push [ï].
		

3. Select “Memory CH,” then push [ï].
		

		

		

••Freq:
Displays the large font sized frequency and small
font sized memory name.

4. Select “ALL,” then push [ï].
		

••Displays the ALL screen.

••Name:
Displays large font sized memory name and a
small font sized frequency.

5. Rotate [DIAL] to select the Memory channel to be
cleared, then push [QUICK].
		

6. Select “Clear,” then push [ï].
		

[MENU]

••The confirmation dialog “Clear?” is displayed.

7. Select <YES>, then push [ï].
[

]

[DIAL]

[V/M]

		

[QUICK]

••Beeps sound, and clears the memory content.
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SCAN OPERATION

Scan
Scanning is a versatile function that can automatically
search for signals. A scan makes it easier to locate
stations to contact or listen to, or to skip unwanted
channels or frequencies.

DDAbout the scan function

In the VFO mode
The frequencies that are set as “PSKIP” are skipped
during a scan. (p. 2-5, 9-18)

In the Memory mode
Repeatedly scans all entered Memory channels.
The frequencies that are set as skip channels “PSKIP”
and “SKIP” are not scanned. (p. 2-8)
LLTwo or more Memory channels must be entered to start a
memory scan.

DDVFO scan

DDMemory scan

ALL (Full scan)
Repeatedly scans the entire band.
118 MHz
P SKIP

ALL (Memory full scan)
Scans all Memory channels.
BAND (Selected band memory scan)
Scans all Memory channels on the same frequency
band as the selected channel.

550 MHz
Scan

P SKIP

Jump

MODE (Mode memory scan)
Scans Memory channels which are entered with
the same receiving mode as the currently selected
mode.

BAND (Selected band scan)
Scans all frequencies over the entire selected band.
Band edge
P SKIP

Band edge
Scan

P SKIP

DDMemory bank scan
ALL (Full bank scan)
Scans all banks.

Jump

PROG 0 ~ 24 (Program scan)
Scans the Program scan edge ranges.
(Scan > Program Scan Edge) (p. 2-9, 9-18)
Band
edge
Jump

Lower
freq.

Scan edges

BANK-LINK (Bank link scan)
Sequentially scans the banks which are set to link
on the MENU screen. (p. 9-18)
(Scan > Bank Link)

Higher Band
freq.
edge

BANK-A–Z (Bank scan)
Scans the Memory channels in the selected bank.

Scan
Jump

LLAt least one Program scan edge range must be
entered to start a Program scan.

Duplex (DUP) scan
The Duplex scan searches for both TX and RX
frequencies which are used in duplex operation.
(p. 8-4)
LL“D–” or “D+” is displayed in the Duplex mode.
LLA Duplex scan does not start when the frequency
offset is set to “0.000 MHz.”

P-LINK0–9 (Program link scan)
 equentially scans the Program scan edge ranges
S
which are set to link on the MENU screen.
(p. 9-19)
(Scan > Program Link)

Tone scan
The Tone scan searches for tone frequencies or
DTCS codes that are used by stations using the
Tone Squelch function.
LLA Tone scan is usable in any VFO, Memory, or
Call channel mode.
LLDuring a scan, rotate [DIAL] to change the scan
direction.
See “Tone Squelch function” or “DTCS code
Squelch function” for details. (pp. 10-11, 10-12)
2-2
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SCAN OPERATION

Scan (Continued)

DDWhen a signal is received

DD[DIAL] operation during a scan

When a signal is received, the scan pauses for
approximately 10 seconds (default), then resumes.
The scan resumes approximately 2 seconds (default)
after the signal disappears.
To manually resume the scan, rotate [DIAL].
LLThese settings can be changed on the MENU
screen. (p. 9-18)
(Scan > Pause Timer)
(Scan > Resume Timer)

••Rotate [DIAL] to change the scan direction during a
scan.
••When the scan is paused, rotate [DIAL] to resume
the scan.

DDSquelch setting for a scan

You can change the squelch level to suit your
operating needs. Set the squelch level to open the
squelch, according to the received signal strength.
During a scan, rotate [SQL] to adjust the squelch
level.

DDTuning step for a VFO scan

The S-meter displays the
received signal strength.

The selected tuning step is applied to the scan.
For a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges.
(p. 2-9)

DDScan Stop Beep function

The Scan Stop Beep function sounds a beep when a
signal is received.
This function can be turned ON or OFF on the MENU
screen. (p. 9-66)
(Sounds > Scan Stop Beep)

DDSkip function

The skip function speeds up scanning by not scanning
those frequencies set as skip channels. (pp. 2-5, 2-8)
TIP: When “Program Skip” is set to OFF, you cannot
use the Scan Skip function. (p. 9-18)
(Scan > Program skip)

When receiving a signal

Beeps

DDTemporary Skip timer

The Temporary Skip function temporarily skips
unwanted frequencies during a scan, for the set
period of time.
• These settings can be changed on the MENU
screen. (p. 9-18)
(Scan > Temporary Skip Timer)

DDReceive mode during a scan

• The VFO scan uses the selected receive mode.

LLFor a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges. (p. 2-9)

• During a Memory or Bank scan, the mode entered
into the channel is used.
Scanning in the FM mode

Displays the scan type

2-3
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VFO mode scan
DDScan type

1. Push [V/M] several times until you enter the VFO
mode.
2. Hold down [SCAN] for 1 second.

The VFO mode scan has 6 scan types.
••ALL:
Full scan
••BAND:
Band scan
••P-LINK0 ~ 9: Program link scan
••P00 ~ 24:
Program scan
••DUP:	Duplex scan
(Displayed only when duplex is set.)
••TONE:	Tone scan
(For the Tone Squelch scanning)

••Opens the Scan Type Select window.
LLIf you hold down [SCAN] for 3 seconds, the last
selected scan starts.

3. Rotate [DIAL] to select a scan type, then push
[ï].

••The scan starts.
		

LLThe frequencies that are set as a Skip channel (PSKIP)
are skipped during a scan. (p. 2-8)
LLWhen “Program Skip” is set to “OFF,” the Skip channel
frequencies are not skipped. (p. 9-18)
(Scan > Program Skip)

TIP:
••During a scan, rotating [DIAL] changes the
scanning direction.
••During a scan, you can change the operating
band, scan edge, and so on, in the Quick Menu
window.
••The scan continuously runs, even if you push
[MENU] or [QUICK] during a scan.
••You can set the tuning step and the operating
mode used for a Program scan or Program Link
scan. (p. 2-9)
••The transceiver can receive on the AIR, 144 MHz,
230 MHz, 300 MHz, and 430 MHz bands.*

LLThe decimal point and the selected scan type icon
blink.
LLWhen receiving a signal, the S-meter displays the
received signal strength.

4. Push [SCAN].

••Cancels the scan.

*Selectable band differs, depending on the transceiver’s
version.
LLYou can transmit on only the amateur band
frequencies.

[SCAN]
[ ]*
[DIAL]

[V/M]

[QUICK]

*The key operation may differ,
depending on the operating status.
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VFO mode scan (Continued)

DDAbout a Scan name

DDSetting the skip frequencies

When a Scan name is assigned, the name is
displayed in the Scan Type Select window. (p. 2-4)

You can set unnecessary frequencies as Skip
channels (PSKIP) to be skipped during a scan. The
Skip function speeds up a scan.

LLThe Scan name is not displayed during a scan.
LLSee page 2-9 to enter the scan name.

1. Start the VFO scan.

When the Scan name is assigned

••When a signal is received, the scan pauses.

2. Push [QUICK].
3. Rotate [DIAL] to select “SKIP.”
		

Scan name

When the Scan name is not assigned
••Sets the frequency as a Skip channel into empty
Memory channel 999.
••The entered Memory channel number blinks.
LLIf channel 999 already has content, the transceiver
automatically searches for another blank channel to
use. If there is no blank channel, a beep sounds, and
the frequency is not set as a Skip channel.

Scan edges

DDAbout a Program Link name

4. After setting, the scan resumes.

When a Program Link name is assigned, the name is
displayed in the Scan Type Select window. (p. 2-4)
LLThe Program Link name is not displayed during a scan.
LLSee page 2-9 to enter the program link name.

TIP: Once frequencies are set as a Skip channel,
these frequencies are skipped until clearing the skip
setting. To clear the skip setting, see page 2-8 for
details.

When the Program Link name is assigned

LLThe skip setting is also cleared when the Memory
channel set as a Skip channel is cleared. (p. 1-12)

Program
Link name

When the Program Link name is not assigned
Program link

2-5

Previous view

2

SCAN OPERATION

Memory scan
DDScan type

NOTE: Two or more Memory channels, which are
not set as Skip channels, must be entered to start a
Memory scan.

The Memory mode scan has 5 scan types.
••ALL:
Full scan
••BAND: Band Memory scan
••MODE: Mode Memory scan
••DUP:	Duplex scan
(Displayed only when duplex is set.)
••TONE:	Tone scan
(For the Tone squelch scanning)

1. P
 ush [V/M] several times until you enter the
Memory mode.
2. Hold down [SCAN] for 1 second.

••Opens the Scan Type Select window.
LLIf you hold down [SCAN] for 3 seconds, the last
selected scan starts.

3. Rotate [DIAL] to select a scan type, then push
[ï].

LLWhen two or more Memory channels, which are not
set as Skip channels, are entered, the Memory scan is
usable.
LLThe channels that are set as a Skip channel (PSKIP or
SKIP) are skipped during a scan. (p. 2-8)

••The scan starts.
		

TIP:
••During a scan, rotating [DIAL] changes the
scanning direction.
••The scan continuously runs, even if you push
[MENU] or [QUICK] during a scan.
LLThe decimal point and
blink.
LLWhen receiving a signal, the S-meter displays the
received signal strength.

4. Push [SCAN].

••Cancels the scan.

[SCAN]
[ ]*
[DIAL]

[V/M]

*The key operation may differ,
depending on the operating status.
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Memory Bank scan
DDScan type

A Memory Bank scan searches through the Memory
channels in the selected bank.

••ALL:
Full bank scan
••BANK-LINK: Bank link scan
••BANK-A ~ Z:	Bank scan
(Displays only banks which contain a
Memory channel.)
••DUP:	Duplex scan
(Displayed only when duplex is set on
the channel.)
••TONE:
Tone scan (For tone scanning)

LLTwo or more Memory channels, which are not set as skip
channels, must be entered to start a Memory Bank scan.
(p. 1-8)

1. Push [V/M] several times until you enter the
Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push
[ï].
		

LLWhen all channels are set as “SKIP” or “PSKIP,” the bank
is skipped during a Bank Link scan. (p. 2-8)
LLWhen all channels in the selected bank are set as “SKIP”
or “PSKIP,” the scan does not start.
LLWhen two or more Memory channels, which are not set
as Skip channels, are entered in a bank, the Memory
bank scan is usable. (p. 2-7)

4. Select a bank to be scanned, then push [ï].
		

TIP:
••During a scan, rotating [DIAL] changes the
scanning direction.
••The scan continuously runs, even if you push
[MENU] or [QUICK] during a scan.
••During a scan, you can change the bank to be
scanned on the Quick Menu window.

5. Hold down [SCAN] for 1 second.

••Opens the Scan Type Select window.
LLIf you hold down [SCAN] for 3 seconds, the last
selected scan starts.

6. Rotate [DIAL] to select a scan type, then push
[ï].

••The scan starts.
		

DDAbout a Bank name

When a Bank name is assigned, the name is
displayed on the Scan Type Select window.
LLThe scan name is not displayed during a scan.
LLSee page 1-11 to enter the Bank name.

When the Bank name is assigned
LLThe decimal point and
blink.
LLWhen receiving a signal, the S-meter displays the
received signal strength.

Bank name

7. Push [SCAN].

When the Bank name is not assigned

••Cancels the scan.

Bank initial

[SCAN]
[ ]*
[DIAL]

[V/M]

[QUICK]

*The key operation may differ,
depending on the operating status.
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Setting and clearing the skip channel
You can set or clear a Skip channel setting.
The channels that are set as a Skip channel are
skipped during a scan.
1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the Memory channel.
		

3. Push [QUICK].
4. Rotate [DIAL] to select “SKIP,” then push [ï].
		

5. Select the option, then push [ï].
••OFF: Cancel the skip setting.
••SKIP: Skipped during a memory scan.
••PSKIP:	Skipped during both VFO and memory
scans.
		

••When a Skip channel is set, “SKIP” or “PSKIP” is
displayed.

TIP: To clear the skip channel setting
To clear the skip channel setting, select “OFF” in
step 5, then push [ï].

[

]

[DIAL]

[V/M]

[QUICK]
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Entering scan edges
You can enter the upper and lower frequency edges to
the Program scan edge ranges for Program scans.
Each Program scan edge range has its own tuning
step and the receive mode.
The default setting is differ, depending on the
transceiver version.
You can enter a total of up to 25 Program scan edge
ranges.

8. Enter a name of up to 16 characters, then push
[ï]. (Example: Air)
		

Scan > Program Scan Edge
1. Push [MENU].
2. Rotate [DIAL] to select “Scan,” then push [ï].

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)

		

LLSee “Entering and editing text” for details. (p. iv)

9. Select “FREQUENCY,” then push [ï].

••Displays the SCAN screen.

		

3. Select “Program Scan Edge,” then push [ï].
		

10. R
 otate [DIAL] to set a lower frequency, then push
[ï]. (Example: 118000)

4. S
 elect a scan edge channel.

		

		

5. Push [QUICK].
6. Select “Edit,” then push [ï].

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

		

11. S
 et a higher frequency, then push [ï].
(Example: 136000)
		

7. Select “NAME,” then push [ï].
		

12. Select “TS,” then push [ï].
		

••Displays the selectable tuning step.

13. Select the tuning step to be used during a scan.
		

••Enter the name entry mode.

LLWhen you select “---,” the tuning step set in the VFO
mode is used during a scan.

☞☞Continued on the next page
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Entering scan edges (Continued)
14. Select “MODE,” then push [ï].
		

••Displays the selectable mode.

15. Select the receive mode to be used during a scan.
		

LLWhen you select “---,” the receive mode set in the
VFO mode is used during a scan.

16. Select “<<Write>>,” then push [ï].
		

••The confirmation dialog “Write?” is displayed.

17. Select <YES>, then push [ï].
		

••Beeps sound, and automatically writes into the
selected scan edge channel.
••Returns to the PROGRAM SCAN EDGE screen.
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PRIORITY WATCH

Priority watch
While operating on a VFO frequency, using the DR
function or while scanning, Priority watch checks for
signals on a selected frequency every 5 seconds.

DDStarting the Priority watch

DDCanceling the Priority watch

To start the Priority watch, select “ON” or “Bell,” as
described below.
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch,” then push
[ï].

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].
		

		

••“P” disappears, and the Priority watch is canceled.

3. Select an option, then push [ï].
••ON:	Starts Priority Watch.
When a signal is received on the Priority
channel, the channel is automatically
selected.
••Bell:	Starts Priority Watch.
When a signal is received on the Priority
channel, the “S” icon blinks.
		

••“P” is displayed, and the Priority watch starts.

3-2

Previous view

3

PRIORITY WATCH

VFO frequency and a Priority channel
Checks the selected Priority channel every 5 seconds,
while receiving on a VFO frequency.

VFO
frequency

Priority
channel

Receiving
(5 seconds)

Step 1. Set the VFO frequency
(See Basic manual section 3)
1. Push [V/M] several times until you enter the VFO
mode.
2. Set the receive frequency and mode you want to
monitor.

Step 4. Canceling the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].

Step 2. Set the Priority channel
To select a Memory channel (p. 1-4)
1. Push [V/M] to enter the Memory mode.
2. Rotate [DIAL] to select the Memory channel you
want to monitor.

DDWhen a signal is received

••“P” disappears, and the Priority watch is canceled.

When “ON” is selected.
When a signal is received on the Priority channel, the
channel is automatically selected.

••The “P” icon blinks.
LLThe scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

To select a Bank channel (p. 1-9)
1. Push [V/M] to enter the Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push [ï].
4. R
 otate [DIAL] to select the Bank channel you want
to monitor.

		

Automatically selects
the Priority channel.

To select a Call channel (p. 1-4)
1. Hold down [CALL] for 1 second to enter the Call
channel mode.
2. Rotate [DIAL] to select the Call channel you want
to monitor.

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains in the VFO mode.
••A beep sounds and the “S” icon blinks.

Step 3. Starts the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch,” then push
[ï].
3. Select the Priority watch option, then push [ï].

		

Remains in the VFO mode.

••“P” is displayed, and the Priority watch starts.

		 Example: Checks Memory channel “002” while
receiving on 146.010 MHz.
		

Priority channel

Checks Memory channel “002”
every 5 seconds.
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VFO frequency and a Memory/Bank scan
Sequentially checks the Memory or Bank channels
every 5 seconds, while receiving on a VFO frequency.

SKIP

VFO
mode

0
1
2

Receiving
(5 seconds)

999
M-CH

When using a
Memory scan

Step 1. Set the VFO frequency
(See Basic manual section 3)
1. Push [V/M] several times until you enter the VFO
mode.
2. Set the receive frequency and mode you want to
monitor.

VFO
mode

SKIP

Receiving
(5 seconds)

00
01
02
99
Bank CH

When using a
Bank scan

Step 4. Canceling the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].
••“P” disappears, and the Priority watch is canceled.
LLThe Memory or Bank scan is also canceled.

Step 2. Start a Memory or Bank scan
To start a Memory scan (p. 2-6)
1. Push [V/M] to enter the Memory mode.
2. Hold down [SCAN] for 1 second.

DDWhen a signal is received

When “ON” is selected.
When a signal is received on the Priority channel, the
channel is automatically selected.

••Opens the Scan Type Select window.

3. Rotate [DIAL] to select a scan type, then push
[ï].

••The “P” icon blinks.
LLThe scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

••The scan starts.

		

To start a Bank scan (p. 2-7)
1. Push [V/M] to enter the Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push [ï].
4. Select a bank to be scanned, then push [ï].
5. Hold down [SCAN] for 1 second.

Automatically selects
the Priority channel.

••Opens the Scan Type Select window.

6. Rotate [DIAL] to select a scan type, then push
[ï].

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains in the VFO mode.

••The scan starts.

••A beep sounds and the “S” icon blinks.

Step 3. Starts the Priority watch (p. 3-2)
1. Push [QUICK].
2. R
 otate [DIAL] to select “PRIO Watch,” then push [ï].
3. Select the Priority watch option, then push [ï].

		

••“P” is displayed, and the Priority watch starts.

Remains in the VFO mode.

		 Example: Sequentially checks the Memory channels
while receiving on 146.010 MHz.
		

The Memory channels
are sequentially checked.

Checks the Memory channels every 5 seconds.
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VFO scan and a Priority channel
Checks the selected Priority channel every 5 seconds,
during a VFO mode scan.

VFO
mode

Priority
channel

Scan
(5 seconds)

Step 1. Set the Priority channel
To select a Memory channel (p. 1-4)
1. Push [V/M] to enter the Memory mode.
2. Rotate [DIAL] to select the Memory channel you
want to monitor.

Step 4. Canceling the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].
••“P” disappears, and the Priority watch is canceled.

To select a Bank channel (p. 1-9)
1. Push [V/M] to enter the Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push
[ï].
4. R
 otate [DIAL] to select the Bank channel you want
to monitor.

DDWhen a signal is received

To select a Call channel (p. 1-4)
1. Hold down [CALL] for 1 second to enter the Call
channel mode.
2. Rotate [DIAL] to select the Call channel you want
to monitor.

		

When “ON” is selected.
When a signal is received on the Priority channel, the
channel is automatically selected.

••The “P” icon blinks.
LLThe scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

Step 2. Starts the Priority watch (p. 3-2)
1. Push [QUICK].
2. R
 otate [DIAL] to select “PRIO Watch,” then push [ï].
3. Select the Priority watch option, then push [ï].

Automatically selects the Priority channel.

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains in the VFO mode.

••“P” is displayed, and the Priority watch starts.

••A beep sounds and the “S” icon blinks.

Step 3. Starts the VFO scan (p. 2-4)
1. In the VFO mode, hold down [SCAN] for 1 second.

		

••Opens the Scan Type Select window.

2. Rotate [DIAL] to select a scan type, then push
[ï].
••The scan starts.

Remains in the VFO mode.

Example: Checks Memory channel “002” during a VFO
mode scan.
		

Checks Memory channel “002”
every 5 seconds.
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PRIORITY WATCH

VFO scan and a Memory/Bank scan
Sequentially checks the Memory or Bank channels
every 5 seconds during a VFO mode scan.
A Memory scan or Bank scan can be selected.

SKIP

VFO
mode

0
1
2

Scan
(5 seconds)

999
M-CH

When using VFO scan
and a Memory scan

Step 1. Start a Memory or Bank scan
To start a Memory scan (p. 2-6)
1. Push [V/M] to enter the Memory mode.
2. Hold down [SCAN] for 1 second.

VFO
mode

00
01

SKIP

Scan
(5 seconds)

02
99
Bank CH

When using VFO scan
and a Bank scan

Step 4. Canceling the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].

••Opens the Scan Type Select window.

••“P” disappears, and the Priority watch is canceled.

3. Rotate [DIAL] to select a scan type, then push
[ï].
••The scan starts.

To start a Bank scan (p. 2-7)
1. Push [V/M] to enter the Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push [ï].
4. Select a bank to be scanned, then push [ï].
5. Hold down [SCAN] for 1 second.

DDWhen a signal is received

6. R
 otate [DIAL] to select a scan type, then push [ï].

		

When “ON” is selected.
When a signal is received on the Priority channel, the
channel is automatically selected.

••The “P” icon blinks.
LLThe scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

••Opens the Scan Type Select window.
••The scan starts.

Step 2. Starts the Priority watch (p. 3-2)
1. Push [QUICK].
2. R
 otate [DIAL] to select “PRIO Watch,” then push [ï].
3. Select the Priority watch option, then push [ï].

Automatically selects the Priority channel.

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains in the VFO mode.

••“P” is displayed, and the Priority watch starts.

Step 3. Starts the VFO scan (p. 2-4)
1. In the VFO mode, hold down [SCAN] for 1 second.

••A beep sounds and the “S” icon blinks.

		

••Opens the Scan Type Select window.

2. Rotate [DIAL] to select a scan type, then push
[ï].
••The scan starts.

		 Example: Sequentially checks the Memory channels
while VFO scanning.
		

Remains in the VFO mode.

Sequentially checks the Memory
channels every 5 seconds.
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PRIORITY WATCH

Scanning “FROM” on the DR screen and a Priority channel
Checks the selected Priority channel every 5 seconds,
while receiving a repeater or simplex frequency in
“FROM” of the DR screen.

Step 1. Set the Priority channel
To set the VFO frequency
(See Basic manual section 3)
1. Push [V/M] several times until you enter the VFO
mode.
2. Set the receive frequency and mode you want to
monitor.

“From”
(DR screen)

Priority
channel

Receiving
(5 seconds)

(Frequency/
Channel)

		 Example: Checks Memory channel “002” every 5
seconds while receiving on a repeater
frequency.
		

To select a Memory channel (p. 1-4)
1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the Memory channel you
want to monitor.
To select a Bank channel (p. 1-9)
1. Push [V/M] several times until you enter the
Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push
[ï].
4. R
 otate [DIAL] to select the Bank channel you want
to monitor.

Checks Memory channel “002”
every 5 seconds.

Step 4. Canceling the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].

To select a Call channel (p. 1-4)
1. Hold down [CALL] for 1 second to enter the Call
channel mode.
2. Rotate [DIAL] to select the Call channel you want
to monitor.

••“P” disappears, and the Priority watch is canceled.

DDWhen a signal is received

When “ON” is selected.
When a signal is received on the Priority channel, the
channel is automatically selected.

Step 2. S
 elect the repeater or simplex frequency in
the DR screen (p. 4-3, D-STAR guide)
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “FROM,” then push [ï].

••The “P” icon blinks.
LLThe scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

		

••Displays the FROM SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select a repeater or a simplex
frequency.

Automatically selects the Priority channel.

Step 3. Starts the Priority watch (p. 3-2)
1. Push [QUICK].
2. R
 otate [DIAL] to select “PRIO Watch,” then push [ï].
3. Select the Priority watch option, then push [ï].

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains on the DR screen.
••A beep sounds and the “S” icon blinks.

••“P” is displayed, and the Priority watch starts.

		

Remains on the DR screen.
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PRIORITY WATCH

DR scan and a Priority channel
Checks the selected Priority channel every 5 seconds,
during a DR scan.

DR
scan

Priority
channel

Scan
(5 seconds)

Step 1. Set the Priority channel
To set the VFO frequency
(See Basic manual section 3)
1. Push [V/M] several times until you enter the VFO
mode.
2. Set the receive frequency and mode you want to
monitor.

		 Example: Checks Memory channel “002” every 5
seconds during a DR scan.
		

To select a Memory channel (p. 1-4)
1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the Memory channel you
want to monitor.
To select a Bank channel (p. 1-9)
1. Push [V/M] several times until you enter the
Memory mode.
2. Push [QUICK].
3. Rotate [DIAL] to select “Bank Select,” then push
[ï].
 otate [DIAL] to select the Bank channel you want
4. R
to monitor.

Checks Memory channel “002”
every 5 seconds.

Step 4. Canceling the Priority watch (p. 3-2)
1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [ï].

To select a Call channel (p. 1-4)
1. Hold down [CALL] for 1 second to enter the Call
channel mode.
2. Rotate [DIAL] to select the Call channel you want
to monitor.

••“P” disappears, and the Priority watch is canceled.

DDWhen a signal is received

Step 2. Start the DR scan (p. 4-5)
1. Hold down [DR] for 1 second to display the DR
screen.
2. Hold down [SCAN] for 1 second.

When “ON” is selected.
When a signal is received on the Priority channel, the
channel is automatically selected.

••The “P” icon blinks.
LLThe scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

••Displays the DR scan setting window.

3. Rotate [DIAL] to select the scan type, then push
[ï].

		

••The selected scan starts.

Step 3. Starts the Priority watch (p. 3-2)
1. Push [QUICK].
2. R
 otate [DIAL] to select “PRIO Watch,” then push [ï].
3. Select the Priority watch option, then push [ï].

Automatically selects the Priority channel.

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains on the DR screen.

••“P” is displayed, and the Priority watch starts.

••A beep sounds and the “S” icon blinks.

		

Remains on the DR screen.
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Skip setting for the DR scan.................................................. 4-40
DDIndividual skip setting..................................................... 4-40
DDGroup skip setting.......................................................... 4-40
Entering the repeater group name........................................ 4-41
Repeater detail screen.......................................................... 4-42
Entering Your (destination) call sign...................................... 4-43
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Rearranging the display order of Your (destination) call signs.. 4-45
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IMPORTANT!
••The repeater list, described in this manual, may differ from your transceiver’s preloaded contents.
••Although Japanese repeaters are used in the setting examples, the Japanese repeater node (port) letters are
different from other country’s.
Be sure to add the repeater node letter in the 8th digit of the call sign, according to the frequency band shown
below.
1200 MHz : A (B in Japan)
430 MHz : B (A in Japan)
144 MHz : C (no D-STAR repeaters in Japan)
To begin digital mode communication using other than the D-STAR Repeater (DR) function
For a Local area call or Gateway call:
1. Set the access repeater’s frequency. (p. 8-2)
2. Set the Duplex direction. (p. 8-4)
3. Set the frequency offset for the Duplex operation.
(p. 8-4)
4. S
 et the call signs (UR/R1/R2). (p. 9-41)

To begin the digital mode communication using other
than the DR function, you can use the VFO mode,
Memory mode or Call channel mode.
This manual description focuses on the DR function
operation which can be set up easily. If you want to
use other than the DR function, see the procedures
as described to the right, or select the repeater in a
memory channel.

For a Simplex call:
1. Set the operating frequency.
2. S
 et the UR call sign (for call sign squelch).
(p. 9-41)
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D-STAR OPERATION

“FROM” (Access repeater) setting
Your access repeater must be set in “FROM” when
you make a call on the DR screen.
You have five ways to set the access repeater.
Setting by [DIAL]
Select the preset repeater by rotating [DIAL] on the DR screen.

Displayed
while rotating
[DIAL]

••When you know your access repeater
From the repeater list (p. 4-4)
You can select your access repeater from the repeater list by
selecting the repeater area and name, if entered, or call sign.

••When you do not know which repeater you can access.
Search for a repeater using the DR scan (p. 4-5)
The Normal DR scan searches for output repeater frequencies of
nearby repeaters. The scan will stop when a signal is detected.
••The scan will also stop on simplex signals.

Scan items

The Near Repeater scan searches for output repeater frequencies of nearby repeaters that are within 160
kilometer (99.4 miles) from your location and the repeater’s location that is entered in the Repeater List. The
DR scan starts scanning and will stop when a signal is detected.
You can also find only FM repeaters using the Near Repeater (FM) scan.
Search for near repeaters (p. 4-6)
Searches for near repeaters that are within 160 kilometer
(99.4 miles) from your location using your GPS location and the
repeater’s location that is entered in the Repeater List.
The nearest repeaters in your transceiver’s Repeater List are
displayed as selectable choices.
You can select the nearby DV only, FM only, or both repeater types.

••When the “FROM” data is saved in the TX History.
Setting from the TX History (p. 4-7)
Select a repeater that you have accessed before from the TX
History record.
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“FROM” (Access repeater) setting (Continued)

DDUsing your transceiver’s repeater list

When your access repeater is in your transceiver’s
repeater list, you can select it from the list. By only
selecting the repeater from the list, the call sign,
frequency, duplex and offset frequency settings are
automatically set for easy operation.
Example: S
 electing the “Hirano” repeater in Japan
from the repeater list.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “FROM,” then push [ï].

••Displays the FROM SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “Repeater List,” then push
[ï].
		

••Displays the REPEATER GROUP screen.

4. S
 elect the repeater group where your access
repeater is listed, then push [ï].
(Example: “11: Japan”)
		

5. Select your access repeater, then push [ï].
(Example: “Hirano”)
		

TIP:
When you select an FM repeater:
When an FM repeater is in your transceiver’s
repeater list, you can select it from the list.
When selecting an FM repeater, the “TO” setting is
not necessary and a “---” is displayed in “TO.”

••Returns to the DR screen, and the selected repeater
name is displayed in “FROM.”

		

LLThe repeater list, described in this manual, may
differ from your transceiver’s preloaded contents.

		 When selecting an FM repeater.
		

(Sample)

How to change the repeater group:
To change the repeater
group on the DR screen,
push [QUICK], then select
“Group Select.”
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“FROM” (Access repeater) setting (Continued)

DDUsing the DR scan

Example: Selecting the “HamFair” repeater in Japan
using the DR scan.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Hold down [SCAN] for 1 second.

Normal scan
To quickly find a repeater, the Normal scan skips
repeaters that are not specified as an access repeater.
(The “USE (FROM)” setting is set to “NO” (SKIP is
set) on the repeater list.)

		

The DR scan scans frequencies to find a signal on a
repeater or a simplex frequency.
You can use two kinds of DR scans, Normal scan and
Near Repeater scan.

••Displays the DR scan setting window.

DR scan
setting window

3. Rotate [DIAL] to select the scan type.
••Normal:
Searches for repeaters whose “USE (FROM)”
setting is set to “YES.”
••Near Repeater (ALL):
Searches for up to 20 nearby DV or FM
repeaters. (Total 40 repeaters)
••Near Repeater (DV):
Searches for up to 20 nearby DV repeaters.
••Near Repeater (FM):
Searches for up to 20 nearby FM repeaters.
4. Push [ï].

Near Repeater scan
The Near Repeater scan searches for up to 20 nearby
repeaters by using your location and the repeater’s
entered location, and then lists the repeaters.
LLThe Near Repeater scan will continue, even if you
turn OFF the power, and then turn it ON again
during the scan.
LLIf your own position is not being received, the last
received position is used.

••The selected scan starts.

NOTE: Even if your transceiver receives a repeater
signal, the repeater may not receive your signal,
because the repeater’s output power is higher than
your transceiver’s, and your signal doesn't reach the
repeater.

While DR scanning

TIP: The DR scan scans the simplex frequencies in
the repeater list, in addition to a D-STAR repeaters.

The repeaters
are sequentially
displayed.

LLWhile DR scanning, the repeaters are sequentially
displayed.
LLThe scan resumes the same as other scans.
(p. 9-18)

5. When the transceiver receives a signal from a
repeater, the scan stops.
		

6. Push [SCAN].

••The DR scan is canceled, and the repeater is set to
“FROM.”
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“FROM” (Access repeater) setting (Continued)

DDUsing the Near Repeater Search function

Step 2: Selecting the access repeater from the
Near Repeater list
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “FROM,” then push [ï].

The transceiver searches for the nearest repeater
by using your location and the repeater’s entered
position.
The nearest repeater in your transceiver’s repeater list
is displayed as the available choices.

••Displays the FROM SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

NOTE:
••When using the Repeater Search function, be sure
to first receive your own position data, or manually
enter your position data.
• If no repeater is found within a 160 kilometer range,
“No Repeater Found” will be displayed.
• If the last received position can be used, “GPS
is invalid. Search by last valid position” will be
displayed.

3. Select “Near Repeater,” then push [ï].
		

••Displays the NEAR REPEATER screen.

4. S
 elect the type of nearby repeater to display, then
push [ï].
		

Example: Selecting the “Icom Repeater” in Japan
from the Near Repeater list.
Step 1: Receiving your own position from the GPS
satellite
LLWhen it is difficult to receive signals indoors, even
if you are near a window, try going outdoors for
better reception.

••Near Repeater (ALL):
Displays up to 20 nearby DV and FM repeaters.
(A total 40 repeaters)
••Near Repeater (DV):
Displays up to 20 nearby DV repeaters.
••Near Repeater (FM):
Displays up to 20 nearby FM repeaters.
5. Select the repeater to select it as your access
repeater, considering the distance from your
position to the repeater, then push [ï].
(Example: “Icom Repeater”)
		

Confirm the GPS receiver is receiving your position.
••The GPS icon blinks when searching for satellites.

➪

➪

➪

••The GPS icon stops blinking when the minimum needed
number of satellites is found.

LLIt may take only a few seconds to receive, or it may take
a few minutes, depending on your operating environment.
LLIf your own position is not being received, the last
received position is used.

Repeater
call sign.
Displayed for Distance and direction
FM repeaters from your position to
the repeater*
••Returns to the DR screen, and the selected repeater is
set in “FROM.”
		 *When the position data accuracy level is set to
“Approximate,” the direction data is not displayed if the
distance to the repeater is less than 5 kilometers.
(p. 4-36)
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“FROM” (Access repeater) setting (Continued)

DDUsing the TX History

Repeaters you transmitted on before are saved in
the TX History. You can select a repeater from the TX
History as your access repeater.
The TX History saves up to 10 of the latest “FROM”
(Access) repeaters.
Example: S
 electing the “Hirano” repeater in Japan
from the TX History.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “FROM,” then push [ï].

••Displays the FROM SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “TX History,” then push
[ï].
		

••Displays the TX HISTORY screen.

4. Select the TX history, then push [ï].
		

••TX History (DV):	Displays the TX history of the
DV repeaters.
••TX History (FM):	Displays the TX history of the
FM repeaters.
5. S
 elect the repeater to use as your access
repeater, then push [ï]. (Example: “Hirano”)
		

••Returns to the DR screen, and the selected repeater is
set in “FROM.”

TIP: When you push [QUICK]
in step 5, you can display
the REPEATER DETAIL
screen, or delete the repeater
information from the TX
HISTORY screen.
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“TO” (Destination) setting
The destination repeater or station must be set in “TO”
when you make a call in the DV mode.
You have eight ways to set the destination.

TIP: After you receive the individual station or
repeater’s signal, the call sign can be captured by
holding down the Call Sign Capture key ([RX→CS]),
and you can quickly and easily reply to a call.

Setting by rotating [DIAL]
Rotate [DIAL] to select the repeater or Your Call
Sign that is displayed on the DR screen. (This
operation is disabled when “CQCQCQ” is set.)
To make a Local Area CQ call

TO SELECT screen

“Local CQ” setting (p. 4-9)
Set “CQCQCQ” in “TO” (Destination).
To make a Gateway CQ call
“Gateway CQ” setting (p. 4-9)
Select a repeater from the repeater list, if you want
to make a Gateway call.
TIP: How to change the
repeater group:
When “Local CQ” or “Gateway
CQ” is selected, you can change
the repeater group.
To change the repeater group on
the DR screen, push [QUICK],
then select “Group Select.”

To make a call to a specific station
“Your Call Sign” setting (p. 4-10)
Select the station call sign in the Your Call Sign
memory.
To make a call through a reflector
“Reflector” setting (p. 4-12)
Select a reflector you want to call through.
To select from RX History
Setting from RX History (p. 4-10)
When you receive a call, the repeater or caller
station data is saved in RX History.
You can select the destination from the record.
To select from TX History
Setting from TX History (p. 4-11)
When you make a call, the destination repeater or
called station data is saved in TX History.
You can select the destination from the record.
To directly enter the destination station call sign
Direct Input (UR) (p. 4-11)
Directly enter the destination station’s call sign.
To directly enter the destination repeater call sign
Direct Input (RPT) (p. 4-12)
Directly enter the destination repeater’s call sign.
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“TO” (Destination) setting (Continued)

DDUsing the “Local CQ” (Local Area call)

DDUsing the “Gateway CQ” (Gateway call)

When “Local CQ” is selected on the TO SELECT
screen, “CQCQCQ” is set in “TO.”

When “Gateway CQ” is selected on the TO SELECT
screen, you can select the repeater to make a
gateway call on the repeater list.

Example: M
 aking a Local area call by accessing the
“Hirano” repeater.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

Example: Making a Gateway CQ call to the
“Hamacho” (Japan) repeater from the
“Hirano” repeater.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “Local CQ,” then push [ï].
		

3. Select “Gateway CQ,” then push [ï].
		

••Displays the REPEATER GROUP screen.

4. S
 elect the repeater group where your destination
repeater is listed, then push [ï].
(Example: “11: Japan”)
5. Select the destination repeater, then push [ï].
(Example: “Hamacho”)
		

••Returns to the DR screen, and “CQCQCQ” is
displayed in “TO.”

••Returns to the DR screen, and “Hamacho” is displayed
in “TO.”

TIP: After selecting a destination repeater, you can
select another repeater preset in your repeater list
by rotating [DIAL].
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“TO” (Destination) setting (Continued)

DDUsing “Your Call Sign”

DDUsing the RX History

The “Your Call Sign” memory saves the “UR”
(destination) call signs. When you select an individual
station call sign for the “TO” (Destination) setting using
“Your Call Sign,” you can make a Gateway call. When
you call the destination through a gateway, the signal
is automatically sent to the last repeater that the
station accessed. So, even if you do not know where
the station is, you can make a call.

When a call is received in the DV mode, the call data
is saved in the RX History.
Up to 50 Callers, and only the last Called call signs
can be saved.
Example: Selecting “Station1” in the RX History.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

NOTE: If the repeater, set in “FROM” (Access
Repeater) has no Gateway call sign, you cannot
make a gateway call.
Example: Selecting “Station1” from the “Your Call
Sign.”
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “RX History,” then push [ï].
		

••Displays the RX HISTORY screen.

4. S
 elect the destination name or call sign, then
push [ï]. (Example: Station1)
		

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “Your Call Sign,” then push [ï].
		

••Displays the YOUR CALL SIGN screen.

4. S
 elect the destination name or call sign, then
push [ï]. (Example: Station1)
		

••Returns to the DR screen, and “Station1” is displayed
in “TO.”

TIP: To add the RX HISTORY data to memory, push
[QUICK], then select “Add To Your Memory.”
		

••Returns to the DR screen, and “Station1” is displayed
in “TO.”

TIP: After selecting a destination, you can select
another station preset in your transceiver by rotating
[DIAL].
		

4-10

Previous view

4

D-STAR OPERATION

“TO” (Destination) setting (Continued)

DDUsing the TX History

DDDirectly entering (UR)

NOTE: Until you make a call in the DV mode, you
cannot select “TO” (destination) from the TX History.

Example: Directly entering the call sign “JM1ZLK.”
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

The TX History saves the name and/or call sign of up
to 20 “TO” (Destination) settings that were used when
you made the calls.

The destination station call sign can be directly
entered.

Example: Selecting the “Hamacho” repeater in the TX
History.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “Direct Input (UR),” then push [ï].
		
••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “TX History,” then push [ï].
		

••Displays the DIRECT INPUT (UR) screen.

4. E
 nter a call sign of up to 8 characters, including
spaces.
		

••Displays the TX HISTORY screen.

4. S
 elect the destination name or call sign, then
push [ï]. (Example: “Hamacho”)
		

LLSee “Entering and editing text” for details. (p. iv)

5. After entering, push [ï].

••Returns to the DR screen, and “JM1ZLK” is displayed
in “TO.”
LLAfter entry, you can correct the call sign in the
DIRECT INPUT (UR) screen.
LLThe entered call sign remains on the DIRECT INPUT
(UR) screen, until you enter a new call sign.

The Sub
name is
displayed.
••Returns to the DR screen, and “Hamacho” is displayed
in “TO.”

		

TIP: If the entered call sign is duplicated in “Your
Call Sign” memory, the name is displayed. (Only
when the name has been entered.)
		

TIP: You can add the TX HISTORY data to memory,
or delete it from the TX HISTORY screen, push
[QUICK], then select the option.
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“TO” (Destination) setting (Continued)

DDDirectly entering (RPT)

The destination repeater call sign can be directly
entered.
Example: D
 irectly entering the call sign “JP1YIU”
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “Direct Input (RPT),” then push [ï].
		

••Displays the DIRECT INPUT (RPT) screen.

4. E
 nter a call sign of up to 8 characters, including
spaces.
		

LLSee “Entering and editing text” for details. (p. iv)

5. After entering, push [ï].

••Returns to the DR screen, and “JP1YIU” is displayed
in “TO.”
LLAfter entry, you can correct the call sign in the
DIRECT INPUT (RPT) screen.
LLThe entered call sign remains on the DIRECT INPUT
(RPT) screen, until you enter a new call sign.

TIP:
••If the entered call sign is duplicated in the repeater
list, the name is displayed. (Only when the name
has been entered.)
		

••When “/” is entered, the repeater call sign can be
used for a Gateway call.
		

“/” is entered.
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Connecting to a Reflector
DDWhat is the reflector?

A reflector is a special server connected to the
Internet and running a version of dplus software. If the
dplus software is installed on your access repeater,
it provides various functions including gateway
and reflector linking capabilities (It is known as the
D-STAR reflector system). The D-STAR reflector
system enables a number of D-STAR repeaters
anywhere to link to a reflector. This means that when
you transmit through a D-STAR repeater linked to a
reflector, your voice can be heard on other repeaters
linked to the reflector, and you can hear other stations
that are connected to the reflector.

D-STAR reflector system

INTERNET

Access repeater

CAN
INTERNET

INTERNET

UK

Reflector
INTERNET

USA
AUS

DDUsing a reflector

4. Select “Use Reflector,” then push [ï].

1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].

		

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “Reflector,” then push [ï].
••Displays the REFLECTOR screen.

••Returns to the DR screen, and “Use Reflector” and
“CQCQCQ” are displayed in “TO.”

5. Hold down [PTT] to transmit.
••Displays
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Connecting to a Reflector (Continued)

DDLinking to a reflector

If your repeater is not currently linked to a reflector, or
you want to change to another reflector, you can do so
following the steps below. Before linking to a reflector,
be sure to unlink any current reflector. (p. 4-15)

Direct entering a reflector
Example: D
 irectly entering “REF010BL.”
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].

Using the TX History
The TX History saves the up to 5 reflectors that your
access repeater linked before.
Example: Selecting the “REF010BL” in the TX History.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “Reflector,” then push [ï].

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

••Displays the REFLECTOR screen.

4. Select “Link to Reflector,” then push [ï].
••Displays the “Link to Reflector” screen.

3. Rotate [DIAL] to select “Reflector,” then push [ï].

5. Select “Direct Input,” then push [ï].
6. Rotate [DIAL] to select the reflector number.
(Example: 010)

••Displays the REFLECTOR screen.

4. Select “Link to Reflector,” then push [ï].
••Displays the “Link to Reflector” screen.

		

5. Select the reflector that you want to link to.
(Example: “REF010BL”)
		

7. Push [MW](→) to move the cursor to the right box.
8. Rotate [DIAL] to select the module letter.
(Example: B)

••Returns to the DR screen, and “Link to Reflector” and
“REF010BL” are displayed in “TO.”

		

6. Hold down [PTT] to link to the reflector.
••Displays

9. Push [ï].

••Returns to the DR screen, and “Link to Reflector” and
“REF010BL” are displayed in “TO.”
		

10. Hold down [PTT] to link to the reflector.
••Displays

while transmitting.
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Connecting to a Reflector (Continued)

DDUnlinking a reflector

DDReflector Echo Testing

Before trying to link to another reflector, be sure to
unlink the current connected reflector.

You can transmit a short message, and after releasing
[PTT], your message will be played back. It is a
useful check of how well your signal is getting into
the repeater, and you can use it to verify that your
repeater is operating normally.

1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].

1. H
 old down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “Reflector,” then push [ï].

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

••Displays the REFLECTOR screen.

4. Select “Unlink Reflector,” then push [ï].
		

3. Rotate [DIAL] to select “Reflector,” then push [ï].
••Displays the REFLECTOR screen.

4. Select “Echo Test,” then push [ï].
		

••Returns to the DR screen, and “Unlink Reflector” and
“U” are displayed in “TO.”

5. Hold down [PTT] to unlink the reflector.
••Displays

while transmitting.

••Returns to the DR screen, and “Echo Test” and “E” are
displayed in “TO.”

5. Hold down [PTT] and speak into the microphone.
••Displays

while transmitting.

6. Release [PTT] to hear your message.
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Connecting to a Reflector (Continued)

DDRequesting repeater information

When you send the repeater information command,
an ID message is sent back.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “Reflector,” then push [ï].
••Displays the REFLECTOR screen.

4. Select “Repeater Information,” then push [ï].
		

••Returns to the DR screen, and “Repeater Information”
and “I” are displayed in “TO.”

5. Hold down [PTT] to send the repeater information
command.
••Displays

while transmitting.

6. Release [PTT] to hear the repeater ID message.

4-16

Previous view

4

D-STAR OPERATION

Message operation
You can save up to 5 short messages in memory, to
transmit in the DV mode.
Each message can be up to 20 characters long.

DDEntering a TX message

DDTransmitting a message

1. Push [MENU].
2. Rotate [DIAL] to select “My Station,” then push
[ï].

My Station > TX Message

Example: Entering “JAPAN TOM” into message
memory number 1.
My Station > TX Message

You can transmit a pre-entered text message by
pushing [PTT]. First, select a TX message which also
turns ON the Message Transmission function.

1. Push [MENU].
2. Rotate [DIAL] to select “My Station,” then push
[ï].
3. Select “TX Message,” then push [ï].

		

••Displays the TX MESSAGE screen.

4. S
 elect a message memory, then push [ï].
(Example: 1: JAPAN TOM)

3. Select “TX Message,” then push [ï].
		

		

••Displays the TX MESSAGE screen.

LLTo not transmit any message, select “OFF.”

4. S
 elect a message memory number, then push
[QUICK].
5. Select “Edit,” then push [ï].

5. Push [MENU].

••Returns to the standby screen.”

		

LL Informatio
••The message is transmitted each time you push
[PTT].
••The message is transmitted along with your voice
signal.

••Enters the TX Message entry mode.

6. Enter a message of up to 20 characters.
(Example: JAPAN TOM)

TIP: RX call sign and message display
As the default, the received call sign and message
are automatically displayed and scrolled on the LCD.
To not display and scroll them, set “RX Call Sign” to
“OFF.”
(Display > RX Call Sign)
		

		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

7. After entering, push [ï].

••Returns to the TX MESSAGE screen.
		

Scrolls

8. Push [MENU].

••Returns to the standby screen.”
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Message operation (Continued)

DDDeleting a TX message

You can delete the entered TX message.
Example: D
 eleting the entered TX message “JAPAN
TOM” from message memory number 1.
My Station > TX Message
1. Push [MENU].
2. Rotate [DIAL] to select “My Station,” then push
[ï].
		

3. Select “TX Message,” then push [ï].
		

••Displays the TX MESSAGE screen.

4. S
 elect a message memory number to delete, then
push [QUICK].
5. Select “Clear,” then push [ï].
		

••The confirmation dialog “Clear?” is displayed.

6. Select <YES>, then push [ï].
		

••Clears the entered message.

7. Push [MENU].

••Returns to the standby screen.”

4-18

Previous view

4

D-STAR OPERATION

Viewing the received call signs
When you receive a DV call, the calling station and
the repeater’s call signs are saved. Up to 50 calls can
be saved. Even if the transceiver is turned OFF, the
RX record is not deleted. When you receive the 51th
call, the oldest history will be deleted.

DDView the call signs in the RX History screen
1. Push [QUICK].
2. Rotate [DIAL] to select “RX History,” then push
[ï].

••Selects the page.

<First page>
• CALLER: 	Displays the caller station’s name*2
and any note entered after the call
sign.
• CALLED: 	Displays the called station’s name*2.

		

••Displays the RX HISTORY screen.

		

3. Rotate [DIAL] to select an RX history memory.
LL Informatio
••The RX history number, the caller’s name (or call
sign), destination, RX message, RX date and time,
“GW,” and “GPS” are displayed on the screen.
••“GW” is displayed when the Gateway call is received.
••“GPS” is displayed when the received call includes the
position data.
••“UP” is displayed when the repeater uplink signal is
received.
••Hold down [RX→CS] for 1 second to temporary set
the received call sign to the “TO” field (destination).

<Second page>
• RXRPT1: 	Displays the repeater’s name*2 that
was accessed by the caller station. If
it was a call through a gateway and
the internet, this item displays the
gateway call sign of the repeater you
received the call from.
• Rx RPT2: 	Displays the repeater’s name*2 you
received the call from.
LL“FREQUENCY” is displayed instead of above
items when the call was not through a repeater
(Simplex call), to show the frequency that was
used.

4. Push [ï].

••Displays the RX history detail screen.

RX HISTORY screen (RX01)

Displayed when a
Gateway call is received.

Received
date and time

5. Rotate [DIAL].

		

D-PRS TX
format icon*1

History
number
First
Caller station*2
page
LLA note may be
displayed after “/”. RX message Called station
(“CQCQCQ” is
displayed if you
received a CQ call.)

<Third page>
• RX MESSAGE:	Displays any message included in
the received call, if entered.
• RX TIME: 	Displays the date and time the
call was received.

		

*1 The displayed icon differs, depending on the D-PRS TX
format.
GPS: Position OBJ: Object
ITEM: Item
WX: Weather
*2 When a name is not entered in the memory, call sign
is displayed. You can change the display type between
“Name Display” and “Call Sign Display” in the Quick menu
window. (Default: Name Display)

☞☞Continued on the next page
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Viewing the received call signs
DD View the call signs in the RX History screen (Continued)
<Fourth page>, <Fifth page>, <Sixth page>
	Displays the position data of the caller station. If a
received signal has no data, then no position data
is displayed.
		

		

		

6. Push [MENU].

••Returns to the standby screen.

TIP: To delete the RX HISTORY data
On the RX HISTORY or the detail screen, push
[QUICK], then select “Delete.”
		

TIP: “RX RPT1” setting may differ, depending on the way the call was made.
Example: When a Local area call is received.
Example: When a Gateway call is received.
RX RPT2

alling
UK c
JG3L ZLK on .
1
..
M
J
ort A
to
HH p
JP3Y

CALLED

RX RPT2

RX RPT1

GW RX RPT1
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H
Y
JP3

ing
call
on
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BK mode communication
The BK (Break-in) function enables you to break
into a conversation, where the two other stations
are communicating with call sign squelch enabled.
(Default: OFF)
LLThe BK function is automatically turned OFF when
transceiver is turned OFF.
DV Set > BK
1. W
 hile two other stations are communicating in the
DV mode, hold down [RX→CS] for 1 second.

6. Push [MENU].

••Returns to the standby screen, and “BK” is displayed.

••The calling station’s call sign is set to “TO”
(Destination).
LLWhen a call sign is not received correctly, error
beeps sound, and no call sign is set.
LLAfter releasing, beeps sound and the calling station’s
call sign is announced. (RX→CS Speech function)

		

7. W
 hen both stations are in standby, push [PTT] to
transmit.

2. Push [MENU].
3. Rotate [DIAL] to select “DV Set,” then push [ï].
		

••Displays
while transmitting.
LL“BK” blinks when receiving the Break-in call.
LLTo cancel the BK mode, select “OFF” in step 5, or
turn OFF the transceiver.

4. S
 elect “BK,” then push [ï].
		

5. Select “ON,” then push [ï].
		

How to use Break-in?
While using digital call sign squelch, the squelch never opens (no audio is heard) even if a call is received, unless
your own call sign is specified.
However, when a call including the “BK ON” signal (break-in call) is received, the squelch will open and audio is
heard even if the call is specified for another station.
Station C calling to Station A with “BK ON”

Station C calling to Station A with “BK OFF”
Station A
and B are
communicating
using digital
Station A
call sign
squelch.

Station A
and B are
communicating
using digital
Station A
call sign
squelch.

Station B
Station C

Station B never hears that
Station C is calling Station A.

Station B
Station C

Station B also hears that
Station C is calling Station A.
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EMR communication
DDAdjusting the EMR AF level

The EMR (Enhanced Monitor Request)
communication function can be used in only the DV
mode. Using the EMR function, no call sign setting is
necessary.
All transceivers that receive an EMR signal
automatically open their squelch to receive the signal.
When an EMR signal is received, the audio (voice)
will be heard at the specified level, even if the volume
setting level is set to the minimum level, or the digital
call sign/digital code squelch is used. (Default: OFF)
LLThe EMR communication function is automatically
turned OFF when the transceiver is turned OFF.

The audio output level when an EMR signal is
received is adjustable between 0 and 32.
When an EMR signal is received, the audio will be
heard at the preset level, or the [VOL] control level,
whichever is higher.
To disable the setting, set it to “0.”
DV Set > EMR AF Level
1. Push [MENU].
2. Rotate [DIAL] to select “DV Set,” then push [ï].
3. Select “EMR AF Level,” then push [ï].
		

Example: Transmitting from the “Hirano” repeater
using the EMR function.
DV Set > EMR
1. Push [MENU].
2. Rotate [DIAL] to select “DV Set,” then push [ï].
		

4. R
 otate [DIAL] to adjust the EMR audio output level
between 0 (minimum) and 32 (maximum) in single
digit steps. (Default: 19)
		

3. Select “EMR,” then push [ï].
		
5. Push [MENU].

••Returns to the standby screen.

4. S
 elect “ON,” then push [ï].
		

5. Push [MENU].

••Returns to the standby screen, and “EMR” is
displayed.

		

6. Push [PTT] to transmit.

••Displays
while transmitting.
LL“EMR” blinks on a station that receives the EMR
signal. The audio (voice) will be heard at the
specified level, or the [VOL] control level, whichever
is higher.
LLTo cancel the EMR mode, select “OFF” in step 4, or
turn OFF the transceiver.
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Automatic DV detection
DV Set > DV Auto Detect

If you receive an FM signal while in the DV mode, the
“DV” and “FM” icons alternately blink to indicate the
received signal is FM.
When the DV Auto Detect function is turned ON, the
transceiver automatically selects the FM mode to
temporarily monitor the signal. (Default: OFF)
LLRegardless of this setting, the “DV” and “FM” icons
alternately blink if you receive an FM signal while in
the DV mode.

1. Push [MENU].
2. R
 otate [DIAL] to select “DV Set,” then push [ï].
		

3. Select “DV Auto Detect,” then push [ï].
		

TIP: When digital call sign squelch (DSQL) or digital
code squelch (CSQL) is set, the transceiver does not
receive FM signals, even if this function is ON. You
can silently wait for calls from others.

4. Select “ON,” then push [ï].
		

5. Push [MENU].

••Returns to the standby screen.
LLWhen an FM signal is received while in the DV
mode, the “DV” and “FM” icons sequentially blink,
and the transceiver receives the signal in the FM
mode.

When an FM signal is received while in the DV mode
DV Auto Detect function: OFF
The “DV” and “FM” icons alternately blink, but the
audio cannot be heard.

These icons
alternately blink

DV Auto Detect function: ON
The “DV” and “FM” icons alternately blink, and the
audio can be heard.

These icons
alternately blink

• • •

The audio
cannot be heard.
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Automatic Reply function
DV Set > Auto Reply

When a call addressed to your own call sign is
received, the Automatic Reply function automatically
replies with your call sign. (Default: OFF)
Depending on the setting, a recorded message may
be transmitted with the call sign.

1. Push [MENU].
2. R
 otate [DIAL] to select “DV Set,” then push [ï].
3. S
 elect “Auto Reply,” then push [ï].
		

NOTE: The Automatic Reply function temporary sets
the received call sign to the destination call sign.
4. Select an option.
		

TIP: To record the Auto Reply message
You can record the Auto Reply message. See page
9-22 for details.
(Voice Memo > DV Auto Reply)

••ON:	Automatically replies with your own call
sign. (No audio reply is sent)
••Voice:	Automatically replies with your call
sign and an Auto Reply message
recorded on the microSD card (up to 10
seconds).
LLIf no card is inserted, or no message is
recorded, replies with your own call sign.
(No audio reply is sent)

••Position:	Automatically replies with your own call
sign and your position data using the
internal or external GPS receiver.

LLWhen “GPS Select” is set to “OFF” or
“Manual,” the internal GPS receiver is
temporarily turned ON.
When “GPS Select” is set to “External
GPS,” but if the external GPS receiver is
not connected, the internal GPS receiver
is temporarily turned ON.

5. Push [MENU].

••Returns to the standby screen, and displays “

		

.”

LLWhen “ON” or “Voice” is selected, the Automatic
Reply function is automatically turned OFF, when you
push [PTT].
When “Position” is selected, the Automatic Reply
function remains ON, when you push [PTT].

Example: After receiving a call from “JM1ZLK,” the
transceiver automatically sends a reply call.

The “TO” setting does not change, but “UR:
JM1ZLK (Caller’s call sign)” is displayed.
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Automatic Reply function (Continued)

DDRecording an Auto Reply message

You can record the Auto Reply message and saved on
a microSD card to reply to the call with your voice.
TIP: Be sure a microSD card is in the card slot.
Voice Memo > DV Auto Reply

DV AUTO REPLY screen operation

1. Push [MENU].
2. Rotate [DIAL] to select “Voice Memo,” then push
[ï].
		

[MENU]
Returns to the standby screen

[ ]
Sets

3. Select “DV Auto Reply,” then push [ï].
		

[ ]
Returns to the
VOICE MEMO
screen
[V/M]
Selects the
microphone

4. Push [MW].

••Starts recording.

		

[MODE]
Adjusts the
microphone gain

[QUICK]
Clears the
recorded message
[MONI]
Stops recording
[RX→CS]
Starts the playback
[MW]
Starts recording

••Push [MONI] to stop recording.
••Push [RX→CS] to start the playback.
••Push [MODE] to display the microphone gain
adjustment bar.
		

LLMaximum record time is 10 second
LLHold the microphone 5 to 10 cm (2 to 4 inches) from
your mouth, then speak at a normal voice level.
LLOnly one message can be recorded. The current
contents will be overwritten if you record again.

5. Push [MENU].

••Returns to the standby screen.

Audio level
is displayed

TIP:
••To delete the recorded message, push [QUICK] on
the DV AUTO REPLY screen, then select “Clear.”
		

••To record message with the optional VS-3
Bluetooth headset, push [V/M] on the DV AUTO
REPLY screen, then select “Bluetooth MIC.”
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Automatic Reply function (Continued)

DDAuto Position Reply function

When you receive a call addressed to your own call
sign, but are in a situation that makes it difficult to
operate the transceiver, this function automatically
replies with your own call sign and transmits your
position data.

2. Your position data is
automatically transmitted.

Destination

1. A call addressed to (ID-4100A/E)
your own call sign.

After receiving the Auto Position Reply call, the caller’s
position data is displayed in a window.
LLOnly the Icom transceivers, ID-4100A/E, ID5100A/E, ID-51A/E PLUS, or ID-51A/E PLUS2,
displays the position after receiving a call. (As of
April 2017)
LLYou can turn OFF the caller’s position indication.
(Display > RX Position Display) (p. 9-63)

Your station
3. After receiving,
the position data
is displayed in the
destination’s window.

Scrolls your call sign or the TX
message.
LLYour status message may be
displayed.

When no valid position data is received
After receiving a call addressed to your own call sign,
the internal GPS receiver is temporarily turned ON for
approximately 5 minutes to receive your position data,
even if “GPS Select” is set to “OFF,” “External GPS,”
or “Manual.” Then, the transceiver automatically
replies with a message, as described below.

Scrolls your message

LLWhen the internal GPS receiver is temporarily ON, and
valid position data is received, the transceiver transmits
your position data if a call addressed to your own call
sign is received again.

TIP:
••The position data is transmitted according to the
GPS TX mode. (p. 9-24)
••When the GPS TX mode settings are incorrect
for the Automatic Reply function, the transceiver
automatically corrects them to reply to a call.
••When the GPS transmission mode is OFF,
“D-PRS” is automatically selected.

Reply message list when no valid position data is
received
Message
Status
No Position
When no position is received.
2 minutes or more has
Old Position
passed since receiving
position data.
The internal GPS receiver is
temporarily turned ON, but
No Posi & GPS Start
has not received your position
data yet.
The internal GPS receiver is
temporarily turned ON, and 2
Old Posi & GPS Start minutes or more have passed
since receiving the position
data.
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Data communication
DDSending data

In addition to digital voice communication, you can
send and receive data. And you can use the DV Fast
Data function for data communication.
The DV Fast Data function uses the data and the
audio frames to send data approximately 3.5 times
faster than the normal speed. So, no audio can be
sent. To send and receive data, the optional OPC2350LU and a data communication software (user
supplied) are required.

1. S
 et your own call sign, the UR call sign and the
repeater call sign.
2. Follow the instructions of your data
communication application software.
3. When you enter text data into your communication
software, the transceiver may automatically
transmit it, depending on the software and the
software settings.
LLWhen “DV Data TX” is set to “PTT,” pushing [PTT]
transmits the text data and a voice signal. (p. 9-48)
(DV Set > DV Data TX)
LLBefore transmission, the transceiver sends
approximately 500 milliseconds of carrier sense.

NOTE: Before staring data communication
“DV Data TX” is set to “Auto” as the default setting.
So, when you enter text data into your
communication software, the transceiver may
automatically transmit it, depending on the software
and the software settings.

NOTE:
••Only the ASCII code can be used for data
communication.
••The standard Message Transmission function also
transmits up to 20 characters. (pp. 4-17, 4-18)
••Depending on the combination of your PC and your
communication software, some data may be lost.
••While receiving voice or data through the internet,
some packets may be lost due to network error
(poor data throughput performance). In such a
case, an “L” is displayed on the screen to indicate
that packet loss has occurred.

DDConnection

Connect the transceiver to your PC using the optional
OPC-2350LU, as shown below.
Transceiver
PC
To the
[DATA] jack

To the
USB port
OPC-2350LU

NOTE: Before you start sending data, be sure to
set the following items. (p. 9-24)
• Set “GPS SELECT” to other than “External GPS.”
(GPS > GPS Set > GPS Select)
• Set “GPS OUT (To DATA Jack)” to “OFF.”
(GPS > GPS Set > GPS Out (To DATA Jack))
• When “GPS TX Mode” is “D-PRS,” set “TX Format”
to other than “Weather.”
(GPS > GPS TX Mode > D-PRS > TX Format)

DDData communication application setting
Set the communication software, as shown below.
••Port:	The COM port number that is used by
the ID-4100A/E.*1
••Baud rate: 4800/9600 bps*2
••Data:
8 bit
••Parity:
none
••Stop:
1 bit
••Flow control: Xon/Xoff

*1 Depending on the PC environment, the COM port number
used by the ID-4100A/E may be higher than 5. In that
case, use an application that can set it to higher than 5.
*2 Set the baud rate in “Data Speed.” (p. 9-60)
(Function > Data Speed)
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Data communication (Continued)

DDDV Fast Data function

DV Set > DV Fast Data > Fast Data

To send data using the DV Fast Data function, do the
following.
LLThe DV Fast Data communication can be made by
only the following Icom transceivers: ID-4100A/E,
ID-5100A/E*, or ID-51A/E (PLUS, PLUS2, 50th
Anniversary model). (As of April 2017)
*Usable only when firmware versions CPU M 1.10, S

1. Push [MENU].
2. R
 otate [DIAL] to select “DV Set,” then push [ï].
		

1.00, C 1.10, and DSP 1.10 or later are installed.

3. Select “DV Fast Data,” then push [ï].
		

NOTE: When using DV Fast Data function, if you
want to send GPS data to other transceivers that can
receive only slow speed data, set “GPS Data Speed”
to “Slow.” (p. 9-49)
(DV Set > DV Fast Data > GPS Data Speed)

4. Select “Fast Data,” then push [ï].
		

TIP: The DV Fast Data function can also be used
when you operating the transceiver through the RSMS1A or RS-MS1I remote control software.
LLThe optional UT-137 Bluetooth unit is required.

5. Select “ON,” then push [ï].
		

UT-137

Bluetooth
Transceiver with
the Bluetooth unit

Android
or iOS
device

6. Push [MENU].

••Returns to the standby screen.
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Digital squelch functions
The digital squelch opens only when you receive a
signal addressed to your own call sign, or a signal that
includes a matching digital code.
You can silently wait for calls from others.
You can independently set the Digital squelch function
in the VFO mode, Memory mode, CALL channel
mode, or DR function.

DDDigital call sign squelch function with a
Pocket beep

DDThe digital call sign squelch setting

1. Push [QUICK].
2. Rotate [DIAL] to select “DSQL,” then push [ï].
		

When a received signal is addressed to your own call
sign, the beeps sound for 30 seconds and an “S”
blinks. Within 30 seconds, push [PTT] to answer, or
operate the transceiver to stop the beeps and turn
OFF the Pocket beep function.
••“S” disappears.
LLIf you make no operation for 30 seconds, the beeps
automatically stop, but “S” continues to blink to
indicate that you received a call.

3. Select “DSQLS” or “DSQL,” then push [ï].
		

••DSQLS:	Turns ON the digital call sign squelch
function with the Pocket beep.

...

ep, Beep

Beep, Be

LL“DSQLS” is displayed.

••DSQL:	Turns ON the digital call sign squelch
function.
LL“DSQL” is displayed.

		
NOTE:
••DO NOT use the digital call sign squelch function
when communicating with two or more stations,
because the digital call sign squelch function
opens only when receiving a signal addressed
to your own call sign. Thus the digital call sign
squelch function can be used when communicating
with only one station.
••Even if the squelch closes by the digital call sign
squelch function, you can receive data in the DV
mode.

 hen the received signal includes a matching call
W
sign, the squelch opens and you can hear the audio.
LLWhen the received signal does not include a matching
call sign, the digital call sign squelch does not open.
However, the S/RF meter displays the received signal
level.
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Digital squelch functions (Continued)

DDDigital code squelch function with a
Pocket beep

DDThe digital code squelch setting

1. Push [QUICK].
2. Rotate [DIAL] to select “DSQL,” then push [ï].
		

When a received signal matches your digital code,
beeps sound for 30 seconds and an “S” blinks.
Within 30 seconds, push [PTT] to answer, or operate
the transceiver to stop the beeps and turn OFF the
Pocket beep function.
••“S” disappears.
LLIf you make no operation for 30 seconds, the beeps
automatically stop, but “S” continues to blink to
indicate that you received a call.

3. Select “CSQLS” or “CSQL,” then push [ï].
••CSQLS:	Turns ON the digital code squelch
function with the Pocket beep.
LL“CSQLS” is displayed.

••CSQL:	Turns ON the digital code squelch
function.
		

LL“CSQL” is displayed.

...

ep, Beep

Beep, Be

4. Push [MENU].
5. Select “DUP/TONE...,” then push [ï].
		

6. Select “Digital Code,” then push [ï].
		

7. Rotate [DIAL] to select the digital code.
		

8. Push [MENU].

••Returns to the standby screen.

 hen the received signal includes a matching code,
W
the squelch opens and you can hear the audio.

LLWhen the received signal does not include a matching
code, the digital code squelch does not open. However,
the S/RF meter displays the signal level.

NOTE: Even if the squelch closes by the digital code
squelch function, you can receive data in the DV
mode.
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Viewing call signs
While in the DV mode, you can display the CALL
SIGN screen.
1. Push [MENU].
2. Rotate [DIAL] to select “Call Sign,” then push [ï].
		

••Displays the CALL SIGN screen.

3. Push [MENU].

••Returns to the standby screen.

CALL SIGN screen
Destination call sign
Access repeater call sign
Gateway repeater call sign

Your own call sign
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Repeater list
DDRepeater list contents

You can save repeater information for quick and
simple communication in up to 1500 repeater memory
channels (Repeater list) in up to 50 Groups.
Entering data into the repeater list is required to use
the DR function.
You can enter four types of frequencies into the
repeater list, as shown below:
••DV repeater
••DV simplex
••FM repeater
••FM simplex

The following contents are included in the repeater
list:
••TYPE:
Frequency type (p. 4-34)
••NAME:
Repeater name (p. 4-34)
••SUB NAME:
Repeater sub name (p. 4-34)
••CALL SIGN:	Repeater call sign and port letter
(p. 4-34)
••GW CALL SIGN:	Gateway repeater’s call sign and
port “G” (p. 4-34)
••GROUP:
Repeater group (p. 4-35)
••USE(FROM):
Access repeater use (p. 4-35)
••FREQUENCY:	Access repeater’s frequency
(p. 4-35)
••DUP:
Duplex direction (p. 4-35)
••OFFSET FREQ:
Frequency offset (p. 4-35)
••MODE:
Operating mode (p. 4-35)
••TONE:
Tone setting (p. 4-35)
••REPEATER TONE: Repeater tone (p. 4-35)
••POSITION:	Position data accuracy level
(p. 4-36)
••LATITUDE:
Latitude of the repeater (p. 4-36)
••LONGITUDE:	Longitude of the repeater
(p. 4-36)
••UTC OFFSET:
UTC Offset (p. 4-36)

TIP:
••For easy operation, the repeater list is preloaded
into your transceiver. However, if you do an All
Reset, the CPU clears all the setting data, the
memory channels, and the repeater list. We
recommend that you back up the memory data to
a microSD card or save it to a PC using the CS4100 cloning software.
••The repeater list can be downloaded from the Icom
website.
http://www.icom.co.jp/world/support/download/firm/
index.html

Example: “Hamacho” repeater information
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Entering new information into the Repeater List
This section describes how to manually enter new
repeater information into the repeater list.
The required setting items differ, depending on your
communication usage. Confirm the required items, as
shown below.

DR screen

NOTE: To enter repeater information into the
repeater list, the repeater’s call sign MUST be
entered first.

DDRequired items for the communication cases
Repeater list
contents

Used as an
access repeater

TYPE
NAME
SUB NAME
CALL SIGN
GW CALL
SIGN
GROUP
USE(FROM)
FREQUENCY
DUP
OFFSET
FREQ
MODE
TONE
REPEATER
TONE
POSITION
LATITUDE
LONGITUDE
UTC OFFSET

DV Repeater


●
●

Used as a
destination
repeater
DV Repeater


●

Used for DV
simplex

Used as an FM
repeater

Used for FM
simplex

DV Simplex


N/A

FM Repeater




FM Simplex


N/A

●

N/A

N/A

N/A

●







●
●
N/A


●
●
●


●
●
N/A

●



N/A

●

N/A

N/A
N/A

N/A
N/A

N/A
N/A







N/A

N/A

N/A






























(For a Gateway call)


●
●

●:			 Must be entered
:		 Possible to enter
N/A: Not Applicable
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Entering new information into the Repeater List (Continued)

DDEntering new information into the repeater list
Step 1. Selecting the repeater group

Step 4. Entering the repeater sub name
1. Select “SUB NAME,” then push [ï].

DV Memory > Repeater List

••Enters the repeater sub name entry mode.

1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
		

2. Enter a sub name of up to 8 characters.
3. After entering, push [ï].
Step 5. Entering the repeater call sign
LLWhen ‘Step 2. Selecting the communication type’ is
set to “DV Simplex” or “FM Simplex,” go to ‘Step 7.
Changing the repeater group.’

3. Select “Repeater List,” then push [ï].
		

1. Select “CALL SIGN,” then push [ï].

••Enters the repeater call sign entry mode.

2. E
 nter the repeater call sign of up to 8 characters,
including spaces.
3. After entering, push [ï].

4. S
 elect a repeater group to add a repeater to, then
push [ï].
		

TIP: Be sure to add the repeater node letter in the
8th digit of the call sign, according to the frequency
band shown below. Note that there are almost
always different node letters between Japanese
D-STAR repeaters and repeaters in other countries.
Cross band operation between different nodes at the
same repeater site can be made.

		 (Example: 11: Japan)
••Displays the repeater list of the selected repeater
group.

5. Push [QUICK].
6. Select “Add,” then push [ï].
		

••1200 MHz: A (B in Japan)
••430 MHz: B (A in Japan)
••144 MHz: C (no D-STAR repeaters in Japan)

Step 6. Entering the gateway repeater call sign
LLThis item is displayed when ‘Step 2. Selecting the
communication type’ is set to “DV Repeater.”
LLThe 8th digit in the call sign, entered in ‘Step 5.
Entering the repeater call sign,’ is automatically
set to “G” as the gateway port, so you can skip this
setting and go to the next item. To change it, follow
the steps, described below.

••The REPEATER LIST EDIT screen is displayed.

Step 2. Selecting the communication type
1. Select “TYPE,” then push [ï].
2. Select the communication type, then push [ï].
••DV Repeater:	Repeater operation in the DV mode.
••DV Simplex: Simplex operation in the DV mode.
••FM Repeater:	Repeater operation in the FM mode.
••FM Simplex:	Simplex operation in the FM mode.

1. Select “GW CALL SIGN,” then push [ï].

••Enters the gateway repeater call sign entry mode.

2. E
 nter a gateway repeater call sign of up to 8
characters, including spaces.

Step 3. Entering the repeater name
1. Select “NAME,” then push [ï].

LLA space or “G” can be entered in the 8th digit.

••Enters the repeater name entry mode.

3. After entering, push [ï].

2. Enter a name of up to 16 characters.
Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

3. After entering, push [ï].
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Entering new information into the Repeater List
DD Entering new information into the repeater list (Continued)
Step 7. Changing the repeater group
LLThe repeater group that is selected in ‘Step 1.
Selecting the repeater group’ is displayed. You can
skip this setting and go to the next item. To change
the group, follow the steps, described below.
1. Select “GROUP,” then push [ï].

 tep 11. Entering the frequency offset
S
LLWhen ‘Step 2. Selecting the communication type’
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.
LLThe offset value* is automatically set when the
access repeater frequency is entered in ‘Step 9.
Entering the access repeater frequency.’

2. S
 elect the repeater group, 01 to 50, then push
[ï].

LLIf necessary, you can change the frequency offset.

••Enters the repeater group selection mode.

*The default value differs, depending on the transceiver
version.

1. Select “OFFSET FREQ,” then push [ï].

Step 8. Setting “USE(FROM)” to be used as an
Access repeater
LLYou can use the entered repeaters as an access
repeater when using the DR function. When not
using as an access repeater, select “NO,” and go to
‘15. Selecting the position data accuracy level.’ In
that case, the entered repeater is not displayed in
the “FROM” field.

••Enters the frequency offset entry mode.

2. R
 otate [DIAL] to enter the frequency offset
between 0.000.00 ~ 59.995.00 MHz, then push
[ï].
LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

1. Select “USE(FROM),” then push [ï].
2. Select “YES” to use the repeater as an access
repeater, then push [ï].

 tep 12. Setting the FM mode
S
LLWhen ‘Step 2. Selecting the communication type’ is
set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

 tep 9. Entering the access repeater frequency
S
1. Select “FREQUENCY,” then push [ï].

1. Select “MODE,” then push [ï].

••Enters the operating mode setting mode.

••Enters the frequency entry mode.

2. Select “FM” or “FM-N,” then push [ï].

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

 tep 13. Setting the tone
S
LLWhen ‘Step 2. Selecting the communication type’ is
set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

2. R
 otate [DIAL] to enter the repeater frequency,
then push [ï].

 tep 10. Selecting the duplex direction
S
LLWhen ‘Step 2. Selecting the communication type’
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.
LL“DUP–” is automatically set when the access
repeater frequency is entered in ‘Step 9. Entering
the access repeater frequency.’
LLIf necessary, you can change the duplex direction.

1. Select “TONE,” then push [ï].
••Enters the tone setting mode.

2. Select the option, then push [ï].

••OFF:	Turn the tone function OFF.
••TONE:	Select when the repeater requires an access
tone.
••TSQL:	Select when you want to use the tone squelch
operation in simplex.

1. Select “DUP,” then push [ï].
2. Select a duplex direction, then push [ï].

 tep 14. Selecting the repeater tone frequency
S
LLWhen ‘Step 2. Selecting the communication type’ is
set to “DV Repeater” or “DV Simplex,” this item is
not displayed.
LLThis setting is required when ‘Step 13. Setting the
tone’ is set to “TONE” or “TSQL.”

••OFF: Turn the duplex function OFF.
••DUP–:	The transmit frequency shifts down from the
receive frequency by the offset amount.
••DUP+:	The transmit frequency shifts up from the
receive frequency by the offset amount.

1. Select “REPEATER TONE,” then push [ï].
••Enters the repeater tone setting mode.

2. R
 otate [DIAL] to select the repeater tone
frequency, then push [ï].
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Entering new information into the Repeater List
DD Entering new information into the repeater list (Continued)
 tep 15. Selecting the position data accuracy level
S
LLWhen the Near Repeater Search function is not
used, or the distance between your position and a
repeater is not displayed, select “OFF,” and go to
‘Step 18. Setting the UTC offset.’

 tep 18. Setting the UTC offset
S
LLUTC (Universal Time Coordinated) offset is the
time difference between UTC and repeater local
time. This is a useful function to know the local time
of the destination repeater before you make a call.
(p. 4-42)

1. Select “POSITION,” then push [ï].
2. Select the position data accuracy level, then push
[ï].

1. Select “UTC OFFSET,” then push [ï].
••Enters the UTC offset entry mode.

2. R
 otate [DIAL] to set the time difference between
UTC and the local time, then push [ï].

••None:	Select when the repeater has no position
data.
••Approximate:	Select when the entered position data is
approximate.
••Exact:	Select when the entered position data is
exactly correct.

 tep 19. Saving the repeater list
S
1. Select “<<Add Write>>,” then push [ï].

••The confirmation dialog “Add Write?” is displayed.

2. Select <YES>, then push [ï].

 tep 16. Entering the latitude
S
LLThis item is displayed only when ‘Step 15.
Selecting the position data accuracy level’ is set to
“Approximate” or “Exact.”

••The entered contents are saved to the repeater list,
and the display returns to the selected repeater group
screen.

TIP: To cancel the entered data
1. Push [] to display “Cancel edit?” window.
2. Select <YES>, then push [ï] to cancel entry
and return to the selected repeater group
screen.
		

1. Select “LATITUDE,” then push [ï].
••Enters the latitude data entry mode.

2. Rotate [DIAL] to enter the latitude.

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
LLTo enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

3. After entering, push [ï].

 tep 17. Entering the longitude
S
LLThis item is displayed only when ‘Step 15.
Selecting the position data accuracy level’ is set to
“Approximate” or “Exact.”
1. Select “LONGITUDE,” then push [ï].
••Enters the longitude data entry mode.

2. Rotate [DIAL] to enter the longitude.

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
LLTo enter an east latitude longitude, select “E,” and to
enter a west longitude, select “W.”

3. After entering, push [ï].
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Editing a repeater list

Deleting a repeater list

This function edits a repeater’s data. This is useful
when already-entered data is incorrect, has changed,
or some data needs to be added to the list.

The entered repeater contents can be deleted from
the repeater list.
DV Memory > Repeater List

DV Memory > Repeater List

1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Repeater List,” then push [ï].
4. Select a repeater group where the repeater you
want to delete is listed, then push [ï].
		

1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Repeater List,” then push [ï].
4. Select a repeater group where the repeater you
want to edit is listed, then push [ï].
		

		 (Example: 11: Japan)
••Displays the repeater list of the selected repeater
group.

		 (Example: 11: Japan)
••Displays the repeater list of the selected repeater
group.

5. Select the repeater to be deleted, then push
[QUICK].
6. Select “Delete,” then push [ï].
		

5. Select a repeater you want to edit, then push
[QUICK].
6. Select “Edit,” then push [ï].
		

••The confirmation dialog “Delete?” is displayed.

7. Select an item, then edit it.
		

7. Select <YES>, then push [ï].
		

LLSee pages 4-34 ~ 4-36 for details.

••The selected repeater contents are deleted from the
repeater list, and returns to the selected repeater
group screen.

8. After editing, select “<<Overwrite>>.”
		

8. Push [MENU].

••Returns to the standby screen.

••The confirmation dialog “OverWrite?” is displayed.

9. Select <YES>, then push [ï].
		

••The edited contents are saved to the repeater list, and
returns to the selected repeater group screen.

10. Push [MENU].

••Returns to the standby screen.

4-37

Previous view

4

D-STAR OPERATION

Rearranging the display order of the repeater
You can move the entered repeaters to rearrange their
display order in the selected repeater group.
The entered repeater cannot be moved out of their
assigned repeater group.
Example: Moving "Hamacho" above “Inage.”
DV Memory > Repeater List
1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Repeater List,” then push [ï].
4. Select a repeater group where the repeater you
want to move is listed, then push [ï].
		

		 (Example: 11: Japan)

5. Select the repeater to be moved, then push
[QUICK].
6. Select “Move,” then push [ï].

••“DESTINATION” blinks at the top left of the screen.

7. S
 elect the location to insert the repeater you want
to move, then push [ï].

		

••The selected repeater is inserted above the
destination repeater name.
LLIf “<<Move End>>” is selected, the repeater is moved
to the bottom of the group.

8. Push [MENU].

••Returns to the standby screen.
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Adding the Repeater information using the RX History
This section describes how to add new repeater
information to the repeater list using the RX history.
1. Push [QUICK].
2. Rotate [DIAL] to select “RX History,” then push
[ï].
		

••Displays the RX HISTORY screen.

3. Rotate [DIAL] to display the repeater you want to
add to the repeater list, then push [ï].
		

••Displays the RX history detail screen.

4. R
 otate [DIAL] to display “RXRPT1” and
“RXRPT2.”
		

5. Push [QUICK].
6. Select “Add To RPT List,” then push [ï].
		

7. S
 elect the repeater call sign that you want to add
to the repeater list, then push [ï].
		

••Displays the REPEATER LIST EDIT screen. The
selected repeater call sign is automatically entered.
LLSee pages 4-34 ~ 4-36 to edit the contents.

TIP: How to select the display type
The RX HISTORY screen has two display types,
Name Display and Call Sign Display.
(Default: Name Display)

8. Select “<<Add Write>>,” then push [ï].
		

1. On the RX HISTORY screen, push [QUICK].
2. Select “Name Display” or “Call Sign Display,”
then push [ï].
		

••The confirmation dialog “Add Write?” is displayed.

9. Select <YES>, then push [ï].
		

••The repeater contents are added to the repeater list,
and the display returns to the RX HISTORY screen.

LLEven if “Name Display” is selected, the call sign is
displayed when a name is not entered in the DV
memory.
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Skip setting for the DR scan
You can set repeaters as scan skip repeaters. The
selected repeaters are skipped for faster scanning.
You can set the skip setting to all repeaters in the
selected repeater group, or to individual repeaters.
LLWhen a repeater is specified as a skip repeater, its
“USE (FROM)” setting is automatically set to “NO.”
In that case, the repeater cannot be selected in
“FROM” field (Access repeater).

DDIndividual skip setting
DV Memory > Repeater List
1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Repeater List,” then push [ï].
4. Select a repeater group where the repeater you
set the skip setting is listed, then push [ï].
		

		 (Example: 11: Japan)
••Displays the repeater list of the selected repeater
group.

5. Select the repeater to be skipped, then push
[QUICK].
6. Select “SKIP,” then push [ï].
		

TIP:
••When you select “Repeater List” on the FROM
SELECT screen, you can set the skip setting as
described to the left.
••When “FROM” is selected, push [QUICK] to set
the skip setting, as shown below.
		

••Displays “SKIP” on the selected repeater’s information
window.
LLSelect “SKIP” again to cancel the skip setting.
LLSelect “SKIP All ON” to set the skip setting to all
repeaters in the group.

DDGroup skip setting

1. On the REPEATER GROUP screen, select a
repeater group, as described above.
2. Push [QUICK], then select “SKIP All ON” to skip
the repeaters in the group during the DR scan.
		

LLDisplays “SKIP” in the “FROM” field.
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Entering the repeater group name
DV Memory > Repeater List > Repeater Group
1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Repeater List,” then push [ï].
4. Select a repeater group that you edit the name.
		

		 (Example: 22:)

5. Push [QUICK].
6. Select “Edit Name,” then push [ï].
		

7. Enter a group name of up to 16 characters.
		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

8. After entering, push [ï].
		

9. Push [MENU].

••Returns to the standby screen.
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Repeater detail screen
According to the content, such as position data, UTC
offset, and so on, the distance between your position
and the repeater or the repeater time can be displayed
on the REPEATER DETAIL screen.
The detail screen can also be entered from the FROM
SELECT screen.
Example: D
 isplaying the “Hamacho” repeater detail
screen
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [ï].
		

The REPEATER DETAIL screen
Sub name Call sign
Repeater name
Repeater time
Direction from
your position*

••Displays the TO SELECT screen.
LLOn the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

Distance
from your
position

3. Select “Gateway CQ,” then push [ï].
		

Group number
Duplex setting
Repeater
frequency

* When the position data accuracy level is set to
“Approximate,” direction data is not displayed if the
distance to the repeater is less than 5 kilometers.

4. Select “11: Japan,” then push [ï].
		

TIP: You can display the repeater details screen
when the DR screen is displayed:
When you set the repeater as shown below, push
[QUICK], then select “Repeater Detail.”
		

5. Select “Hamacho,” then push [QUICK].
		

6. Select “Detail,” then push [ï].

••Displays the REPEATER DETAIL screen.

		

••Displays the REPEATER DETAIL screen.

LLIf there is no position data, the distance and direction
from your position are not displayed.
(p. 5-3)
LLWhen selecting the FM repeater, either of “FM” or
“FM-N” and the tone setting are displayed.

7. Push [ï].

••Returns to the previous screen.
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Entering Your (destination) call sign
You can manually enter a Your (destination) call sign.
When a Your (destination) call sign is set to “TO,” you
can make a call to a station, even if you do not know
where the station is currently located.
Up to 300 Your call signs can be entered.
Example: Entering “Station 1/JM1ZLK” to the Your
Call Sign memory.
DV Memory > Your Call Sign

12. Select “<<Add Write>>,” then push [ï].
		

1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Your Call Sign,” then push [ï].
4. Push [QUICK].
5. Select “Add,” then push [ï].
		

••The confirmation dialog “Add Write?” is displayed.

13. Select <YES>, then push [ï].
		

••Displays the YOUR CALL SIGN EDIT screen.

6. Select “NAME,” then push [ï].
		

••“Station 1 JM1ZLK” is entered into the Your Call Sign
memory.

••Enters the name entry mode.

14. Push [MENU].

7. E
 nter a name of up to 16 characters.
(Example: S
 tation 1)
		

••Returns to the standby screen.

TIP:
To cancel the entered data
1. Push [] to display “Cancel edit?.”
2. Select “YES” to cancel the entry and the display
returns the YOUR CALL SIGN screen.
		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

8. After entering, push [ï].
9. Select “CALL SIGN,” then push [ï].
		

To edit the entered data:
To edit the entered data, select “Edit” in step 5.
This is useful when already-entered data is incorrect,
has changed or some data needs to be added to the
list.
		

••Enters Your call sign entry mode.

10. E
 nter Your call sign of up to 8 characters,
including spaces. (Example: JM1ZLK)
		

11. After entering, push [ï].
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Deleting Your (destination) call sign
You can delete Your (destination) call signs from the
Your Call Sign memory.
DV Memory > Your Call Sign
1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Your Call Sign,” then push [ï].
4. Push [QUICK].
5. Select “Delete,” then push [ï].
		

••The confirmation dialog “Delete?” is displayed.

6. Select <YES>, then push [ï].
		

••The selected call sign contents are deleted from the
Your call sign list, and the display returns to the YOUR
CALL SIGN screen.

7. Push [MENU].

••Returns to the standby screen.

TIP: You cannot delete the Your (destination) call
sign if it is selected on the DR screen. In that case,
the following screen is displayed.
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Rearranging the display order of Your (destination) call signs
You can move Your call signs to rearrange their
display order.
It is easy to find stations that you often communicate
with if the stations are moved to the top of the list.
Example: Moving “Station 1” above “Station 3.”
DV Memory > Your Call Sign
1. Push [MENU].
2. Rotate [DIAL] to select “DV Memory,” then push
[ï].
3. Select “Your Call Sign,” then push [ï].
4. S
 elect a Your (destination) call sign to be moved,
then push [QUICK].
5. Select “Move,” then push [ï].

••“DESTINATION” blinks at the top left of the screen.

6. Select the location to insert the call sign you want
to move, then push [ï].

		

••The selected call sign is inserted to above the
destination.
LLIf “<<Move End>>” is selected, the call sign is moved
to the bottom of the list.

7. Push [MENU].

••Returns to the standby screen.
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Your setting is correct?
If you make a local area call with a gateway setting
still selected in “TO,” the destination repeater will be
busy while you transmit.
So the stations that use that repeater as their Access
repeater cannot access it, as shown below.
BE SURE to set CQCQCQ in “TO” when you intend to
make a local call, or after you finish a Gateway call.
Example: JM1ZLK wants to make a Local area call.
Hamacho repeater
ing
sten r t A
i
l
po
ZLK
JM1 P1YIU all...
c
J
l
on loca
a
for

Hirano repeater

ning
liste r t A
K
L
po
Z
JM1 P1YIU all...
c
J
l
on loca
a
for

g
tenin
LK lis
A
JM1Z YIU por t
1
on JP cal call...
lo
for a

Caller
(JM1ZLK)

t!

rrec
ng is inco
His setti cess the
ac
I cannot
!
repeater

Called
Hirano area
Hamacho area

JM1ZLK’s setting

The destination (“TO”) setting is incorrect.
Correct setting

To make a Local area call, set the
destination (“TO”) to “CQCQCQ.”
See page 4-9 for details.
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NOTE: With this setting, the Local area call can be
made, but the destination repeater, selected in “TO,”
is also busy while you transmit.
So the station that uses the destination repeater as
their Access repeater cannot access it.

Previous view

Section 5

GPS OPERATION
GPS operation......................................................................... 5-2
DDConfirming the GPS signal receiving............................... 5-2
DDWhen a received signal contains position data................ 5-2
Checking your location............................................................ 5-3
DDDisplaying Position Data.................................................. 5-3
DDDisplayed items............................................................... 5-5
DDTX format: D-PRS Position (Mobile)................................ 5-6
DDTX format: D-PRS Position (Base).................................. 5-6
DDTX format: D-PRS Object................................................. 5-7
DDTX format: D-PRS Item..................................................... 5-7
DDTX format: D-PRS Weather.............................................. 5-8
DDTX mode: NMEA.............................................................. 5-8
DDChanging the GPS memory or alarm............................... 5-9
DDAbout the Grid Locator..................................................... 5-9
DDChanging the Compass Direction.................................. 5-10
DDSaving your own or a received position data................. 5-10
Checking GPS information (Sky view screen)........................5-11
Transmitting GPS data (D-PRS and NMEA)......................... 5-12
DDType of position data...................................................... 5-12
Transmitting D-PRS data....................................................... 5-13
DDD-PRS............................................................................ 5-13
DDOperating in the D-PRS mode....................................... 5-13
DDDisplayed items............................................................. 5-14
DDSetting D-PRS Position (Mobile/Base).......................... 5-15
DDSetting D-PRS Object/Item............................................ 5-17
DDSetting D-PRS Weather................................................. 5-21
DDWeather station transmission......................................... 5-23
DDConfirming the weather data input................................. 5-23
DDApplication setting.......................................................... 5-23
DDAbout the weather data content..................................... 5-23
DDDisplaying your location using a mapping software....... 5-24
Transmitting NMEA data........................................................ 5-25
DDSetting the GPS data sentence..................................... 5-25
DDEntering a GPS message.............................................. 5-26
Adding or editing GPS memory............................................. 5-27
DDGPS memory................................................................. 5-27
DDAdd a GPS memory....................................................... 5-27
DDEntering the GPS Memory group name......................... 5-30
DDDeleting GPS memory................................................... 5-30
DDRearranging the display order of the GPS data............. 5-31
DDSetting the GPS alarm................................................... 5-32
GPS Logger function............................................................. 5-34
DDGPS Logger operating outline....................................... 5-34
DDGPS Logger operation................................................... 5-34
DDSetting the GPS record interval..................................... 5-34
DDSetting the GPS record sentence.................................. 5-35
DDViewing the log data on a PC Map................................ 5-36
GPS Auto transmission for only Simplex............................... 5-38
DDSetting the GPS automatic transmission....................... 5-38

5-1

Previous view

5

GPS OPERATION

GPS operation
DDWhen a received signal contains
position data

NOTE: The built-in GPS receiver cannot calculate
its position data if it cannot receive signals from the
GPS satellites.

When a received signal contains position data, the
caller’s position data is displayed in the RX position
window.
See page 5-3 for details.

The transceiver has a built-in internal GPS receiver.
The GPS receiver’s position data can be received in
any mode. Also, a NMEA format compatible external
GPS receiver can be connected to the transceiver
through the [DATA] jack.
To receive signals from an external GPS source,
connect an external NMEA format compatible receiver
to the transceiver according to the instructions, shown
to the right.
Position data can be transmitted in only the DV mode.

Example: When the signal from JM1ZLK contains
position data.

When you receive the signal, the RX
position data is displayed in the RX
position window.

DDConfirming the GPS signal receiving

Confirm the GPS receiver is receiving your position
data.
	The GPS icon blinks when searching for satellites.
➪
➪
➪

After a few seconds, the window disappears.

	The GPS icon stops blinking when the minimum
needed number of satellites is found.
When the received signal contains
position data, the RX position icon is
displayed as shown above.

LLIt may take only a few seconds to receive, or it may take
a few minutes, depending on your operating environment.
If you have difficulties receiving, we recommend that you
try a different location.
LLWhen the “GPS Select” item is set to “Manual,” the icon
is not displayed.
(GPS > GPS Set > GPS Select) (p. 9-24)

LLYou can turn OFF the caller’s position data
indication. (p. 9-63)
(Display > RX Position Display)
LLYou can turn OFF the RX position icon indication.
(p. 9-63)
(Display > RX Position Indicator)

Connection

To the
[DATA] jack

Cable

GPS
Receiver
To the
RS-232C port

Terminal information
e

q
2.5 mm
(0.1 in) (d)

w

q Tip: RXD
w Ring: TXD
e Sleeve: GND
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Checking your location
[About the GPS Position screen]
<MY>
Compass direction
Longitude

You can check your current location.
This section is described using received position data.

top is North.

DDDisplaying Position Data

1. Push [QUICK].
2. Select “GPS Position,” then push [ï].
3. Rotate [DIAL] to select the screen.

••My screen (MY), the received screen (RX), the GPS
Memory channel screen (MEM), and the GPS Alarm
channel screen (ALM) are selectable.
••MY:	Displays your location in latitude and longitude,
grid locator, altitude, speed*, time, compass
heading* and course direction*.
				
* Does not displayed when “GPS Select” is set
to “Manual.” (p. 9-24)
(GPS > GPS Set > GPS Select)
••RX:	Displays the caller station’s location in latitude
and longitude, grid locator, altitude, distance/
direction from your location, SSID, course,
speed, TX power level, height, antenna gain,
antenna direction, temperature, rainfall, wind
direction, wind speed, barometric pressure,
humidity, Time stamp, D-PRS symbol, and call
sign.
Depending on the received signal, some data
may not be displayed. (p. 5-5)
••MEM:	Displays the GPS memory channel’s location
in latitude and longitude, grid locator, and
distance/direction from your location.
••ALM: 	Displays the GPS alarm memory channel
location in latitude and longitude, grid locator,
and distance/direction from your location.

Displays
Your course Grid
My location
direction is
locator
90° degrees.

Direction from
your location
Caller is
south of you.

The course
heading of the
caller is 95
degrees.

Direction from
your location
The location is
East of you.

Direction from
your location
The location is
East of you.

*
Displays the GPS
Memory position screen

Distance from
your location

*
Displays the GPS
alarm position screen

Distance from
your location

*When a name is not entered in the Memory channel, date
and time are displayed instead of the name.

GPS alarm:
Tokyo Big Sight
236 ml

This is an

Caller station (D-PRS: mobile) example for
Course: 95 degrees
Speed: 7.8 mph

D-PRS symbol
Displays the time the caller
acquired the position data

<ALM>

NOTE: Latitude, longitude, and altitude data may
differ, depending on your GPS.

78.0 ml

Distance from
your location

<MEM>

TIP: If you transmit with the GPS POSITION screen
open, the screen is temporarily canceled. To check
the position data while transmitting, push [QUICK],
then select “GPS Position” while transmitting.

236 ml

Displays received
position screen

Caller’s call sign with SSID

••Returns to the standby screen.

Course: 90 degrees
Speed: 21.2 mph

Time

<RX>
When the caller’s TX format is D-PRS Position (Mobile
station)

4. Push [].

Your station

Altitude Speed

Your course
heading is
East.

••Displays the GPS POSITION screen.

GPS memory:
Tokyo Skytree

Latitude

the GPS data
screens

5-3

Previous view

5

GPS OPERATION

Checking your location (Continued)
GPS position data has two transmit modes, D-PRS
and NMEA. Moreover, with the D-PRS mode data,
five position formats, Position (Mobile station/Base
station), Object, Item and Weather, are selectable.
D-PRS

NMEA

Position (Mobile)
Position (Base)
Object
Item

Example: When the caller’s TX format is D-PRS
Position (Mobile)

Weather

••D-PRS:	D-PRS is a function which simultaneously
sends position data received from the
internal or external GPS receiver, using the
slow speed data packet space, along with
voice.
••Mobile:	A station operating from a vehicle, a
vessel, or other location, away from it's
normal base location.
••Base:	A station operating at home or in any
building.
••Object:	Transmitting Object data such as an
earthquake information, satellite track
information, and so on.
An Object contains a time stamp.
••Item:	Transmitting Item data such as a traffic
accident, lighthouse, antenna, or DV
access point location, and so on.
An Item does not contain a time stamp.
••Weather:	A station transmitting a weather information
received from the weather device.
••NMEA:	A station transmitting position data
(NMEA0183) received from the internal or
an external GPS receiver.

TIP: For users who have a D-STAR transceiver
model prior to the ID-4100A/E:
The GPS TX mode, “GPS (DV-G)” and “GPS-A (DVA),” are now called “NMEA” and “D-PRS.”
••GPS (DV-G)  NMEA
••GPS-A (DV-A)  D-PRS
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Checking your location (Continued)

DDDisplayed items

✓
✓
✓
✓
✓
✓
✓
✓

✓
✓
✓
✓

✓
✓

✓
✓
✓

✓
✓
✓

✓
✓
✓
✓
✓
✓
✓
✓

✓
✓
✓
✓

✓
✓
✓

✓
✓
✓

✓
✓
✓

✓: Displayed
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✓
✓
✓
✓
✓
✓

Weather

✓
✓
✓
✓
✓
✓

Data extension: Power/Height/Gain/Directivity

✓
✓
✓
✓
✓
✓

Data extension: Course/Speed

Data extension: OFF

✓
✓
✓
✓
✓
✓

Data extension: Power/Height/Gain/Directivity

✓
✓
✓
✓
✓
✓

Data extension: Course/Speed

✓
✓
✓
✓
✓
✓
✓
✓

Data extension: OFF

✓
✓
✓
✓
✓
✓
✓
✓

Base

Mobile

Compass
Latitude
Longitude
Grid locator
Altitude
Distance
Course
Speed
Power
Height
Gain
Directivity
Temperature
Rainfall
Wind direction
Wind speed
Barometric pressure
Humidity
Symbol
Time stamp
Call sign

NMEA

Depending on the caller’s transmit mode or transmit format, the displayed items differ.
D-PRS
Position
Object
Item

✓
✓
✓
✓
✓

✓
✓
✓
✓

✓

✓

✓

✓

✓

✓

✓
✓
✓
✓
✓
✓
✓
✓
✓
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Checking your location (Continued)

DDTX format: D-PRS Position (Mobile)

DDTX format: D-PRS Position (Base)

Displays the following items when the caller’s TX
format is D-PRS Position (Mobile).
		

Compass
Latitude
Longitude
GL
ALT
DST
COURSE
SPEED
Symbol
GPS Time Stamp
Call sign

Displays the following items when the caller’s TX
format is D-PRS Position (Base).
		

Displays the caller’s direction
from your location
Displays the caller’s latitude
Displays the caller’s longitude
Displays the grid locator based
on the caller’s latitude and
longitude.
Displays the caller’s altitude
Displays the caller’s distance
from your location
Displays the caller’s course over
ground
Displays the caller’s speed
Displays the caller’s D-PRS
symbol
Displays the time that the caller
acquired the position data.
Displays the caller’s call sign
(with SSID)

Compass
Latitude
Longitude
GL
ALT
DST
POWER
HEIGHT
GAIN
DIRECT
Symbol
GPS Time Stamp
Call sign

5-6

Displays the caller’s direction
from your location
Displays the caller’s latitude
Displays the caller’s longitude
Displays the grid locator based
on the caller’s latitude and
longitude.
Displays the caller’s altitude
Displays the caller’s distance
from your location
Displays the caller’s TX power
level
Displays the height of the caller’s
antenna
Displays the gain of the caller’s
antenna
Displays the direction the caller’s
antenna was pointing
Displays the caller’s D-PRS
symbol
Displays the time that the caller
acquired the position data.
Displays the caller’s call sign
(with SSID)
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Checking your location (Continued)

DDTX format: D-PRS Object

DDTX format: D-PRS Item

Displays the following items when the caller’s TX
format is D-PRS Object.
		

Compass
Latitude
Longitude
GL
ALT
DST
COURSE
SPEED
POWER
HEIGHT
GAIN
DIRECT
Symbol
GPS Time Stamp
Call sign

Displays the following items when the caller’s TX
format is D-PRS Item.
		

Displays the Object’s direction
from your location
Displays the Object’s latitude
Displays the Object’s longitude
Displays the grid locator based on
the Object’s latitude and longitude
Displays the Object’s altitude
Displays the Object’s distance
from your location
Displays the Object’s course
over ground
Displays the Object’s speed
Displays the Object’s TX power
level
Displays the height of Object’s
antenna
Displays the gain of Object’s
antenna
Displays the direction that the
Object’s antenna was pointing
Displays the Object’s D-PRS
symbol
Displays the time that the caller
sent the Object’s data.
Displays the caller’s call sign
(with SSID)

Compass
Latitude
Longitude
GL
ALT
DST
COURSE
SPEED
POWER
HEIGHT
GAIN
DIRECT
Symbol
Call sign

Displays the Item’s direction from
your location
Displays the Item’s latitude
Displays the Item’s longitude
Displays the grid locator based
on the Item’s latitude and
longitude
Displays the Item’s altitude
Displays the Item’s distance from
your location
Displays the Item’s direction over
ground
Displays the Item’s speed
Displays the Item’s TX power
level
Displays the height of Item’s
antenna
Displays the gain of Item’s
antenna
Displays the direction that the
Item’s antenna was pointing
Displays the Item’s D-PRS
symbol
Displays the caller’s call sign
(with SSID)

LLWhen the Item’s status is finished, “KILLED” is
displayed.

LLWhen the Object’s status is finished, “KILLED” is
displayed.
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Checking your location (Continued)

DDTX format: D-PRS Weather

DDTX mode: NMEA

Displays the following items when the caller’s TX
format is D-PRS Weather.
		

Compass
Latitude
Longitude
GL
DST
TEMP
RAIN
WDIR
WSPD
BARO
HUMI
Symbol
GPS Time Stamp
Call sign

Displays the following items when the caller’s TX
mode is NMEA.
		

Displays the caller’s direction
from your location
Displays the caller’s latitude
Displays the caller’s longitude
Displays the grid locator based
on the caller’s latitude and
longitude
Displays the caller’s distance
from your location
Displays the temperature of the
caller’s area
Displays the rainfall of the
caller’s area
Displays the wind direction of the
caller’s area
Displays the wind speed of the
caller’s area
Displays the barometric pressure
of the caller’s area
Displays the humidity of the
caller’s area
Displays the caller station’s
D-PRS symbol
Displays the time that the caller
acquired the weather data.
Displays the caller’s call sign
(with SSID)

Compass
Latitude
Longitude
GL
ALT
DST
COURSE
SPEED
GPS Time Stamp
Call sign
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Displays the caller’s direction
from your location
Displays the caller’s latitude
Displays the caller’s longitude
Displays the grid locator based
on the caller’s latitude and
longitude
Displays the caller’s altitude
Displays the caller’s distance
from your location
Displays the caller’s direction
over ground
Displays the caller’s speed
Displays the time that the caller
acquired the position data.
Displays the caller’s call sign
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Checking your location (Continued)

DDChanging the GPS memory or alarm

DDAbout the Grid Locator

You can change the GPS memory or GPS alarm in
the GPS POSITION screen.

Grid Locator (GL) is a location compressed into a 6
character code, calculated by the longitude and the
latitude.
The locator is simply calculated by dividing the earth
surface into squares.
It is used to find the area of a radio station.

1. Push [QUICK].
2. Rotate [DIAL] to select “GPS Position,” then push
[ï].
••Displays the GPS POSITION screen.

3. Rotate [DIAL] to display the MEM screen or ALM
screen.
4. Push [QUICK].
5. When the MEM screen is displayed in step 3,
select “GPS Memory Select,” or when the ALM
screen is displayed in step 3, select “Alarm
Select.”
		
MEM screen

Field

PM74SO
Square
Subsquare

••The grid locator map of Japan
44

ALM screen
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74

43

47

LLSee “Adding or editing GPS memory” or “Setting the
GPS alarm” for details. (pp. 5-27, 5-32)

140°
64

42

46

6. Select the GPS memory or GPS alarm to display
on the GPS POSITION screen.
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Checking your location (Continued)

DDChanging the Compass Direction

DDSaving your own or a received position
data

You can change the compass direction between
Heading Up, North Up, and South Up.
Heading Up

North Up

You can save the position data of your station from
wherever you are, and also the position data of the
caller station.
The GPS Memory has a total of 300 channels, and
the channels can be assigned into one of 27 banks, A
~ Z, and (No Group).

South Up

1. Push [QUICK].
2. Rotate [DIAL] to select “GPS Position,” then push
[ï].
••Displays the GPS POSITION screen.

1. Push [QUICK].
2. Rotate [DIAL] to select “GPS Position,” then push
[ï].

3. Select the screen that you want to save.
		

••Displays the GPS POSITION screen.

3. Push [QUICK].
4. S
 elect “Compass Direction,” then push [ï].
		

LLTo save your own position data: MY screen
LLTo save a received position data: RX screen

4. Push [QUICK].
5. Select “Add To GPS Memory,” then push [ï].
		

5. Select the compass direction.
••Heading Up:	The compass always points to your
heading course direction.
••North Up:
The top is always north.
••South Up: The top is always south.

LLSee pages 5-27 ~ 5-29 for entering details.

6. Select “<<Add Write>>,” then push [ï].
		

When you select “South Up.”

••The confirmation dialog “Add write?” is displayed.
LLTo select the destination group to be saved, select
“GROUP.”

7. Select <YES>, then push [ï].
		

••Saves the data in the GPS memory, then returns to
the GPS POSITION screen.

8. Push [].

••Returns to the standby screen.

TIP: The position data is saved in the selected
group with the "GROUP" item.
(GPS > GPS memory)
5-10
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GPS OPERATION

Checking GPS information (Sky view screen)
This screen is used to view GPS satellite information
when the GPS icon does not stop blinking for a long
time.
GPS Information displays the quantity, signal power
and location of the GPS satellites.
The sky view screen displays the location of GPS
satellites. The screen also displays the direction,
elevation angle, satellite numbers, and their receiving
signal strength status.

Signal strength graph

1. Push [QUICK].
2. Rotate [DIAL] to select “GPS Information,” then
push [ï].

Sky
view
screen

••Displays the GPS INFORMATION screen.

		

Altitude Tracking Longitude Latitude
satellite
quantity
North

		 Meaning of each icon
••():
Untracking satellite.
••(01):	Tracking satellite with a weak signal,
shown by the satellite number.
••(‚1):	Tracking satellite with a strong signal,
shown by the satellite number.
••(SAT):
The quantity of tracking satellites.
••Altitude:	The altitude of your station.
The altitude is only displayed when 4
or more satellites are tracked. When 3
or less satellites are tracked, “------ft”
is displayed.
••Longitude/Latitude:
			Longitude and Latitude of your
station.
••Signal strength graph:
				
Signal strength of the satellites
				
: Tracking satellite with a strong
signal
				
: Tracking satellite with a weak
signal
				
: Untracking satellite
3. Push [].

Untracking
satellite
Satellite
number 16’s
signal is weak.

Satellite
number 7’s
signal is
strong.

Elevation angle
0 degree line
Elevation angle
30 degree line
Elevation angle
60 degree line
Elevation angle
90 degree line
(Zenith)

••The image of the satellite number 7

••Returns to the standby screen.

N

Elevation angle 90
degree line (Zenith) Elevation angle
60 degree line
Elevation angle
E 30 degree line
Elevation angle
0 degree line

Satellite
number 7

W
5-11
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GPS OPERATION

Transmitting GPS data (D-PRS and NMEA)
DDType of position data

GPS position data has two types of TX mode, D-PRS
and NMEA. Moreover, in the D-PRS mode, you can
select a TX format from Position (Mobile station/Base
station), Object, Item and Weather.
Type of position data for transmission
D-PRS (p. 5-13)

NMEA (p. 5-25)

Position (Mobile) (p. 5-15)
Position (Base) (p. 5-15)
Object (p. 5-17)
Item (p. 5-17)
Weather (p. 5-21)
••D-PRS:	D-PRS is a function that simultaneously
sends position data received from the
internal or external GPS receiver, using the
slow speed data packet space, along with
voice.
••Mobile:	A station operating from a vehicle, a vessel,
or other location, away from it's normal
base location.
You can transmit direction and speed
information.
••Base:	A station operating at home or in a building.
You can transmit the TX power level,
height, antenna gain and antenna direction
information.
••Object:	Transmitting Object data such as an
earthquake information, satellite track
information, and so on.
An Object contains a time stamp.
••Item:	Transmitting Item data such as a traffic
accident, lighthouse, antenna, or DV
access point location, and so on.
An Item does not contain a time stamp.
••Weather:	A station transmitting weather information
received from a weather device.
••NMEA:	A station transmitting position data
(NMEA0183) received from the internal or
external GPS receiver.

For users who have a D-STAR transceiver model
prior to the ID-4100A/E:
The GPS TX mode, “GPS (DV-G)” and “GPS-A (DVA),” are now called as “NMEA” and “D-PRS.”
• GPS (DV-G)  NMEA
• GPS-A (DV-A)  D-PRS
For users who have one of the following models:
(ID-800H, IC-91AD/E91, IC-U82, IC-V82, IC-7100,
ID-51A/E, ID-31A/E, IC-9100, IC-80AD/E80D, ID880H/E880, IC-92AD/E92D, IC-2820H/E2820)
When you receive a D-PRS position (Base),
Object, Item or Weather signal, position data is not
displayed.
5-12
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GPS OPERATION

Transmitting D-PRS data
When D-PRS is selected as GPS TX mode, you can
transmit D-PRS data.
When operating in the D-PRS mode, the following
codes are transmitted to the PC.
D-PRS code is based on APRS® code.
(APRS®: Automatic Packet Reporting System).

NOTE:
••If “GPS select” is set to “Manual,” the manually
entered position data in “Manual Position” is
change to the D-PRS data format to transmit.
(p. 9-24)
(GPS > GPS Set > Manual Position)
••Please note that if “GPS Auto TX” is set to any
other setting than “OFF,” the data is transmitted
according to the set time. (p. 9-40)
(GPS > GPS Auto TX)

DDD-PRS

D-PRS is a mode that simultaneously sends position
data received from the internal or external GPS
receiver, using the slow speed data packet space,
along with voice in the DV mode.
In an analog mode, you can transmit or receive
only voice or data at one time. However a D-PRS
capable radio can transmit or receive message data
or GPS position data at the same time voice is being
transmitted or received.
I-GATE is required to send position data to the APRS
server.
The image of D-PRS
<Using a repeater>
Voice, Messages and
D-PRS positions

Information from an APRS network
D-STAR
repeater

D-PRS positions

I-GATE

Voice, Messages and
D-PRS positions

<Simplex>

JA3YUA-Z

Voice, Messages and
D-PRS positions

D-PRS
positions

PC
APRS server

Voice, Messages and
D-PRS positions

I-GATE

D-PRS positions

DDOperating in the D-PRS mode

To transmit in D-PRS, follow the steps below, and
for more details, see the pages listed along with the
steps.

You can check the
location on a map site.

TIP: In the D-PRS mode, you can transmit
earthquake or weather information, in addition to
position data.
(GPS > GPS TX mode > TX format)

1. “MY” (Your own call sign) entering (p. 9-47)
2. Receiving GPS data (p. 5-2)
3. Set “GPS TX mode” to “D-PRS.” (p. 5-15)

TX format of D-PRS
••Position (Mobile/Base):
				Used to transmit position data.
••Object:	Used to transmit specific position data.
(Contains a time stamp.)
••Item:	Used to transmit specific position data.
(Does not contain a time stamp.)
••Weather:	Used to transmit weather information.

LLSet transceivers prior to the ID-4100A/E to “GPS-A
(DV-A).”

4. Set TX information (pp. 5-15 ~ 5-22)

LLYou must set SSID and symbol.
(GPS > GPS TX Mode > D-PRS > TX Format >
Position, Object, item or Weather > SSID, Symbol)

			 
Complete (You can transmit in the D-PRS mode.)

5-13
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GPS OPERATION

Transmitting D-PRS data (Continued)

DDDisplayed items

Data extension: Power/Height/Gain/Directivity

Weather

✓
✓
✓

✓
✓
✓
✓
✓
✓
✓

Data extension: Course/Speed

✓

Data extension: OFF

✓

Data extension: Power/Height/Gain/Directivity

✓
✓
✓

Data extension: Course/Speed

✓
✓
✓

Data extension: OFF

Base

Unproto Address
Comment
Altitude
Object Name/Item
Name
Data Type
Position information
(Latitude/Longitude/
Altitude)
Data Extension
Course
Speed
Power
Height
Gain
Directivity
Symbol
SSID
Time stamp

Mobile

Depending on the TX format, the setting items and displayed order of the items differ.
D-PRS
Position
Object
Item

✓
✓

✓
✓

✓
✓

✓
✓

✓
✓

✓
✓

✓
✓

✓

✓

✓

✓

✓

✓

✓
✓

✓
✓

✓
✓

✓
✓

✓
✓

✓
✓

✓

✓
✓
✓

✓

✓

✓
✓
✓

✓

✓
✓
✓

✓
✓
✓

✓
✓
✓
✓
✓
✓
✓

✓
✓

✓: Displayed

5-14
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GPS OPERATION

Transmitting D-PRS data (Continued)

DDSetting D-PRS Position (Mobile/Base)
Set to transmit as a D-PRS Position.

1. Setting the GPS TX Mode to D-PRS

5. Setting the SSID
To assist in identifying a station’s type, the displayed
APRS® (Automatic Packet Reporting System) based
SSID is added after the D-PRS data call sign.
The way to add SSID’s differs, depending on whether
you enter a space in your call signs or not.

GPS > GPS TX Mode
1.
2.
3.
4.

Push [MENU].
Rotate [DIAL] to select “GPS,” then push [ï].
Select “GPS TX Mode,” then push [ï].
Select “D-PRS,” then push [ï].

1. Select “SSID,” then push [ï].
2. Select the SSID, then push [ï].
••---:	The space in call sign is converted
to “-.” If no text is entered after the
space, the space will be deleted, and
the space is not converted to “-.”
Example: JA3YUA A > JA3YUA-A
••(-0):	No SSID is added. If a call sign
includes a space, any text or digit
after the space will be deleted.
••-1~-15:	Adds an SSID of -1 to -15 to your call
sign.
Example: SSID is “-9.”
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call
sign.
Example: SSID is “-Z.”
JA3YUA A → JA3YUA-Z

TIP: If the TX information setting has been done, you
can easily turn ON the GPS TX mode by pushing
[MENU] after step 4.
••Returns to the standby screen, then displays “

.”

2. Checking the Unproto Address
You should use the default address, and editing is not
recommended.
1. Select “Unproto Address,” then push [ï].
LLThe default setting is “API410,DSTAR*.”

2. P
 ush [].

••Returns to the previous screen.

3. Setting the TX format to “Position”
1. Select “TX Format,” then push [ï].
2. Select “Position,” then push [ï].
••Displays the POSITION screen.

4. Setting the Symbol
Select the symbol that indicates your operating
situation. The selected symbol channel’s symbols
(1~4) are transmitted along with the position data.
1. Select “Symbol,” then push [ï].
2. Select the symbol channel, then push [QUICK].
3. Select “Edit Symbol,” then push [ï].
4. Select the symbol, then push [ï].

About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

LL1:Car, 2: Van, 3: Truck, and 4:House QTH (VHF) are
set as defaults.
LLSee page 9-24 to directly edit a symbol.

☞☞Continued on the next page.

5. Select the symbol channel, then push [ï].
••Returns to the POSITION screen.
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GPS OPERATION

Transmitting D-PRS data
DD Setting D-PRS Position (Mobile/Base) (Continued)
6. Entering a comment
Enter a comment, and transmit it with the D-PRS
position data.
The number of characters you can enter differs,
depending on the data extension and altitude settings.
(See to the right.)
Data Extension

8. Setting the Altitude
Set the altitude data transmission.
1. Select “Altitude,” then push [ï].
2. Select “ON,” then push [ï].
NOTE: If you transmit with the altitude setting ON,
the character string is included in a comment on the
products that cannot display the altitude. (IC-9100,
IC-80AD, IC-E80D, ID-880H, ID-E880, IC-92AD, ICE92D, IC-U82, IC-V82)

Characters
Altitude entered (Max.)

OFF

OFF

43 (Default)

OFF

ON

35

Course/Speed

OFF

36

Course/Speed

ON

28

Power/Height/Gain/Directivity

OFF

36

Power/Height/Gain/Directivity

ON

28

9. Setting the Data Extension
Set the data extension of your station’s information.
1. Select “Data Extension,” then push [ï].
2. Select the option to transmit, then push [ï].
••OFF:	Does not transmit any
information.
••Course/Speed:	Transmits the course and speed
data along with the position data.
••Power/Height/Gain/Directivity:
				Transmits the TX power level,
height, antenna gain and antenna
direction, along with the position
data.

1. Select “Comment,” then push [ï].
2. Select the comment number 1 ~ 4, then push
[QUICK].
3. Select “Edit,” then push [ï].
••Enters the Comment entry mode.

4. Enter a comment.

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)

10. Setting the TX power
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

¬

LLSee “Entering and editing text” for details. (p. iv)
LLThe symbol “ ” shows the transmittable comment
range. Please note that the characters that exceed
the range will not be transmitted.

5. After entering, push [ï].
6. Select the entered comment number, then push
[ï].

Select the TX power level of the base station, to
transmit along with the position data.
1. Select “Power,” then push [ï].
2. Select the option, then push [ï].
••Options: Set to between 0, 1, 4, 9, 16, 25, 36,
49, 64, and 81W.

7. Setting the Time Stamp
Set the time stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
1. Select “Time Stamp,” then push [ï].
2. Select the time stamp, then push [ï].
••OFF: Does not transmit the time information.
••DHM:	Transmits the time stamp in the Day, Hour,
and Minute format.
••HMS:	Transmits the time stamp in the Hour,
Minute, and Second format.

11. Setting the antenna height
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”
Select the height of the base station’s antenna, to
transmit along with the position data.
1. Select “Height,” then push [ï].
2. Select the option, then push [ï].
••Options: Set to between 10, 20, 40, 80, 160,
320, 640, 1280, 2560, and 5120 feet.
LLYou can change the unit to “meter.” (p. 9-64)

☞☞Continued on the next page.
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Transmitting D-PRS data

DDSetting D-PRS Object/Item

DD Setting D-PRS Position (Mobile/Base) (Continued)
12. Setting the antenna gain
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Set to transmit as a D-PRS Object or Item.
1. Setting the GPS TX Mode to D-PRS
GPS > GPS TX Mode

Select the gain of the base station’s antenna, to
transmit along with the position data.
1. Select “Gain,” then push [ï].
2. Select the option, then push [ï].
 et to between 0 and 9 dB.
••Options: S

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
••Displays the GPS screen.

3. Select “GPS TX Mode,” then push [ï].
4. Select “D-PRS,” then push [ï].

13. Setting the antenna directivity
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

TIP: If the TX information setting has been done, you
can easily turn ON the GPS TX mode by pushing
[MENU] after step 4.

Select the direction the base station’s antenna was
pointing, to transmit along with the position data.
1. Select “Directivity,” then push [ï].
2. Select the option, then push [ï].
 et to between Omni, 45ºNE, 90ºE,
••Options: S
135ºSE, 180ºS, 225ºSW, 270ºW,
315ºNW and 360ºN.

2. Checking the Unproto Address
You should use the default address, and editing is not
recommended.
1. Select “Unproto Address,” then push [ï].

14. Exiting the MENU screen
Push [MENU].

••Returns to the standby screen, then displays “

••Returns to the standby screen, then displays “

.”

LLThe default setting is “API410,DSTAR*.”

2. P
 ush [].

••Returns to the previous screen.

3. Setting the TX format to “Object” or “Item”
1. Select “TX Format,” then push [ï].
2. Select “Object” or “Item,” then push [ï].

.”

••Displays the OBJECT or ITEM screen.

4. Entering Object name or Item name
Enter an Object or Item name, such as an event
information or location.
1. Select “Object Name” or “Item Name,” then push
[ï].
••Displays the “Object Name” or “Item Name” screen.

2. E
 nter an Object or Item name of up to 9
characters.
Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)

LLSee “Entering and editing text” for details. (p. iv)

3. After entering, push [ï].

☞☞Continued on the next page.
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Transmitting D-PRS data
DD Setting D-PRS Object/Item (Continued)
5. Setting Data type
Set the Object or Item’s status.
1. Select “Data Type,” then push [ï].
2. Select the option, then push [ï].
		 (For an Object)

8. Setting the Position
Set the position data of an Object or Item.
For example, if you want to transmit traffic accident
information as an Item, set the location where the
accident has happened.
If the position data is entered in the GPS memory, you
can easily set the position data from the memory.

••Live Object: The Object is valid.
••Killed Object: The Object is invalid.

		 (For an Item)
••Live Item: The Item is valid.
••Killed Item: The Item is invalid.

1. Select “Position,” then push [ï].
2. Push [QUICK].
3. Select “Edit,” then push [ï].

6. Setting Symbol
Select a symbol that indicates an Object or Item.
1. Select “Symbol,” then push [ï].
2. Select the symbol, then push [ï].

••Displays the POSITION EDIT screen.

TIP: When you select “Capture From GPS” or “Set
From GPS Memory” in step 3, you can capture the
position data from the GPS, or set the Object or
Item’s position data from the GPS memory.

LL“Radio” is set as the default.
LLSee page 9-24 for directly editing a symbol.

Entering the latitude
4. Select “LATITUDE,” then push [ï].

7. Entering a Comment
Enter a comment to transmit as an Object or Item.
The number of characters you can enter differs,
depending on the data extension and altitude settings.
(p. 5-19)
Data Extension

••Displays the LATITUDE screen.

5. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
6. Rotate [DIAL] to enter the latitude.
••Range: Set to between 0°00.00' to 90°00.00'.

Characters
Altitude entered (Max.)

OFF

No data

43 (Default)

OFF

Set

35

Course/Speed

No data

36

Course/Speed

Set

28

Power/Height/Gain/Directivity

No data

36

Power/Height/Gain/Directivity

Set

28

LLYou can change the unit to “ddd°mm'ss".” (p. 9-64)
LLTo enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

7. Repeat steps 5 and 6 to enter the latitude.
8. After entering, push [ï].
Entering the longitude
9. Select “LONGITUDE,” then push [ï].
••Displays the LONGITUDE screen.

1. Select “Comment,” then push [ï].
2. Push [QUICK].
3. Select “Edit,” then push [ï].

10. P
 ush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
11. Rotate [DIAL] to enter the longitude.
••Range: Set to between 0°00.00' to 180°00.00'.

••Enters the Comment entry mode.

4. Enter a comment.

LLYou can change the unit to “ddd°mm'ss".” (p. 9-64)
LLTo enter an east longitude, select “E,” and to enter a
west longitude, select “W.”

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)

12. Repeat steps 10 and 11 to enter the longitude.
13. After entering, push [ï].

¬

LLSee “Entering and editing text” for details. (p. iv)
LLThe symbol “ ” shows the transmittable comment
range. Please note that the characters that exceed
the range will not be transmitted.

☞☞Continued on the next page.

5. After entering, push [ï].

••Displays the entered Comment.

6. Push [].

••Returns to the OBJECT or ITEM screen.
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Transmitting D-PRS data
DD Setting D-PRS Object/Item
8. Setting the Position (Continued)
Entering the altitude
14. Select “ALTITUDE,” then push [ï].

11. Setting the Speed
LLThis item is displayed when “9. Setting Data
Extension” is set to “Course/Speed.”

••Displays the ALTITUDE screen.

Set the Object or Item’s speed.
1. Select “Speed,” then push [ï].
2. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
3. Rotate [DIAL] to enter the Object or Item’s speed.
••Range: Set to between 0 and 1150 mph.

15. Rotate [DIAL] to select between plus and minus.
16. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
17. Rotate [DIAL] to enter the altitude.
••Range: Set to between –32808 and +32808 feet.
18. Repeat steps 16 and 17 to enter the altitude.
19. After entering, push [ï].
20. Select “<<Write>>,” then push [ï].

LLYou can change the unit to “km/h” or “knots.”
(p. 9-64)

••The confirmation dialog “Write?” is displayed.

4. After entering, push [ï].

••Writes the entered position data.

12. Setting the TX power
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

21. Select <YES>, then push [ï].
22. P
 ush [].

••Returns to the OBJECT or ITEM screen.

9. Setting the Data Extension
Set the data extension of an Object or Item’s
information.
1. Select “Data Extension,” then push [ï].
2. Select the option to transmit, then push [ï].
••OFF:	Does not transmit any
information.
••Course/Speed:	Transmits the course and speed
data along with the position data.
••Power/Height/Gain/Directivity:
				Transmits the TX power level,
height, antenna gain and antenna
direction, along with the position
data.

Select the TX power level of the Object or Item if the
station is a repeater, node, access point, and so on
and an antenna is installed.
1. Select “Power,” then push [ï].
2. Select the option, then push [ï].
••Options: Set to between 0, 1, 4, 9, 16, 25, 36,
49, 64, and 81W.
13. Setting the antenna height
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”
Select the height of the Object or Item’s antenna if the
station is a repeater, node, access point, and so on
and an antenna is installed.
1. Select “Height,” then push [ï].
2. Select the option, then push [ï].
••Options: Set to between 10, 20, 40, 80, 160,
320, 640, 1280, 2560, and 5120 feet.

10. Setting the Course
LLThis item is displayed when “9. Setting Data
Extension” is set to “Course/Speed.”

LLYou can change the unit to “meter.” (p. 9-64)

Set the Object or Item’s course when the station
moves.
1. Select “Course,” then push [ï].
2. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
3. Rotate [DIAL] to enter the Object or Item’s course.
••Range: Set to between 0º and 360º.
4. Repeat steps 2 and 3 to enter the course.
5. After entering, push [ï].

14. Setting the antenna gain
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”
Select the gain of the Object or Item antenna.
1. Select “Gain,” then push [ï].
2. Select the option, then push [ï].
••Options: Set to between 0 and 9 dB.
☞☞Continued on the next page.
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Transmitting D-PRS data
DD Setting D-PRS Object/Item (Continued)
15. Setting the antenna directivity
LLThis item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

17. Setting Time Stamp
LLThis item is displayed when the TX format is
“Object.”

Select the direction the base Object or Item’s antenna
was pointing.
1. Select “Directivity,” then push [ï].
2. Select the option, then push [ï].
••Options: S
 et to between Omni, 45ºNE, 90ºE,
135ºSE, 180ºS, 225ºSW, 270ºW,
315ºNW and 360ºN.

Set the time stamp function to transmit the Object’s
time data in UTC (Universal Time Coordinated) time.
1. Select “Time Stamp,” then push [ï].
2. Select the time stamp,” then push [ï].
••DHM:	Transmits the time stamp in the Day, Hour,
and Minute format.
••HMS:	Transmits the time stamp in the Hour,
Minute, and Second format.

16. Setting the SSID
To assist in identifying a station’s type, the displayed
APRS® (Automatic Packet Reporting System) based
SSID is added after the D-PRS data call sign.
The way to add SSID’s differs, depending on whether
you enter a space in your call signs or not.

18. Exiting the MENU screen
Push [MENU].

••Returns to the standby screen, then displays “

1. Select “SSID,” then push [ï].
2. Select the SSID to set, then push [ï].
••---:	The space in call sign is converted
to “-.” If no text is entered after the
space, the space will be deleted, and
the space is not converted to “-.”
Example: JA3YUA A > JA3YUA-A
••(-0):	No SSID is added. If a call sign
includes a space, any text or digit
after the space will be deleted.
••-1~-15:	Adds an SSID of -1 to -15 to your call
sign.
Example: SSID is “-9.”
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call
sign.
Example: SSID is “-Z.”
JA3YUA A → JA3YUA-Z
About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.
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Transmitting D-PRS data (Continued)

DDSetting D-PRS Weather

5. Setting the SSID
To assist in identifying a station’s type, the displayed
APRS® (Automatic Packet Reporting System) based
SSID is added after the D-PRS data call sign.
The way to add SSID’s differs, depending on whether
you enter a space in your call signs or not.

Set to transmit as a D-PRS Weather station.
1. Setting the GPS TX Mode to D-PRS
GPS > GPS TX Mode

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].

1. Select “SSID,” then push [ï].
2. Select the SSID to set, then push [ï].
••---:	The space in call sign is converted
to “-.” If no text is entered after the
space, the space will be deleted, and
the space is not converted to “-.”
Example: JA3YUA A > JA3YUA-A
••(-0):	No SSID is added. If a call sign
includes a space, any text or digit
after the space will be deleted.
••-1~-15:	Adds an SSID of -1 to -15 to your call
sign.
Example: SSID is “-9.”
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call
sign.
Example: SSID is “-Z.”
JA3YUA A → JA3YUA-Z

••Displays the GPS screen.

3. Select “GPS TX Mode,” then push [ï].
4. S
 elect “D-PRS,” then push [ï].
TIP: If the TX information setting has been done, you
can easily turn ON the GPS TX mode by pushing
[MENU] after step 4.
••Returns to the standby screen, then displays “

.”

2. Checking the Unproto Address
You should use the default address, and editing is not
recommended.
1. Select “Unproto Address,” then push [ï].
LLThe default setting is “API410,DSTAR*.”

2. P
 ush [].

••Returns to the previous screen.

3. Setting the TX format to “Weather”
1. Select “TX Format,” then push [ï].
2. Select “Weather,” then push [ï].

About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

••Displays the WEATHER screen.

4. Setting Symbol
Select a symbol that indicates the weather station.
1. Select “Symbol,” then push [ï].
2. Select the symbol, then push [ï].
LLSee page 9-24 for directly editing a symbol.
LL“WX Station” is set as the default.

☞☞Continued on the next page.
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DD Setting D-PRS Weather (Continued)
7. Entering a Comment
Enter a comment to transmit as a D-PRS Weather
station.
1. Select “Comment,” then push [ï].
2. Push [QUICK].
3. Select “Edit,” then push [ï].
••Displays the “Comment” screen.

4. Enter a comment of up to 43 characters.
Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
¬

LLSee “Entering and editing text” for details. (p. iv)
LLThe symbol “ ” shows the transmittable comment
range. Please note that the characters that exceed
the range will not be transmitted.

5. After entering, push [ï].
6. Push [].

••Returns to the WEATHER screen.

8. Setting Time Stamp
Set the time stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
1. Select “Time Stamp,” then push [ï].
2. Select the time stamp,” then push [ï].
••OFF:	Does not transmit the time information.
••DHM:	Transmits the time stamp in the Day, Hour,
and Minute format.
••HMS:	Transmits the time stamp in the Hour,
Minute, and Second format.
9. Exiting the MENU screen
Push [MENU].

••Returns to the standby screen, then displays “

.”
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Transmitting D-PRS data (Continued)

DDWeather station transmission

DDApplication setting

When you transmit as a weather station, you should
set the weather station’s settings, and input the
weather data to the [DATA] terminal.
You can input the weather data from a third party’s
weather device by converting it to the APRS weather
format in your PC or microcomputer.

Configure the communication software as follows.
••Port:	The COM port number that is used by
the ID-4100A/E.*1
••Baud rate: 4800/9600 bps*2
••Data:
8 bit
••Parity:
none
••Start:
1 bit
••Stop:
1 bit
••Flow control: none

After completing the weather station’s settings, and
inputting the weather data, you can transmit as a
weather station.

*1 Depending on the PC environment, the COM port number
used by the ID-4100A/E may be higher than 5. In that
case, use an application that can set it to higher than 5.
*2 Set the baud rate in the “Data Speed” item.
(Function > Data Speed) (p. 9-60)

NOTE: If the weather data is not input to the [DATA]
terminal, you cannot transmit as a weather station.
Transceiver
To the
[DATA]
jack

PC

Cable

DDAbout the weather data content

To the
RS-232C
port

The weather data should be input according to the
format (based on the APRS® Weather Data) as shown
below.

or
To the
USB port

OPC-2350LU

Weather device

Example:
220/004 g005 t077 r000 p000 P000 h50 b09900 End code
1 2
3 4 5
6
7
8
9

Microcomputer

Terminal information
e

q
2.5 mm
(0.1 in) (d)

w

No.

q Tip: RXD
w Ring: TXD
e Sleeve: GND

1
2
3
4

DDConfirming the weather data input

You can confirm whether or not the weather data is
input to the [DATA] terminal.

5
6

1. Set the “GPS TX Mode” to “D-PRS,” and the “TX
format” to “Weather.” (pp. 5-21, 5-22)
2. On the standby screen, push [QUICK].
3. Rotate [DIAL] to select “Weather Information,”
then push [ï].

7
8
9

••Displays the weather information screen as shown
below if the weather data is input to the [DATA]
terminal.
LLWhen the weather information is displayed, you can
transmit as a weather station. If “-” is displayed on
the screen, the weather data does not input to the
[DATA] terminal. In that case, check the input data
settings.

Item

Value
000 to 360
Wind speed
000 to 999
Gust speed
g000 to g999
Temperature
t-99 to t-01,
t000 to t999
Rainfall
r000 to r999*1
Rainfall (24 Hours) p000 to p999*1
Rainfall (Midnight)
P000 to P999*1
Humidity
h00, h01 to h99
(h00 indicates 100%.)
Barometric pressure b00000 to b99999*2
Wind direction

Unit
º
mph
mph
ƒ
inch
inch
inch
%
hPa,
mb

*1 The last two digits indicate the two decimal place.
*2 The last digit indicates the one decimal place.

LLIf you have no data, enter a space or “.” (period)
instead of a number.
(Example: “.../...g...t077r000p...P...h50b.....”)
LLEnter <CR>, <LF> or <CR><LF> for an end code.
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DDDisplaying your location using a mapping software
If you transmit to an I-GATE station, and then enter
the call sign information on the internet map website,
the set symbol is displayed.

PC

JA3YUA-Z

You can check the
location at a map site.

For your reference
D-PRS data content
D-PRS data content are shown below.
DPosition (Mobile)
(e.g.) JA3YUA-A>API410,DSTAR*:/002338h3437.38N/13534.29E>090/002/A=000012ID-4100 OP.SATOH
q
r
!0
e
w
i
u
!1
!3
!4
o
o
DPosition (Base)
(e.g.)

JA3YUA-A>API410,DSTAR*:/002338h3437.38N/13534.29E-PHG5132/ID-4100 OP.SATOH
q

w

e

r

i

u

!0

o

!2

o

!4

DObject
(e.g.)

JA3YUA-A>API410,DSTAR*:;HAM FESTA*012345z3437.38N\13534.29Eh/2017.4.1 am10-pm4
q

w

e

r

t

y

i

u

!0

o

!4

o

DItem
(e.g.)

JA3YUA-A>API410,DSTAR*:)REPEATER!3454.00N/13536.00ErPHG5132/439.39MHｚDV RPT JP3YHH A
q

w

e

r

t

y

i

!0

o

o

!2

!4

DWeather
(e.g.)

JA3YUA-A>API410,DSTAR*:/012345z3454.00N/13536.00E_220/004g005t077r000p000P000h50b09900
q

w

e

qCall sign
wSSID
eUnproto Address
rD-PRS Data type
/ Position with time stamp
! Position without time stamp
; Object
) Item
tObject Name/Item Name
yData Type
* Live Object
! Live Item
_ Killed Object/Killed Item
uTime Stamp(UTC)
h Hour Minute Second
z Day Hour Minute
iLatitude
oSymbol
!0Longitude
!1Data Extension(Course/Speed)
Course:0 ~ 360°
Speed:0 ~ 999 knots

r

u

i

!0

o

!5

o

!6

!7

!8

@0

!9

@1

@2

!2Data Extension(PHG codes)
PHG codes definitions
0

1

2

3

4

5

6

7

8

9

First: Power

0

1

4

9

16

25

36

49

64

81

(W)

Second: Height

10

20

40

80

160

320

640

1280

2560

5120

(feet)

6

7

8

9

(dB)

360°N

−

−

Third: Gain
Fourth: Directivity

0

1

2

3

4

5

omni

45°NE

90°E

135°SE

180°S

225°SW

!3Altitude
−99999 ~ 999999 feet
!4Comment
!5Wind direction/Wind speed
Wind direction:0 ~ 360°
Wind speed: 0 ~ 999 mph
!6Gust speed
0 ~ 999 mph
!7Temperature
−99 ~ 999ƒ
!8Rainfall
0.00 ~ 9.99 inch
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!9Rainfall (24 Hours)
0.00 ~ 9.99 inch
@0Rainfall (Midnight)
0.00 ~ 9.99 inch
@1Humidity
1 ~ 99%, 00=100%
@2Barometric pressure
0.0 ~ 9999.9 hPa

270°W 315°NW
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Transmitting NMEA data
Set a GPS sentence to transmit GPS data in the DV
mode.

DDSetting the GPS data sentence
GPS > GPS TX Mode > NMEA > GPS Sentence
1.
2.
3.
4.
5.

Push [MENU].
Rotate [DIAL] to select “GPS,” then push [ï].
Select “GPS TX Mode,” then push [ï].
Select “NMEA,” then push [ï].
Select “GPS Sentence,” then push [ï].

NOTE:
••Set the GSV sentence to OFF when sending the
GPS message to a conventional digital transceivers
(IC-2820H, IC-E2820, ID-800H, IC-91AD, IC-E91,
IC-V82, IC-U82, IC-2200H).
The GSV sentence is incompatible with them.
••If “GPS Select” is set to “Manual,” the transceiver
automatically sets the NMEA sentence, and
transmits it along with the manually entered
position data in “Manual Position.” (p. 9-24)
(GPS > GPS Set > Manual Position)
••Please note that if “GPS Auto TX” is set to any
other setting than “OFF,” the data is automatically
transmitted according to the set time. (p. 9-40)
(GPS > GPS Auto TX)

••Displays the “GPS Sentence” screen.

6. Rotate [DIAL] to select the GPS sentence, then
push [ï].
		

••Displays “✓” when the sentence is set to ON.
LLThe selectable GPS sentences are RMC, GGA, GLL,
VTG, GSA and GSV. The GGA sentence is set to ON
as the default GPS sentence.

7. Repeat step 6 to set the GPS sentence.

TIP: To return to the default setting:
1. Push [QUICK] in step 6.
2. Select “Default,” then push [ï].

LLA maximum of four GPS sentences can be set at a
time.

8. Push [MENU].

••Returns to the standby screen, then displays “

.”

The display while transmitting NMEA data
Displayed when “GPS TX Mode” is
set to “NMEA.”

LLWhen you transmit, the set GPS sentence
is also transmitted.

••Contents of GPS sentence
Lon
Date
2D COG SOG
Sentence
Alt UTC
Status
Others
/Lat
(UTC)
/3D (True) (knot)
RMC
Magnetic variation, Mode Indicator
✔
✔
✔
✔
✔
✔
Number of satellites in use, HDOP, Geoidal
GGA
✔
✔
✔
✔
separation, Age of Differential GPS data
GLL
Mode Indicator
✔
✔
✔
COG (Magnetic north), SOG (km/h), Mode
VTG
✔
✔
Indicator
ID numbers of satellites used in solution, PDOP,
GSA
✔
✔
HDOP, VDOP
Total number of sentences, Sentence number,
GSV
Total number of satellites in view, Satellite
information (ID, Elevation, Azimuth, S/N)
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Transmitting NMEA data (Continued)

DDEntering a GPS message

Enter a GPS message to be transmitted with the
position data.
Example: Entering “Japan TOM”
GPS > GPS TX Mode > NMEA > GPS Message
1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
••Displays the GPS screen.

3. Select “GPS TX Mode,” then push [ï].
4. S
 elect “NMEA,” then push [ï].
5. Select “GPS Message,” then push [ï].
••Displays the “GPS Message” screen.

6. Push [QUICK].
7. Select “Edit,” then push [ï].
		

••Enters the GPS message entry mode.

8. Enter a GPS message of up to 20 characters.
		

		 (Example: Japan TOM)
Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

9. After entering, push [ï].

••Displays the entered message.

		

10. Push [MENU].

••Returns to the standby screen.
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Adding or editing GPS memory
DDGPS memory

Group names are just
example.

GPS Memory

You can add GPS data to GPS Memory.
You can add your own position data, other station’s
position data, or any position data that are manually
entered.

(No Group)
Icom Osaka HC

A: ICOM

The GPS Memory is capable of storing a total of 300
channels, and conveniently saved in up to 27 groups,
from A to Z and “(No Group).” The A to Z groups can
also be named.

Icom America
B: HAM festa

Tokyo Bigsite

C: Railroad

Dayton Hamventio
Friedrichshafen

Z:

DDAdd a GPS memory

Example: Add "HOME" into (No Group)
1. Adding GPS Memory and entering the edit mode
GPS > GPS Memory

2. Entering the GPS Memory name
1. Select “NAME,” then push [ï].

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Memory,” then push [ï].

2. E
 nter a GPS memory name of up to 16
characters.
		

4. Select “(No Group),” then push [ï].
5. Push [QUICK].
6. Select “Add,” then push [ï].
		

		 (Example: HOME)

••Enters the GPS Memory name entry mode.

••The previously added GPS memories are displayed on
the GPS MEMORY screen.

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

••Displays the GPS MEMORY EDIT screen.

3. After entering, push [ï].

••Returns to the GPS MEMORY EDIT screen.

TIP: To edit the previously saved GPS memory,
select “Edit” in the step 6. You can enter the content
in the same way as described above.
		

☞☞Continued on the next page
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Adding or editing GPS memory
DD Add a GPS memory (Continued)
3. Entering the GPS Memory date
1. Select “DATE,” then push [ï].

6. Entering the GPS Memory longitude
1. Select “LONGITUDE,” then push [ï].

••Enters the date entry mode.

••Displays the LONGITUDE screen.

2. P
 ush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
3. Rotate [DIAL] to enter the date.
••Range: S
 et to between 2000/01/02 and
2099/12/30.
4. Repeat steps 2 and 3 to enter the date.
		

2. P
 ush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
3. Rotate [DIAL] to enter the longitude.
••Range: Set to between 0°00.00' to 180°00.00'.
LLYou can change the unit to “ddd°mm'ss".” (p. 9-64)
LLTo enter an east longitude, select “E,” and to enter a
west longitude, select “W.”

4. Repeat steps 2 and 3 to enter the longitude.
		

5. After entering, push [ï].
5. After entering, push [ï].

4. Entering the GPS Memory time
1. Select “TIME,” then push [ï].

7. Entering the GPS Memory altitude
1. Select “ALTITUDE,” then push [ï].

••Enters the time entry mode.

2. P
 ush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
3. Rotate [DIAL] to enter the time.
••Range: S
 et to between 00:00:00 and 23:59:59.
4. Repeat steps 2 and 3 to enter the time.
		

••Displays the ALTITUDE screen.

2. Rotate [DIAL] to select between plus and minus.
3. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
4. Rotate [DIAL] to enter the altitude.
••Range: Set to between –32808 and +32808 feet.
5. Repeat steps 3 and 4 to enter the altitude.
		

5. After entering, push [ï].
5. Entering the GPS Memory latitude
1. Select “LATITUDE,” then push [ï].

6. After entering, push [ï].

••Displays the LATITUDE screen.

8. Selecting the GPS memory group
1. Select “GROUP,” then push [ï].
2. Select the group between (No Group) and A ~ Z.
		

2. P
 ush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.
3. Rotate [DIAL] to enter the latitude.
••Range: Set to between 0°00.00' to 90°00.00'.
LLYou can change the unit to “ddd°mm'ss".” (p. 9-64)
LLTo enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

LLA total of up to 300 memories can be saved.

4. Repeat steps 2 and 3 to enter the latitude.
		

☞☞Continued on the next page

5. After entering, push [ï].
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Adding or editing GPS memory
DD Add a GPS memory (Continued)
9. Writing the GPS memory
1. Select “<<Add Write>>,” then push [ï].

••The confirmation dialog “Add write?” is displayed.
LLIf a previously added GPS memory was edited,
select “<<Overwrite>>.”

2. Select <YES>, then push [ï].
		

••The data is added to the GPS memory, and then the
selected GPS Memory group screen is displayed.

3. Push [MENU].

••Returns to the standby screen.

To view the entered content:
To view the entered content, select the GPS
memory channel.
		

To cancel the entered data:
To cancel the entered data, push [] to display the
confirmation dialog, as shown below.
Select <YES> to cancel entering and the display
returns to the GPS Memory group screen.
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Adding or editing GPS memory (Continued)

DDDeleting GPS memory

DDEntering the GPS Memory group name

You can delete the GPS memories.
Please note that deleted GPS memories cannot be
restored.
There are two ways to delete the memories:
••Deletes all GPS memory in a group.
••Deletes a specific memory.

You can enter a name for each GPS Memory group.
GPS > GPS Memory

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Memory,” then push [ï].
••Displays the GPS MEMORY screen.

Example: Deleting all in the Group F.
GPS > GPS Memory

4. S
 elect the group that the name to be entered,
then push [QUICK].
5. Select “Edit Name,” then push [ï].
		

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Memory,” then push [ï].
••Displays the GPS MEMORY screen.

4. S
 elect the group where the GPS memory to
delete is saved, then push [QUICK].
5. Select “Delete All In Group,” then push [ï].
		

••Enters the Group Name entry mode.

6. Enter a GPS group name of up to 16 characters.
		

		 (Example: HOME AREA)

••The confirmation dialog “Delete all in group?” is
displayed.

6. Select <YES>, then push [ï].
		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

7. After entering, push [ï].
		

8. Push [MENU].

••Returns to the standby screen.

••All GPS memory in the selected group are deleted,
then returns to the GPS MEMORY screen.
LLWhen selecting a blank group, “Blank” is displayed.

		

7. Push [MENU].

••Returns to the standby screen.

Deleting a specific GPS memory
You can delete a specific GPS memory.
1. S
 elect the GPS memory to delete, then push
[QUICK].
2. Select “Delete,” then push [ï].
3. Select <YES>, then push [ï].
••The selected GPS memory channel is deleted.
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Adding or editing GPS memory (Continued)

DDRearranging the display order of the GPS data
You can move the entered GPS memories to
rearrange their display order in the selected GPS
memory group.
In order to move the GPS memory out of their
assigned memory group, edit and move, and then
save.
GPS > GPS Memory
1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Memory,” then push [ï].
••Displays the GPS MEMORY screen.

4. S
 elect the group where the GPS memory to move
is saved.
5. Select the GPS memory to move, then push
[QUICK].
6. Select “Move.”

••“DESTINATION” blinks at the top left of the screen.

7. S
 elect the location to insert the memory you want
to move, then push [ï].

••The selected memory is inserted above the destination
memory name.
LLIf “<<Move End>>” is selected, the memory is moved
to the bottom of the group.

8. Push [MENU].

••Returns to the standby screen.
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Adding or editing GPS memory (Continued)

DDSetting the GPS alarm

A GPS alarm can sound when a target location comes
into the alarm area.
This function can be set to the caller station, all GPS
Memory channels, a specified Memory group or a
specified Memory channel.
Alarm area 2 (Setting specific station)

Alarm area 1 (Setting plural stations)
When all channels or group is selected:
0.25’

0.25’
0.25’

Point A

When a specified memory is selected:
N

Your
location

0.25’

Your
location

Extended range
(Approximate 1 km,
1094 Y)

Point B
Point C

Limited range
(Approximate 500 m,
547 Y)

Beeps three times

Beeps one times Beeps three times

Example: Set the alarm to all GPS memory (All
Memories).
GPS > GPS Alarm
1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Alarm,” then push [ï].
4.
5.

••Displays the GPS ALARM screen.
Select “Alarm Select,” then push [ï].
Select “Group,” then push [ï].

		

6. Select “All Memories,” then push [ï].
		

When the GPS alarm sounds

••Returns to the GPS ALARM screen.
LLIf you want to set the alarm to a GPS memory group,
select“(No Group)” or “A” to “Z.”

Blinks

7. Push [MENU].

••Returns to the standby screen, then displays “ì.”
LLWhen either one of the stations in a specified group
enters the set range, the alarm sounds three times,
“GPS ALARM” pops up on the screen, and “ì”
blinks.
LLTo cancel the GPS alarm, select “OFF” in the step 5.

Alarm sounds, and “GPS ALARM”
pops up.

TIP: When “All Memories”, “A” to “Z” or “(No Group)”
is selected, the alarm sounds depending on the
“Alarm Area (Group)” setting on the MENU screen.
(GPS > GPS Alarm > Alarm Area (Group))
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Adding or editing GPS memory
DD Setting the GPS alarm (Continued)
Example: Set the alarm setting to RX (RX/Memory).
GPS > GPS Alarm
1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Alarm,” then push [ï].
4.
5.

••Displays the GPS ALARM screen.
Select “Alarm Select,” then push [ï].
Select “RX,” then push [ï].

		

••Returns to the GPS ALARM screen.
LLIf you want to set the alarm to a GPS memory
channel, select “Memory,” and then select “(No
Group)” or “A” to “Z.”

6. Push [MENU].

••Returns to the standby screen, then displays “ì.”
LL Informatio
••When a station with its GPS alarm set enters within an
approximate 1 kilometer (1093 yard) range, the alarm
sounds once. When it enters within an approximate
500 meter (546 yard) range, the alarm sounds three
times.
••When the GPS alarm sounds, “GPS ALARM” pops up
on the screen, and “ì” blinks.
••To cancel the GPS alarm, select “OFF” in the step 5.

When the GPS alarm sounds
Blinks

Alarm sounds, and “GPS ALARM”
pops up.

NOTE: Even if “RX” is selected in step 5, when the
received signal has no position data, the GPS alarm
does not sound.
TIP: When “RX” or a GPS memory channel is
selected, the alarm sounds depending on the “Alarm
Area (RX/Memory)” setting on the MENU screen.
(GPS > GPS Alarm > Alarm Area (RX/Memory))
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GPS Logger function
The GPS Logger function enables you to save the
position data from a GPS receiver into a microSD card
as a log.
The GPS Logger saves Latitude, Longitude, Altitude,
Positioning state, Course, Speed and Date.
If you use this GPS Logger while driving, you can
check your driving history on a mapping software.

NOTE:
••The GPS logger function requires a microSD card
(User supplied).
••Once the GPS logger function is turned ON, the
transceiver continuously saves the position data
from the GPS receiver, even if the transceiver is
turned OFF, then ON again. To cancel this function,
turn OFF the function. While this function is ON,
and when the transceiver is turned OFF, the log file
will be closed. Then the transceiver is turned ON
and Positioning is carried out by the GPS receiver,
a new log file will be created.
••When the microSD card is full, this function will be
automatically paused.

DDGPS Logger operating outline

To use GPS Logger function, perform following
operations.
1. Insert a microSD card*.
*User supplied

2. Check whether or not the GPS receiver is
receiving your position data. (p. 5-2)
3. Turn ON the GPS Logger function.
				

Completed! The GPS Logger function starts.

DDGPS Logger operation

DDSetting the GPS record interval

Select whether or not save your route as a log.
When the GPS Logger function is ON, the transceiver
saves the position data from GPS receiver into
microSD card in a specified time interval.
The saved GPS sentences are GGA, RMC, GSA and
VTG.

For example, when you are walking and if the time
interval is set to “1sec,” a lot of position data is saved
at near place. Select the GPS Logger function record
interval to suit your travel speed.
(Default: 5sec)
GPS > GPS Logger > Record Interval

GPS > GPS Logger > GPS Logger

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Logger,” then push [ï].
4. Select “Record Interval,” then push [ï].
		

1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Logger,” then push [ï].
		

••Displays the GPS LOGGER screen.

••Displays the “Record Interval” screen.

4. S
 elect “GPS Logger,” then push [ï].
		

5. Select a record interval.
••Options: Set to between 1, 5, 10, 30 and 60
seconds.
		

5. Select “ON,” then push [ï].
		

6. Push [MENU].

••Returns to the standby screen.

6. Push [MENU].

••Returns to the standby screen, and the GPS Logger
function starts.
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GPS Logger function (Continued)

DDSetting the GPS record sentence

Select the GPS sentence for the GPS Logger function.
The function records only the selected sentence, so
the data volume will be reduced.
See the contents table shown below before selecting.
GPS > GPS Logger > Record Sentence
1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Logger,” then push [ï].
4. Select “Record Sentence,” then push [ï].
		

••Displays the “Record Sentence” screen.

5. Rotate [DIAL] to select the GPS sentence, then
push [ï].
		

••“✓” disappears when the sentence is set to OFF.
LLThe selectable GPS sentences are RMC, GGA, VTG
and GSA. All sentences are set to ON as the default.

6. Push [MENU].

••Returns to the standby screen.

••Contents of GPS sentence
Lon
Date
2D COG SOG
Sentence
Alt UTC
Status
Others
/Lat
(UTC)
/3D (True) (knot)
RMC
Mode Indicator
✔
✔
✔
✔
✔
✔
Number of satellites in use, HDOP, Geoidal
GGA
✔
✔
✔
✔
separation, Age of Differential GPS data
COG (Magnetic north), SOG (km/h), Mode
VTG
✔
✔
Indicator
ID numbers of satellites used in solution, PDOP,
GSA
✔
✔
HDOP, VDOP
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GPS Logger function (Continued)

DDViewing the log data on a PC Map

If you want to display the your log data, copy the log
file to your PC.
LLWindows 10 is used for these instructions.
5. Double-click the “Gps” folder.
		

1. Turn OFF the transceiver, then remove the
microSD card from the transceiver.

LLTo removing the card while the transceiver power is
ON, unmount it first. (See Basic manual sction 7)

2. Insert the card into the microSD card drive or a
memory card reader* on your PC.

Double-click

		 *User supplied.

3. Click the “Open folder to view files” option to
access the card.
		

The log files
are saved here

Click

••The log files are displayed.
LLThe files are named with the time the log was
started, in the following format:
yyyymmdd_hhmmss.log
yyyy = year, mm = month, dd = day, hh = hour,
mm = minute, ss = second

••Displays the ‘ID-4100’ folder.

4. Double-click the “ID-4100” folder.
		

6. Import the log file to a mapping software.

Double-click

••You can see your route on the software map.
LLThe file may not be compatible with all mapping
software.

••Eight folders are displayed.
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GPS Logger function (Continued)

For your information— About the recorded NMEA sentence for GPS logging
Regarding the GPS logging data of the ID-4100A/E, each sentence corresponds to the NMEA standard and
is recorded in the following format.

D GGA sentence
(e.g.) $GPGGA,161229.487,3723.2475,N,12158.3416,W,1,07,1.0,9.0,M,25.5,M,3,0000*18<CR><LF>
q

w

e

r

t

y u

q GGA protocol header ($GPGGA)
w UTC of position (16:12:29.487)
e Latitude (North 37º 23.2475′) N=North, S=South
r Longitude (West 121º 58.3416′) E=East, W=West
t GPS quality indicator (1)
0=Fix not available or invalid, 1=SPS mode
2=DGPS (SPS), 6=Estimated (Dead Reckoning) mode
y Number of satellites in use (7), 00–12

i

o

!1

!0

!2

u Horizontal Dilution of Precision (1.0) 0.0–50.0
i Altitude re: mean-sea-level (geoid), meters
(9.0 meters)
o Geoidal separation, meters (25.5 meters)
!0 Age of Differential GPS data (3 seconds)
!1 Check Sum (*18) Error detection data
started with “*” (hex code)
!2 End code
*Blank shows when not positioned.

D RMC sentence
(e.g.) $GPRMC,161229.487,A,3723.2475,N,12158.3416,W,0.13,309.62,010417, , ,D*10<CR><LF>
q

w

r

e

t

y

q RMC protocol header ($GPRMC)
w UTC of position (16:12:29.487)
e Status (A)
A=Data valid
V=Data invalid/not positioned
r Latitude (North 37º 23.2475′) N=North, S=South
t Longitude (West 121º 58.3416′) E=East, W=West
y Speed over ground (0.13 knots)
u Course Over Ground (309.62º; degrees True)
0.00º–359.99º

u

i

o

!0

!1

i UTC date of position (’17 Apr 1st) ddmmyy
o Mode Indicator (D)
A=Autonomous mode, D=DGPS,
E=Estimated (dead reckoning) mode,
N=Data not valid, R=Almanac data
!0 Check Sum (*10) Error detection data
started with “*” (hex code)
!1 End code
*Blank shows when not positioned.

D GSA sentence
(e.g.) $GPGSA,A,3,07,02,26,27,09,04, , , , , ,15,1.8,1.0,1.5*33<CR><LF>
q

r

we

t y u i

o

q GSA protocol header ($GPGSA)
t Position Dilution of Precision (1.8) 0.0–50.0
w Mode indicator 1 (A)
y Horizontal Dilution of Precision (1.0) 0.0–50.0
M=Manual, forced to operate in 2D or 3D mode
u Vertical Dilution of Position (1.5) 0.0–50.0
A=Automatic, allowed to automatically switch 2D/3D
i Check Sum (*33) Error detection data
e Mode indicator 2 (3)
started with “*” (hex code)
1=Fix not available,
o End code
2=2D (using satellites; less than 3),
*Blank shows when not positioned.
3=3D (using satellites; more than 4)
r ID numbers of satellites used in solution (07, 02, 26, 27, 09, 04…15)
01–32 *Shows up to 12 ID’s

D VTG sentence
(e.g.) $GPVTG,309.62,T, ,M,0.13,N,0.2,K,A*03<CR><LF>
q

w

e

r

t

y

u

i

q VTG protocol header ($GPVTG)
w Course Over Ground (309.62º; degrees True)
0.00º–359.99º
e Course over ground degrees; Magnetic north
r Speed over ground, knots (0.13 knots)
t Speed over ground, kilometer per hour (0.2 km/hr)

y Mode Indicator (A)
A=Autonomous mode, D=DGPS,
E=Estimated (dead reckoning) mode,
N=Data not valid, R=Almanac data
u Check Sum (*03) Error detection data
started with “*” (hex code)
i End code
*Blank shows when not positioned.

5-37

Previous view

5

GPS OPERATION

GPS Auto transmission for only Simplex
In the DV mode, this function automatically transmits
the GPS receiver’s current position data at a selected
interval, and should only be used in the simplex mode.
LLYour own call sign must be entered to activate the
GPS automatic transmission.
LLWhen “GPS TX Mode” is set to “NMEA,” be sure
to set “GPS Select” to “Internal GPS” or “External
GPS.”
When “GPS TX Mode” is set to “D-PRS,” and “TX
Format” is set to “Position” or “Weather,” be sure to
set “GPS Select” to “Internal GPS,” “External GPS,”
or “Manual.”
Otherwise, you cannot use this function.
(GPS > GPS Set > GPS Select) (p. 9-24)

DDSetting the GPS automatic transmission
GPS > GPS Logger > GPS Auto TX
1. Push [MENU].
2. Rotate [DIAL] to select “GPS,” then push [ï].
3. Select “GPS Auto TX,” then push [ï].
		

4. Select the position data transmit interval.
		

••Options: S
 et to between OFF, 5, 10, 30 seconds,
or 1, 3, 5, 10, and 30 minutes.
(Default: OFF)
LL Informatio
••Selecting “OFF” cancels the GPS automatic
transmission.
••If four GPS sentences are selected in “GPS
Sentence,” “5sec” cannot be selected.
••The GPS message is also transmitted, if entered.

5. Push [MENU].

••Returns to the standby screen.

NOTE:
••Use GPS automatic transmission in only the
simplex mode.
••GPS automatic transmission through a repeater
may interfere with other communications.
When a GPS message is entered, the transceiver
transmits it along with the position data. See page
5-26 for the GPS message entry.
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Saving data onto a microSD card
You can save the following data onto the card:
• Data settings of the transceiver
Memory channel contents, repeater lists, Your (UR)
memory and GPS memories that are saved in the
transceiver.
• Communication contents
Communication audio.
• Communication log
The communication and RX history logs.
• Automatic answering voice audio for the DV
mode
Voice audio used for the Auto Reply function in the DV
mode.
• Voice audio for the Voice TX function
Voice audio for the Voice TX function to be used in
amateur radio contests, and so on.
• GPS position data
GPS position data that is saved as tracking data.
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Saving the setting data onto a microSD card
You can save the Memory channels, Menu screen
item settings, and repeater lists on a microSD card.
Saving data settings on a card enables you to easily
restore the transceiver to its previous settings, even if
you perform an All Reset.
TIP: The setting data are saved in the “icf” file
format that is used in the CS-4100 cloning
software. When the saved data on a card is copied
to a PC, you can edit it with the cloning software.
You can save the setting data as a new file or to
overwrite an older file.
To save as a new file
SD Card > Save Setting

To overwrite a file
To overwrite a file, select the file to be overwritten in
step 4 to the left.
		

1. Push [MENU].
2. Rotate [DIAL] to select “SD Card,” then push [ï].
3. Select “Save Setting,” then push [ï].
 elect “<<New File>>,” then push [ï].
4. S
		

••Displays the FILE NAME screen.
LLThe file name is automatically named in the following
manner: Setyyyymmdd_xx (yyyy: Year, mm: month,
dd: day, xx: serial number)
Example: If a second file is saved on April 1, 2017,
the file is named “Set20170401_02.”
LLTo change the file name, see “Save with a different
file name.” (p. 6-4)

5. Push [ï].
		

••The confirmation dialog “Save file?” is displayed.

6. Select <YES>, then push [ï].
		

••Saves the data settings.
LLWhile saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.

7. Push [MENU].

••Returns to the standby screen.
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Saving with a different file name
SD Card > Save Setting
1. Push [MENU].
2. Rotate [DIAL] to select “SD Card,” then push [ï].
3. Select “Save Setting,” then push [ï].
4. Select “<<New File>>,” then push [ï].
		

••Displays the FILE NAME screen.

5. Push [RX→CS].

••Deletes the entered characters.
LLIf [RX→CS] is continuously held down, the
characters are continuously deleted.

6. Enter a name of up to 20 characters.
(Example: My data)
		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) + , . = ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

7. After entering, push [ï].

••The confirmation dialog “Save file?” is displayed.

8. Select <YES>, then push [ï].
		

••Saves the data settings.
LLWhile saving, “SAVING” and a progress bar are
displayed, then returns to the SD CARD screen after
the saving is completed.

9. Push [MENU].

••Returns to the standby screen.
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Loading the saved data files that are on the microSD card
Memory channels, Menu screen item settings, and
repeater lists can be copied to the transceiver.
This function is convenient when copying saved data,
such as memory channels, or repeater lists, to another
ID-4100A/E, and then operating with the same data.
TIP: Saving the current data is recommended before
loading other data into the transceiver.
(Example: Loading all the data into the
“Set20170401_01” file)
SD Card > Load Setting
1.
2.
3.
4.

7. Select <YES>, then push [ï].
		

Push [MENU].
Rotate [DIAL] to select “SD Card,” then push [ï].
Select “Load Setting,” then push [ï].
Select a file to load.

••Starts the file check.
LLWhile checking the file, displays “CHECKING FILE”
and a progress bar.
		

		

••Displays the LOAD SETTING screen.

5. Select the loading option, then push [ï].
••ALL:	Loads all memory channels, Menu screen
item settings and the repeater list into the
transceiver.
••Except My Station:
				Loads all memory channels, Menu screen
item settings and the repeater list except
MY call signs and TX message into the
transceiver.
••Repeater List Only:
				Loads only the repeater list into the
transceiver.

8. After checking, settings data loading begins.

LLWhile loading, “LOADING” and a progress bar are
displayed.
		

9. After loading ends, “COMPLETED!” is displayed.
LLTo complete the loading, restart the transceiver.

		

		

••The confirmation dialog “Keep 'SKIP' settings in the
Repeater List?” is displayed.

6. Select <YES>, <NO> or <Cancel>, then push [ï].
••YES:	Retains the skip settings of the repeater
list. (p. 4-40)
••NO:	Does not retain the skip settings of the
repeater list.
••Cancel: Returns to the LOAD FILE screen.
		

••When you select <YES> or <NO>, the confirmation
dialog “Load file?” is displayed.
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Backing up the data saved on the microSD card onto a PC
A backup file enables easy restoration, even if the
data on the microSD card is accidentally deleted.
LLIf your PC does not have a microSD card slot,
connect a memory card reader (user supplied) to
use the microSD card.

1. ID-4100

DDAbout the microSD card’s folder
contents

2. Csv

3. GpsMemory

6. Gps

4. RptList

7. QsoLog

5. YourMemory

8. Reply
9. RxLog

The folder in the microSD card contains the following:
1. ID-4100 folder
Contains the folders created in the ID-4100.
2. Csv folder
Contains the GPS Memory, Repeater List and
Your Call Sign Memory folders.
3. GpsMemory folder
Saves the Gps Memory in the “csv” format to
import.
4. RptList folder
Saves the Repeater List in the “csv” format to
import.
5. YourMemory folder
Saves the Your Call Sign Memory in the “csv”
format to import.
6. Gps folder
Saves GPS logging data in the “log” format.
7. QSOLog folder
Saves QSO log data in the “csv” format.
8. Reply folder
Saves Automatic reply data in the “wav” format.
9. R xLog folder
Saves RX record log data in the “csv” format.
10. Setting folder
Saves the transceiver’s setting data in the “icf”
format.
11. Voice folder
Creates the recorded QSO audio date folders.
12. y yyymmdd folder
Saves the recorded audio file in the “wav” format.
The folder name is automatically created in the
following format:
yyyymmdd (yyyy:year, mm:month, dd:day)
13. VoiceTx folder
Saves the recorded voice audio data for the Voice
TX function in the “wav” format.

10. Setting
11 Voice

12. yyyymmdd
12. yyyymmdd

13. VoiceTx
(Example: Selecting the setting data)
When the microSD card is inserted into the microSD
card slot of your PC or the microSD card reader, the
screen is displayed as shown below.

Click

Double-click

Double-click

Setting data
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Backing up the data saved on the microSD card onto a PC (Continued)

DDMaking a backup file on your PC

Windows® 10 is used for these instructions.
1. Insert the microSD card into the microSD card
drive or a memory card reader* on your PC.

5. O
 pen a folder to copy a backup file to, then rightclick, and then click “Paste.”

2. C
 lick the “Open folder to view files” option to
access the card.
		

		 (Example: Copying into the “Backup” folder on the
C drive)
		

		 *User supplied.

••Copies the microSD card data onto your hard disk.

Click
Click
••Displays the ‘ID-4100’ folder.

3. Right-click “Removable disk.”
4. Click “Copy.”
		
6. To remove the microSD card, click the removable
disk icon (“ ” in the screen shot shown below) in
the task bar.
Then, click “Eject Removable Disk.”
		

Right-click

Click

		 (When a memory card reader is connected.)

7. W
 hen “Safe To Remove Hardware” is displayed,
remove the microSD card.
		

Click

		 (When a memory card reader is connected.)
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Importing or Exporting a CSV format file
DDImporting

Please read this section before importing or exporting
a Comma Separated Values (CSV) format file from the
microSD card.
You can import or export the following data:
• Your Call Sign Memory
• Repeater List
• GPS Memory

NOTE:
••Before importing, make a backup file of all the
transceiver’s data to the microSD card in case of
data loss.
••The transceiver cannot display a file that has a
file name longer than 21 characters. In this case,
rename it using 20 characters or less. When you
export the data in a CSV format file using the CS4100, BE SURE to name it using 20 characters or
less.
Example: Importing the Your Call sign memory.
SD Card > Import/Export > Import
1.
2.
3.
4.
5.

Push [MENU].
 otate [DIAL] to select “SD Card,” then push [ï].
R
 elect “Import/Export,” then push [ï].
S
Select “Import,” then push [ï].
S
 elect “Your Call Sign,” then push [ï].

		

6. Select the CSV file to import.
		

••The confirmation dialog “Import file?” is displayed.

7. Select <YES>, then push [ï].
		

••Starts to import.
LLWhile importing, “IMPORTING” and a progress bar
are displayed.
LLAfter importing ends, “COMPLETED!” is displayed.
LLTo complete the importing, restart the transceiver.
		

TIP: To import a repeater list, see the step 6 on page
6-5 for details.
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Importing or Exporting a CSV format file (Continued)

DDExporting

You can export Your Call Sign Memory, Repeater List
and GPS Memory.
To save as a new file
Example: Exporting the Your Call sign memory.

To overwrite a file
To overwrite a file, select the file to be overwritten in
step 6 to the left.

		

SD Card > Import/Export > Export
1.
2.
3.
4.
5.

Push [MENU].
Rotate [DIAL] to select “SD Card,” then push [ï].
Select “Import/Export,” then push [ï].
S
 elect “Export,” then push [ï].
Select “Your Call Sign.”

		

6. Select “<<New File>>.”
		

••Displays the FILE NAME screen.
LLThe file name is automatically named in the following
manner; Your*yyyymmdd_xx (yyyy: Year, mm: month,
dd: day, xx: serial number)
* “Rpt” is displayed for a repeater list, and “Gps” is
displayed for a GPS memory.
LLTo change the file name, see “Save with a different
file name.” (p. 6-4)

7. Push [ï].
		

••The confirmation dialog “Export file?” is displayed.

8. Select <YES>, then push [ï].
		

••Exports the data settings.
LLWhile exporting, “EXPORTING” and a progress bar
are displayed.

9. Push [MENU].

••Returns to the standby screen.
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VOICE MEMORY

Recording a QSO audio
NOTE:
••Be sure to insert a microSD card into the
transceiver before recording the audio.
••Once the recording has started, it will continue,
even if the transceiver is restarted.
To starting to record
1. Push [QUICK].
2. Rotate [DIAL] to select “<<REC Start>>,” then
push [ï].
		

To stop recording
1. Push [QUICK].
2. Rotate [DIAL] to select “<<REC Stop>>,” then
push [ï].
		

Displayed

Recording Standby mode

The recording starts when you transmit or the squelch
opens.
		
Blinks
Displayed

LL Informatio
••The recording pauses while no signal is received, and
resumes when a signal is received again.
••The recording continues until you manually stop
recording, or the card becomes full.
••If the recording file’s content reaches 2GB, the
transceiver automatically creates a new file, and
continues recording.

TIP: When the PTT Automatic Recording function is
set to ON, the recording automatically starts when
“<<REC Start>>” is selected. In that case, recording
continues even while no signal is received.
See page 7-4 for details.
(Voice Memo > QSO Recorder > Recorder Set >
PTT Auto REC)
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Playing back the recorded audio
NOTE: Insert the microSD card, which contains the
recorded audio file, into the transceiver’s slot.

The VOICE PLAYER screen description
[MENU]
Cancels

Voice Memo > QSO Recorder > Play Files
1. Push [MENU].
2. Rotate [DIAL] to select “Voice Memo,” then push
[ï].
		

[ï]

Cancels

[]

[QUICK]

Cancels

[V/M](

3. Select “QSO Recorder,” then push [ï].
		

••Displays the file
information
••Deletes the file

)

Plays the previous file

[MODE](
Rewinds

)

[MONI](
[RX→CS](

4. S
 elect “Play Files,” then push [ï].
		

)

Plays the next file
Fast forwards

[MW](

)/(

)

)

Pauses or plays

Fast forward/Rewind
••Hold down [RX→CS]( ) or [MODE]( ) for 1
second to continuously fast forward/rewind the file.
••The default skip time is 10 seconds. If you want to
change it, see page 7-4 for details.
••You can fast forward or rewind the file that is
playing by rotating [DIAL]. The fast forward/rewind
time is 1/20 of the total file time, regardless of the
skip time setting.

••Displays the recorded file folders.

5. Select the folder that contains the audio file to
play, then push [ï].
		

LLThe folder name is automatically named in the
following manner: yyyymmdd (yyyy: year, mm:
month, dd: day)

Rewind while playing
If you push [MODE]( ) within the first one second
of the file, the skip time at the end of the previously
recorded file will playback.

6. Select the audio file to play.

••The VOICE PLAYER screen is displayed, and the file
starts to play.

Playing the previous file
••While the oldest file in the folder is playing back,
push [V/M]( ) to start playing the file at the
beginning.
••When the playback is paused at the beginning of
a file, push [V/M]( ) to move to the beginning of
the previous file, and pause.

Operating mode
Recorded
time
Operating
Total playback
frequency
time

Playing the next file
••While the latest file in the folder is playing back,
push [MONI]( ) to stop playing.
••When the playback is paused, push [MONI]( ) to
move to the beginning of the next file, and pause.

Current playback file and the
total number of files in the folder
Recorded
date
Recording
information

Operating information
 he operating frequency, mode, and audio category
T
(received audio or transmitted audio) is also
recorded as the operating information.

Played back time/
Total time
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Changing the QSO recorder settings
You can change the recording setting on the MENU
screen.
See page 9-21 for details.
Record only the received audio
Voice Memo > QSO Recorder > Recorder Set >
REC Mode

Synchronize the recording to PTT
Voice Memo > QSO Recorder > Recorder Set >
PTT Auto REC

		

		

LLThe default setting is “TX&RX” (Both transmitted and
received audio are recorded).

LLThe default setting is “OFF” (Recording is not
synchronized to PTT.).

TIP: When “PTT Auto REC” is set to “ON”
••Starts recording not only when PTT is pushed,
but also when switched to transmit by the CI-V
command.
••When “REC Mode” is set to “RX Only,” the transmit
audio is not recorded.
••A signal that is received within 10 seconds after the
squelch is closed is recorded in same file.

Continue to record even while the squelch is
closed
Voice Memo > QSO Recorder > Recorder Set >
RX REC Condition
		

Change the Skip Time
Voice Memo > QSO Recorder > Player Set >
Skip Time

LLThe default setting is “Squelch Auto” (Records only while
the squelch is open).

		

Record the QSO audio as one file
Voice Memo > QSO Recorder > Recorder Set >
File Split
		

LLThe default setting is “10sec.”

LLThe default setting is “ON” (transmitted and received
audio are separately recorded in different files).
LLWhen “RX REC Condition” is set to “Squelch Auto,” an
audio file is created every time the squelch opens. The
received audio is recorded in a separated file.
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Deleting the audio folder/file
NOTE: A deleted audio file can NOT be recovered.

DDDelete an Audio Folder

DDDelete an Audio File

NOTE: All audio files in the folder are deleted.

Voice Memo > QSO Recorder > Play Files
1.
2.
3.
4.

Voice Memo > QSO Recorder > Play Files
1. Push [MENU].
2. Rotate [DIAL] to select “Voice Memo,” then push
[ï].
		

Push [MENU].
R
 otate [DIAL] to select “Voice Memo,” then push [ï].
Select “QSO Recorder,” then push [ï].
Select “Play Files,” then push [ï].
••Displays the recorded file folders.

5. Select the folder that contains the audio file to
delete, then push [ï].
		

3. Select “QSO Recorder,” then push [ï].
		
6. Select the audio file to delete.
		
4. S
 elect “Play Files,” then push [ï].
		
Recorded
time
••Displays the recorded file folders.

5. Select the folder to delete.
		

Operating mode
Operating
frequency

Total playback
time

7. Push [QUICK].
8. Select “Delete,” then push [ï].
		

6. Push [QUICK].
7. Select “Delete,” then push [ï].
		

••The confirmation dialog “Delete file?” is displayed.

9. Select <YES>, then push [ï].
		

••The confirmation dialog “Delete folder?” is displayed.

8. Select <YES>, then push [ï].
		

••A beep sounds, and then the folder is deleted.

10. Push [MENU].

••Returns to the standby screen.

TIP: To delete all files
Select “Delete All” in step 8.
		

••A beep sounds, and then the folder is deleted.

9. Push [MENU].

••Returns to the standby screen.

TIP: To delete all folders
Select “Delete All Folders” in step 7.
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Viewing the file information
The recorded audio file contains the recording data
(operating frequency, operating mode, recorded date,
and so on).

File information examples

LLDepending on the recording status, some data may not
be displayed.
LLThe file name is automatically named in the following
manner: yyyymmdd_hhmmss (yyyy: year, mm: month,
dd: day, hh: hour, mm: minute, ss: second)

Voice Memo > QSO Recorder > Play Files
1. Push [MENU].
2. Rotate [DIAL] to select “Voice Memo,” then push
[ï].
3. Select “QSO Recorder,” then push [ï].
4. Select “Play Files,” then push [ï].

• TX audio file information
Operating
information (TX)

••Displays the recorded file folders.

5. Select the folder that contains the file to view the
information, then push [ï].
		

MY station
location

6. Select the audio file to view the information.
		

DR setting

7. Push [QUICK].
8. Select “File Information,” then push [ï].
		

File data

• RX audio file information
Operating
information (RX)

••Displays the File Information window.

9. Push [MENU].
10. Returns to the screen selected in step 6.

MY station
location

TIP: To view the folder information
Push [QUICK] in step 5, and then select “Folder
Information” to view the folder information.
		

Caller and
received
repeater

RX station
location
Folder name
Total files
(total size)

File data
Created date
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Viewing the microSD card memory capacity
You can check the microSD card memory capacity
and available recording time.
SD Card > SD Card Info
1. Push [MENU].
2. Rotate [DIAL] to select “SD Card,” then push [ï].
		

3. Select “SD Card Info,” then push [ï].
		

••Displays the remaining capacity and available
recording time.

4. Push [MENU].

••Returns to the standby screen.
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Playing back the recorded audio on the PC
You can play back the recorded QSO audio on your
PC.
LLOperation data is not displayed.
Windows 10 is used for these instructions.
Example: P
 laying back the audio file on the microSD
card on the PC, through the memory card
reader (user supplied).
1. Insert the microSD card into a memory card
reader on your PC.
2. Click the “Open folder to view files” option to
access the card.
		

6. Double-click the file to play back.
		 (Example: “20170403_104630.wav”)
		

Double-click

Click
LL Informatio
••See the instruction manual of your player for operation
details.
••The audio file may not play back, depending on the
player.

3. Double-click the ‘ID-4100’ folder.
		

Double-click
4. Double-click the ‘Voice’ folder.
		

Double-click
5. D
 ouble-click the folder that contains the audio file
to play back. (Example: “20170403”)
		

Double-click
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REPEATER AND DUPLEX OPERATIONS

FM Repeater operation
A repeater receives signals and on one frequency, and
then retransmits them on a different frequency. When
using a repeater, the transmit frequency is shifted
from the receive frequency by a frequency offset.
A repeater can be accessed using the Duplex function
by setting the transceiver’s offset to the same value as
the repeater’s offset.
See Section 4 for details on accessing a D-STAR
repeater.

1. P
 ush [V/M] several times until you enter the VFO
mode.
2. Push [BAND].
••Enters the Band Select mode.

3. Rotate [DIAL] to select the operating band.
4. Push [BAND] again.
••Returns to the frequency display.

5. Push [MODE] several times until you select the
FM mode.
6. Rotate [DIAL] to set the receive frequency
(Repeater output frequency).

Repeater
434.540 MHz

439.540 MHz

Station A

TX: 434.540 MHz
RX: 439.540 MHz

LLWhen the Auto Repeater function (usable in only the
USA version) is turned ON, skip steps 7 ~ 12. (p. 8-5)

434.540 MHz

7. Push [QUICK].
8. Rotate [DIAL] to select “DUP,” then push [ï].
		

439.540 MHz

Station B

TX: 434.540 MHz
RX: 439.540 MHz

••Displays the Duplex direction setting window.

9. Select the offset direction, then push [ï].
		

••Displays “D–” or “D+.”
LLYou can set the frequency offset in the MENU screen.
(DUP/TONE... > Offset Freq) (p. 9-16)

10. Push [QUICK].
11. Select “TONE,” then push [ï].
		

••Displays the Tone function setting window.

12. Select “TONE,” then push [ï].
		

TIP:
••When the Repeater tone frequency or the
frequency offset is changed, the tone or offset for
Auto Repeater function is also changed.
••If the offset value will cause the transmit frequency
to be out of the band, “OFF BAND” is displayed on
the display when [PTT] is pushed, and transmit will
be inhibited. (p. 8-5)

••Turns ON the repeater tone, and “TONE” is displayed.
LLYou can set the tone frequency in the MENU screen.
(DUP/TONE... > Repeater Tone) (p. 9-16)

13. Operate in the normal way.

LLSubaudible tone is superimposed on your transmit signal.

8-2

Previous view

8

REPEATER AND DUPLEX OPERATIONS

FM Repeater operation (Continued)

DDChecking the repeater input signal

DD1750 Hz tone burst

1. Push [MONI] to listen on the repeater input
frequency.

1. P
 ush [MODE] several times until you select the
FM mode.
2. While holding down [PTT] on the microphone
to transmit, push [T-CALL] if assigned to a
microphone key.

You can check whether another station’s transmit
signal can be received directly or not, by listening to
the repeater input frequency.

A 1750 Hz tone is required to access many European
repeaters.
LLThis operation is only for the ID-4100E.

••While monitoring, “BUSY” blinks.

LL Informatio
••While monitoring, the displayed frequency
automatically changes to the transceiver transmit
frequency (repeater input frequency).
••When the other station’s signal can be directly
received, move to a non-repeater frequency and use
simplex. (duplex OFF)
••While monitoring, the Attenuator function is temporarily
disabled to receive a weak signal.

••Accesses the repeater with a short tone burst.
••Displays “1750Hz TONE.”

		

Sending the tone burst

2. P
 ush [MONI] again to cancel monitoring.

3. Operate in the normal way.

While monitoring
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Duplex operation
The Duplex operation shifts the transmit frequency
up or down from the receive frequency by an offset
amount.

DDSetting the frequency offset

DDSetting the duplex direction

1. Push [QUICK].
2. Rotate [DIAL] to select “DUP,” then push [ï].
3. Select the offset direction, then push [ï].
••OFF:	For simplex operation (the receive and
transmit frequencies are the same).
••DUP–:	The transmit frequency shifts down
from the receive frequency by the offset
amount.
••DUP+:	The transmit frequency shifts up from the
receive frequency by the offset amount.
		

NOTE: The frequency offset cannot be changed
when using the DR function.
DUP/TONE... > Offset Freq

1. Push [MENU].
2. Rotate [DIAL] to select “DUP/TONE...,” then push
[ï].
		

3. Select “Offset Freq,” then push [ï].
		

4. R
 otate [DIAL] to set the offset.
(Example: 0.700.00 MHz)
		

••Displays “D–” or “D+.”

DDDuplex operation

LLSet to between 0.000.00 and 59.99500 MHz.
LLThe selected tuning step in the VFO mode is used to
set the offset.

1. P
 ush [MONI] to listen to the transmit frequency to
check whether another station is transmitting on
it, or not.

5. Push [ï] to set the offset.
6. Push [MENU].

••The transceiver transmit frequency is displayed on the
display.

••Returns to the standby screen.

2. P
 ush [MONI] again to cancel monitoring.
3. Operate in the normal way.

TIP: If the offset value will cause the transmit
frequency to be out of the band, “OFF BAND” is
displayed on the display when [PTT] is pushed, and
transmit will be inhibited. (p. 8-5)

NOTE: When the Auto repeater is ON, and the
operating frequency is set out of the repeater output
frequency range, the duplex mode is automatically
cancelled.

8-4

Previous view

8

REPEATER AND DUPLEX OPERATIONS

Off band indication

Auto repeater function

If the transmit frequency is out of the amateur band,
the off band indication, “OFF BAND,” is displayed
on the display when [PTT] is pushed. Check the
frequency offset or duplex direction in this case.
(p. 8-2)

When the operating frequency falls within the repeater
output frequency range, the Auto Repeater function
automatically sets the repeater settings (duplex ON/
OFF, duplex direction, tone encoder ON/OFF).
The Auto Repeater function uses the preset repeater
tone frequency and frequency offset.
NOTE for the USA version transceiver:
When turned ON, the Auto Repeater function has
priority over the manual duplex setting. If the transmit
frequency changes after setting, the Auto Repeater
function may have changed the duplex setting.

Displayed

Function > Auto Repeater
1.
2.
3.
4.

Push [MENU].
R
 otate [DIAL] to select “Function,” then push [ï].
 elect “Auto Repeater,” then push [ï].
S
Select the option to turn ON the Auto Repeater
function.
••OFF:	Turn OFF the function.
••ON (DUP):	Turns ON only the duplex
operation. (Default)
••ON (DUP, TONE):	Turns ON the duplex
operation and tone encoder.
5. Push [MENU].
••Returns to the standby screen.

Frequency range and offset direction

8-5

Frequency range

Shift direction

145.200 ~ 145.495 MHz

“DUP–” is set

146.610 ~ 146.995 MHz

“DUP–” is set

147.000 ~ 147.395 MHz

“DUP+” is set

442.000 ~ 444.995 MHz

“DUP+” is set

447.000 ~ 449.995 MHz

“DUP–” is set
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MENU SCREEN

Selecting a Menu item
DDMENU screen operation

You can use the MENU screen to set infrequently
changed values or function settings.
In addition to this page, see pages 9-3 through 9-15
for details of each item’s options and their default
value.

[MENU]
Switches between the MENU
screen and the standby screen.

TIP: The MENU screen is constructed in a tree
structure. You may go to the next tree level, or go
back a level, depending on the selected item.

[ï]
••Sets an
option.
••Goes to the
next tree
level.

		

[]
Goes back
tree levels.

[DIAL]
Selects an
item or option.

[QUICK]
Returns to
the default
setting.

		

Simplified description—‘Select’ operation
In this manual, user’s ‘Select’ operation is simplified,
as shown below.

		

Simplified description:
Select “30min.”
Operation:
Rotate [DIAL] to select “30min.”

		

Example: Set the “Auto Power OFF” item to “30 min.”
Time Set > Auto Power OFF
1. Push [MENU].
2. Rotate [DIAL] to select “Time Set,” then push [ï].

		

		

		

3. Select “Auto Power OFF,” then push [ï].
		

		
4. Select “30min,” then push [ï].
		

		
••Sets the option, then goes back a tree level.
(TIME SET screen is displayed.)

5. Push [MENU].

••Returns to the standby screen.

TIP: To return to the default setting:
1. Push [QUICK] in step 4.
2. Select “Default,” then push [ï].
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Menu items and Default settings
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
DUP/TONE...
Offset Freq

Settings to access repeaters.
0.000~0.600.00*1~59.995 MHz

Repeater Tone

67.0~88.5~254.1 Hz

TSQL Freq

67.0~88.5~254.1 Hz

Tone Burst

OFF or ON

DTCS Code

023~754

DTCS Polarity

Both N, TN-RR, TR-RN, or
Both R
00~99

Digital Code

Sets the frequency offset for duplex (repeater)
operation.
Selects a tone frequency used to access the
repeaters.
Selects a tone frequency for the Tone Squelch
or the Pocket Beep function.
Turns the Tone Burst function ON or OFF.
This function is used to suppress the RX
squelch tail noise in the FM mode, if you
transmit a signal which superimposes the
CTCSS tone or subaudible tone.
Selects a DTCS (both encoder/decoder)
code for DTCS Squelch or the Pocket Beep
function.
Selects the DTCS polarity for the DTCS
Squelch or the Pocket Beep function.
Selects a digital code for the Digital Code
Squelch function.

Manage Memory
Memory CH
Call CH

Manages your Memory or Call channel data.
ALL, A~Z
Manages the Memory channels.
C0/C1(144):146.010 FM*2
Manages the Call channels.
C0/C1(430):440.000 FM*2

Scan
Pause Timer

Set scan options.
2sec~10sec~20sec, or HOLD

Resume Timer

0sec~2sec~5sec, or HOLD

Temporary Skip Timer

5min, 10min, or 15min

Program Skip

OFF or ON

Bank Link

A: ✔ ~Z: ✔

Program Scan Edge

00~24

Program Link
See page 9-19 for details of the preset values.

Selects the Scan Pause time. When receiving
signals, the scan pauses according to this set
period of time.
Selects the Scan Resume time from a pause
after the received signal disappears.
Selects the Temporary Skip time. When the
time is set, specified frequencies are skipped
for this set period of time during a scan.
Turns the Program Skip Scan function ON or
OFF for a VFO mode scan.
Selects banks to be scanned during a Bank
Link Scan.
Sets the frequency ranges for a Program
scan.
Sets the Link function for the Program Scan
Edge channels.

*1 The default value may differ, depending on the frequency band and the transceiver version.
*2 The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Voice Memo
QSO Recorder
<<REC Start>>*
Play Files*
Recorder Set
REC Mode
RX REC Condition

Set the TX/RX voice recording options.
Set QSO recorder options.
Starts recording the received signal audio.

LLWhile recording, <<REC Stop>> is displayed.

Plays the recorded audio.
TX&RX or RX Only
Always or Squelch Auto

File Split

OFF or ON

PTT Auto REC

OFF or ON

Player Set
Skip Time

3sec, 5sec, 10sec, or 30sec

DV Auto Reply*
Voice TX
Record*
TX Set
Repeat Time
TX Monitor
<<TX>>*
GPS
GPS Set
GPS Select
Manual Position
GPS Out (To DATA Jack)

Selects whether or not to record the TX audio.
Selects whether or not the squelch status
affects the RX voice audio recording.
Selects whether or not to automatically create
a new file if transmission and reception, or
squelch status (open and close) is changed.
Turns the PTT Automatic Recording function
ON or OFF.
Sets the Skip time to rewind or forward the
recorded audio when you push the fast-rewind
or fast-forward key during playback.
Records a voice audio to use the Auto Reply
function in the DV mode.

Set microphone voice recording options.
T1~T4
Starts recording the microphone audio.
1sec~5sec~15sec

Sets the repeat interval. The transceiver
repeatedly transmits the recorded voice audio
at this interval.
The TX Monitor function outputs the TX
voice audio from the speaker during voice
transmission.
The transceiver transmits the recorded voice
audio.

OFF or ON
T1~T4, Repeat TX
Set GPS options.
OFF, Internal GPS,
External GPS, or Manual

OFF or ON

Selects either the internal or an external
GPS receiver that the transceiver receives its
position data from.
Manually enter your current position.
Turns the output of GPS information from the
internal GPS receiver to the [DATA] jack ON
or OFF.

* Be sure to insert the microSD card into the transceiver before selecting these items.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
GPS TX Mode
OFF
D-PRS
Unproto Address
TX Format
Position
Symbol
SSID
Comment
Time Stamp
Altitude
Data Extension
Power
Height
Gain
Directivity
Object
Object Name
Data Type
Symbol
Comment
Position
Data Extension
Course
Speed
Power
Height
Gain

Set the GPS TX mode.
Turns OFF the GPS TX function.
API410,DSTAR*

Enters an unproto address, or keeps the
default.

1:Car, 2:Van, 3:Truck, or
4:House QTH (VHF)
- - -, (-0), -1~-15, or -A~-Z

Selects a D-PRS Symbol to transmit.

Selects the APRS® call sign SSID.
Enters a comment to transmit.
OFF, DHM, or HMS
Selects the format to transmit the current UTC
time as a time stamp.
OFF or ON
Turns the altitude transmit option ON or OFF.
OFF, Course/Speed, or
Selects whether to transmit the course/speed
Power/Height/Gain/Directivity
data, or power/height/gain/directivity data.
0W, 1W, 4W, 9W, 16W, 25W,
Selects a base station’s TX power level to
36W, 49W, 64W, or 81W
transmit.
10ft, 20ft, 40ft, 80ft, 160ft, 320ft, Selects a base station’s height to transmit.
640ft, 1280ft, 2560ft, or 5120ft*
0dB~9dB
Selects a base station’s antenna gain to
transmit.
Omni, 45°NE, 90°E, 135°SE,
Selects a base station’s antenna directivity to
180°S, 225°SW, 270°W,
transmit.
315°NW, or 360°N
Set Object data such as an earthquake information, satellite track information,
and so on, to transmit along with the position data.
An Object contains a time stamp.
Enters an Object’s name to transmit.
Live Object, Killed Object
Selects an Object’s status to transmit.
Radio
Selects an Object’s symbol to transmit.
Enters an Object’s comment to transmit.
Sets an Object’s position data to transmit.
OFF, Course/Speed, or
Selects whether to transmit an Object’s course/
Power/Height/Gain/Directivity
speed data, or power/height/gain/directivity
data.
0°~360°
Sets an Object’s course to transmit.
0mph~1150mph*
Sets an Object’s speed to transmit.
0W, 1W, 4W, 9W, 16W, 25W,
Selects an Object’s TX power level
36W, 49W, 64W, or 81W
information to transmit.
10ft, 20ft, 40ft, 80ft, 160ft, 320ft, Selects an Object’s height information to
640ft, 1280ft, 2560ft, or 5120ft* transmit.
0dB~9dB
Selects an Object’s antenna gain information
to transmit.

* The unit may differ, depending on the “Display Unit” settings. (p. 9-64)
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Directivity
SSID
Time Stamp
Item
Item Name
Data Type
Symbol
Comment
Position
Data Extension
Course
Speed
Power
Height
Gain
Directivity
SSID
Weather
Symbol
SSID

Omni, 45°NE, 90°E, 135°SE,
180°S, 225°SW, 270°W,
315°NW, or 360°N
- - -, (-0), -1~-15, or -A~-Z

Selects an Object’s antenna directivity
information to transmit.

WX Station
- - -, (-0), -1~-15, or -A~-Z

Selects a weather station’s symbol to transmit.
Selects the APRS® call sign SSID for the
weather station.
Enters a weather station’s comment to
transmit.
Selects a format to transmit the current UTC
time as a time stamp.

Selects the APRS® call sign SSID for the
Object.
DHM or HMS
Selects a format to transmit the current UTC
time as a time stamp.
Set Item data such as a traffic accident, lighthouse, antenna, or DV access point
location, and so on, to transmit along with the position data.
An Item does not contain a time stamp.
Enters an Item’s name to transmit.
Live Item, Killed Item
Selects an Item’s status to transmit.
Radio
Selects an Item’s symbol to transmit.
Enters an Item’s comment to transmit.
Sets an Item’s position data to transmit.
OFF, Course/Speed, or
Selects whether to transmit an Item’s course/
Power/Height/Gain/Directivity
speed data, or power/height/gain/directivity
data.
0°~360°
Sets an Item’s course to transmit.
0mph~1150mph*
Sets an Item’s speed to transmit.
0W, 1W, 4W, 9W, 16W, 25W,
Selects an Item’s TX power level information
36W, 49W, 64W, or 81W
to transmit.
10ft, 20ft, 40ft, 80ft, 160ft, 320ft, Selects an Item’s height information to
640ft, 1280ft, 2560ft, or 5120ft* transmit.
0dB~9dB
Selects an Item’s antenna gain information to
transmit.
Omni, 45°NE, 90°E, 135°SE,
Selects an Item’s antenna directivity
180°S, 225°SW, 270°W,
information to transmit.
315°NW, or 360°N
- - -, (-0), -1~-15, or -A~-Z
Selects the APRS® call sign SSID for the Item.

Comment
Time Stamp
NMEA
GPS Sentence

OFF, DHM, or HMS

RMC, GGA, GLL, VTG, GSA, or
GSV

GPS Message
GPS Information
GPS Position
GPS Memory

(No Group), A~Z

Transmits position data in selected GPS
sentences.
Enter a GPS message to be transmitted.
Displays the received GPS information.
Displays your position, RX station, GPS
memory, and Alarm positions.
Displays the GPS memory contents.

* The unit may differ, depending on the “Display Unit” settings. (p. 9-64)
9-6

Previous view

9

MENU SCREEN

Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
GPS Alarm
Alarm Select
Alarm Area (Group)
Alarm Area (RX/Memory)

OFF, RX, Group, or Memory
0.08’ ~ 0.25’ ~ 59.99’*1
Limited, Extended, or Both

Select the target for the GPS alarm function.
Enter the GPS alarm active range.
Select the GPS alarm active range.

GPS Logger*2
GPS Logger

OFF or ON

Turns the GPS Logger function ON or OFF, to
save your route as you move.
Selects the GPS Logger function record
interval.
Selects the GPS Logger function record
sentences.
Selects a time option for the GPS automatic
transmission function.

Record Interval

1sec, 5sec, 10sec, 30sec, or
60sec

Record Sentence

✔ RMC/ ✔ GGA/ ✔ VTG/ ✔ GSA

GPS Auto TX

OFF, 5sec, 10sec, 30sec, 1min,
3min, 5min, 10min, or 30min

Call Sign
UR: CQCQCQ, R1: --------,
R2: --------, MY: --------

Set and display the DV mode call signs.
Displays the operating call signs.
Sets the operating call signs according to the
type of call you want to make.

RX History
RX01:

Displays the received call history in the DV mode.
Displays the calls your transceiver received.

DV Memory
Your Call Sign
Repeater List

Saves call signs or repeater information to use in the DV mode.
Saves station call signs. Add or edit call signs.
Blank
01:~50:
Saves repeater information.
Add or edit a repeater information.
NOTE: The repeater list described in this manual may differ from your preloaded list.

My Station
My Call Sign
TX Message

DV Set
Tone Control
RX Bass

Sets and saves MY call sign to use in the DV mode.
1:~6:
Saves MY call signs.
Select or edit a MY call sign to use in the DV
mode.
1:~5: or OFF
Saves TX Messages.
Select or edit TX Message to use in the DV
mode.
Sets values for the DV mode operations.
Cut, Normal, or Boost

RX Treble

Cut, Normal, or Boost

RX Bass Boost

OFF or ON

Sets the DV mode received audio bass filter
level to Cut, Normal or Boost.
Sets the DV mode received audio treble filter
level to Cut, Normal or Boost.
Turns the DV mode received audio Bass
Boost function ON or OFF

*1 The unit may differ, depending on the “Display Unit” settings. (p. 9-64)
*2 Be sure to insert the microSD card into the transceiver before selecting these items.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
TX Bass

Cut, Normal, or Boost

TX Treble

Cut, Normal, or Boost

Auto Reply
DV Data TX

OFF, ON, Voice, or Position
PTT or Auto

DV Fast Data

Fast Data

OFF or ON

GPS Data Speed

Slow or Fast

TX Delay (PTT)

1sec~2sec~10sec, or OFF

Digital Monitor

Auto, Digital, or Analog

Digital Repeater Set

OFF or ON

DV Auto Detect

OFF or ON

RX Record (RPT)

ALL or Latest Only

BK

OFF or ON

EMR

OFF or ON

EMR AF Level

0~19~32

9-8

Sets the DV mode transmit audio bass filter
level to Cut, Normal or Boost.
Sets the DV mode transmit audio treble filter
level to Cut, Normal or Boost.
Selects the Automatic Reply function.
Selects to manually or automatically transmit
low speed data.
The DV Fast data mode sends data through
both the audio and data frames in the DV
mode. The data speed of the DV Fast data
mode (approximately 3480 bps) is 3.5 times
faster than the lowspeed data communication
mode (approximately 950 bps). In the DV Fast
data mode, no audio can be sent.
Selects whether or not to use DV Fast data
mode for data communication in the DV
mode.
Set the GPS data transmission speed in the
DV Fast data mode.
Set the TX delay time after releasing [PTT]
when the “DV Data TX” item is set to “PTT”
and data is sent using the DV Fast data
function.
Selects the DV mode RX monitoring when
[SQL] is held down.
Turns the digital repeater setting function ON
or OFF. This function is usable in any DV
mode except when using the DR function.
Turns the DV mode automatic detect function
ON or OFF.
The transceiver can record the data of up to
50 individual calls.
Turns the Break-in (BK) function ON or OFF.
The BK function enables you to break into a
conversation between two stations with call
sign squelch enabled.
Turns the Enhanced Monitor Request (EMR)
communication mode ON or OFF.
After turning OFF the transceiver, the EMR
mode will be canceled.
Sets the audio output level when an EMR
mode signal is received.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
SPEECH
RX Call Sign SPEECH
RX>CS SPEECH

Sets the Speech functions.
OFF, ON (Kerchunk), or
ON (All)
OFF or ON

DIAL SPEECH
MODE SPEECH

OFF or ON
OFF or ON

SPEECH Language

English or Japanese

Alphabet

Normal or Phonetic Code

SPEECH Speed
SPEECH Level

Slow or Fast
0~7~9

DTMF
DTMF Memory
DTMF Speed
QSO/RX Log
QSO Log*1
RX History Log*1
CSV Format
Separator/Decimal
Date
Function
Squelch/ATT Select

Selects the RX call sign speech function
option while ON, or turns it OFF.
Turns the RX>CS Speech function ON or
OFF.
Turn the Dial Speech function ON or OFF.
Turn the Operating Mode Speech function ON
or OFF.
Selects either English or Japanese as the
speech language.
Selects the alphabet character announcement
type.
Selects Slow or Fast speech speed
Sets the volume level for the voice
synthesizer.

Sets the DTMF Memory functions.
d0:~d9:, dA:~dD:, dM:, or d#:
Displays a list of the DTMF memory channels.
The DTMF memory can save up to 24-digit
DTMF code.
100ms, 200ms, 300ms, or
Selects the DTMF transmit speed.
500ms
Sets the QSO/RX History Log options.
OFF or ON
Selects whether or not to make a
communication log on the microSD card.
OFF or ON
Selects whether or not to make a DV mode’s
receive history log on the microSD card.
Sep [,] Dec [.]*3,
Sep [;] Dec [.], or Sep [;] Dec [,]
yyyy/mm/dd, mm/dd/yyyy*3, or
dd/mm/yyyy
Sets various function’s options.
OFF, S-Meter Squelch, or ATT

Squelch Delay

Short or Long

Fan Control
Dial Speed-UP
Auto Repeater*2

Slow, Mid, Fast, or Auto
OFF or ON
OFF, ON (DUP), or
ON (DUP,TONE)

Selects the separator and the decimal
character for the CSV format.
Selects the date format.

Selects to use the S-Meter Squelch or the
Attenuator function for the [SQL] control.
Selects to shorten or lengthen the time until
the squelch opens.
Selects the cooling fan control action.
Turns the dial speed acceleration ON or OFF.
Turns the Auto Repeater function ON or OFF.

*1 Be sure to insert the microSD card into the transceiver before selecting these items.
*2 Displayed only in the USA version transceivers.
*3 The default value may differ, depending on the transceiver version.
9-9

Previous view

9

MENU SCREEN

Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Remote MIC Key
During RX/Standby

[F-1]:MODE [F-2]:Monitor

During TX

[F-1]:T-CALL [F-2]:---

Up/Down MIC Key
During RX/Standby

[UP]:UP [DN]:DOWN

During TX

[UP]:--- [DN]:---

One-Touch PTT(Remote MIC) OFF or ON

Active Band

OFF or ON
OFF or ON
OFF, 1min, 3min, 5min, 10min,
15min, or 30min
Single or All

MIC Gain

1~2*~4

Data Speed

4800bps or 9600bps

CI-V
CI-V Address

02h~9Ah~DFh

PTT Lock
Busy Lockout
Time-Out Timer

CI-V Baud Rate
CI-V Transceive

4800, 9600, 19200, or Auto
OFF or ON

CI-V Bluetooth➝REMOTE 00~DFh
transceive Address
Power OFF (With No
Controller)
Display
LCD Backlight Brightness
LCD Backlight Color
Key Backlight Brightness
Key Backlight Color

OFF or ON

Sets the Display options.
1~4
White, Amber, Green, or Blue
1~4
White, Amber, Green, or Blue

* The default value may differ, depending on the transceiver version.
9-10

Selects the key function for [F-1] or [F-2] on
the supplied remote-control microphone.
Selects the key function to be used while
receiving or in the standby mode.
Selects the key function to be used while
transmitting.
Selects the key function for [UP] or [DN] on
the optional hand microphone.
Selects the key function to be used while
receiving or in the standby mode.
Selects the key function to be used while
transmitting.
Turns the One-Touch PTT function ON or
OFF.
Turns the PTT Lock function ON or OFF.
Turns the Busy Lockout function ON or OFF.
Selects the Time-Out Timer time options.
Enables continuous frequency selection
across all bands by rotating [DIAL].
Sets the microphone sensitivity to suit your
preference.
Selects the data transmission speed for
low-speed communication, or between the
[DATA] jack and external modules like a GPS
receiver, and so on.
Sets the transceiver's unique CI-V
hexadecimal address code.
Sets the CI-V code transfer speed.
Turns the CI-V Transceive function ON or
OFF.
Sets the address to inhibit the external control
with CI-V for the transceiver through the [SP]
(REMOTE) jack.
Selects whether or not to automatically turn
OFF the transceiver when the controller is
disconnected from the transceiver.

Selects the LCD backlight brightness level.
Selects the LCD backlight color.
Selects the key backlight brightness level.
Selects the key backlight color.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Backlight Night Time Setting
Night Time Setting

OFF or ON

Brightness

1~2~4

Night Time Start

0:00~18:00~23:59

Selects whether or not to turn down the
backlight brightness for nighttime operation.
Selects the backlight brightness level for
nighttime operation.
Sets the start time for nighttime operation.

Night Time End

0:00~6:00~23:59

Sets the end time for nighttime operation.

OFF, Auto-OFF, or Auto 1~3

Sets the Auto Dimmer function for nighttime
operation.
Sets the period of time until the backlight turns
OFF when “Auto Dimmer” is set to “Auto-OFF”
or “Auto-1” to “Auto-3.”
Select the transceiver operation when [PTT] is
pushed when the Auto Dimmer is activated.
Select the transceiver operation when
receiving a DV signal while the Auto Dimmer
is activated.
Sets the contrast level of the LCD.
Selects the call sign and message display
option when receiving a call.
Selects whether or not to display the indicator
when the position data is included in the
signal received in the DV mode.
Selects whether or not to display the caller’s
position data in a dialog when the data is
included in the signal received in the DV
mode.
Sets the RX position data display period of
time.
Selects whether or not to display the caller’s
position data in a dialog when the data is
included in the Auto Reply signal.
Selects whether or not to display My or Your
call sign while transmitting.
Selects the scrolling speed of the message,
call sign, or other text.
Selects whether or not to display the opening
message at power ON.
Selects whether or not to display the power
source voltage at power ON.

Auto Dimmer Setting
Auto Dimmer
Auto Dimmer Timer

5sec, 10sec

Auto Dimmer Cancel (PTT) OFF or ON
Auto Dimmer Cancel
(DV RX)

OFF or ON

LCD Contrast
RX Call Sign

1~8~16
OFF, Normal, RX Hold, or Hold

RX Position Indicator

OFF or ON

RX Position Display

OFF or ON

RX Position Display Timer

5sec, 10sec, 15sec, 30sec, or
Hold
OFF or ON

Reply Position Display

Scroll Speed

OFF, Your Call Sign, or
My Call Sign
Slow or Fast

Opening Message

OFF or ON

Voltage (Power ON)

OFF or ON

TX Call Sign

* The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Display Unit
Latitude/Longitude
Altitude/Distance
Speed
Temperature
Barometric

ddd°mm.mm' or ddd°mm'ss"
m or ft/ml*
km/h, mph*, or knots
ç or ƒ*
hPa, mb, mmHg, or inHg*

Rainfall
Wind Speed
Display Language

mm or inch*
m/s, mph*, or knots
English or Japanese

System Language

English or Japanese

Sounds
Beep Level
Key-Touch Beep
Home CH Beep
Band Edge Beep
Scan Stop Beep
Standby Beep
Scope AF Output
Time Set
Date/Time
DATE
TIME
GPS Time Correct

Sets the Sound options.
0~9
OFF or ON

Sets the beep output level.
Turns the confirmation beep tones ON or OFF
when key is pushed.
OFF or ON
Turns the Home CH Beep ON or OFF.
OFF or ON
Turns the Band Edge Beep ON or OFF.
OFF or ON
Turns the Scan Stop Beep ON or OFF.
OFF, ON, ON (to me:High Tone), Turns the Standby Beep function in the DV
or ON (to me:Alarm/High Tone) mode ON or OFF.
OFF or ON
Selects the audio output option during a
sweep.
Sets the Time options.
2000/01/01~2099/12/31
0:00~23:59
OFF or Auto

UTC Offset

–14:00~±0:00~+14:00

Auto Power OFF

OFF, 30min, 60min, 90min, or
120min

DV Gateway
<<Terminal Mode>>
<<Access Point Mode>>

Selects position format to display the position.
Selects the units to display the distance and
altitude.
Selects the units to display the speed.
Selects the units to display the temperature.
Selects the units to display the barometric
pressure.
Selects the units to display the rainfall.
Selects the units to display the wind speed.
Selects the display language in the DR
screen or MENU screen. When “English” is
selected in “System Language,” this item is
not displayed.
Selects English or Japanese as the system
language of the transceiver.

Sets the current date.
Sets the current time.
Sets to automatically correct the time using a
GPS signal.
Enters the time difference between UTC and
the local time.
Turns the Auto power OFF function ON or
OFF.

Enters the Terminal mode or Access Point mode.
Enters the Terminal mode.
Enters the Access Point mode.

* The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
SD Card*1
Load Setting
File selection
Save Setting
<<New File>>
File selection
Import/Export
Import
Export
CSV Format
Separator/Decimal
Date

Sets the microSD card options.
ALL, Except My Station, or
Repeater List Only

Saves the settings as a new file.
Saves the settings in a selected file.
Your Call Sign, Repeater List, or
GPS Memory
Your Call Sign, Repeater List, or
GPS Memory

Imports the Your call sign, Repeater list, or
GPS memory data in the CSV format file.
Exports the Your call sign, Repeater list, or
GPS memory data in the CSV format file.

Sep [,] Dec [.]*2, Sep [;] Dec [.],
or Sep [;] Dec [,]
yyyy/mm/dd, mm/dd/yyyy*2, or
dd/mm/yyyy

Selects the separator and the decimal
character for the CSV format.
Selects the date format.

SD Card Info

Displays the free space and remaining
recording time of the card.
Enters the Firmware Update mode.
Formats the card.
Electronically unmounts the card.

Firmware Update
Format
Unmount
Bluetooth Set*3
Bluetooth
Auto Connect

Loads the settings file to the transceiver.

Sets the Bluetooth options.
OFF or ON
OFF or ON

Pairing/Connect
Device Search
Search Headset
Search Data Device
Pairing list
<<Pairing Reception>>

Turns the Bluetooth function ON or OFF.
Selects whether or not to automatically
connect to a paired Bluetooth device when the
device is turned ON.
Pairs or connects to a Bluetooth device.
Searches for Bluetooth headsets.
Searches for Bluetooth data devices.
Displays paired devices.
Accepts the connection request from a
Bluetooth device.

*1 Be sure to insert the microSD card into the transceiver before selecting these items.
*2 The default value may differ, depending on the transceiver version.
*3 The optional UT-137 Bluetooth unit is required.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Headset Set
AF Output
Headset Function Select

Headset Only or
Headset & Speaker
Normal, Microphone, or PTT

Selects the AF output option when you use a
Bluetooth headset.
Select the PTT and microphone combination
when either a Bluetooth headset or the radio
microphone are used.

VOX
VOX

OFF or ON

Turn the VOX function ON or OFF when you
use a Bluetooth headset.
VOX Level
OFF, 1~5~10
Set the MIC Gain level.
If the microphone input level is higher than
this set value, the transceiver starts to
transmit, and if the input level is lower than
this set value, returns to receive.
VOX Delay
0.5sec, 1.0sec, 1.5sec, 2.0sec, Sets the VOX Delay time for the transmitter
2.5sec, or 3.0sec
stays ON after you stop speaking before the
VOX switches to receive.
VOX Time-Out Timer OFF, 1min, 2min, 3min, 4min,
Sets the VOX Time-Out Timer to prevent an
5min, 10min, or 15min
accidental prolonged transmission.
Icom Headset
Sets to use the optional Icom VS-3 Bluetooth
headset.
Power Save
OFF or ON
Sets the Power save function to prolong the
headset battery life.
One-Touch PTT
OFF or ON
Sets the One-Touch PTT function to change
between transmission and reception by
pushing [PTT].
PTT Beep
OFF or ON
Sets to sound a beep when you push [PTT].
Custom Key Beep
OFF or ON
Sets to sound a beep when you push custom
key ([PLAY]/[FWD]/[RWD]).
Custom Key
[PLAY]:---, [FWD]:UP,
Selects the key function of custom key
[RWD]: DOWN
([PLAY]/[FWD]/[RWD]).
Data Device Set
Sets the data device options.
Serialport Function
CI-V (Echo Back OFF),
Selects to transmit or receive CI-V commands
CI-V(Echo Back ON), or DV Data or DV data.
Bluetooth Device Information
Displays the optional UT-137 Bluetooth unit
information.
Initialize Bluetooth Device
Resets the optional UT-137 Bluetooth unit.
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Menu items and Default settings (Continued)
NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.
Others
Information
Voltage
Version

Set other options.
Displays the power source voltage.
Displays the transceiver’s firmware version
number.

Clone
Clone Mode

Reads or writes the CS-4100 data from or to
the PC.

Reset
Partial Reset

Returns all settings to their defaults, without
clearing the memory contents, call sign
memories or repeater lists.
Clears all entries and memories, and returns
all settings to their defaults.

All Reset
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DUP/TONE items
Offset frequency

(Default: 0.600.00*)

DTCS Code

(Default: 023)

DUP/TONE... > Offset Freq

DUP/TONE... > DTCS Code

Set the frequency offset for duplex (repeater)
operation to between 0.000.00 and 59.99500 MHz.
LLThe duplex shift direction (DUP–/DUP+) is set in
the duplex setting window.
LLWhen the DR function is ON, editing is restricted.

Select a DTCS (both encoder/decoder) code for the
DTCS squelch.
A total of 104 codes (023 ~ 754) are selectable.
• Selectable DTCS codes
023
025
026
031
032
036
043
047
051
053
054
065
071

*The default value may differ, depending on the frequency
band and the transceiver version.

Repeater Tone

(Default: 88.5)

DUP/TONE... > Repeater Tone
Select a CTCSS tone frequency for repeater access
and other functions.
50 tone frequencies (67.0 ~ 254.1 Hz) are selectable.
TSQL Freq

(Default: 88.5)

DUP/TONE... > TSQL Freq

152
155
156
162
165
172
174
205
212
223
225
226
243

244
245
246
251
252
255
261
263
265
266
271
274
306

311
315
325
331
332
343
346
351
356
364
365
371
411

DTCS Polarity

Select a CTCSS tone frequency for the tone squelch
or the Pocket beep function.
50 frequencies (67.0 ~ 254.1 Hz) are selectable.

412
413
423
431
432
445
446
452
454
455
462
464
465

466
503
506
516
523
526
532
546
565
606
612
624
627

631
632
654
662
664
703
712
723
731
732
734
743
754

(Default: Both N)

DUP/TONE... > DTCS Polarity
Select the DTCS polarity to use for transmitting and
receiving.
• Both N:	Normal polarity is used for both TX and RX.
• TN-RR:	Normal polarity is used for TX; Reverse
polarity for RX.
• TR-RN:	Reverse polarity is used for TX; Normal
polarity for RX.
• Both R:	Reverse polarity is used for both TX and RX.

• Selectable repeater tone/tone squelch
frequencies (Unit: Hz)
67.0 085.4 107.2 136.5 165.5 186.2 210.7 254.1
69.3 088.5 110.9 141.3 167.9 189.9 218.1
71.9 091.5 114.8 146.2 171.3 192.8 225.7
74.4 094.8 118.8 151.4 173.8 196.6 229.1
77.0 097.4 123.0 156.7 177.3 199.5 233.6
79.7 100.0 127.3 159.8 179.9 203.5 241.8
82.5 103.5 131.8 162.2 183.5 206.5 250.3
Tone Burst

072
073
074
114
115
116
122
125
131
132
134
143
145

DTCS code’s polarity for transmitting or receiving can
be independently set with this item.
Digital Code

(Default: OFF)

(Default: 00)

DUP/TONE... > Digital Code

DUP/TONE... > Tone Burst

Select the digital code for digital code squelch.
A total of 100 codes (00 ~ 99) are selectable.

Turn the Tone Burst function ON or OFF in the FM
mode when using tone squelch.
• OFF:	When you transmit a signal that superimposes
the CTCSS tone, the other station may hear
a short burst of noise from their receiver, just
after you stop transmitting.
• ON:	
When you transmit a signal that superimposes
the CTCSS tone, the function mutes the noise
from being heard in the other station’s receiver.
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Manage Memory items
Memory CH

Call CH

Manage Memory > Memory CH

Manage Memory > Call CH

You can delete, copy and edit your memory data.
Up to 1000 Memory channels can be saved.
Also, 26 memory banks, A to Z, can be used to save
groups of operating channels, and so on.
Up to 100 channels can be assigned to a bank.
• ALL:	All Memory channels are listed.
• A–Z:	Memory channels that is saved in the bank
are listed.

You can delete, copy or edit your Call channel data.
The Call channel can be assigned to 2 different
channels (C0 and C1) in the 144 MHz and 430 MHz
bands.
The default setting is differ, depending on the
transceiver version.
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Scan items
Pause Timer

(Default: 10sec)

Bank Link

(Default: A: ✔ ~ Z: ✔ )

Scan > Pause Timer

Scan > Bank Link

Select the scan Pause time. When receiving a signal,
the scan pauses for the scan Pause Timer time.
• 2sec ~ 20sec : When a signal is received, the scan
pauses for 2 ~ 20 seconds (set in 2
second steps).
• HOLD
: The scan pauses on a received
signal until the signal disappears.

Select banks to be scanned during a Bank Link Scan.
The Bank Link function scans all channels in the
selected banks.
Select a bank, A ~ Z, then push [ï] to turn the Link
function ON or OFF.

Resume Timer

••Displays “✔” when the function is set to ON.

Program Scan Edge

(Default: 2sec)

Scan > Program Scan Edge

Scan > Resume Timer

You can delete, copy or edit the lower and higher
frequencies for programmed scans.
The transceiver has a total of up to 25 frequency
ranges (00 ~ 24), and you can set scan name, tuning
step, and the receive mode for each scan edge.
The default setting is differ, depending on the
transceiver version.
See page 2-9 for Entering scan edges.

Select the scan Resume Timer time.
When a received signal disappears, the scan resumes
according to the scan Resume Timer setting.
• 0sec:	The scan resumes immediately after
the signal disappears.
• 1sec ~ 5sec:	The scan resumes 1 ~ 5 seconds after
the signal disappears.
• HOLD:	The scan remains paused for the
Pause Timer setting, even if the signal
disappears.
NOTE: Rotate [DIAL] to resume the scan. The
Resume Timer must be set shorter than the Pause
Timer, otherwise this timer does not work properly.
Temporary Skip Timer

(Default: 5min)

Scan > Temporary Skip Timer
Set the Temporary Skip Timer to 5, 10 or 15 minutes.
When the time is set, the unwanted frequencies are
skipped for this set period during a scan.
This timer is activated for the VFO scan, Memory scan
and DR scan.
Program Skip

(Default: ON)

Scan > Program Skip
Turn the Program Skip Scan function ON or OFF for a
VFO mode scan.
This function enables the transceiver to skip the
unwanted frequencies or channels that inconveniently
stop scanning.
Set the unwanted frequencies or channels to “PSKIP”
in the Memory Channel screen.
• OFF:	The transceiver scans all frequencies.
• ON:	The transceiver does not scan frequencies set
as “PSKIP” frequencies.
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Scan items (Continued)
Program Link

(Default: Refer to the table below)

Adding a Scan Edge channel to the Program Link
1. Select a Program Link number between 0 and 9,
then push [ï].
2. Push [QUICK].
3. Select “Add,” then push [ï].
		

Scan > Program Link
This item sets the link function for two or more
program scan edge ranges to be sequentially scanned
during the Program Link Scan.
The link function scans all frequencies in the scan
range.
Default settings of the Program Link
The Program Scan Edge channels “01” and “02” are
set in the Program Link No. 0 as the default.
Program Link

4. S
 elect a programmed scan number you want to
add to the selected link channel.

(Example: 00: 118.000-550.000)
		

01：144.000−148.000

0：
Edit Name

02：430.000−450.000

1：

...

Blank

5. Push [MENU].

9：

••Returns to the standby screen.

Deleting the link channel
1. Select a Program Link number between 0 and 9,
then push [ï].
2. Select the programmed scan number you want to
delete.
(Example: 02: 430.000-450.000)
		

Program Link number (0 to 9) Program Scan Edge channel

LLThe Program Link No. screen displays the
frequency range. (The default scan edge frequency
may differ, depending on the transceiver version.)
LLYou can add a link setting by pushing [QUICK]
when two or more pairs of Program Scan Edge
channels are entered.
LLWhen only one Program Scan Edge channel is
entered, or there is no Programmed Scan Edge (00
to 24) is left, “Add” is not displayed after pushing
[QUICK].

3. Push [QUICK].
4. Select “Delete,” then push [ï].
		

5. Push [MENU].

••Returns to the standby screen.
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Scan items (Continued)
Editing a Program Scan Link name
1. Select a Program Link number between 0 and 9,
then push [QUICK].
		

2. Select “Edit Name,” then push [ï].
		

••Enters the Program Link Name edit mode.

3. Enter a Program Scan Link name of up to 16
characters.
		

		 (Example: Japan)
Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)

4. After entering, push [ï].
		

5. Push [MENU].

••Returns to the standby screen.
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Voice Memo items (For Record/Playback)
<<REC Start>>

REC Mode

Voice Memo > QSO Recorder > <<REC Start>>

Voice Memo > QSO Recorder > Recorder Set >
REC Mode

After selecting “<<REC Start>>,” push [ï] to start
voice recording.

(Default: TX&RX)

Records both the transmitted and received audio as
the default setting.
••TX&RX:	Records both the transmitted and received
voice audio.
••RX Only:	Records only the received voice audio.

••“Recording started.” is displayed.

LL Informatio

••Be sure a microSD card is in the card slot.
••While recording, “<<REC Stop>>” is displayed on the QSO
RECORDER screen. To stop recording, select “<<REC
Stop>>.”
••Once recording has started, the recording will continue,
even if the transceiver is turned OFF and then later turned
ON again.

When transmitted while recording
When “File Split” is set to “OFF,” the recording is
paused. After you finish transmitting, the recording
resumes.
When “File Split” is set to “ON,” a new file is
automatically created, and the transmitted voice audio
is recorded into the new one.

Play Files
Voice Memo > QSO Recorder > Play Files

RX REC Condition

Performs the following steps to play back the recorded
audio on the microSD card.

(Default: Squelch Auto)

Voice Memo > QSO Recorder > Recorder Set >
RX REC Condition

TIP: Be sure a microSD card is in the card slot.

Select whether or not the squelch status affects the
RX voice audio recording.
••Always:	The transceiver always records the
RX voice audio regardless of the
squelch status.
••Squelch Auto:	The transceiver records the RX voice
audio only when a signal is received
(the squelch is opened).
When the squelch closes while
recording, the recording will continue
for 2 seconds, and then pause.

Playing back
1. Select “Play Files,” then push [ï].

••Displays the folders on the microSD card
LLThese folders contain the recorded audio files.

2. S
 elect the folder that includes the audio file to play
back, then push [ï].
3. Select the file to play back, then push [ï].
••The VOICE PLAYER screen is displayed and the
selected file is played back.
LLSee “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 7-3)

File Split

4. Push [MENU].

••Returns to the standby screen.

(Default: ON)

Voice Memo > QSO Recorder > Recorder Set >
File Split

NOTE:
••The folder name is automatically created, as shown
below:
Recording date: 1st April 2017
Folder name: 20170401
• The file name is automatically created, as shown
below:
Recording date and time: 1st April 2017 15:30:00
File name:	20170401_153000
• The voice audio is recorded onto a microSD
card, and saved in the “wav” format. (“.wav” is not
displayed on the transceiver’s screen.)
• The recorded voice audio can also be played back
with a PC.

Turn the File Split function ON or OFF.
• OFF:	When the recording starts, a new file is
automatically created in the folder on the
microSD card. The voice audio is continuously
recorded into the file, even if transmission and
reception, or the squelch status (open and
close) is switched.
If the file size exceeds 2 GB, a new file is
automatically created in the same folder, and
the voice audio is recorded there.
• ON:	When the recording starts, a new file is
automatically created in the folder of the
microSD card. During recording, and if
transmission and reception, or squelch status
(open and close) is switched, a new file is
automatically created in the same folder, and
the voice audio is saved into the new one.
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Voice Memo items (Continued)
PTT Auto REC

(Default: OFF)

Voice Memo > QSO Recorder > Recorder Set >
PTT Auto REC
Turn the PTT Automatic Recording function ON or
OFF.
LLTransmitting from a Bluetooth VOX device, or
sending a CI-V command also starts recording.
LLWhen "REC Mode" is set to "RX Only," the
transmitted voice audio is not recorded.
••OFF:	Turns OFF the function.
••ON:	The recording automatically starts when [PTT]
is pushed.
The recording will stop when:
• No signal is transmitted for 10 seconds after
releasing [PTT].
• No signal is received for 10 seconds after
releasing [PTT].
-W
 hen transceiver receives a signal 10
seconds after releasing [PTT], the recording
automatically starts.
• Frequency or operating mode is changed
after releasing [PTT].
Skip Time

(Default: 10sec)

Voice Memo > QSO Recorder > Player Set >
Skip Time
Select the Skip timer to 3, 5, 10 or 30 seconds to
rewind or skip forward for this set period when you
push the fast-rewind or fast-forward key while playing
the recorded voice audio.
LLSee “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 7-3)
DV Auto Reply
Voice Memo > DV Auto Reply
Up to 10 seconds of audio can be recorded for the
automatic reply function.
TIP: Be sure a microSD card is in the card slot.
LLSee “Automatic Reply function” for details. (p. 4-24)
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Voice TX items
Record

<<TX>>

Voice TX > Record

Voice TX > <<TX>>

Up to one minute of audio can be recorded onto a
microSD card for voice transmission. (p. 10-5)
Four independent voice audios can be memorized into
each memory T1 ~ T4.
While recording a QSO voice audio, this function is
disabled.

The transceiver transmits the recorded voice audio.
If the memory T1 ~ T4 with “Repeat TX” is selected,
the recorded voice audio is repeatedly transmitted for
up to 10 minutes, at the “Repeat Time” interval.
(p. 10-6)
NOTE:
• If 10 minutes passes while transmitting, the
transceiver continues to transmit until the complete
voice audio transmission is finished.
• Any one of the following action will cancel the
transmission.
- Push [PTT].
- Turn OFF the transceiver, then turn it ON again.
- Push any key (except for [VOL] and [ ]).

TIP: Be sure a microSD card is in the card slot.
Repeat Time

(Default: 5sec)

Voice TX > TX Set > Repeat Time
Set the repeat period of time to between 1 and 15
seconds (in 1 second steps).
The transceiver repeatedly transmits the recorded
voice audio for this set period of time.
NOTE: The recorded voice audio is repeatedly
transmitted for up to 10 minutes. If 10 minutes
passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.
TX Monitor

(Default: ON)

Voice TX > TX Set > TX Monitor
Turn the TX Monitor function ON or OFF.
• OFF:	The TX voice audio is not heard from the
speaker.
• ON:	The TX voice audio is heard from the speaker.
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GPS items
GPS Select

(Default: Internal GPS)

Unproto Address

(Default: API410,DSTAR*)

GPS > GPS Set > GPS Select

GPS > GPS TX Mode > D-PRS > Unproto Address

Select either the internal or external GPS receiver that
the transceiver receives its position data from, or to
manually enter your current position data.
• OFF:	A GPS receiver is not used.
• Internal GPS:	Position data of the internal GPS data
is used for the GPS functions.
• External GPS:	Position data of an external GPS
receiver is used for the GPS
functions.
• Manual:	Manually enter the current Latitude,
Longitude and Altitude in Manual
Position.
LLData communication is disabled when “External
GPS” is selected. (p. 4-27)
LLWhen “External GPS” is set, but if the external
GPS receiver is not connected, the internal GPS
receiver is temporarily turned ON if you use the
Automatic Position Reply function.

Displays an unproto address of up to 56 alphanumeric
characters.
NOTE: You should use the default address, and
editing is not recommended.
TX Format

GPS > GPS TX Mode > D-PRS > TX Format
Select the format to transmit the position data in the
D-PRS mode.
••Position:	The caller station is the mobile or base
station.
••Object:	Transmits a certain location’s information,
such as an event, earthquake, and so on.
(time stamp data is included.)
••Item:	Transmits repeater or antenna information
that needs no time information.
(time stamp data is not included.)
••Weather:	Transmits weather information received
from a weather device.

Manual Position (Default: LATITUDE : 0°00.00’N,
LONGITUDE : 0°00.00’E
ALTITUDE : ------ft)

Symbol

GPS > GPS Set > Manual Position

Select the symbol that indicates your operating
situation. The selected symbol channel’s symbols
(1~4) are transmitted along with the position data.

(Default: OFF)

Editing a symbol
1. Select the symbol channel, then push [QUICK].
2. Select “Edit Symbol,” then push [ï].
3. Push [QUICK].
4. Select “Direct Input,” then push [ï].
5. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first digit.
6. Rotate [DIAL] to select a character or symbol to
the selected digit.

GPS > GPS Set > GPS Out (To DATA Jack)
Select whether or not the position data of the internal
GPS receiver is output to the [DATA] jack.
TIP:
••When “GPS Select” is set to “OFF,” “External GPS,”
or “Manual,” GPS position data is not output from
the [DATA] jack.
••When you want to operate data communication in
the DV mode, set to “OFF.”
GPS TX Mode

(Default: Car)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Symbol

Manually enter the latitude, longitude and Altitude of
your current position.
LLYou can capture the position from the GPS receiver
if “Capture From GPS” is selected. (p. 5-18)
GPS Out (To DATA jack)

(Default: Position)

Selectable characters and symbols
<For the first digit> /, \, 0 to 9, A to Z
<For the second digit> A to Z, a to z, 0 to 9, ! " #
$%&’()*+,-./:;<=>?@[\]^_`{|}˜

(Default: OFF)

7. After selecting, push [ï].

••Sets the Symbol into the channel selected in step 1.

GPS > GPS TX Mode

Selecting a preset symbol
1. Select the symbol channel, then push [QUICK].
2. Select “Edit Symbol,” then push [ï].
3. Select the symbol, then push [ï].

Select a GPS transmission mode to send a GPS
position data while in the DV mode.
••OFF: Does not transmit a GPS data.
••D-PRS:	Transmits GPS data in the D-PRS format.
••NMEA:	Transmits a GPS data in the NMEA format.

LL1:Car, 2: Van, 3: Truck, and 4:House QTH (VHF) are
set as defaults.

4. Select the symbol channel, then push [ï].
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GPS items (Continued)
Symbol list
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GPS items (Continued)
SSID

(Default: - --)

Comment

GPS > GPS TX Mode > D-PRS > TX Format >
Position > SSID

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Comment

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.
••---:		The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA-A
••(-0):	No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA
••-1~-15:	Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”
JA3YUA → JA3YUA-9
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”
JA3YUA → JA3YUA-Z
JA3YUA A → JA3YUA-Z

Enter a comment to transmit it with the D-PRS
position data.
You can enter up to four comments.
The number of characters you can enter differs,
depending on the Data Extension and Altitude
settings.
Data Extension

Characters
Altitude entered (Max.)

OFF

OFF

43 (Default)

OFF

ON

35

Course/Speed

OFF

36

Course/Speed

ON

28

Power/Height/Gain/Directivity

OFF

36

Power/Height/Gain/Directivity

ON

28

The symbol “ ” displays the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.
		

About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (or APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

Transmittable comment range display
(In case of up to 28 characters)
Time Stamp

(Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Time Stamp
Sets the transmitting time stamp type to DHM, HMS or
OFF.
The time stamp is transmitted along with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.
••OFF: Does not transmit the time information.
••DHM:	Transmits the time stamp in the Day, Hour,
and Minute format.
••HMS:	Transmits the time stamp in the Hour, Minute,
and Second format.
When your location is manually set, time stamp data
cannot be transmitted.
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GPS items (Continued)
Altitude

(Default: OFF)

Power

(Default: 0W)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Altitude

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Power

Select whether or not to transmit altitude data along
with the position data in the D-PRS mode.
• OFF: No altitude data is transmitted.
• ON:	Transmits altitude data along with the position
data.

Select the TX power level of the base station, to
transmit along with the position data.
Options: Set to between 0, 1, 4, 9, 16, 25, 36, 49, 64,
and 81W.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.
Data Extension

Height

(Default: 10ft)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Height

(Default: OFF)

Select the height of the base station’s antenna, to
transmit along with the position data.
Options: Set to between 10, 20, 40, 80, 160, 320, 640,
1280, 2560, and 5120 feet.*

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Data Extension
Select whether or not to transmit course/speed data
or Power/Height/Gain/Directivity data along with the
position data in the D-PRS mode.
••OFF:	Does not transmit any information.
••Course/Speed:	Transmits course and speed data
along with the position data.
The Course and Speed data is not
transmitted when your location is
manually set.
When transmitting with this setting,
your station is regarded as a mobile
station.
••Power/Height/Gain/Directivity:
				Transmits the TX power level, height,
antenna gain and antenna direction,
along with the position data.
The Power, Height, Gain and
Directivity data is transmitted even if
your location is manually set.
Only the Icom transceivers, ID51A/E PLUS, ID-51A/E PLUS2,
ID-5100A/E, and ID-4100A/E, can
receive Power, Height, Gain and
Directivity data. (As of April 2017)

*If the Altitude/Distance unit is set to “m,” select between 3,
6, 12, 24, 49, 98, 195, 390, 780, and 1561 meters. (p. 9-64)

LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
Gain

(Default: 0dB)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Gain
Select the gain of the base station’s antenna, to
transmit along with the position data.
Options: Set to between 0 and 9 dB.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
Directivity

(Default: Omni)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Directivity
Select the direction the base station’s antenna was
pointing, to transmit along with the position data.
Options: Set to between Omni, 45ºNE, 90ºE, 135ºSE,
180ºS, 225ºSW, 270ºW, 315ºNW and 360ºN.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.
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GPS items (Continued)
Object Name

Comment

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Object Name

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Comment

Enter an Object name of up to 9 characters.

Enter a comment.
The number of characters you can enter differs,
depending on the Data Extension and Altitude data
entry.

Data Type

(Default: Live Object)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Data Type
Set the Object’s status.
••Live Object: The Object is valid.
••Killed Object: The Object is invalid.
Symbol

Data Extension

Altitude

OFF
—
OFF
Entered
Course/Speed
—
Course/Speed
Entered
Power/Height/Gain/Directivity
—
Power/Height/Gain/Directivity Entered

(Default: Radio)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Symbol
The symbol is an icon which represents Object’s
means of transportation or location. The saved symbol
is transmitted along with the position data while in the
D-PRS mode.
See page 9-25 for the symbol list.

Characters
entered
(maximum)
43 (Default)
35
36
28
36
28

The symbol “ ” shows the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.
		

Editing a symbol
1. Push [QUICK].
2. Rotate [DIAL] to select “Direct Input,” then push
[ï].
3. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first
digit.
4. R
 otate [DIAL] to select a character or symbol to
the selected digit.

Transmittable comment range display
(In case of up to 28 characters)

Selectable characters and symbols
<For the first digit>
/, \, 0 to 9, A to Z
<For the second digit>
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
,-./:;<=>?@[\]^_`{|}˜

5. Push [ï] to set the symbol.
Selecting a preset symbol
1. On the “Symbol” screen, rotate [DIAL] to select
the symbol.
2. Push [ï] to set the symbol.
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GPS items (Continued)
Position

		

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Position
Displays the position information of the Object.
Push [QUICK] to open the window shown below.
		

After entering the position data
Data Extension

(Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Data Extension
Select whether or not to transmit the Course/Speed
data or Power/Height/Gain/Directivity data along with
the position data in the D-PRS mode.
••OFF:	Does not transmit any information.
••Course/Speed:	Transmits the Course and Speed
data along with the position data.
••Power/Height/Gain/Directivity:
				Transmits the Power, Height, Gain
and Directivity data, along with the
position data.
Only the Icom transceivers, ID51A/E PLUS, ID-51A/E PLUS2,
ID-5100A/E, and ID-4100A/E, can
receive Power, Height, Gain and
Directivity data. (As of April 2017)

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS, or set the Object’s position from the
GPS memory. (p. 5-18)
Entering the latitude
1. Rotate [DIAL] to select “Edit,” then push [ï].
••Displays the POSITION EDIT screen.

2. Select “LATITUDE,” then push [ï].
••Displays the LATITUDE screen.

3. Rotate [DIAL] to enter the latitude.

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
LLTo enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

4. After entering, push [ï].

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

Entering the longitude
5. Select “LONGITUDE,” then push [ï].
••Displays the LONGITUDE screen.

6. Rotate [DIAL] to enter the longitude.

Course

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
LLTo enter an east latitude longitude, select “E,” and to
enter a west longitude, select “W.”

(Default: 0º)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Course

7. After entering, push [ï].

Set the Object’s course to between 0º and 360º.
LLThis item is displayed when “Data Extension” is set
to “Course/Speed.”

Entering the altitude
8. Select “ALTITUDE,” then push [ï].
••Displays the ALTITUDE screen.

Speed

9. Rotate [DIAL] to select between plus and minus.
10. P
 ush [MW] to move the cursor forwards.
11. Rotate [DIAL] to enter the altitude.

(Default: 0mph)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Speed

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.

Set the Object’s speed to between 0 and 1150 mph.*

*If the Speed unit is set to “km/h,” select between 0 to 1850
km/h, or set to “knots,” select between 0 and 999 knot.
(p. 9-64)

12. After entering, push [ï].
13. Select “<<Write>>,” then push [ï].

••The confirmation dialog “Write?” is displayed.

LLThis item is displayed when “Data Extension” is set
to “Course/Speed.”

14. Select <YES>, then push [ï].

••Writes the entered position data.

15. Push [].

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.
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GPS items (Continued)
Power

(Default: 0W)

SSID

(Default: ---)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Power

GPS > GPS TX Mode > D-PRS > TX Format > Object
> SSID

Select the TX power level of the Object, to transmit
along with the position data.
Options: Set to between 0, 1, 4, 9, 16, 25, 36, 49, 64,
and 81W.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.
••---:		The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA-A
••(-0):	No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA
••-1~-15:	Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”
JA3YUA → JA3YUA-9
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”
JA3YUA → JA3YUA-Z
JA3YUA A → JA3YUA-Z

Height

(Default: 10ft)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Height
Select the height of the Object’s antenna, to transmit
along with the position data.
Options: Set to between 10, 20, 40, 80, 160, 320, 640,
1280, 2560, and 5120 feet.*

*If the Altitude/Distance unit is set to “m,” select between 3,
6, 12, 24, 49, 98, 195, 390, 780, and 1561 meters. (p. 9-64)

LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
Gain

(Default: 0dB)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Gain
Select the gain of the Object’s antenna, to transmit
along with the position data.
Options: Set to between 0 and 9 dB.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
Directivity

About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (or APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

(Default: Omni)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Directivity
Select the direction the Object’s antenna was pointing,
to transmit along with the position data.
Options: Set to between Omni, 45ºNE, 90ºE, 135ºSE,
180ºS, 225ºSW, 270ºW, 315ºNW and 360ºN.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Time Stamp

(Default: DHM)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Time Stamp
Sets the transmitting time stamp type to DHM or HMS.
The time stamp is transmitted along with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.
••DHM:	Transmits the time stamp in the Day, Hour,
and Minute format.
••HMS:	Transmits the time stamp in the Hour, Minute,
and Second format.
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Item Name

Comment

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Item Name

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Comment

Enter an Item name of up to 9 characters.

Enter a comment.
The number of characters you can enter differs,
depending on the Data Extension and Altitude data
entry.

Data Type

(Default: Live Item)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Data Type
Set the Item’s status.
••Live Item: The Item is valid.
••Killed Item: The Item is invalid.
Symbol

Data Extension

Altitude

OFF
—
OFF
Entered
Course/Speed
—
Course/Speed
Entered
Power/Height/Gain/Directivity
—
Power/Height/Gain/Directivity Entered

(Default: Radio)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Symbol
The symbol is an icon which represents Item’s means
of transportation or location. The saved symbol is
transmitted along with the position data while in the
D-PRS mode.
See page 9-25 for the symbol list.

Characters
entered
(maximum)
43 (Default)
35
36
28
36
28

The symbol “ ” shows the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.
		

Editing a symbol
1. Push [QUICK].
2. Rotate [DIAL] to select “Direct Input,” then push
[ï].
3. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first
digit.
4. R
 otate [DIAL] to select a character or symbol to
the selected digit.

Transmittable comment range display
(In case of up to 28 characters)

Selectable characters and symbols
<For the first digit>
/, \, 0 to 9, A to Z
<For the second digit>
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
,-./:;<=>?@[\]^_`{|}˜

5. Push [ï] to set the symbol.
Selecting a preset symbol
1. On the “Symbol” screen, rotate [DIAL] to select
the symbol.
2. Push [ï] to set the symbol.
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Position

		

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Position
After entering the position data

Displays the position information of the Item.
Push [QUICK] to open the window shown below.
		

Data Extension

(Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Data Extension
Select whether or not to transmit the Course/Speed
data or Power/Height/Gain/Directivity data along with
the position data in the D-PRS mode.
••OFF:	Does not transmit any information.
••Course/Speed:	Transmits the Course and Speed
data along with the position data.
••Power/Height/Gain/Directivity:
				Transmits the Power, Height, Gain
and Directivity data, along with the
position data.
Only the Icom transceivers, ID51A/E PLUS, ID-51A/E PLUS2,
ID-5100A/E, and ID-4100A/E, can
receive Power, Height, Gain and
Directivity data. (As of April 2017)

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS, or set the Item’s position from the
GPS memory. (p. 5-18)
Entering the latitude
1. Rotate [DIAL] to select “Edit,” then push [ï].
••Displays the POSITION EDIT screen.

2. Select “LATITUDE,” then push [ï].
••Displays the LATITUDE screen.

3. Rotate [DIAL] to enter the latitude.

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
LLTo enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

4. After entering, push [ï].

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

Entering the longitude
5. Select “LONGITUDE,” then push [ï].
••Displays the LONGITUDE screen.

6. Rotate [DIAL] to enter the longitude.

Course

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
LLTo enter an east latitude longitude, select “E,” and to
enter a west longitude, select “W.”

(Default: 0º)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Course
Set the Item’s course to between 0º and 360º.
LLThis item is displayed when “Data Extension” is set
to “Course/Speed.”

7. After entering, push [ï].

Entering the altitude
8. Select “ALTITUDE,” then push [ï].

Speed

••Displays the ALTITUDE screen.

9. Rotate [DIAL] to select between plus and minus.
10. P
 ush [MW] to move the cursor forwards.
11. Rotate [DIAL] to enter the altitude.

(Default: 0mph)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Speed

LLPush [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.

Set the Item’s speed to between 0 and 1150 mph.*

••The confirmation dialog “Write?” is displayed.

LLThis item is displayed when “Data Extension” is set
to “Course/Speed.”

*If the Speed unit is set to “km/h,” select between 0 to 1850
km/h, or set to “knots,” select between 0 and 999 knot.
(p. 9-64)

12. After entering, push [ï].
13. Select “<<Write>>,” then push [ï].
14. Select <YES>, then push [ï].

••Writes the entered position data.

15. Push [].

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

9-32

Previous view

9

MENU SCREEN

GPS items (Continued)
Power

(Default: 0W)

SSID

(Default: ---)

GPS > GPS TX Mode > D-PRS > TX Format > Item
> Power

GPS > GPS TX Mode > D-PRS > TX Format > Item
> SSID

Select the TX power level of the Item, to transmit
along with the position data.
Options: Set to between 0, 1, 4, 9, 16, 25, 36, 49, 64,
and 81W.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.
••---:		The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA-A
••(-0):	No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA
••-1~-15:	Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”
JA3YUA → JA3YUA-9
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”
JA3YUA → JA3YUA-Z
JA3YUA A → JA3YUA-Z

Height

(Default: 10ft)

GPS > GPS TX Mode > D-PRS > TX Format > Item
> Height
Select the height of the Item’s antenna, to transmit
along with the position data.
Options: Set to between 10, 20, 40, 80, 160, 320, 640,
1280, 2560, and 5120 feet.*

*If the Altitude/Distance unit is set to “m,” select between 3,
6, 12, 24, 49, 98, 195, 390, 780, and 1561 meters. (p. 9-64)

LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
Gain

(Default: 0dB)

GPS > GPS TX Mode > D-PRS > TX Format > Item
> Gain
Select the gain of the Item’s antenna, to transmit
along with the position data.
Options: Set to between 0 and 9 dB.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
Directivity

About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (or APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

(Default: Omni)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Directivity
Select the direction the Item’s antenna was pointing,
to transmit along with the position data.
Options: Set to between Omni, 45ºNE, 90ºE, 135ºSE,
180ºS, 225ºSW, 270ºW, 315ºNW and 360ºN.
LLThis item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
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Symbol

(Default: WX Station)

••-1~-15:	Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”
JA3YUA → JA3YUA-9
JA3YUA A → JA3YUA-9
••-A~-Z:	Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”
JA3YUA → JA3YUA-Z
JA3YUA A → JA3YUA-Z

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > Symbol
The symbol is an icon which represents weather
station’s means of transportation or location. The
saved symbol is transmitted along with the position
data while in the D-PRS mode.
See page 9-25 for the symbol list.

About the SSID
To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

Editing a symbol
1. Push [QUICK].
2. Rotate [DIAL] to select “Direct Input,” then push
[ï].
3. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first
digit.
4. R
 otate [DIAL] to select a character or symbol to
the selected digit.

Comment

Selectable characters and symbols

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > Comment

<For the first digit>
/, \, 0 to 9, A to Z
<For the second digit>
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
,-./:;<=>?@[\]^_`{|}˜

Enter a comment of up to 43 characters.
Time Stamp

5. Push [ï] to set the symbol.

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > Time Stamp

Selecting a preset symbol
1. On the “Symbol” screen, rotate [DIAL] to select
the symbol.
2. Push [ï] to set the symbol.
SSID

(Default: DHM)

Sets the transmitting time stamp type to DHM, HMS or
OFF.
The time stamp is transmitted along with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.
••OFF: Does not transmit the time information.
••DHM:	Transmits the time stamp in the Day, Hour,
and Minute format.
••HMS:	Transmits the time stamp in the Hour, Minute,
and Second format.

(Default: - --)

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > SSID
Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.
••---:		The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA-A
••(-0):	No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JA3YUA → JA3YUA
JA3YUA A → JA3YUA
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GPS Sentence

(Default: GGA)

GPS Message

GPS > GPS TX Mode > NMEA > GPS Sentence

GPS > GPS TX Mode > NMEA > GPS Message

Select sentences to be transmitted in the GPS mode
to transmit position data.
Options: Set to between RMC, GGA, GLL, VTG, GSA
and GSV.

Enter a GPS message of up to 20 alphanumeric
characters. (p. 5-26)
NOTE: When you do not want to send a message,
delete the entered message.

LL Informatio
••A maximum of four GPS sentences can be set at a
time.
••Displays “✓” when the sentence is set to ON.
••Even if the GPS Auto TX Timer is set to “5 sec.,”
when 4 sentences are selected, the time the GPS
Auto TX Timer is automatically changed to “10 sec.”
••“VTG,” “GSA” and “GSV” sentences will not be
transmitted when your position has been manually
set.
NOTE: Set the GSV sentence to OFF when
sending the GPS message to conventional digital
transceivers (IC-2820H, IC-E2820, ID-800H, IC91AD, IC-E91, IC-V82, IC-U82, IC-2200H).
The GSV sentence is incompatible with them. Those
transceivers will not display GPS messages properly
if sent as a GSV sentence from the ID-4100A/E.

TIP: Contents of GPS sentence
The Time Stamp is shown based on the UTC (Universal Time Coordinated) time.
Sentence Lat/Lon
RMC
GGA
GLL
VTG
GSA
GSV
Sentence
RMC

✔
✔
✔

Alt
✔

GPS Time Date
COG SOG
Status 2D/3D
Stamp (UTC) (UTC)
(True) (knot)
✔
✔
✔

✔

✔
✔
✔
✔

✔

✔

✔

✔

✔

Others

GLL
VTG

Magnetic Variation, Mode Indicator
Number of used satellites, HDOP, Geoidal separation, Age of Differential GPS data,
Differential reference station ID
Mode Indicator
COG (Magnetic north), SOG (km/h), Mode Indicator

GSA

PRN number of satellites, PDOP, HDOP, VDOP

GSV

Total number of sentences, Sentence number, Total number of satellites in view,
Satellite information (ID, Altitude, Azimuth, S/N)

GGA
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GPS Information

RX screen (Received position of the other station)
Depending on the caller’s TX mode or TX format, the
displayed items and these meanings are differ.
The following lists describe the items for each
category.
No data is displayed when no position data is received
on your transceiver.

GPS > GPS Information
Displays the GPS satellite direction, altitude, satellite
number and receiving status. (p. 5-11)
		

<1. When the caller’s TX mode is NMEA>
Displays the caller’s direction
Compass*
from your position.
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based
GL
on the latitude and longitude of
the caller’s position.
ALT
Displays the caller’s altitude
Displays the caller’s distance
DST
from your position
Displays the caller’s direction
COURSE
over ground
SPEED
Displays the caller’s speed
Displays the time that the caller
GPS Time Stamp
acquired the position data.
Call sign
Displays the caller’s call sign

(Example: Tracking 4 satellites)

Regular characters
(Example: 01)
Reversed
characters
(Example: 01)
SAT
Altitude

Latitude
Longitude

Untracking satellite
Tracking satellites (weak signal)
Tracking satellites (strong signal)
Number of tracking satellite
The altitude of your station.
The altitude is only displayed
when 4 or more satellites are
tracked. When 3 or less satellites
are tracked, “------ft” is displayed.
--°--.--'- (Non-positioning)/
Latitude of your station.
---°--.--'- (Non-positioning)/
Longitude of your station.

<2. When the caller’s TX format is D-PRS Position
(Mobile station)>
Displays the caller’s direction from
Compass*
your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based on
GL
the latitude and longitude of the
caller’s position.
ALT
Displays the caller’s altitude
Displays the caller’s distance from
DST
your position
Displays the caller’s direction over
COURSE
ground
SPEED
Displays the caller’s speed
Symbol
Displays the caller’s D-PRS symbol
GPS Time
Displays the time that the caller
Stamp
acquired the position data.
Displays the caller’s call sign (with
Call sign
SSID)

GPS Position
GPS > GPS Position
Your current position, received position or GPS
memory alarm position information is displayed.
(p. 5-3)
Rotating [DIAL] selects the MY, RX, MEM, and ALM
screens.
MY screen (MY Position)
Compass*
Displays your direction
Latitude
Displays your latitude
Longitude
Displays your longitude
Displays the grid locator based
GL
on the latitude and longitude of
your position.
ALT
Displays your own altitude
SPEED
Displays your speed over ground
Displays current time received
TIME
from the GPS
COURSE
Displays your direction heading
LLWhen “GPS Select” is set to “Manual,” the screen
displays only latitude, longitude, altitude, GL (Grid
locator), and time (internal clock).

*The display type can be changed. (p. 5-10)
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<3. When the caller’s TX format is D-PRS Position
(Base station)>
Displays the caller’s direction from
Compass*
your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based on
GL
the latitude and longitude of the
caller’s position.
ALT
Displays the caller’s altitude
Displays the caller’s distance from
DST
your position
POWER
Displays the caller’s TX power level
HEIGHT
Displays the caller’s antenna height
GAIN
Displays the caller’s antenna gain
Displays the direction of caller’s
DIRECT
antenna was pointing
Symbol
Displays the caller’s D-PRS symbol
GPS Time
Displays the time that the caller
Stamp
acquired the position data.
Displays the caller’s call sign (with
Call sign
SSID)

<5. When the caller’s TX format is D-PRS Weather>
Displays the caller’s direction
Compass*
from your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based
GL
on the latitude and longitude of
the caller station’s position
Displays the caller’s distance
DST
from your position
Displays the temperature of the
TEMP
caller station’s area
Displays the rainfall of the caller
RAIN
station’s area
Displays the wind direction of the
WIND DIR
caller station’s area
Displays the wind speed of the
WIND SPD
caller station’s area
Displays the barometric pressure
BARO
of the caller station’s area
Displays the humidity of the
HUMI
caller station’s area
Displays the caller station’s
Symbol
D-PRS symbol
Displays the time that the caller
GPS Time Stamp
acquired the weather data.
Displays the caller’s call sign
Call sign
(with SSID)

<4. W
 hen the caller’s TX format is D-PRS Object/
Item>
Displays the Object/Item’s direction
Compass*
from your position
Latitude
Displays the Object/Item’s latitude
Longitude
Displays the Object/Item’s longitude
Displays the grid locator based on
GL
the latitude and longitude of the
Object/Item’s position.
ALT
Displays the Object/Item’s altitude
Displays the Object/Item’s distance
DST
from your position
Displays the Object/Item’s direction
COURSE
over ground
SPEED
Displays the Object/Item’s speed
Displays the Object/Item’s TX power
POWER
level
Displays the Object/Item’s antenna
HEIGHT
height
Displays the Object/Item’s antenna
GAIN
gain
Displays the direction that the
DIRECT
Object/Item’s antenna was pointing
Displays the Object/Item’s D-PRS
Symbol
symbol
GPS Time
Displays the time that the caller sent
Stamp
the Object’s data.
Displays the caller’s call sign (with
Call sign
SSID)

MEM screen (GPS memory alarm position)
Displays GPS Memory channel’s
Compass*
direction from your position
Displays GPS Memory channel’s
Latitude
latitude
Displays GPS Memory channel’s
Longitude
longitude
Displays the grid locator based
GL
on the latitude and longitude of
GPS Memory channel’s.
Displays GPS Memory channel’s
DST
distance from your position
GPS memory
Displays the selected GPS
name*
memory name

LLWhen the object or Item is disabled, “KILLED” is
displayed.
*These items can be selected in the Quick Menu screen.
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GPS Memory

ALM screen (GPS alarm position)
Displays GPS Alarm area’s
Compass*
direction from your position
Displays GPS Alarm area’s
Latitude
latitude
Displays GPS Alarm area’s
Longitude
longitude
Displays the grid locator based
GL
on the latitude and longitude of
GPS Alarm area’s.
Displays GPS Alarm area’s
DST
distance from your position
Displays “RX,” GPS memory
group name or GPS memory
GPS Alarm*
name specified for the GPS
alarm function.

GPS > GPS Memory
The transceiver has 300 GPS Memory channels to
save the received position data, or often-used position
data, along with an alphanumeric channel name.
The channels can be divided into the “(No Group)”
group and each memory group (A to Z) for easy
memory management.
The display of the GPS memory
GPS memories not assigned to
(No Group)
any group.
A~Z:G
 roup
GPS memories assigned to the
Name
selected group.
GPS memory groups (A ~ Z)
GPS memory group name
GROUP NAME
(Up to 16 alphanumeric
characters)
LLYou can edit the GPS memory group name.
(p. 5-30)
GPS memory channels
GPS memory channel name
NAME
(Up to 16 alphanumeric
characters)
DATE
Saved date
TIME
Saved time
LATITUDE
Saved location (latitude)
LONGITUDE
Saved location (longitude)
ALTITUDE
Saved altitude
The group letter and the name of
GROUP
the group
LLWhen you save the received position data on the
GPS POSITION screen, the received station’s call
sign is used as the GPS memory name.
LLYou can edit the GPS memory contents, such as
the GPS memory name. (p. 5-27)
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Alarm Select

(Default: OFF)

Alarm Area (RX/Memory)

(Default: Both)

GPS > GPS Alarm> Alarm Select

GPS > GPS Alarm> Alarm Area (RX/Memory)

Select the target position(s) for the GPS alarm
function.
••OFF:
Turns OFF the function.
••RX:		The GPS alarm sounds when a target (the
last received position) enters in your active
alarm range, .
••Group:	The GPS alarm sounds when a target
(positions in the GPS memory, or in the
selected GPS memory group) enters in
your active alarm range.
••Memory:	The GPS alarm sounds when a target (the
specified position in the GPS memory)
enters in the active alarm range.

Select the GPS active alarm range.
When a target enters in the active alarm range, the
GPS alarm sounds and the GPS alarm icon blinks.

Alarm Area (Group)

LLWhen “Alarm Select” is set to “RX” or “Memory,” this
setting is enabled.

••Limited:	The transceiver sounds 3 beeps and the
GPS alarm icon blinks when the target
enters the 500 meter range.
••Extended:	The transceiver sounds 3 beeps and the
GPS alarm icon blinks when the target
enters the 1 kilometer range.
••Both:	The transceiver sounds a beep and the
GPS alarm icon blinks when the target
enters the 1 kilometer range, and sounds
3 beeps and the icon blinks when it enters
the 500 meter range.
When the target exits the 500 meter
range, but is still in the 1 kilometer range,
the icon continues to blink, but no beeps
sound.

(Default: 0.25')

GPS > GPS Alarm> Alarm Area (Group)
Set the GPS active alarm range.
When a target enters in the specified active alarm
range, the GPS alarm sounds and the GPS alarm icon
blinks.

LLWhen “Alarm Select” is set to “Group,” this setting is
enabled.

Example:
When a target enters in the active alarm range (500
meter or 1 kilometer range, depending on the setting),
the GPS alarm sounds and the GPS alarm icon blinks.

Ranges differs, depending on the “Position Format”
setting.
zzPosition Format = dddºmm.mm'
Ranges: 00.08' to 59.99' (0.01' steps)
zzPosition Format = dddºmm'ss''
Ranges: 00'05'' to 59'59'' (0’01" steps)

Your
position

Example:
When a target enters in the active alarm range, the
GPS alarm sounds and the GPS alarm icon blinks.
0.25’

Limited range
(Approximate 500 m,
547 Y)

Beeps one times Beeps three times

N

0.25’
0.25’

Point A

0.25’

Your
position
Point B
Point C

Extended range
(Approximate 1 km,
1094 Y)

Beeps three times
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GPS Logger

(Default: OFF)

GPS Auto TX

(Default: OFF)

GPS > GPS Logger > GPS Logger

GPS > GPS Auto TX

Turn the GPS Logger function ON or OFF.
This function logs the position, altitude, course, speed
and number of satellites being used.
••OFF: Turns OFF the function.
••ON:	The transceiver automatically logs GPS data.
Once this function is turned ON, the GPS data
will be continuously logged until turning it OFF,
even if the transceiver power is turned OFF,
then ON again.

Select an option for the GPS automatic transmission
function.
This function automatically transmits the current
position data received from a GPS receiver, as well as
any entered GPS message, at the selected interval.
••OFF:	Does not automatically transmit
the position data. (When you push
[PTT], the transceiver transmits the
position data.)
••5 sec to 30 min:	Transmits the current position data
at the selected interval (5*, 10, or
30 seconds, or 1, 3, 5, 10, or 30
minutes).

LLThis function requires a microSD card (User
supplied).
LLWhen “GPS select” is set to “OFF” or “Manual,” this
function does not save the log.

*Not displayed when you set four GPS
sentences in “GPS Sentence.”

TIP: The log data is saved on the microSD card. The
file name is automatically created, as shown below:
••Log start date and time: 1st April 2017 15:30:00
••File name:
20170401_153000.log
Record Interval

NOTE: When the GPS transmit mode is “NMEA,” set
the “GPS Select” item to “Internal GPS” or “External
GPS.” If you set to “Manual” or “OFF,” the current
position data will not be automatically transmitted.

(Default: 5sec)

GPS > GPS Logger > Record Interval
Select the GPS Logger function record interval of 1, 5,
10, 30, or 60 seconds.
Record Sentence
(Default: ✔ RMC/ ✔ GGA/ ✔ VTG/ ✔ GSA)
GPS > GPS Logger > Record Sentence
Set the GPS Logger function record sentence to
RMC, GGA, VTG, or GSA.
••Displays “✓” when the sentence is set to ON.
NOTE: Select at least one sentence, otherwise an
error beep will sound.
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Call Sign items
Call Sign

Step 2. Gateway “R2” setting
1. Select “R2,” then push [ï].

Call Sign
Sets or views the “UR,” “R1,” “R2,” and “MY” call signs
to use in the DV mode.
When not using the DR function, sets the call signs on
this screen.

LLTo manually enter the call sign, push [QUICK], then
select “Edit.”

2. Select “GW,” then push [ï].

About the RPT2 SELECT screen
NOT USED* For local area call
To select the gateway call sign from
GW
the repeater list.
Repeater
To select the repeater that has the
name
same gateway as the “R1” repeater.

For Simplex operation (DV mode)
You can set the “UR” and “MY” call signs.
For Duplex (repeater) operation
(DV mode/DR function)
You can set only “MY” call sign when the DR function
is ON.

Step 3. Destination “UR” setting
1. Select “UR,” then push [ï].

<To manually set the Duplex (repeater) operation>
Example:	Making a gateway CQ call to Hamacho
repeater (JP1YIU A) from the Hirano
repeater (JP3YHH A), in the DV mode.

LLTo manually enter the call sign, push [QUICK], then
select “Edit.”

2. Select “Gateway CQ,” then push [ï].
3. Select repeater group where your destination
repeater is listed, then push [ï].

(Example: 11:Japan)
4. Select the repeater, then push [ï].

(Example: Hamacho)

LLBefore starting to set the call sign, set the
frequency of your access repeater and duplex
direction on the standby screen. (Section 4)
TIP: When the DR function is ON, the repeater call
sign is automatically set. (p. 9-49)

About the YOUR SELECT screen
To select “CQCQCQ” to make a nonCQCQCQ
call sign specific call.
To select “Gateway CQ” to make a
Gateway CQ*
call using the repeater list.
To select the destination “UR” call sign
Your Call Sign
using the Your Call Sign memory.
To select the destination “UR” call sign
RX History
using the RX History.
To select the destination “UR” call sign
TX History
using the TX History.

Step 1. Setting the call sign “R1”
1. Rotate [DIAL] to select “R1.”
2. Push [QUICK]
3. Select “Edit,” then push [ï].
4. Rotate [DIAL] to enter the first character.

LLSelectable characters are Alphanumeric characters
and symbol (“/”)

5. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
6. Repeat steps 4 and 5 to enter the repeater call
sign of up to 8 characters, including a space.

(Example: JP3YHH A)
7. After entering, push [ï].

*Not displayed in the Simplex mode.
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RX History items
RX History

Contents of the detail screen
The contents of the detail screen differ, whether the
position data is included in the received data or not.
The position data that is included in the received data
can be divided into five categories. Depending on the
caller’s TX mode or TX format, the displayed items
and these meanings differ.
The following lists show the items for each category.
LLNo data is displayed when no position data is
received.

RX History
When a call is received in the DV mode, the call
information such as the caller station’s call sign, the
repeater’s call sign, and so on, are saved on this
screen. Up to 50 records can be saved.
LLEven if the transceiver is OFF, the saved records
are not deleted.
TIP: To display the RX record contents
On the RX HISTORY screen, rotate [DIAL] to display
the RX record contents (RX01 ~ RX50).

TIP: On the RX HISTORY screen, push [ï] to
display the detail screen.

Contents of the RX History Top screen
RX01 ~ RX50
RX history number
Displays the caller station’s name*2.
CALLER*1
Displays the called station’s name*2.
CALLED*1
Displays any message included in
MESSAGE
the received call, if entered.
Displays the date and time the call
RX TIME
was received.
Displays when a call is received
GW
through the internet.
Displays when position data is
included. (NMEA or Mobile/Base
GPS
station)
Displays when the Object’s data is
OBJ
included.
Displays when the Item’s data is
ITEM
included.
Displays when the weather station’s
WX
data is included.
Displays when an uplink signal is
(UP)
received.

Common items
CALLER*1
Displays the caller station’s name*2.
1
Displays the called station’s name*2.
CALLED*
Displays the name of the repeater
that was accessed by the caller
station.
If it was a call through a gateway
RXRPT1*1, *3
and the internet, this item displays
the gateway repeater name of your
local area repeater.
Displays the name of the repeater
RXRPT2*1, *3
you received the call from.
Displays any message included in
RX MESSAGE
the received call, if entered.
Displays the date and time the call
RX TIME
was received.
<1. When the caller’s TX mode is NMEA>
Displays the caller’s direction from
Compass*4
your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based on
GL
the caller’s latitude and longitude
ALT
Displays the caller’s altitude
Displays the caller’s distance from
4
DIST*
your position
Displays the caller’s direction over
COURSE
ground
SPEED
Displays the caller’s speed
GPS Time
Displays the time that the caller
Stamp
acquired the position data.
Call sign
Displays the caller’s call sign
Displays the GPS message included
GPS MESSAGE in the position data of the received
call.

*1 These items can be changed to the call sign display. In
that case, the call sign and a note that is entered after the
call sign are displayed.
*2 If the name is not entered, the call sign and a note that is
entered after the call sign are displayed.
*3 “FREQUENCY” is displayed instead of these items when
the call was not through a repeater (Simplex call), to show
the frequency that was used.
*4	If you have no position data, these items are not
displayed.
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RX History items (Continued)
<2. When the caller’s TX format is D-PRS Position
(Mobile station)>
Displays the caller’s direction from
Compass*
your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based on
GL
the caller’s latitude and longitude
ALT
Displays the caller’s altitude
Displays the caller’s distance from
DIST*
your position
Displays the caller’s direction over
COURSE
ground
SPEED
Displays the caller’s speed
GPS Time
Displays the time that the caller
Stamp
acquired the position data.
Displays the caller’s call sign (with
Call sign
SSID)
Symbol
Displays the caller’s D-PRS symbol
Displays the GPS message included
GPS MESSAGE in the position data of the received
call.

<4. W
 hen the caller’s TX format is D-PRS Object/
Item>
Displays the Object/Item’s direction
Compass*
from your position
Latitude
Displays the Object/Item’s latitude
Longitude
Displays the Object/Item’s longitude
Displays the grid locator based
GL
on the Object/Item’s latitude and
longitude
ALT
Displays the Object/Item’s altitude
Displays the Object/Item’s distance
DIST*
from your position
Displays the Object/Item’s direction
COURSE
over ground
SPEED
Displays the Object/Item’s speed
Displays the Object/Item’s TX power
POWER
level
Displays the height of Object/Item’s
HEIGHT
antenna
Displays the gain of Object/Item’s
GAIN
antenna
Displays the direction that the
DIRECT
Object/Item’s antenna was pointing
GPS Time
Displays the time that the caller sent
Stamp
the Object’s data.
Displays the caller’s call sign (with
Call sign
SSID)
Displays the Object/Item’s D-PRS
Symbol
symbol
Displays “KILLED” when the object
Status
or Item station is disabled.
Displays the GPS message included
GPS MESSAGE in the position data of the received
call.

<3. W
 hen the caller’s TX format is D-PRS Position
(Base station)>
Displays the caller’s direction from
Compass*
your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based on
GL
the caller’s latitude and longitude
ALT
Displays the caller’s altitude
Displays the caller’s distance from
DIST*
your position
POWER
Displays the caller’s TX power level
Displays the height of caller’s
HEIGHT
antenna
Displays
the gain of caller’s antenna
GAIN
Displays the direction that the
DIRECT
caller’s antenna was pointing
GPS Time
Displays the time that the caller
Stamp
acquired the position data.
Displays the caller’s call sign (with
Call sign
SSID)
Symbol
Displays the caller’s D-PRS symbol
Shows the GPS message included
GPS MESSAGE in the position data of the received
call.

*If you have no position data, these items are not displayed.
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RX History items (Continued)
<5. When the caller’s TX format is D-PRS Weather>
Displays the caller’s direction from
Compass*
your position
Latitude
Displays the caller’s latitude
Longitude
Displays the caller’s longitude
Displays the grid locator based on
GL
the caller’s latitude and longitude
Displays the caller’s distance from
DIST*
your position
Displays the temperature of the caller’s
TEMP
area
Displays the rainfall of the caller’s
RAIN
area
Displays the wind direction of the
WIND DIR
caller’s area
Displays the wind speed of the
WIND SPD
caller’s area
Displays the barometric pressure of
BARO
the caller’s area
Displays the humidity of the caller’s
HUMI
area
Symbol
Displays the caller’s D-PRS symbol
GPS Time
Displays the time that the caller
Stamp
acquired the position data.
Shows the D-PRS comment
GPS MESSAGE included in the position data of the
received call.
Displays the caller’s call sign (with
Call sign
SSID)
*If you have no position data, these items are not displayed.
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Repeater List
<DV Repeater>
TYPE
DV Repeater
Repeater name of up to 16
NAME
alphanumeric characters
Repeater sub name of up to 8
SUB NAME
alphanumeric characters
CALL SIGN
Repeater call sign
GW CALL SIGN Gateway call sign
Repeater group where the repeater
GROUP
is assigned
Select whether or not to use the
USE(FROM)
repeater as an access repeater
(FROM) in the DR screen
Operating frequency of the access
FREQUENCY
repeater
Duplex setting to use the access
DUP
repeater
Frequency offset to use the access
OFFSET FREQ
repeater
Position data accuracy level
POSITION
(“None,” “Approximate” or “Exact”)
LATITUDE*
Latitude position of the repeater
LONGITUDE*
Longitude position of the repeater
Time difference between UTC
UTC OFFSET
(Universal Time Coordinated) and
the local time

Your Call Sign
DV Memory > Your Call Sign
The transceiver has a total of 300 memories to save
an individual station call sign.
The saved call sign and name are displayed on the
YOUR CALL SIGN or RX HISTORY screen.
LLYou can enter the Your (UR) Call Sign into the
Memory using the RX History. (p. 4-10)
LLTo add, edit or move the Your Call Sign in the
memory, see pages 4-43 ~ 4-45 for details.
Repeater List
DV Memory > Repeater List
You can save repeater information for quick and
simple communication when using repeaters.
The transceiver has a total of 1500 repeater memory
channels, storable in 50 groups (01 to 50).
NOTE: For easy operation, a repeater list is
preloaded into your transceiver. However, if the
CPU clears all entered contents (All Reset), the
repeater list is also cleared. We recommend that
memory data be backed up using a microSD card,
or be saved to a PC using the CS-4100 cloning
software.

NOTE: When the repeater is used for a simplex
communication, refer to the list below to set the
settings.

TIP: About the repeater list
The repeater list can be downloaded from the Icom
website.
http://www.icom.co.jp/world/support/download/firm/
index.html

<DV Simplex>
TYPE

Repeater Group (01 ~ 50)
Repeater group name of up to 16
Group name
alphanumeric characters

NAME
SUB NAME

You can set the Skip setting. (p. 4-40)

GROUP
USE(FROM)
FREQUENCY
POSITION
LATITUDE*
LONGITUDE*
UTC OFFSET

DV Simplex
Enter the name of up to 16
alphanumeric characters
Enter the sub name of up to 8
alphanumeric characters
Set the repeater group
Select whether or not to set in the
“FROM” field on the DR screen
Frequency to operate simplex
Position data accuracy level
(“None,” “Approximate,” or “Exact”)
Latitude position of the access point
Longitude position of the access
point
Time difference between UTC
(Universal Time Coordinated) and
the local time

* Displayed when “POSITION” is set to “Approximate” or
“Exact.”
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DV Memory items (Continued)
<FM Repeater>
TYPE
FM repeater
FM repeater name of up to 16
NAME
alphanumeric characters
FM repeater sub name of up to 8
SUB NAME
alphanumeric characters
CALL SIGN
FM repeater call sign
Repeater group where the repeater
GROUP
is assigned
Select whether or not to use the
USE(FROM)
FM repeater as an access repeater
(FROM) on the DR screen
Operating frequency of the FM
FREQUENCY
repeater
Duplex setting to use the FM
DUP
repeater
Frequency offset to use the FM
OFFSET FREQ
repeater
MODE
Receiving mode of the FM repeater
Tone function setting of the FM
TONE
repeater
FM repeater tone frequency (Tone
REPEATER
Encoder) setting of the access
TONE
repeater.
Position data accuracy level
POSITION
(“None,” “Approximate” or “Exact”)
LATITUDE*
Latitude position of the FM repeater
Longitude position of the FM
LONGITUDE*
repeater
Time difference between UTC
UTC OFFSET
(Universal Time Coordinated) and
the local time

<FM Simplex>
TYPE
NAME
SUB NAME
GROUP
USE(FROM)
FREQUENCY
MODE
TONE
REPEATER
TONE
POSITION
LATITUDE*
LONGITUDE*
UTC OFFSET

FM Simplex
Enter the name of up to 16
alphanumeric characters
Enter the sub name of up to 8
alphanumeric characters
Set the repeater group
Select whether or not to set in the
“FROM” field on the DR screen
Frequency to operate simplex
Receiving mode for simplex FM
Tone function setting for simplex
FM
FM simplex tone frequency (Tone
Encoder) setting of the access
repeater
Position data accuracy level
(“None,” “Approximate” or “Exact”)
Latitude position of the station
Longitude position of the station
Time difference between UTC
(Universal Time Coordinated) and
the local time

* Displayed when “POSITION” is set to “Approximate” or
“Exact.”
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My Station items
My Call Sign
My Station > My Call Sign
The transceiver has a total of 6 memories to save
your own call signs.
You can enter a call sign of up to 8 digits. Also, a note
of up to 4 characters, for operating radio type, area,
and so on, can be entered.
LLSee the D-STAR guide for MY call sign entry.
LLTo select other My Call Sign, rotate [DIAL] to select,
then push [ï] on the MY CALL SIGN screen.
TX Message
My Station > TX Message
The transceiver has a total of 5 memories to save
short messages for simultaneous transmission in the
DV mode.
Enter a message of up to 20 alphanumeric characters
for each memory.
LLSee page 4-17 for TX message entry.
LLTo select other TX message, rotate [DIAL] to select,
then push [ï] on the TX MESSAGE screen.
TIP: To transmit no message, select “OFF.”
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DV Set items
RX Bass

(Default: Normal)

Auto Reply

(Default: OFF)

DV Set > Tone Control > RX Bass

DV Set > Auto Reply

Set the received audio bass filter level to Cut, Normal
or Boost.
••Cut:	Reduces the low frequencies
••Normal:	Normal tone balance
••Boost:	Increases the low frequencies

Set the Automatic Reply function to ON, OFF, Voice,
Position. This function automatically replies to a call
addressed to your own call sign, even if you are away
from the transceiver.
••OFF:	Turns OFF the function.
••ON:	Replies with your own call sign. (No audio
reply is sent)
••Voice:	Replies with your call sign and any Auto
Reply message recorded on the SD (up to
10 seconds).
If no microSD card is inserted, or no
message is recorded, only your call sign is
transmitted. The transmitted audio can be
monitored.
••Position*: 	Replies with your own call sign and
transmits your position data using the
internal or external GPS receiver.

RX Treble

(Default: Normal)

DV Set > Tone Control > RX Treble
Set the received audio treble filter level to Cut, Normal
or Boost.
••Cut:	Reduces the high frequencies
••Normal:	Normal tone balance
••Boost:	Increases the high frequencies
RX Bass Boost

(Default: OFF)

DV Set > Tone Control > RX Bass Boost

*When “GPS Select” is set to “OFF” or “Manual,” the internal
GPS receiver is temporarily turned ON.
When “GPS Select” is set to “External GPS,” but if the
external GPS receiver is not connected, the internal GPS
receiver is temporarily turned ON.

Turn the received audio Bass Boost function ON or
OFF.
This function is separate from the “Boost” setting of
the RX Bass.
••OFF:	Turns OFF the function.
••ON:	This function boosts the received audio bass.
TX Bass

LLWhen “ON” or “Voice” is selected, the Automatic
reply function is automatically turned OFF when
you push [PTT].
When “Position” is selected, the Automatic reply
function is not turned OFF, even if you push [PTT].

(Default: Normal)

DV Set > Tone Control > TX Bass
Set the transmit audio bass filter level to Cut, Normal
or Boost.
••Cut:	Reduces the low frequencies
••Normal:	Normal tone balance
••Boost:	Increases the low frequencies
TX Treble

DV Data TX

(Default: Auto)

DV Set > DV Data TX
Select whether to manually or automatically transmit
data in the DV mode.
••PTT:	Push [PTT] to manually transmit data.
••Auto:	When data is input from a PC through the
[DATA] jack, the transceiver automatically
transmits it.

(Default: Normal)

DV Set > Tone Control > TX Treble
Set the transmit audio treble filter level to Cut, Normal
or Boost.
••Cut:	Reduces the high frequencies
••Normal:	Normal tone balance
••Boost:	Increases the high frequencies
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DV Set items (Continued)
Fast Data

(Default: OFF)

Digital Monitor

(Default: Auto)

DV Set > DV Fast Data > Fast Data

DV Set > Digital Monitor

Select whether or not to use the DV Fast Data function
for data communication in the DV mode.
The DV Fast Data function uses the data and the
audio frames to send data approximately 3.5 times
faster than the normal speed. So, no audio can be
sent.
••OFF:	Sends data at the slow speed (approximately
950 bps).
••ON:	Sends data at the fast speed (approximately
3480 bps).

Select a receive mode when [MONI] is pushed in the
DV mode.
••Auto:	Receives in the DV mode or the FM mode,
depending on the received signal.
••Digital:	Receives in the DV mode.
••Analog:	Receives in the FM mode.
Digital Repeater Set
DV Set > Digital Repeater Set
Turn the Digital Repeater Setting function ON or OFF.
In any DV mode except when using the DR function,
and when accessing a repeater that has a call sign
that is different than the transceiver’s setting, this
function reads the repeater’s signal and automatically
sets the repeater call sign in R1 and R2.
••OFF:	Turns OFF the function.
••ON:	Automatically sets the repeater call sign.

LLEven if “ON” is selected, while holding down [PTT],
the data is sent at the slow speed, because the
audio frame is used for the microphone audio
transmission and the audio transmission has
priority.
The GPS data speed is set in “GPS Data Speed.”
GPS Data Speed

(Default: ON)

(Default: Slow)

DV Set > DV Fast Data > GPS Data Speed

DV Auto Detect

Set the GPS data speed when the data is sent using
the DV Fast Data function.
LLWhen you send the GPS data to other transceivers
that can receive only slow speed data, set to
“Slow.”
••Slow:	Sends GPS data in the slow speed
(approximately 950 bps).
••Fast:	Sends GPS data in the fast speed
(approximately 3480 bps).

Turn the DV mode automatic detect function ON or
OFF. If you receive an FM signal in the DV mode, this
function temporarily switches to the FM mode.
••OFF:	Turns OFF the function. The operating mode
is fixed to the DV mode.
••ON:	Automatically selects the FM mode for
temporary operation.

TX Delay (PTT)

(Default: OFF)

DV Set > DV Auto Detect

RX Record (RPT)

(Default: 2sec)

(Default: ALL)

DV Set > RX Record (RPT)

DV Set > DV Fast Data > TX Delay (PTT)

The transceiver can record the data of up to 50
individual calls. When the received signal includes a
status message (“UR?” or “RPT?”) that is sent back
from the access repeater, you can record up to 50
messages, or only the last call, in the Received Call
Record.
••ALL:	Records up to 50 calls.
••Latest Only:	Records only the last call.

Set the TX delay time.
In the data communication mode and after releasing
[PTT], the transceiver automatically sends the data
using the DV Fast Data function for this set period.
••OFF:	After releasing [PTT], the transceiver
returns to receive.
••1 ~ 10sec:	After releasing [PTT], the transceiver
sends data by using the DV Fast Data
function for this set period.
The transceiver automatically returns to
receive when the TX data is completely
sent, or when this set period ends,
whichever is sooner.
NOTE: This function is usable only when “DV Data
TX” is set to “PTT.”
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DV Set items (Continued)
BK 

(Default: OFF)

DV Set > BK
The Break-in (BK) function enables you to break
into a conversation, where the two other stations are
communicating with call sign squelch enabled.
• OFF: Turns OFF the function.
• ON: Turns ON the function.
LLThe BK function is automatically turned OFF when
transceiver is turned OFF.
EMR

(Default: OFF)

DV Set > EMR
The Enhanced Monitor Request (EMR) function
enables all transceivers that receive an EMR signal
automatically open their squelch to receive the signal.
• OFF: Turns OFF the function.
• ON: Turns ON the function.
LLThe EMR function is automatically turned OFF
when transceiver is turned OFF.
EMR AF Level

(Default: 19)

DV Set > EMR AF Level
Set the audio output level to between 0 and 32 for
when an EMR communication signal is received.
When an EMR signal is received, the audio will be
heard at the set level, or the [VOL] control level,
whichever is higher.
To disable the setting, set to “0.”
NOTE: After an EMR signal disappears, the audio
level will remain at the EMR level. In this case, rotate
[VOL] to adjust the audio level.
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SPEECH items
RX Call Sign SPEECH

(Default: ON (Kerchunk))

DIAL SPEECH

(Default: OFF)

SPEECH > RX Call Sign SPEECH

SPEECH > DIAL SPEECH

Turn the RX call sign speech function ON or OFF for
calls received in the DV mode.
• OFF:	The caller station’s call sign is not
announced, even when a call is
received.
• ON (Kerchunk):	The caller station’s call sign is
announced only when they make a
short transmission.
• ON (All):	The caller station’s call sign is
always announced.

Turn the Dial Speech function ON or OFF.
The Dial Speech function announces the frequency or
repeater call sign that is selected by rotating [DIAL].
• OFF:	The frequency or repeater call sign is not
announced.
• ON:	The frequency or repeater call sign is
announced, 1 second after rotating [DIAL].
In the VFO, Memory, or Call channel mode,
the frequency is announced.
When using the DR function, the repeater call
sign is announced.

LL Informatio
• When the digital squelch function is used, the calling
station’s call sign is not announced if the received
signal is not addressed to your call sign, or does not
include a matched digital code.
• When you receive a signal from a repeater (“UR?”
or “RPT?”), the caller station’s call sign is not
announced.
• While scanning, the transceiver resumes the scan
during an announcement.
• Even if a note is entered after the call sign, it is not
announced.
• When you receive a signal during an announcement,
the transceiver cancels announcement, and you can
hear the received audio.
RX>CS SPEECH

LLWhen using the DR function, the frequency is
announced if Simplex is selected or the FM
repeater does not have a call sign.
LLWhen you receive a signal during an
announcement, the transceiver cancels
announcement, and you can hear the received
audio.
MODE SPEECH

(Default: ON)

SPEECH > MODE SPEECH
Turn the Operating Mode Speech function ON or OFF.
When this function is ON, the selected operating
mode is announced.
• OFF:	The selected operating mode is not
announced.
• ON:	The selected operating mode is announced.

(Default: ON)

SPEECH > RX>CS SPEECH

LLWhile the VFO scanning, the operating mode is
announced when you change the mode.

Turn the RX>CS Speech function ON or OFF.
The RX>CS Speech function announces the station
call sign that is selected from a Received Call Record
by pushing [RX→CS].
• OFF:	The station call sign is not announced.
• ON:	The station call sign is announced.

SPEECH Language

(Default: English)

SPEECH > SPEECH Language
Set the speech language to English or Japanese.

LLIf a call is received during an announcement, the
received audio is muted, and audio is not recorded
onto the microSD card.
If the call sign is announced while recording,
the recorded contents are silent during the
announcement.

Alphabet

(Default: Normal)

SPEECH > Alphabet
Select either “Normal” or “Phonetic Code” to
announce the alphabet characters.
• Normal:	Normal code is used.
(Example: A as eh, B as bee)
• Phonetic Code:	Phonetic code is used.
(Example: A as Alfa, B as Bravo)
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SPEECH items (Continued)
SPEECH Speed

(Default: Fast)

SPEECH > SPEECH Speed
Set the speech speed to Slow or Fast.
SPEECH Level

(Default: 7)

SPEECH > SPEECH Level
Adjust the voice synthesizer volume level to between
0 (OFF), 1 (minimum) and 9 (maximum).
The voice synthesizer audio output level is linked with
the [VOL] setting from the minimum audio volume up
to the set level.
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DTMF items
You can set the DTMF tone code and DTMF memory
channel for DTMF tone operation.
See pages 10-8 ~ 10-10 for details.
DTMF Memory

(Default: d0)

DTMF > DTMF Memory
Shows a list of the DTMF memory channels.
• d0 to d#: DTMF memory channel list
DTMF Speed

(Default: 100ms)

DTMF > DTMF Speed
Select the DTMF transmit speed.
• 100ms:	Transmits the DTMF codes at about 100
milliseconds per code.
5 characters per second.
• 200ms:	Transmits the DTMF codes at about 200
milliseconds per code.
2.5 characters per second.
• 300ms:	Transmits the DTMF codes at about 300
milliseconds per code.
1.6 characters per second.
• 500ms:	Transmits the DTMF codes at about 500
milliseconds per code.
1 character per second.
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QSO/RX Log items
QSO Log

(Default: OFF)

Separator/Decimal

QSO/RX Log > QSO Log

QSO/RX Log > CSV Format > Separator/Decimal

Select whether or not to make a communication log
on a microSD card.
The communication log is made on a microSD card,
and saved in the “csv” format.
LLThis function requires a microSD card (User
supplied).
• OFF:	The QSO Log function is OFF.
• ON:	The transceiver makes a log on the microSD
card.
The transceiver starts making a log when you
begin talking.

Select the separator and the decimal character for the
CSV format.
• Sep [,] Dec [.]:	Separator is “,” and Decimal is “.”
• Sep [;] Dec [.]:	Separator is “;” and Decimal is “.”
• Sep [;] Dec [,]:	Separator is “;” and Decimal is “,”
*The default value may differ, depending on the transceiver
version.

Date

(Default: mm/dd/yyyy*)

QSO/RX Log > CSV Format > Date
Select the date format between “yyyy/mm/dd,” “mm/
dd/yyyy” and “dd/mm/yyyy.” (y: year, m: month, d: day)

TIP:
••The folder name is automatically created, as
[ID-4100\QsoLog].
••The file name is automatically created, as shown
below:
Log start date and time: 1st April 2017 15:30:00
File name:
20170401_153000.csv
••The log contents is not displayed on the
transceiver.
••You can display the log contents on a PC.
RX History Log

(Default: Sep [,] Dec [.]*)

*The default value may differ, depending on the transceiver
version.

(Default: OFF)

QSO/RX Log > RX History Log
Select whether or not to make a DV mode’s receive
history log on a microSD card.
The receive history log is made on a microSD card,
and saved in the “csv” format.
LLThis function requires a microSD card (User
supplied).
• OFF: The RX History Log function is OFF.
• ON:	The transceiver makes a DV mode’s receive
history log on the microSD card.
The transceiver starts making a receive
history log when you finish talking.
TIP:
••The folder name is automatically created, as
[ID-4100\RxLog].
••The file name is automatically created, as shown in
the example below:
Log start date and time: 1st April 2017 15:30:00
File name:
20170401_153000.csv
••The log contents is not displayed on the
transceiver.
••You can display the log contents on a PC.
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QSO/RX Log items (Continued)
The call log contents are shown below:
Contents
Example
Descriptions
TX/RX
TX
RX
Transmission and reception
Date
4/1/2017
4/1/2017
Date and time the call was started.
13:51:48
13:51:48
Frequency
438.010000 438.010000 Operating frequencies
(When Duplex is set, the RX frequency is displayed.)
Mode
DV
DV
Operating mode (AM/AM-N/FM/FM-N/DV)
My Latitude
34.764667 34.764667 Your latitude (unit: degree) (+: North latitude, –: South latitude)
My Longitude 135.375333 135.375333 Your longitude (unit: degree) (+: East longitude, –: West longitude)
My Altitude
50.5
50.5
Your altitude (unit: m) Records to one decimal place.
RF Power
Low
(Blank)
TX output power level
S-meter
(Blank)
S0
The relative signal strength of the receive signal (in twelve levels)
RPT Call Sign JP3YHJ A JP3YHJ A Repeater call sign (DV mode only)
TX Call Sign
CQCQCQ (Blank)
TX Call sign (DV mode only)
RX Call Sign (Blank)
JA3YUA A/ RX Call sign (DV mode only)
4100
RX Latitude
(Blank)
34.764667 Caller’s latitude, if sent. (unit: degree)
(+: North latitude, –: South latitude)
Records only when you receive in the DV mode.
RX Longitude (Blank)
135.375333 Caller’s longitude, if sent. (unit: degree)
(+: East longitude, –: West longitude)
Records only when you receive in the DV mode.
RX Altitude
(Blank)
30.5
Caller’s altitude, if sent. (unit: m)
Records only when you receive in the DV mode.
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QSO/RX Log items (Continued)
The RX log contents are shown below:
Contents
Example
Descriptions
Frequency
438.010000
RX Frequency
Mode
DV
Operating mode (DV mode is fixed)
Caller
JA3YUA A
Call sign of the caller station (up to 8 characters)
/
4100
Note after the call sign (up to 4 characters)
Called
CQCQCQ
Call sign of the called station
Rx RPT1
JP3YHH G
Access repeater call sign of the caller station or the gateway repeater call sign
of your local area repeater.
Rx RPT2
JP3YHJ A
Access repeater call sign of the called station
Message
Hello CQ D-STAR! Message included in the received call (up to 20 characters)
Status
(Blank)
Normal: blank, Uplink: “RPT UP”, Access repeater reply: “UR?” or “RPT?”
Received date
4/1/2017
Date and time the call was received
13:51:48
Depending on the setting, the format may differ.
BK
*
BK call: “*”, Normal call: Blank
EMR
*
EMR call: “*”, Normal call: Blank
Latitude
34.764667
Caller’s latitude, if sent. (unit: degree) (+: North latitude, –: South latitude)
Longitude
135.375333
Caller’s longitude, if sent. (unit: degree) (+: East longitude, –: West longitude)
Altitude
30.5
Caller’s altitude, if sent. (unit: m) Records to one decimal place.
SSID
-A
Caller’s SSID, if sent. (0, -1 to -15, -A to -Z)
D-PRS Symbol Car
Icon: Converts to text, None: Code
Course
123
Caller’s course (unit: degree)
Speed
23.5
Caller’s speed (unit: km/h) Records to one decimal place.
Power
49
TX power (unit: W)
Height
24
Antenna height (unit: m)
Gain
6
Antenna gain (unit: dB)
Directivity
Omni
Antenna directivity
(Omni, 45, 90, 135, 180, 225, 270, 315 or 360)
Object/Item
HAM FES
Object name or Item name (up to 9 characters)
Name
Data Type
Live Object
Data type of Object or Item (Live or Kill)
Temperature
20.5
Temperature (unit: ç) Records to two decimal places.
Rainfall
253.75
Rainfall (unit: mm) Records to two decimal places.
Rainfall (24
253.75
Rainfall (24 Hours) (unit: mm) Records to two decimal places.
Hours)
Rainfall
253.75
Rainfall (Midnight) (unit: mm) Records to two decimal places.
(Midnight)
Wind Direction
315
Wind Direction (unit: degree)
Wind Speed
10.0
Wind Speed (unit: m/s) Records to one decimal place.
Gust Speed
10.0
Gust Speed (unit: m/s) Records to one decimal place.
Barometric
1013.0
Barometric (unit: hPa) Records to one decimal place.
Humidity
85
Humidity (unit: %)
GPS Time Stamp 12:00:00
Time data that the caller station acquires the position data
GPS Message
Osaka City/
Caller is “NMEA”: Records the GPS message
ID-4100
Caller is “D-PRS: Records the D-PRS comment
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Function items
Squelch/ATT Select

(Default: S-Meter Squelch)

Auto Repeater

(Default: ON (DUP))

Function > Squelch/ATT Select

Function > Auto Repeater

Select the function that varies according to the [SQL]
control position.
• OFF:	Both the S-Meter Squelch and
Attenuator are disabled.
• S-Meter Squelch:	The S-Meter Squelch activates
and adjusts the squelch level
when [SQL] is set between 12
o’clock and the fully clockwise
position.
• ATT:	The Attenuator is enabled and
adjusts the attenuator level when
[SQL] is set between 12 o’clock
and the fully clockwise position.

The Auto repeater function automatically turns the
duplex operation and tone encoder* ON or OFF. The
offset and repeater tone* are not changed by the
auto repeater function. Reset these setting values, if
necessary.
LLThis item is displayed only in the USA version
transceiver.
• OFF:
Turns OFF the function.
• ON (DUP):	Turns ON the duplex operation
only. (Default)
• ON (DUP, TONE):	Turns ON the duplex operation
and tone encoder*.

Squelch Delay

Remote MIC Key

* The tone encoder will not be turned ON in the DV mode.

(Default: Short)

Function > Squelch Delay

Function > Remote MIC Key

Set the squelch delay to short or long to prevent
repeated opening and closing of the squelch when
receiving the same signal.
• Short: Shortens the time until the squelch opens.
• Long: Lengthens the time until the squelch opens.

The function assignments for [F-1] and [F-2] keys on
the supplied HM-207S hand microphone (remotecontrol) can be changed.
See pages 9-58 ~ 9-59 for the assignable key
functions.
• During RX/Standby:	The assigned key function is
enabled while receiving or in
standby.
• During TX:	The assigned key function is
enabled during transmission.

Fan Control

(Default: Auto)

Function > Fan Control
Select the cooling fan control between Slow, Mid, Fast
and Auto.
• Slow: The fan rotates slow.
• Mid: The fan rotates at mid speed.
• Fast: The fan rotates fast.
• Auto:	The fan automatically turns ON during
transmission or when the internal temperature
of the transceiver exceeds the preset value. It
remains ON until the temperature drops below
the value.
Dial Speed-UP

Up/Down MIC Key
Function > Up/Down MIC Key
The function assignments for the [UP] and [DN] keys
on the optional HM-154 hand microphone or HM-232
hand microphone (simple) can be changed.
See pages 9-58 ~ 9-59 for the assignable key
functions.
• During RX/Standby:	The assigned key function is
enabled while receiving or in
standby.
• During TX:	The assigned key function is
enabled during transmission.

(Default: ON)

Function > Dial Speed-UP
Turn the dial speed acceleration ON or OFF.
The acceleration automatically speeds up the tuning
dial speed when you rapidly rotate [DIAL].
• OFF: Turns OFF the function.
• ON: Turns ON the function.
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Function items (Continued)
• During RX/Standby:
Function
--UP
DOWN
VOL UP
VOL DOWN
SQL UP
SQL DOWN
Monitor
CALL
MR (000 CH)
MR (001 CH)
VFO/MR
DR
FROM/TO
(DR)
Home CH

BAND/BANK

●: Default setting : Available N/A: Not available
Up/Down MIC
Remote MIC Key
Key
Description
[F-1]
[F-2]
[UP]
[DN]
No function




Push to increase the frequency, Memory channel, repeater
N/A
N/A

●
or station call sign.
Push to decrease the frequency, Memory channel, repeater
N/A
N/A

●
or station call sign.
Push to increase the volume level.
N/A
N/A


Push to decrease the volume level.
N/A
N/A


Push to increase the squelch level.
N/A
N/A


Push to decrease the squelch level.
N/A
N/A


Push to open or close the squelch.



●
Push to select a call channel.
N/A
N/A


In the Memory mode, push to select Memory channel 000.




In the Memory mode, push to select Memory channel 001.




Push to select between the VFO mode and the Memory
N/A
N/A


mode.
Push to turn the DR function ON or OFF.




On the DR screen, push to select between “FROM” and




“TO.”
Push to directly select the Home CH that is set to the
selected mode (VFO/Memory) or DR screen.
N/A
N/A


While in the CALL CH or Weather channel mode, or when
no Home CH is set, an error beep sounds.
Push to select an operating band.
In the VFO mode, push to change the operating band, and
N/A
N/A


in the Memory Bank mode, push to select Bank A ~ Z, or
OFF.
LLOnly the entered bank is selectable.

SCAN
Temporary
Skip
RX>CS

••Push to start a scan.
••While scanning, push to stop the scan.
Push to set the frequency to be skipped during scanning.
The selected frequencies are temporarily skipped for faster
scanning.
Hold down for 1 second to set the last calling station’s call
sign to “TO” (destination).
Push to announce the frequency, operating mode or call
sign.

SPEECH

LLIn the VFO, Memory or Call channel mode, the frequency and
the operating mode are announced.
LLIn the DR screen, the call sign is announced. If Simplex is
selected, the frequency is announced.

MODE
LOW

Push to change the operating mode.
Push to change the transmit power level.
Push to turn the Duplex mode ON or OFF, and the shift
direction to DUP+ or DUP–.
Push to turn the Priority watch ON or OFF.

DUP
PRIO

































●



























☞☞Continued on the next page
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Function items
• During RX/Standby (Continued):

Function

●: Default setting : Available N/A: Not available
Remote MIC Key

Description

Push to select between tone types.
<<MODE>> FM/FM-N
Repeater Tone
TONE:
TSQLS:	Pocket Beep with Tone Squelch
TSQL:	(Tone Squelch)
DTCSS:	Pocket Beep with DTCS Code Squelch
DTCS:	DTCS Code Squelch
TSQL-R:	Reverse Tone Squelch
DTCS-R:	Reverse DTCS Code Squelch
DTCS (T) (“DTCS” blinks):
	TX:DTCS, RX:OFF
TONE (T)/DTCS (R) (“T-DTCS” is displayed, “T” blinks.):
TONE/DSQL
	
TX:TONE, RX:DTCS
DTCS (T)/TSQL (R) (“D-TSQL” is displayed, “D” blinks.):
	
TX:DTCS, RX:CTCSS
TONE (T)/TSQL (R) (“T-TSQL” is displayed, “T” blinks.):
	
TX:TONE, RX:CTCSS

Up/Down MIC
Key
[UP]
[DN]

[F-1]

[F-2]

















<<MODE>> DV

LLYou can set this setting on the DR screen.

MW
MUTE

Voice TX
(T1)

DTMF
DIRECT TX
T-CALL

DSQLS:	Pocket Beep with Digital Call sign Squelch
DSQL:	Digital Call sign Squelch
CSQLS:	Pocket Beep with Digital Code Squelch
CSQL:	Digital Code Squelch
In the VFO mode or on the DR screen, hold down to save
the displayed frequency into a Memory blank channel.
Push to turn the Mute function ON or OFF.
••Push to transmit the voice audio recorded on the microSD
card once.
••Hold down for 1 second to repeatedly transmit the voice
audio.

















Push to display the DTMF code direct entry mode screen.





N/A

N/A

Push to transmit a 1750 Hz tone.









LLThis key function can also be used on the DR screen.
LLIf the voice audio is not saved in the [T1] (Voice memory number
for TX) on the Voice TX record screen, this function is disabled.

• During TX:
●: Default setting : Available N/A: Not available
Function
--LOW
Voice TX
(T1)
T-CALL

Remote MIC Key

Description
No function
Push to change the transmit power level.
Push to transmit the voice audio recorded on the microSD
card once.
Hold down for 1 second to repeatedly transmit the voice audio.
- To make a repeat transmission, [PTT] must be released.
Push to transmit a 1750 Hz tone.
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●
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[F-1]



[F-2]
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●







Previous view

9

MENU SCREEN

Function items (Continued)
One-Touch PTT (Remote MIC)

(Default: OFF)

Active band

(Default: All)

Function > One-Touch PTT (Remote MIC)

Function > Active Band

Set the On-Touch PTT function for the HM-207S.
The function enables you to transmit without
sequentially holding down the [PTT] button.
• OFF: Push [PTT] to transmit and release to receive.
• ON:	Push [PTT] to transmit, then push again to
receive.

Enables continuous frequency selection of the
operating frequency across all bands using [DIAL].
• Single:	When you rotate [DIAL] on the band edge,
the top or bottom frequency in the displayed
band is selected.
• ALL:	When you rotate [DIAL], the next band is
displayed.

PTT Lock

(Default: OFF)

LLTo select another band when “Single” is selected,
push [QUICK], then select “Band Select.”
LLThis setting is for the [DIAL] operation, so all
frequencies are scanned, even if “Single” is
selected.

Function > PTT Lock
Turn the PTT lock function ON or OFF.
To prevent accidental transmissions, this function
disables [PTT].
• OFF:	Turns OFF the function.
• ON:	Turns ON the function.
Busy Lockout

MIC Gain
Function > MIC Gain

(Default: OFF)

Set the microphone gain to between 1 (minimum) and
4 (maximum), to suit your preference.
Higher values make the microphone more sensitive to
your voice.

Function > Busy Lockout
Turn the busy lockout function ON or OFF.
This function inhibits transmission while receiving a
signal, or when the squelch is open.
• OFF: Turns OFF the function.
• ON:	Turns ON the function.
Time-Out Timer

(Default: 2*)

*The default settings may differ, depending on your
transceiver version.

Data Speed

(Default: OFF)

(Default: 9600bps)

Function > Data Speed

Function > Time-Out Timer

Select the data speed for outputting a GPS
information, inputting a weather information, or data
communication in the DV mode to 4800 bps or 9600
bps.

To prevent accidental prolonged transmission, the
transceiver has a time-out timer.
The function inhibits continuous transmissions longer
than the set period of time.
• OFF:	Turns OFF the function.
• 1 to 30 min:	The transmission is cut OFF after the
set period of time ends (1, 3, 5, 10, 15 or
30 minutes).

CI-V Address

(Default: 9Ah)

Function > CI-V > CI-V Address
To distinguish equipment, each CI-V transceiver has
its own Icom standard address in hexadecimal code.
The ID-4100A/E’s default address is 9Ah.
When 2 or more ID-4100A/Es are simultaneously
controlled by a PC, set a different address for each
transceiver between 02h and DFh (hexadecimal).
CI-V Baud Rate

(Default: Auto)

Function > CI-V > CI-V Baud Rate
Set the CI-V data transfer speed to 4800, 9600, 19200
bps or Auto.

LLWhen “Auto” is selected, the baud rate is automatically
set, according to the data rate of the controller.
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Function items (Continued)
CI-V Transceive

(Default: OFF)

Function > CI-V > CI-V Transceive
Turn the CI-V Transceive function ON or OFF.
• OFF:	Turns OFF the function.
• ON:	When you change a setting on one
transceiver, the same settings is automatically
changed on other connected transceivers or
receivers.
CI-V Bluetooth➝REMOTE Transceive Address

(Default: 00h)
Function > CI-V >
CI-V Bluetooth➝REMOTE Transceive Address
If you remotely operate your transceiver using
Bluetooth when “CI-V Transceive” is set to ON,
the devices in the same system are also externally
controlled through the external speaker (REMOTE)
jack.
To prohibit the external control of an Icom transceiver,
set this value to other than “00h.”
The control signal is output from the external speaker
(REMOTE) jack.
Select an address between 00h and DFh.
Power OFF (With No Controller)

(Default: ON)

Function > Power OFF (With No Controller)
Select whether or not to automatically turn OFF the
transceiver when the controller is disconnected from
the transceiver.
• OFF:	The transceiver power is not turned OFF.
To turn OFF the transceiver, turn OFF the DC
supply, or disconnect the power cable.
When you connect the controller again, the
controller may perform incorrectly. This is not
the controller’s malfunction.
• ON:	The transceiver is automatically turned OFF.
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Display items
LCD Backlight Brightness

(Default: 4)

Auto Dimmer

(Default: OFF)

Display > LCD Backlight Brightness

Display > Auto Dimmer Setting > Auto Dimmer

Set the LCD backlight brightness level to between 1
(Dark) and 4 (Bright).

This function sets the Auto Dimmer operation for the
display backlight.
• OFF:	Auto Dimmer function is turned OFF.
The display backlight is turned ON continuously
while the transceiver is turned ON.
• Auto-OFF:
			The display backlight is automatically turned
ON when operating the transceiver. The
backlight is automatically turned OFF after the
set time of inactivity in the Auto Dimmer Timer.
• Auto-1 to Auto-3:
			 The display backlight is automatically turned ON
when operating the transceiver. The backlight
automatically returns to the 1 ~ 3 set level after
the Auto Dimmer Timer set time ends.

LCD Backlight Color

(Default: White)

Display > LCD Backlight Color
Set the LCD backlight color to between White, Amber,
Green, and Blue.
Key Backlight Brightness

(Default: 4)

Display > Key Backlight Brightness
Selects the key backlight brightness level to between
1 (Dark) and 4 (Bright).
Key Backlight Color

(Default: White)

Auto Dimmer Timer

Display > Key Backlight Color

Display > Auto Dimmer Setting >
Auto Dimmer Timer

Selects the key backlight color to between White,
Amber, Green, and Blue.
Night Time Setting

Set the backlight lighting period of time to between 5
and 10 seconds.
• 5sec:	The Auto dimmer function automatically
activates after 5 seconds of inactivity.
• 10sec:	The Auto dimmer function automatically
activates after 10 seconds of inactivity.

(Default: OFF)

Display > Backlight Night Time Setting >
Night Time Setting
Select whether or not to reduce the backlight
brightness for the nighttime operation.
You can set the nighttime operation start or stop time
with “Night Time Start” or “Night Time End.”
• OFF: Does not reduce the backlight brightness.
• ON: Reduces the backlight brightness.

Auto Dimmer Cancel (PTT)

Select the transceiver operation when [PTT] is pushed
while the Auto Dimmer is activated.
• OFF:	Pushing [PTT] transmits a signal without
turning OFF the Auto Dimmer when the Auto
Dimmer is activated.
• ON:	Pushing [PTT] turns OFF the Auto Dimmer
and then transmits a signal when the Auto
Dimmer is activated.

Display > Backlight Night Time Setting > Brightness
Select the backlight brightness level for the nighttime
operation between 1 (Dark) and 4 (Bright).
Night Time Start

(Default: 18:00)

Display > Backlight Night Time Setting >
Night Time Start

Auto Dimmer Cancel (DV RX)

(Default: OFF)

Display > Auto Dimmer Setting >
Auto Dimmer Cancel (DV RX)

Set the start time for the nighttime operation to
between 0:00 and 23:59.
Night Time End

(Default: OFF)

Display > Auto Dimmer Setting >
Auto Dimmer Cancel (PTT)

(Default: 2)

Brightness

(Default: 5sec)

Select the transceiver operation when receiving a DV
signal while the Auto Dimmer is activated.
• OFF:	Receiving a DV signal displays the RX screen
without turning OFF the Auto Dimmer when
the Auto Dimmer is activated.
• ON:	Receiving a DV signal turns OFF the Auto
Dimmer and then displays the RX screen
when the Auto Dimmer is activated.

(Default: 6:00)

Display > Backlight Night Time Setting >
Night Time End
Set the end time for the nighttime operation to
between 0:00 and 23:59.
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Display items (Continued)
LCD Contrast

(Default: 8)

RX Position Display

(Default: ON)

Display > LCD Contrast

Display > RX Position Display

Set the LCD contrast level to between 1 (lowest
contrast) and 16 (highest contrast).

Select whether or not to display the caller’s position
in a dialog when the signal received in the DV mode
contains a caller station’s position.
• OFF:	Does not display the caller’s position.
• ON:	Displays the caller’s position.

RX Call Sign

(Default: Normal)

Display > RX Call Sign

LLYou can set the display period of time in the “RX
Position Display Timer” item.

Select whether or not to display the call sign and the
message of the caller station, when a call is received.
• OFF:	Does not display the caller station’s call
sign and message.
• Normal:	The caller station’s call sign and message
scroll only once across the display.
• RX Hold:	The caller station’s call sign and message
scroll once, and then only the call sign is
displayed until the signal disappears.
• Hold:	The caller station’s call sign and message
scroll only once, and then only the call sign
is displayed until the signal disappears.
When the signal disappears, the call sign
and the message are alternately displayed,
each for 2 seconds.

RX Position Display Timer

(Default: 10sec)

Display > RX Position Display Timer
Set the display period of time for the caller’s position.
• 5/10/15/30sec:	Displays the caller’s position for this
set period of time.
• Hold:	Displays the caller’s position until you operate
the transceiver.
Reply Position Display

(Default: ON)

Display > Reply Position Display

LLWhen this item is set to “Normal,” “RX Hold” or
“Hold,” and if you enter the caller station’s call sign
and name in Your Call Sign screen, the entered
name is displayed with “( )” after the call sign.

Select whether or not to display the caller's position in
a dialog when the Auto Reply signal contains a caller
station’s position.
• OFF: Does not display the caller's position.
• ON: Displays the caller's position.

RX Position Indicator

TX Call Sign

(Default: ON)

(Default: Your Call Sign)

Display > RX Position Indicator

Display > TX Call Sign

Select whether or not to display “ ” (RX position
indicator) when the signal received in the DV mode
contains position data.
• OFF : Displays no indicator even though the
received signal contains position data.
• ON : Displays the indicator when the received
signal contains position data.

Select whether or not to display your own or the
destination call sign while transmitting in the DV mode.
• OFF:	Does not display any call sign.
• Your Call Sign:	Displays and scrolls the destination’s
call sign. When the destination’s call
sign and name are entered in your
memory, the transceiver displays
the name after the call sign in any
DV mode except when using the DR
function.
• My Call Sign:	Displays and scrolls your own call
sign.

LLWhen the “RX Call Sign” is set to “OFF,” the
indicator is not displayed when the received signal
contains position data, even if this item is set to
ON.

Scroll Speed

(Default: Fast)

Display > Scroll Speed
Set the scrolling speed of the message, call sign, or
other text, that is displayed on the screen.
• Slow: The scroll speed is slow.
• Fast: The scroll speed is fast.
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Display items (Continued)
Opening Message

(Default: ON)

Barometric

(Default: inHg*)

Display > Opening Message

Display > Display Unit > Barometric

Select whether or not to display the opening message
at power ON.
• OFF:	Opening message is not displayed.
• ON:	Icom logo, MY call sign, the product model
(“ID-4100A” or “ID-4100E”)* are displayed.

Select between the hPa, mb, mmHg and inHg format
to display the barometric pressure.
Rainfall
Display > Display Unit > Rainfall

*Depending on the version.

Voltage (Power ON)

(Default: inch*)

Select either the mm or inch format to display the
amount of rainfall.

(Default: ON)

Display > Voltage (Power ON)

Wind Speed

Select whether or not to display the power source
voltage at power ON.
• OFF:	Does not display the voltage of the external
DC power source at power ON.
• ON:	Displays the voltage of the external DC power
source at power ON.

(Default: mph*)

Display > Display Unit > Wind Speed
Select between the m/s, mph and knots format to
display the wind speed.
Display Language

(Default: English)

Display > Display Language

NOTE: When the voltage of the external DC power
source is over 17.0 V, “Over Voltage” is displayed.
In that case, immediately disconnect the DC power
source.

Set the screen display language type in the DR screen
or MENU screen to English or Japanese.

Display > Display Unit > Latitude/Longitude

LLThis item is displayed only when the “System
Language” is set to “Japanese.” See page 9-65
“Choose your language carefully” about setting
cautions.

Select either the ddd ºmm.mm' or ddd ºmm'ss'' format
to display the position.

System Language

Latitude/Longitude

(Default: ddd ºmm.mm')

Altitude/Distance

Display > System Language

(Default: feet/mile*)

Set the system language of the transceiver.
• English:	The system language of the transceiver is
English.
Only alphabetical characters (A to Z, a to
z, 0 to 9) and symbols (! " # $ % & ' ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~) can be
displayed. If Japanese characters (Kanji,
Hiragana and Katakana) are included,
the display shows “=” or “_” instead of
that character. In that case, you can only
delete “=” or “_” in the transceiver's edit
mode.
• Japanese:	The system language of the transceiver is
Japanese.
Kanji, Hiragana and Katakana characters,
and the 2-bytes symbols can be
displayed. To display such characters
in the DR screen or Menu mode, set
“Display Language” to “Japanese.”

Display > Display Unit > Altitude/Distance
Select either the meter or feet/mile format to display
the distance and altitude.
Speed

(Default: mph*)

Display > Display Unit > Speed
Select either the km/h, mph or knots format to display
the speed.
Temperature

(Default: English)

(Default: ºF*)

Display > Display Unit > Temperature
Select either the degrees ºC or ºF format to display
the temperature.

LLWhen this item is set to “English,” “Display
Language” is not displayed.
*The default value may differ, depending on the transceiver
version.
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Display items (Continued)
Choose your language carefully
When the system language of the transceiver
is set to Japanese, the transceiver has the
capability to display both English and Japanese
characters. HOWEVER, if you select Japanese as
the display language, all menu items throughout
the transceiver system will be displayed in only
Japanese characters. There will be no English item
names. Unless you are fluent in reading Japanese
characters, use this feature with extreme caution.
If you change the transceiver’s language to
Japanese, and cannot understand the menu system
in the new setting, you will have to change the
language back to English in “Display Language” or
“System Language,” or by doing a partial reset of the
transceiver CPU. A partial reset will not clear your
call sign databases.
To do a partial reset of the CPU, do the following
steps:
1. Push [MENU].
2. Rotate [DIAL] to select the 8th page, then push
[ï].
		

3. Select the bottom item, then push [ï].
		

4. Select the upper item, then push [ï].
		

LLDo not select the lower item. The lower item is
for the All reset function, and the All reset clears
all entries and returns all settings to their factory
defaults.

5. The dialog is displayed.
Select the left option, then push [ï].
		

••When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.
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Sounds items
Beep Level

(Default: 9)

Standby Beep

(Default: ON (to me:Alarm/High Tone))

Sounds > Beep Level

Sounds > Standby Beep

Set the beep audio output level to between 0 (OFF), 1
(minimum) and 9 (maximum).
Key-Touch Beep

Turn the Standby Beep function ON or OFF.
This function sounds a beep after a received signal
disappears, in the DV mode.
• OFF:	Does not sound a beep after a received signal
disappears.
• ON:	Sounds a beep after a received signal
disappears.
• ON (to me: High Tone):
			Sounds a high pitched beep when a received
signal that is addressed to your call sign (MY)
disappears.
When any other received signal disappears, a
regular beep sounds.
• ON (to me: Alarm/High Tone):
			Sounds alarm (PiRoPiRoPiRo) when a
received signal that is addressed to your call
sign (MY) disappears.
			 - If you release [PTT] and/or a signal is
received within 5 seconds, the alarm sound
changes to a high pitch beep sound when the
received signal disappears.
			 - If no signal is received for 5 seconds after
you release PTT, the next signal addressed
to your call sign will again sound the alarm
sound.
			When any other received signal disappears, a
regular beep sounds.

(Default: ON)

Sounds > Key-Touch Beep
Turn the confirmation beep tones ON or OFF.
• OFF:	No beep sounds.
• ON: A beep sounds when you push a key.
Home CH Beep

(Default: ON)

Sounds > Home CH Beep
Turn the Home CH Beep ON or OFF.
• OFF:	No beep sounds.
• ON:	Sounds a beep when you select the Home CH
by rotating [DIAL].
LLYou can set a Home CH for the VFO mode,
Memory mode and the DR function. (p. 10-7)
Band Edge Beep

(Default: OFF)

Sounds > Band Edge Beep
Turn the Band edge beep ON or OFF.
• OFF:	No beep sounds.
• ON:	A beep sounds when you tune into or out of
the AIR, 144 MHz, 230 MHz, 300 MHz, or
430 MHz band’s frequency range by rotating
[DIAL].
Scan Stop Beep

LLThe standby beep sounds even when “Key-Touch
Beep” is set to “OFF.”
LLThe standby beep output level is depending on the
Beep level setting.

(Default: OFF)

Sounds > Scan Stop Beep

Scope AF Output

Turn the scan stop beep ON or OFF.
• OFF:	No beep sounds.
• ON:	A beep sounds when a scan stops by receiving
a signal.

(Default: ON)

Sounds > Scope AF Output
Select the audio output option during a sweep by the
Band Scope function.
• OFF:	No audio is heard during the sweep.
• ON: Audio is heard during the sweep.
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Time Set items

DV Gateway items

DATE

Enters the Terminal mode or Access Point mode.
See “About the DV Gateway function” for details.
LL“About the DV Gateway function” can be
downloaded from the Icom website.

Time Set > Date/Time > DATE
Manually set the date to between 2000/01/01 and
2099/12/31.

<<Terminal Mode>>

TIME

DV Gateway > <<Terminal Mode>>

Time Set > Date/Time > TIME

The Terminal mode enables you to make a direct
Gateway call through the Internet using the optional
OPC-2350LU and a Windows PC or Android device.
In the Terminal mode, “<<Normal Mode>>” is
displayed on the DV GATEWAY screen. To cancel the
Terminal mode, push [ï].
LLYou can cancel the Terminal mode in the Quick
Menu window.

Manually set the time that is displayed at the top of
the screen to between 0:00 and 23:59. The time is
displayed in the 24 hour format.
LLWhen “GPS Time Correct” is set to “Auto,” the GPS
receiver automatically sets the time by calculating
the received Universal Time of Coordinated (UTC)
time and the “UTC Offset” setting. (p. 9-67)
GPS Time Correct

<<Access Point Mode>>

(Default: Auto)

DV Gateway > <<Access Point Mode>>

Time Set > GPS Time Correct

The Access Point mode enables the D-STAR
transceiver to make a Gateway call through an
ID-4100A/E using the optional OPC-2350LU to a
Windows PC or Android device.
In the Access Point mode, “<<Normal Mode>>” is
displayed in the DV GATEWAY screen. To cancel the
Access Point mode, push [ï].
LLYou can cancel the Access Point mode in the Quick
Menu window.

This function corrects the time by using the time
information that a GPS sentence contains.
It is corrected by calculating the received UTC time
and the “UTC Offset” setting.
• OFF: Does not correct the time.
• Auto: Automatically corrects the time.
UTC Offset

(Default: ±0:00)

Time Set > UTC Offset
Set the time difference between UTC time and the
local time to between –14:00 and +14:00 in 00:05
steps.
Auto Power OFF

(Default: OFF)

Time Set > Auto Power OFF
Select whether or not to automatically turn OFF the
transceiver after inactivity for this set period of time.
Does not turn OFF the transceiver.
• OFF:
• 30/60/90/120min:	Turns OFF the transceiver after
inactivity for this set period of time.
LL“AUTO POWER OFF” is displayed and beeps
sound 5 seconds before turning OFF the
transceiver. If you operate the transceiver during
this period of time, the Auto Power OFF timer is
reset.
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SD Card items
Load Setting

Separator/Decimal

SD Card > Load Setting

SD Card > Import/Export > CSV Format >
Separator/Decimal

Select from the list when you load the setting file.

(Default: Sep [,] Dec [.]*)

Select the separator and the decimal character for the
CSV format.
• Sep [,] Dec [.]:	Separator is “,” and Decimal is “.”
• Sep [;] Dec [.]:	Separator is “;” and Decimal is “.”
• Sep [;] Dec [,]:	Separator is “;” and Decimal is “,”

Save Setting
SD Card > Save Setting
Save the setting file.

*The default value may differ, depending on the transceiver
version.

Import
SD Card > Import/Export > Import

Date

Import the UR call sign, repeater list or GPS memory
data in the CSV format file.

(Default: mm/dd/yyyy*)

SD Card > Import/Export > CSV Format > Date
Select the date format between “yyyy/mm/dd,” “mm/
dd/yyyy” and “dd/mm/yyyy.” (y: year, m: month, d: day)

Export
SD Card > Import/Export > Export

*The default value may differ, depending on the transceiver
version.

Export the UR call sign, repeater list or GPS memory
data in the CSV format file.

SD Card Info
SD Card > SD Card Info
Displays the microSD card’s free space and its
remaining recording time.
Firmware Update
SD Card > Firmware Update
Displays the Firmware Update mode.

LLSee “Updating the firmware” (p. 13-3) for details.

Format
SD Card > Format
Formats the microSD card, deleting all data.
Unmount
SD Card > Unmount
Electrically unmounts the microSD card while the
transceiver is ON.
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Bluetooth® Set items
The optional UT-137 Bluetooth unit is required.

Headset Function Select

Bluetooth

Bluetooth Set > Headset Set >
Headset Function Select

(Default: OFF)

Bluetooth Set > Bluetooth

Select the PTT and microphone combination when
both the Bluetooth headset and the transceiver
microphone are used.
LLTo use the Bluetooth function, the optional UT-137
Bluetooth unit is required.

Turns the Bluetooth function ON or OFF.
LLTo use the Bluetooth function, the optional UT-137
Bluetooth unit is required.
• OFF: Turns OFF the function.
• ON: Turns ON the function.
Auto Connect

• Normal:	Transmits the audio from the Bluetooth
headset or the transceiver microphone
whichever [PTT] is pushed.
• Microphone:	Transmits the audio from the Bluetooth
headset.
Transmission is enabled by pushing
either the [PTT] on the Bluetooth
headset, or the transceiver microphone.
The transceiver microphone is only
used for the PTT control.
• PTT:	Transmits the audio from the
transceiver microphone.
Transmission is enabled by pushing
either the [PTT] on the Bluetooth
headset, or the transceiver microphone.
The Bluetooth headset is only used for
the PTT control.

(Default: ON)

Bluetooth Set > Auto Connect
Select whether or not to automatically connect to the
paired Bluetooth device when its power is turned ON.
• OFF: Does not connect to the paired device.
• ON:	Automatically connects to the last connected
device.
Paring/Connect
Bluetooth Set > Paring/Connect
Searches for the Bluetooth device to connect, or
display the paired Bluetooth devices in the list.
See page 12-3 for details.

NOTE:
•W
 hen you select “PTT,” turn OFF the VOX function.
•D
 O NOT select “PTT” when the microphone is not
connected to the transceiver, and you use only the
Bluetooth headset.

<<Paring Reception>>
Bluetooth Set > <<Paring Reception>>
Enters the pairing reception mode.
See page 12-10 for details.
AF Output

(Default: Normal)

LLThe Bluetooth headset operation for each option is
listed below.

(Default: Headset Only)

Bluetooth Set > Headset Set > AF Output
Select the AF Output device when a Bluetooth
headset is connected.
• Headset Only:	Outputs audio to only the
connected Bluetooth headset.
• Headset & Speaker:	Outputs audio to both the
connected Bluetooth headset
and the transceiver’s speaker.
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Normal
Microphone

TX control
Enabled
Enabled

PTT

Enabled

TX audio
Enabled
Enabled
Disabled

(Audio from the microphone
is transmitted.)
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Bluetooth® Set items (Continued)
VOX

(Default: OFF)

Power Save

Bluetooth Set > Headset Set > VOX > VOX

Bluetooth Set > Headset Set > Icom Headset >
Power Save

The Voice Operated Transmission (VOX) function
starts transmitting without pushing [PTT] when you
speak into the microphone, then automatically returns
to receive when you stop speaking.
LLTo use the VOX function, the optional VS-3 headset
is required.

Select whether or not to operate with the Power Save
mode while the optional VS-3 headset is connected.
LLWhen a headset (user supplied) or a data device is
connected, the Power Save mode is automatically
turned OFF, regardless of this setting.

• OFF: Turns OFF the function.
• ON: Turns ON the function.
VOX Level

• OFF: Turns OFF the function.
• ON:	The Power Save mode is enabled when no
communication or operation is performed for
120 seconds.

(Default: 5)

Bluetooth Set > Headset Set > VOX > VOX Level

One-Touch PTT

Set the VOX gain level to between OFF, 1 (minimum
sensitivity) and 10 (maximum sensitivity).
Higher values make the VOX function more sensitive
to your voice.
When “OFF” is selected, the transmission does not
start when you speak into the microphone. (The VOX
function is OFF.)

(Default: OFF)

Bluetooth Set > Headset Set > Icom Headset >
One-Touch PTT
Set the One-Touch PTT function when the optional
VS-3 headset is connected.
This function enables you to transmit without
continuously holding down [PTT].
LLWhen a headset (user supplied) is connected, this
function is automatically turned ON, regardless of
this setting.

NOTE: Before setting the VOX gain level, it is
recommended that you set the microphone gain
level in “Function” of the Menu screen or the
Bluetooth headset.
VOX Delay

(Default: OFF)

• OFF: Transmits while holding down [PTT].
• ON:	Pushing [PTT] changes transmission and
reception.

(Default: 0.5sec)

(Default: OFF)

Bluetooth Set > Headset Set > VOX > VOX Delay

PTT Beep

Set the VOX Delay time to 0.5, 1.0, 1.5, 2.0, 2.5 or 3.0
seconds.
The VOX Delay is the amount of time the transmitter
stays ON after you stop speaking, before the VOX
switches to receive.

Bluetooth Set > Headset Set > Icom Headset >
PTT Beep

VOX Time-Out Timer

Set the beep sound when you push [PTT] on the
optional VS-3 headset.
• OFF: No beep sounds.
• ON:	A beep sounds.

(Default: 3min)

Custom Key Beep

Bluetooth Set > Headset Set > VOX >
VOX Time-Out Timer

(Default: OFF)

Bluetooth Set > Headset Set > Icom Headset >
Custom Key Beep

Set the VOX Time-Out Timer to between OFF, 1, 2,
3, 4, 5, 10, or 15 minutes to prevent an accidental
prolonged transmission.
If a continuous transmission exceeds the set period of
time, the transmission will be cut off.
When “OFF” is selected, the continuous transmission
is not cut off.

Set the beep sound when you push the Custom Key
([PLAY]/[FWD]/[RWD]) on the optional VS-3 headset.
• OFF: No beep sounds.
• ON:	A beep sounds.

☞☞Continued on the next page.
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Bluetooth® Set items (Continued)
Custom Key

(Default: [PLAY]: ---, [FWD]: UP, [RWD]: DOWN)

Function

Bluetooth Set > Headset Set > Icom Headset >
Custom Key

SPEECH

Assigns the following key functions to the Custom Key
([PLAY]/[FWD]/[RWD]) on the optional VS-3 headset.
Function
--UP
DOWN
VOL UP
VOL DOWN
SQL UP
SQL DOWN
Monitor
CALL
MR (000 CH)
MR (001 CH)
VFO/MR
DR
FROM/TO
(DR)

HOME CH

BAND/BANK

Description
No function
Push to increase the frequency,
Memory channel, repeater or select the
next station call sign.
Push to decrease the frequency,
Memory channel, repeater or select the
previous station call sign.
Push to increase the volume level.
Push to decrease the volume level.
Push to increase the squelch level.
Push to decrease the squelch level.
Push to open or close the squelch.
Push to select a call channel.
In the Memory mode, push to select
Memory channel 000.
In the Memory mode, push to select
Memory channel 001.
Push to select between the VFO mode
and the Memory mode.
Push to turn the DR function ON or
OFF.
On the DR screen, push to select
between “FROM” and “TO.”
Push to directly select the Home CH
that is set to the selected mode (VFO/
Memory) or DR screen.
While in the CALL CH or Weather
channel mode, or when no Home CH
is set, an error beep sounds.
Push to select an operating band.
In the VFO mode, push to change the
operating band, and in the Memory
Bank mode, push to select Bank A ~ Z,
or OFF.

MODE

Temporary
Skip
RX>CS

LLIn the VFO, Memory and Call channel
mode, the frequency and the operating
mode are announced.
LLIn the DR screen, the call sign is
announced. If Simplex is selected, the
frequency is announced.

Push to change the operating mode.
Push to change the transmit power
LOW
level.
Push to turn the Duplex mode ON or
DUP
OFF, and the shift direction to DUP+ or
DUP–.
Push to turn the Priority watch ON or
PRIO
OFF.
Push to select between tone types.
<<MODE>> FM/FM-N
TONE:
Repeater Tone
TSQLS:	Pocket Beep with Tone
Squelch
TSQL:	(Tone Squelch)
DTCSS:	Pocket Beep with DTCS
Code Squelch
DTCS:	DTCS Code Squelch
TSQL-R:	Reverse Tone Squelch
DTCS-R:	Reverse DTCS Code
Squelch
DTCS (T) (“DTCS” blinks):
	TX:DTCS, RX:OFF
TONE (T)/DTCS (R)
(“T-DTCS” is displayed, “T” blinks.):
TX:TONE, RX:DTCS
TONE/DSQL 	
DTCS (T)/TSQL (R)
(“D-TSQL” is displayed, “D” blinks.):
	
TX:DTCS, RX:CTCSS
TONE (T)/TSQL (R)
(“T-TSQL” is displayed, “T” blinks.):
	
TX:TONE, RX:CTCSS

LLOnly the entered bank is selectable.

SCAN

Description
Push to announce the frequency,
operating mode or call sign.

Push to start a scan.
While scanning, push to stop the scan.
Push to set the frequency to be
skipped during scanning.
The selected frequencies are
temporarily skipped for faster scanning.
Hold down for 1 second to set the
last calling station’s call sign to “TO”
(destination).

MW
MUTE
9-71

<<MODE>> DV
LLYou can set this setting on the DR
screen.
DSQLS:	Pocket Beep with Digital
Call sign Squelch
DSQL:	Digital Call sign Squelch
CSQLS:	Pocket Beep with Digital
Code Squelch
CSQL:	Digital Code Squelch
In the VFO mode or on the DR screen,
hold down to save the displayed
frequency into a Memory blank
channel.
Push to turn the Mute function ON or
OFF.
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Bluetooth® Set items (Continued)
Custom Key (Continued)
Function

Voice TX
(T1)

T-CALL

Description
••Push to transmit the voice audio
recorded on the microSD card once.
••Hold down for 1 second to repeatedly
transmit the voice audio.

LLThis key function can also be used on
the DR screen.
LLIf the voice audio is not saved in the [T1]
(Voice memory number for TX) on the
Voice TX record screen, this function is
disabled.

Push to transmit a 1750 Hz tone.

Serialport Function
(Default: CI-V (Echo Back OFF))

Bluetooth Set > Data Device Set >
Serialport Function
Set the serial port function for the Bluetooth SPP
(Serial Port Profile) connection to a data device, PC
and so on.
• CI-V (Echo Back OFF):
			Transmits or receives a CI-V command.
Does not send back the serial data
received from the SPP connection.
• CI-V (Echo Back ON):
			Transmits or receives a CI-V command.
Sends back the serial data received from
the SPP connection.
• DV Data:	Transmits or receives data in the DV
mode.
Does not input the cloning or weather
data entries, or output the GPS data.
Bluetooth Device Information
Bluetooth Set > Bluetooth Device Information
Displays the Bluetooth device information.
Initialize Bluetooth Device
Bluetooth Set > Initialize Bluetooth Device
Initializes the installed Bluetooth unit.
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Others items
Voltage
Others > Information > Voltage
Displays the voltage of the external power supply.
Version
Others > Information > Version
Displays the transceiver firmware’s version number.
LLWhen the optional UT-137 Bluetooth unit is
installed, the unit’s version number is also
displayed.
Clone Mode
Others > Clone > Clone Mode
Select to enter the clone mode to read or write the
CS-4100 data from or to the PC.
See page 10-14 for details.
Partial Reset
Others > Reset > Partial Reset
Select to reset the operating settings to their default
values (VFO frequency, VFO settings, menu contents)
without clearing the items below.
• Memory channel content
• Scan Edge content
• Call channel content
• Call sign memories
• Message content
• DTMF memory content
• GPS Memory content
• Repeater list content
See page 10-18 for details.
All Reset
Others > Reset > All Reset
Select to clear all content and return all settings to
their factory defaults.
See page 10-18 for details.
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Selecting a Squelch delay

Transmit power levels and RF meter

You can select a squelch delay in the MENU screen to
prevent repeated opening and closing of the squelch
while receiving the same signal.

The transmit power level and the RF meter displays
are shown below.

Function > Squelch Delay

LOW

MID

HIGH

5W

15 W

25/50 W*

RF meter
(TX display)

1. Push [MENU].
2. Rotate [DIAL] to select “Function,” then push [ï].
		

Power level
(at TX)

*Depending on the transceiver version.

3. Select “Squelch Delay,” then push [ï].
		

TIP: To change the transmit power level
Push [QUICK], then select “TX Power.”
		

4. Select an option.
••Short:	Short squelch delay.
••Long: Long squelch delay.
		

5. Push [MENU].

••Returns to the standby screen.
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Attenuator function

Microphone gain level setting

The transceiver has an RF attenuator related to
the squelch control setting. You can add up to
approximately 20 dB of attenuation at its maximum
setting.
You can set the Attenuator to [SQL] in the MENU
screen.

Set the microphone gain level in the MENU screen.
Function > MIC Gain
1. Push [MENU].
2. Rotate [DIAL] to select “Function,” then push [ï].
		

Function > Squelch/ATT Select
1. Push [MENU].
2. Rotate [DIAL] to select “Function,” then push [ï].
		

3. Select “MIC Gain,” then push [ï].
		

3. Select “Squelch/ATT Select,” then push [ï].
		

4. Rotate [DIAL] to set the microphone gain level.
LLSet higher values to make the microphone more
sensitive to your voice.

		
4. Select “ATT,” then push [ï].
		

5. Push [MENU].

••Returns to the standby screen.

5. Push [MENU].

••Returns to the standby screen.

DDOperating the Attenuator function

Rotate [SQL] clockwise past the 12 o’clock position
to turn ON the Attenuator and adjust the attenuation
level up to approximately 20 dB.

Noise squelch

You can adjust the
Attenuation level between
12 o’clock and the fully
clockwise position.
Displayed
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Band Scope function
DDSweep operation

Use the Band Scope function to visually search for
a specified frequency range around the displayed
frequency.
You can use this function to search for a signal, and
see the received signal strength level.
The Band Scope function has two sweep types,
Single sweep and Continuous sweep:
• A Single sweep searches the specified frequency
range only once.
• A Continuous sweep repeatedly searches the
specified frequency range.

Example: Continuous sweeps centered on 146.010 MHz
1. Push [V/M] several times until you enter the VFO
mode.
2. Rotate [DIAL] to set 146.010 MHz.
		

3. Push [QUICK].
4. Rotate [DIAL] to select “Band Scope,” then push
[ï].
		

The transceiver sweeps in “±25 × Tuning step” steps
centered on the displayed frequency.
LL‘±25’ is fixed.
For example, if the display frequency is 146.010 MHz
and its tuning step is 20 kHz, the sweep range is
between 145.510 MHz (lower frequency) and 146.510
MHz (higher frequency). (146.010 MHz ±0.5 MHz)
See the calculation below.
+25 × 20 kHz = +500 kHz (0.5 MHz)
–25 × 20 kHz = –500 kHz (–0.5 MHz)
Upper frequency: 146.510 MHz
(146.010 MHz + 0.5 MHz)
Lower frequency: 145.510 MHz
(146.010 MHz – 0.5 MHz)

5. Select “Continuous Sweep,” then push [ï].
		

Example: A strong signal is received on 146.030 MHz.
(Tuning step: 5 kHz)

6. Push [ï].

••Returns to the frequency display and starts continuous
sweeping.
••Stops the continuous sweeping.

7. W
 hen the sweeping stops, rotate [DIAL] to move
the sweep marker to a detected signal.
		

Strong level
Weak level

The signal on 146.030 MHz
Band Scope display

LLYou can hear the signal audio.

Center frequency
(Example: 146.010 MHz)

8. Push [QUICK].
9. Rotate [DIAL] to select “Band Scope,” then push
[ï].
10. Select “Scope OFF,” then push [ï].
		

Sweep marker

TIP:
••The specified tuning step is used during a sweep.
If the tuning step is set too wide, the signals in the
sweep range may not be displayed (they may be
skipped), even if they are strong signals. Thus we
recommend that you set the tuning step to 20 kHz
or less to use the Band Scope function.
See Basic manual section 3 for details.
••You can hear the displayed frequency’s audio
during a sweep.
• You can turn OFF the audio output during a sweep
in the MENU screen. (p. 9-66)
(Sounds > Scope AF Output)

••Turns OFF the Band Scope function.

TIP: In the Band scope setting window, select
“Center Recall” to set the sweep marker to the
center frequency.
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Voice TX function
The Voice TX function transmits the audio that is on
the microSD card, one time or repeatedly, for up to 10
minutes at the specified interval.
Up to 4 memories can be used for repeatedly calling
CQ or for other events.
When the key function [Voice TX (T1)] is assigned to
a microphone key, push the key to transmit the saved
audio in the “T1” (Voice memory number for TX).
(p. 9-59)
NOTE: Be sure to insert a microSD card into the
transceiver.

DDRecording the voice audio
Voice TX > Record
1. Push [MENU].
2. Rotate [DIAL] to select “Voice TX,” then push [ï].
3. Select “Record,” then push [ï].

8. Push [].

••Returns to the VOICE TX RECORD screen.

		

••Displays the VOICE TX RECORD screen.

4. Select the memory number, “T1” ~ “T4.”
		
TIP: On the VOICE TX RECORD screen, push
[QUICK], then select “Clear” to clear the recorded
audio.

••The “VOICE TX RECORD (T1)” screen is displayed
when “T1” memory is selected.

5. Push [MW] to start recording.
		
Audio
level

Displayed
while
recording

[]

[QUICK]

Cancels

Deletes the file

[MODE]

Recording
time

[MONI]

Sets the mic gain

Stops recording

[RX→CS]
Playback

[MW]

Starts to record

LLHold the microphone 5 to 10 cm (2 to 4 inches) from
your mouth, then speak at a normal voice level.
LLThe maximum record time is 1 minute.

6. Push [MONI] to stop recording.
7. Push [RX→CS] to playback the recorded audio.
		

LLIf you push [MW], the recording starts again. In this
case, the previous recorded audio will be overwritten.
LLPush [MODE] to display the microphone gain setting
screen. Rotate [DIAL] to set the gain level.
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Voice TX function (Continued)

DDTransmitting the recorded voice audio

DDChanging the voice TX settings

You can change the voice TX settings on the MENU
screen. (p. 9-23)

NOTE: Be sure to insert a microSD card into the
transceiver.

Setting the Repeat Time
Set the repeat interval for the voice repeat
transmission.
The transceiver repeatedly transmits the recorded
voice audio at 5 second intervals as the default.

Voice TX > <<TX>>
1.
2.
3.
4.

Push [MENU].
Rotate [DIAL] to select “Voice TX,” then push [ï].
Select “<<TX>>,” then push [ï].
Select the memory number, “T1” ~ “T4,” then push
[ï].
		

Voice TX > TX Set > Repeat Time
		

Using the TX Monitor function
The TX voice audio is output from the speaker as the
default. (Default: ON)
Voice TX > TX Set > TX Monitor
		
••The recorded voice audio is transmitted once.
LL Informatio
••While transmitting, the SD card icon blinks.
••When you select “T1 (Repeat TX)” ~ “T4 (Repeat
TX)” in step 4, the transceiver repeatedly transmits
the recorded voice audio for up to 10 minutes at the
interval specified in “Repeat Time.”
••Push [PTT] to cancel a recorded voice transmission.

TIP: To send the recorded voice audio in the Quick
Menu window, push [QUICK], then select “Voice TX.”
		

10-6

Previous view

10

OTHER FUNCTIONS

Home channel function
Home channels are often-used frequencies you can
preset in the transceiver’s VFO mode, Memory mode
and DR function. Select the Home channel by just
pushing [HOME] in each mode.

DDHome channel setting

DDHome channel operation

1. Select a mode (VFO or Memory) or the DR screen
in which you want to set the Home channel.
2. Select a frequency to be set as the Home
channel.

1. S
 elect a mode (VFO or Memory) or the DR
screen in which you want to select the Home
channel.
		

LLOn the DR screen, select “FROM.”

3. Push [QUICK].
4. R
 otate [DIAL] to select “Home CH Set,” then push
[ï].
		

2. Push [HOME] on the microphone.
		

5. Select an option, then push [ï].
		

••Selects the Home channel of the selected mode or DR
screen.

DDHome CH Beep function

When the specified Home CH is selected by rotating
[DIAL], a beep sounds.
You will know the Home CH selection without looking
at the display.
LLYou can turn OFF the Home CH Beep function on
the MENU screen.
(Sounds > Home CH Beep)

LLIn the VFO mode, select “Set Frequency,” in the
Memory mode, select “Set Channel.” or on the DR
screen, select “Set Repeater.”

TIP: Selecting “Clear” in step 4 clears the Home
channel setting.
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Using the DTMF memory
The transceiver can save up to 16 memories of
24-digit DTMF code.

DDEntering DTMF code
DTMF > DTMF Memory
1. Push [MENU].
2. Rotate [DIAL] to select “DTMF,” then push [ï].
		

3. Select “DTMF Memory,” then push [ï].
		

••Displays the DTMF memory list (d0 to d#).

4. S
 elect the DTMF memory, then push [ï].
(Example: d0)
		

5. Enter the DTMF code, then push [ï].
(Example: 12345A)
		

••Saves the channel, and returns to the DTMF
MEMORY screen.
LLSee “Entering and editing text” for details. (p. iv)

6. Push [MENU].

••Returns to the standby screen.

TIP: To clear the entered DTMF code, push [QUICK]
on the DTMF MEMORY screen, then select “Clear.”
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Using the DTMF memory (Continued)

DDTransmitting DTMF code

DDTransmitting DTMF code (Direct Input)

1. Push [QUICK].
2. Rotate [DIAL] to select “DTMF TX,” then push [ï].
		

1. Push [QUICK].
2. Rotate [DIAL] to select “DTMF TX,” then push [ï].
3. Select “Direct Input.”
		

3. Select the DTMF memory channel to transmit,
then push [ï].
		

4. E
 nter the DTMF code, then push [ï].
(Example: 123A)
		

••Transmits the selected DTMF code.
LLThe DTMF code scrolls during transmission.

••Transmits the entered DTMF code.
LLThe DTMF code scrolls during transmission.
LLSee “Entering and editing text” for details. (p. iv)
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Using the DTMF memory (Continued)

DDSelecting the DTMF transmit speed
You can select the DTMF transmit speed.
DTMF > DTMF Speed
1. Push [MENU].
2. Rotate [DIAL] to select “DTMF,” then push [ï].
		

3. Select “DTMF Speed,” then push [ï].
		

4. Select a transmit speed.
••100ms:	Transmits the DTMF tones at about 100
milliseconds per code.
5 characters per second.
••200ms:	Transmits the DTMF tones at about 200
milliseconds per code.
2.5 characters per second.
••300ms:	Transmits the DTMF tones at about 300
milliseconds per code.
1.6 characters per second.
••500ms: 	Transmits the DTMF tones at about 500
milliseconds per code.
1 character per second.
		

5. Push [MENU].

••Returns to the standby screen.

Image of the DTMF transmit speed

Pi, Po, Pa

When “100ms” is set,
the DTMF transmit
speed is fast.

Pi−, Po−, Pa−

When “500ms” is set,
the DTMF transmit
speed is slow.
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Tone squelch operation
The tone squelch opens only when you receive a
signal containing a matching subaudible tone in the
FM or FM narrow mode. You can silently wait for calls
from others using the same tone.
Also, the reversed tone squelch function will mute
the squelch when a signal containing a matched
subaudible tone.

DDTone squelch frequency setting and operation
Step 1. Setting the tone squelch frequency
DUP/TONE... > TSQL Freq

About the tone squelch type:

••TSQLS:	Enables the Tone Squelch with the Pocket
Beep function.
••TSQL:
Enables the Tone Squelch function.
••TSQL-R:	Enables the Reverse Tone Squelch function.
••TONE(T)/DTCS(R)
(“T-DTCS” is displayed, “T” blinks.):
				When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)
••DTCS(T)/TSQL(R)
(“D-TSQL” is displayed, “D” blinks.):
				When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching
tone frequency. (Audio is heard)
••TONE(T)/TSQL(R)
(“T-TSQL” is displayed, “T” blinks.):
				When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching
tone frequency. (Audio is heard)

1. Push

[V/M] several times until you enter the VFO
mode.
2. Push [MODE] several times until you select the
FM or FM-N (FM narrow) mode.
3. Rotate [DIAL] to set an operating frequency.
		

4. Push [MENU].
5. Rotate [DIAL] to select “DUP/TONE...,” then push
[ï].
6. Select “TSQL Freq,” then push [ï].
7. Rotate [DIAL] to set a tone squelch frequency,
then push [ï].
		

LLSet to between 67.0 and 254.1 Hz.

8. Push [MENU].

••Returns to the standby screen.

Step 2. Using the tone squelch
1. Push [QUICK].
2. Select “TONE,” then push [ï].
3. Select the tone squelch type. (Example: TSQL)
		

To sound beeps when a call is received.
If “TSQLS” is selected, beeps sound for 30
seconds and “S” blinks when a call with the
matched tone signal is received.
		

LLWithin 30 seconds, push [PTT] to stop the beeps.
(“S” disappears) After that, the transceiver selects
the regular tone squelch operation. If you make no
operation for 30 seconds, the beeps automatically
stop, but “S” continues to blink to indicate that you
received a call.

4. H
 olding down [PTT] and call a station.
Operate normally.
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DTCS squelch operation
The tone squelch opens only when you receive a
signal containing a matching DTCS code in the FM
or FM narrow mode. You can silently wait for calls
from others using the same tone. Also, a reversed
tone squelch function will mute the squelch when you
receive a signal containing a matched DTCS code.

DDDTCS code setting and operation
Step 1. Setting the DTCS code
About the DTCS code type:

DUP/TONE... > DTCS Code

••DTCSS:	Enables the DTCS squelch with the Pocket
Beep function.
••DTCS:
Enables the DTCS Squelch function.
••DTCS-R:	Enables the Reverse DTCS Squelch
function.
••DTCS(T) (“DTCS” blinks):
				When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the function is OFF.
••TONE(T)/DTCS(R)
(“T-DTCS” is displayed, “T” blinks.):
				When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)
••DTCS(T)/TSQL(R)
(“D-TSQL” is displayed, “D” blinks.):
				When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching
tone frequency. (Audio is heard)

1. Push

[V/M] several times until you enter the VFO
mode.
2. Push [MODE] several times until you select the
FM or FM-N (FM narrow) mode.
3. Rotate [DIAL] to set an operating frequency.
		

4. Push [MENU].
5. Rotate [DIAL] to select “DUP/TONE...,” then push
[ï].
6. Select “DTCS Code,” then push [ï].
7. Rotate [DIAL] to set a DTCS code, then push [ï].
		

LLSet to between 023 and 754.

8. Push [MENU].

••Returns to the standby screen.

DDThe DTCS code operation

To sound beeps when a call is received.
If “DTCSS” is selected, beeps sound for 30
seconds and “S” blinks when a call with the
matching tone signal is received.
		

1. Push [QUICK].
2. Select “TONE,” then push [ï].
3. Select the DTCS code type. (Example: DTCS)
		

LLWithin 30 seconds, push [PTT] to stop the beeps.
(“S” disappears) After that, the transceiver selects
the regular tone squelch operation. If you make no
operation for 30 seconds, the beeps automatically
stop, but “S” continues to blink to indicate that you
received a call.

4. H
 olding down [PTT] and call a station.
Operate normally.
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Weather channel operation (USA version only)
DDWeather alert function

There are 10 weather channels for monitoring
the National Oceanographic and Atmospheric
Administration (NOAA) weather broadcasts.

NOAA broadcast stations transmit weather alert tones
before important weather announcements.
When the weather alert function is turned ON, the
selected weather channel is monitored every 5
seconds for an announcement.
When an alert signal is detected, the “ALT” and the
WX channel are alternately displayed, and a beep
sounds until you change the operating mode or
weather channel, turn OFF the Weather Alert function,
or turn OFF the transceiver.
The previously selected (used) weather channel
is checked periodically during standby, or while
scanning.

DDSelecting a Weather channel

1. Push [QUICK].
2. Rotate [DIAL] to select “Weather CH,” then push
[ï].
		

••Enters the Weather channel mode.

3. Rotate [DIAL] to select a weather channel.
		

1. Push [QUICK].
2. Rotate [DIAL] to select “Weather Alert,” then push
[ï].
		

••Displays the selected weather channel number (“WX01” ~ “WX-10”).

TIP: To return to the previous frequency or Memory
channel, push [QUICK], then select “Weather CH
OFF.”

3. Select “ON.”
		

••Turns ON the Weather Alert function, and “W” is
displayed.
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Cloning function
The ID-4100A/E has a data cloning capability. This
function is useful when you want to copy all of the
entered contents from one ID-4100A/E to another.
Cloning can also be done with a PC.
Transceiver-to-Transceiver cloning using a
microSD card (p. 10-15)

Cloning from a PC using an optional cloning cable
(CS-4100 Instruction manual)
By using the CS-4100 cloning software and an
optional cloning cable, cloning can be done with a PC.
See the CS-4100 instruction manual that can be
downloaded from the Icom website.
http://www.icom.co.jp/world/support/

Sub

Master

OPC-478UC
(Option)

Cloning from a PC using a microSD card (p. 10-17,
CS-4100 Instruction manual)
To the
[DATA] jack

To the memory
card slot

To the
USB port

To the
speaker jack

OPC-2350LU
(Option)

To the
USB port

IMPORTANT: When using the OPC-2350LU, set
the “DV Data TX” setting of the transceiver to “PTT,”
before reading or writing setting data. Otherwise,
when a PC input data through the [DATA] jack, the
transceiver automatically transmits it.
(MENU > DV Set > DV Data TX)

To the memory
card reader

LLIf your PC does not have a microSD card slot,
connect a memory card reader (user supplied) to
use the microSD card.
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Cloning function (Continued)

DDTransceiver-to-Transceiver cloning using a microSD card
This section describes the cloning method using a
microSD card. Memory channel contents, MENU
item settings and repeater lists can be saved onto the
microSD card.
LLRecorded voice memories are not included in the
cloning data. To play back the master transceiver’s voice
memory, insert the microSD card into a sub transceiver,
or make a copy onto the sub transceiver’s microSD card
using a PC.
LLAssumes that the microSD card has already been
inserted into the transceiver.

Step 1. Saving the master transceiver’s setting
data onto the microSD card.

Step 2. Remove the microSD card from the master
transceiver, then insert it into the sub
transceiver.
1. Hold down the master transceiver’s [ ] to turn
OFF the power.
2. Remove the microSD card from the master
transceiver.
3. Insert the microSD card into the sub transceiver,
then hold down the sub transceiver’s [ ] to turn
ON the power.

SD Card > Save Setting
1. Push [MENU].
2. Rotate [DIAL] to select “SD Card,” then push [ï].
3. Select “Save Setting,” then push [ï].
4. Select “<<New File>>,” then push [ï].
		

NOTE: Before inserting, be sure to check the card
direction. If the card is forcibly or inversely inserted,
it will damage the card and/or the slot.

••Displays the FILE NAME screen.
LLThe file name is automatically named in the following
manner: Setyyyymmdd_xx (yyyy: Year, mm: month,
dd: day, xx: serial number)
Example: If a second file is saved on April 1, 2017,
the file is named “Set20170401_02.”
LLTo change the file name, see “Save with a different
file name.” (p. 6-4)

		

5. Push [ï].
		

Master

Sub

TIP: The setting data are saved in the “icf” file format
that is used in the CS-4100 cloning software.
When the saved data on a card is copied to a PC,
you can edit it with the cloning software.

••The confirmation dialog “Save file?” is displayed.

6. Select <YES>, then push [ï].
		

••Saves the data settings.
LLWhile saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.

7. Push [MENU].

••Returns to the standby screen.
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Cloning function
DD Transceiver-to-Transceiver cloning using a microSD card (Continued)
Step 3. Loading the setting data into the sub
transceiver.
7. Select <YES>, then push [ï].

SD Card > Load Setting
1.
2.
3.
4.

		

Push [MENU].
Rotate [DIAL] to select “SD Card,” then push [ï].
Select “Load Setting,” then push [ï].
Select a file to load.

••Starts the file check.
LLWhile checking the file, displays “CHECKING FILE”
and a progress bar.
		

		

••Displays the LOAD SETTING screen.

5. Select the loading option, then push [ï].
••ALL:	Loads all memory channels, Menu screen
item settings and the repeater list into the
transceiver.
••Except My Station:
				Loads all memory channels, Menu screen
item settings and the repeater list except
MY call signs and TX message into the
transceiver.
••Repeater List Only:
				Loads only the repeater list into the
transceiver.

8. After checking, settings data loading begins.

LLWhile loading, “LOADING” and a progress bar are
displayed.
		

9. After loading ends, “COMPLETED!” is displayed.
LLTo complete the loading, restart the transceiver.

		

		

••The confirmation dialog “Keep 'SKIP' settings in the
Repeater List?” is displayed.

6. Select <YES>, <NO> or <Cancel>, then push [ï].
••YES:	Retains the skip settings of the repeater
list. (p. 4-40)
••NO:	Does not retain the skip settings of the
repeater list.
••Cancel: Returns to the LOAD FILE screen.
		

••When you select <YES> or <NO>, the confirmation
dialog “Load file?” is displayed.
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Cloning function (Continued)

DDCloning from a PC using a microSD card
You can clone transceivers from a PC using a microSD
card.
Set memory content, Menu item settings and repeater
list in the CS-4100 cloning software, and save them
in an “icf” file format. Copy the “icf” file to the “Setting”
folder in the “ID-4100” folder of the microSD card.
microSD card configuration
Insert the microSD card that includes the “icf” file, then
load it to complete the cloning.
Csv

GpsMemory

Gps

RptList

QsoLog

YourMemory

Click

Reply
ID-4100

Double-click

RxLog
Setting
Voice

yyyymmdd

VoiceTx

yyyymmdd

Double-click

Connections

To the memory
card slot

Copy the “icf”
file.

To the memory
card reader
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Resetting the CPU
Occasionally, erroneous information will be displayed
when, for example, first applying power. This may
be caused externally by static electricity or by
other factors. If this problem occurs, turn OFF the
transceiver. After waiting a few seconds, turn ON the
transceiver again. If the problem is still there, perform
a Partial reset or an All reset.

NOTE for the All reset:
After you perform an All reset, you cannot use the
DR function because the repeater list will be cleared.
So we recommend you save the setting data onto
a microSD card, or to your PC using the CS-4100
cloning software before performing an All reset.
After the All reset is finished, load or write the saved
data into your transceiver.

DDPartial Reset

DDAll Reset

Others > Reset > Partial Reset

Others > Reset > All Reset

1. Push [MENU].
2. Rotate [DIAL] to select “Others,” then push [ï].

1.
2.
3.
4.

		

Push [MENU].
Rotate [DIAL] to select “Others,” then push [ï].
Select “Reset,” then push [ï].
Select “All Reset,” then push [ï].

		

3. Select “Reset,” then push [ï].
		

••The confirmation dialog “All Reset?” is displayed.

5. Select <NEXT>, then push [ï].
		

4. Select “Partial Reset,” then push [ï].
		

••The confirmation dialog as shown below is displayed.

6. Select <YES>, then push [ï].

••The confirmation dialog “Partial Reset?” is displayed.

		

5. Select <YES>, then push [ï].
		

••After the All reset is finished, the default screen is
displayed.

••When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.

LLA Partial reset resets the operating settings to their
default values (VFO frequency, VFO settings, menu
contents) without clearing the items below:
••Memory channel contents
••Scan Edge contents
••Call channel contents
••Call sign memories
••Message data
••DTMF memory contents
••GPS Memory contents
••Repeater list

LLAn All reset clears all setting, and returns all
settings to their factory defaults. Therefore, the
repeater list, Memory channel contents, filter
settings and so on will be cleared, so you will
need to reenter your memories, list and operating
settings.
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Remote control (CI-V) information
DDCI-V connection example

The transceiver's operating frequency, mode, VFO
and memory selection, can be remotely controlled
using a PC.
The Icom Communications Interface V (CI-V) is used
for remote control.

OPC-478UC
(Option)

ID-4100A/E

To the
USB port

To the
Speaker jack

DDPreparing

To control the transceiver, first set its address, data
communication speed, and transceive function.
These settings are set on the MENU screen. (p. 9-60)
(Function > CI-V)
LLWhen the OPC-478UC is connected, the received
audio cannot be heard. To hear the received audio,
use the cable as shown to the right.

PC
• Connections (ID-4100A/E side)
SP

GND

SP
GND
SP
I/O

3.5 (d) mm
(1⁄8 inch)

I/O

DDData format

The CI-V system can be written using the following
data formats. Data formats differ according to
command numbers. A data area or sub command is
added for some commands.
Controller to ID-4100A/E

OK message to controller

E0

9A

Cn

Sc

q

w

e

r

t

FD

FE FE

FD

FE FE

Data area
y

E0

9A

E0

9A

FB

u

ID-4100A/E to controller

NG message to controller

10-19

FA

FD

End of message
code (fixed)

Controller’s
default address

(see the command table)

Transceiver’s
default address

Command number

Preamble
code (fixed)

FE FE

Data area

(fixed)

Sc

(fixed)

Cn

NG code OK code

E0

Transceiver’s
default address

9A

u

Controller’s
default address

FE FE

y

Preamble
code (fixed)

t

End of message
code (fixed)

r

BCD code data such as
for frequency, memory
number entry
(see the data content description)

e

Sub command number

w

(see the command table)

q

FD
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Remote jack (CI-V) information (Continued)

DDCommand table
Cmd.

00

Sub
cmd.

01
03
04
05
06
07
0C
0D
0F

14

10
11
12
01

03

15

0A
0B
16
01

02
05

11
16

42
43

46
4B

5B

5C
5D

Data

Description

Cmd.

see p. 10-21 Send operating frequency for
transceive
see p. 10-21 Send operating mode for transceive
see p. 10-21 Read operating frequency
see p. 10-21 Read operating mode
see p. 10-21 Send operating frequency
see p. 10-21 Send operating mode
Select VFO mode
see p. 10-21 Read frequency offset*1
see p. 10-21 Send frequency offset
Read duplex setting
(10=simplex, 11=DUP–, 12=DUP+)
Set simplex operation
Set DUP– operation
Set DUP+ operation
0000 to
Send/read audio output level
0255
(000=Minimum, 0128=Center,
0255=Maximum)
0000 to
Send/read squelch level
0255
(000=Minimum, 0128=Center,
0255=Maximum)
see p. 10-21 Send/read RF power setting
see p. 10-21 Send/read external microphone gain.
see p. 10-22 Send/read VOX gain.
00
Read noise/S-meter squelch status
(squelch close)
01
Read noise/S-meter squelch status
(squelch open)
0000 to
Read S-meter level
0255
(0000=S0, 0170=S9)
00
Read tone squelch and RF squelch
status (squelch close)
01
Read tone squelch and RF squelch
status (squelch open)
0000 to
Read RF power meter
0255
(0026=LOW, 0077=MID, 0255=HIGH)
00
Send/read Repeater tone OFF
01
Send/read Repeater tone ON
00
Send/read Tone squelch OFF
01
Send/read Tone squelch ON
02
Send/read Reversed Tone squelch ON
00
Send/read VOX function OFF
01
Send/read VOX function ON
00
Send/read DTCS OFF
01
Send/read DTCS ON
02
Send/read Reversed DTCS ON
00
Send/read DSQL/CSQL OFF (DV
mode only)
01
Send/read DSQL ON (DV mode only)
02
Send/read CSQL ON (DV mode only)
00, 01, 02
Send/read GPS TX mode
(00=OFF, 01=D-PRS, 02=NMEA)
00 to 09
Tone setting
00=OFF, 01=TONE, 02=TSQL,
03=DTCS, 04=TSQL-R, 05=DTCS-R,
06=DTCS (T), 07=TONE (T) /DTCS
(R), 08=DTCS (T)/TSQL (R), 09=TONE
(T) /TSQL (R)

18
19
1B

1C
1F

20 00

10-20

Sub
cmd.

00
01
00
00
01
02
07
00

00
01
02
00

Data

see p. 10-22
see p. 10-22
see p. 10-22
see p. 10-22
00
01
see p. 10-22
see p. 10-22
see p. 10-22
00*3
01*3

01

01
02
00

see p. 10-23
see p. 10-23
00*3
01*3

02

01
02
00

see p. 10-23
see p. 10-23
00*3
01*3

03

01
02
00

see p. 10-23
see p. 10-23
00
01

04

01

see p. 10-24

02

see p. 10-24

00

00
01

01

see p. 10-26

02

see p. 10-26

Description

Turning OFF the transceiver
Turning ON the transceiver*2
Read transceiver ID
Send/read Repeater tone frequency
Send/read Tone squelch frequency
Send/read DTCS code and polarity
Send/read CSQL code (DV mode)
Send/read Transceiver’s status (RX)
Send/read Transceiver’s status (TX)
Send/read DV MY call sign
Send/read DV TX call signs
Send/read DV TX message
Send/read Auto DV RX Call signs
output OFF
Send/read Auto DV RX Call signs
output ON
Output DV RX Call signs for transceive
Read DV RX Call signs for transceive
Send/read Auto DV RX message
output OFF
Send/read Auto DV RX message
output ON
Output DV RX message for transceive
Read DV RX message for transceive
Send/read Auto DV RX status output
OFF
Send/read Auto DV RX status output
ON
Output DV RX status for transceive
Read DV RX status for transceive
Send/read Auto DV RX GPS/D-PRS
data output OFF
Send/read Auto DV RX GPS/D-PRS
data output ON
Output DV RX GPS/D-PRS data for
transceive
Read DV RX GPS/D-PRS data for
transceive
Send/read Auto DV RX GPS/D-PRS
message output OFF
Send/read Auto DV RX GPS/D-PRS
message output ON
Output DV RX GPS/D-PRS message
for transceive
Read DV RX GPS/D-PRS message for
transceive
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Remote jack (CI-V) information (Continued)

01

q

F

E

F

E

w

F

E

9

e

A

E

r

0

1

0

X

100 MHz digit: 1, 2, 3, 4, 5

0

1000 MHz digit: 0
(Fixed)

10 MHz digit: 0 ~ 9

1 MHz digit: 0 ~ 9

10 kHz digit: 0 ~ 9

t
X

10 Hz digit
0
5
3
0
6
5

Operating mode
Command: 01, 04, 06
q
X

w
X

X

X

q Mode w Filter setting

AM
AM-N
FM
FM-N
DV

02
02
05
05
17

01
02
01
02
01

u

t

8

X

100 Hz digit
0
2
3
5
6
7

Operating
mode

*1 Below 100 Hz is omitted.

sending the power ON command (18 01), the
*2 When
command “FE” must be sent before the basic format.
• 19200bps: 25
• 9600bps: 13
• 4800bps: 7
Example: When sending with 4800 bps

X

1

F

D

Duplex Frequency offset setting
Command: 0C, 0D

×7

q Preamble code (fixed)
w Transceiver’s default address
e Controller’s default address
r Command number
t Sub command number
u End of message code (fixed)

q

*3 Output setting is automatically turned OFF after turning
OFF the transceiver, then turn it ON again.

w

e

X

X

X

X

X

RF power level setting
Command: 14 0A
LOW
MID
0 ~ 84
85 ~ 170

X
1 MHz digit

00

X

10 MHz digit

02
24 00

r

X

10 kHz digit

23 00
01

e

X

100 kHz digit: 0 ~ 9

05

w
0

100 kHz digit

04

q
X

100 Hz digit: 0, 2, 3, 5, 6, 7

03

see p. 10-26 Send/read DV TX data (Up to 30 byte)
00
Send/read Auto DV RX data output
OFF
01
Send/read Auto DV RX data output ON
see p. 10-26 Send/read DV RX data (Up to 30 byte)
00, 01
Send/read DV data TX setting
(00=PTT, 01=Auto)
Send/read DV fast data setting
00, 01
(00=OFF, 01=ON)
Send/read GPS Data Speed setting
00, 01
(00=Slow, 01=Fast)
Send/read TX Delay (PTT) setting
00~10
(00=OFF, 01=1 sec. ~ 10=10 sec.)
see p. 10-26 Read the position
00
Send/read the GPS receiver OFF
01
Send/read the internal GPS ON
02
Send/read the external GPS ON
Send/read the manually entered
03
position
see p. 10-26 Send/read manually entered position
00
Send/read TX output power setting
OFF
01
Send/read TX output power setting ON
00
TX output power setting OFF for
transceive
01
TX output power setting ON for
transceive

Receive frequency setting
Command: 00, 03, 05

1 kHz digit: 0, 1, 2, 3, 5, 6, 7, 8

01
02

Description

100 Hz digit

00

Data

1 kHz digit

22 00
01

Sub
cmd.

10 Hz digit: 0, 3, 5, 6
(according to the 100 Hz digit)
1 Hz digit: 0
(Fixed)

Cmd.

HIGH
171 ~ 255

External microphone gain setting
Command: 14 0B
1
2
3
4
0000 ~ 0063 0064 ~ 0127 0128 ~ 0191 0192 ~ 0255
10-21
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Remote jack (CI-V) information (Continued)
VOX gain setting
Command: 14 16
OFF
1

2

3

4

7

8

9

DV MY call sign setting
Command: 1F 00
Set your own call sign and note of up to 12 characters.

0000 ~ 0022 0023 ~ 0046 0047 ~ 0069 0070 ~ 0092 0093 ~ 0115

5

6

q~i

o ~ !2

X X ••• X X X X X X X X X X

0016 ~ 0139 0140 ~ 0162 0163 ~ 0185 0186 ~ 0208 0209 ~ 0232

10

q ~ i: Your own call sign setting (8 characters)
o ~ !2: Note setting (4 characters)

0233 ~ 0255

Repeater tone/tone squelch frequency setting
Command: 1B 00, 1B 01
X

e
X

X

X

q~i

10 Hz digit

100 Hz digit

DTCS code and polarity setting
Command: 1B 02
w

!7 ~ @4

q ~ i:	UR (Destination) call sign setting (8
characters)
o ~ !6:	R1 (Access/Area repeater) call sign setting (8
characters)
!7 ~ @4:	R2 (Link/Gateway repeater) call sign setting
(8 characters)

*Not necessary when setting a frequency.
LLSee page 9-16 for the tone frequency list.

q

o ~ !6

X X ••• X X X X ••• X X X X ••• X X
1 Hz digit

0

Fixed: 0

Fixed: 0

0

w

0.1 Hz digit

q*

DV TX call signs setting (24 characters)
Command: 1F 01
Set “UR,” “R1” and “R2” call signs of 8 characters
(fixed).

Character’s code of the call sign
Character
ASCII code
0~9
30 ~ 39
A~Z
41 ~ 5A
(Space)
20
/
2F

e

0 (fixed)
First digit: 0 ~ 7
Second digit: 0 ~ 7
Third digit: 0 ~ 7

X X 0 X X X

DV TX message setting
Command: 1F 02
Set the transmit message of up to 20 characters.
“FF” stops sending or reading messages.

Receive polarity: 0: Normal
1: Reverse
Transmit polarity: 0: Normal
1: Reverse

Character
A~Z
0~9
!
$
&
?
’
^
–
/
,
;
<
(
[
{
¦
¯

LLSee page 9-16 for the DTCS code list.

Digital code squelch setting
Command: 1B 07
X

X

First digit: 0 ~ 9

Second digit: 0 ~ 9

q

10-22

ASCII code
41 ~ 5A
30 ~ 39
21
24
26
3F
27
5E
2D
2F
2C
3B
3C
28
5B
7B
7C
7E

Character
a~z
Space
#
%
\
"
`
+
M
.
:
=
>
)
]
}
_
@

ASCII code
61 ~ 7A
20
23
25
5C
22
60
2B
2A
2E
3A
3D
3E
29
5D
7D
5F
40
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Remote jack (CI-V) information (Continued)
DV RX message
Command: 20 0101, 20 0102

DV RX call sign data
Command: 20 0001, 20 0002

@1 ~ @8

q ~ @0

q Header flag data (First byte)
Data
Description
bit7 (0: Fixed)
—
bit6 (0: Fixed)
—
bit5 (0: Fixed)
—
bit4
0/1
0=Voice, 1=Data
bit3
0/1
0=Direct, 1=Through repeater
bit2
0/1
0=No Break-in, 1=Break-in
bit1
0/1
0=Data, 1=Control
bit0
0/1
0=Normal, 1=EMR

@9 ~ #2

X X ••• X X X X ••• X X X X X X

q ~ @0: Message (20 characters)
@1 ~ @8: Call sign of the caller station (8 characters)
@9 ~ #2: Note of the caller station (4 characters)

LLFF: W
 hen no call sign is received since the transceiver
power ON.

Example: When a Gateway call is received
RX RPT2

w Header flag data (Second byte)
Data
Description
bit2 bit1 bit0
1
1
1 Repeater control
1
1
0 Send auto acknowledge
1
0
1 (Not used)
1
0
0 Request to re-transmit
0
1
1 Send acknowledge
0
1
0 Receive no reply
0
0
1 Repeater disabled
0
0
0 NULL

alling
UK c
JG3L ZLK on .
1
..
to JM H port A
H
Y
JP3

CALLED

GW
RX RPT1
INTERNET
g to
allin
Kc
...
3LU on
JG ZLK port A
1
JM YHH
3
JP

to
ing
call
LUK n
JG3 ZLK o rt A...
o
JM1 HH p
Y
JP3

CALLER
YOUR STATION

CALLER: Caller’s call sign
CALLED: Called station call sign
RXRPT1:	Call sign of the repeater that was accessed
by the caller station

e ~ !0:	Call sign of the caller station
(8 characters, fixed)
!1 ~ !4: Note of the caller station (4 characters, fixed)
!5 ~ @2:	Call sign of the called station
(8 characters, fixed)
@3 ~ #0:	Call sign of the access/area repeater (R1)
(8 characters, fixed)
#1 ~ #8:	Call sign of the link/gateway repeater (R2)
(8 characters, fixed)

LLIf it was a call through a gateway and the
internet, this item displays the gateway call
sign of the repeater you received the call from.

RXRPT2:	Call sign of the repeater you received the
call from

DV RX Status setting
Command: 20 0201, 20 0202
Data
Function
Description
bit7 0 (Fixed)
—
Receiving a While receiving a digital voice
bit6 0/1 voice call
signal, select “1.” (Regardless
of DSQL and CSQL setting)
Last call
When the last call was
bit5 0/1
finisher
finished by you, select “1.”
Receiving a When the audio tone can be
bit4 0/1
signal
heard, select “1.”
Receiving a While receiving a BK call,
bit3 0/1
BK call
select “1.”
Receiving a While receiving a EMR call,
bit2 0/1
EMR call
select “1.”
Receiving a When “DV” and “FM” are
bit1 0/1 signal other blinking, select “1.”
than DV
Packet loss While displaying packet loss
bit0 0/1
status

LL“FF” stands for no call sign receiving after turning ON the
transceiver.
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Remote jack (CI-V) information (Continued)
GPS/D-PRS data— Position
Command: 20 03 01, 20 03 02
q~o

!0 !1

!2 ~ !6

!7 ~ @2

@3 ~ @6

@7 @8

@9 ~ #1

#2 ~ #8

#9 $0 $1 $2

0 0XX ••• XXXXXXXX ••• XXXX ••• XXXX ••• XXXXXXXX ••• XXX X ••• XXXXXXXXXX

Data number

q ~ o: Call sign/SSID
			

*9 ASCII characters (A–Z, 0–9, /, -, space)

			

*2 ASCII characters (00h–EFh)

			

*y: Year, m: Month, d: Day, H: Hour, M: Minute,
S: Second

Data

!0, !1: Symbol

0
1
2
3
4
5
6
7
8
9

!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @6: Altitude (0.1 meter steps)
@7, @8: Course (1 degree steps)
@9 ~ #1: Speed (0.1 km/h steps)
#2 ~ #8: Date (UTC: yyyymmddHHMMSS)
#9:		
$0:		
$1:		
$2:		

Power (see the table to the right)
Height (see the table to the right)
Gain (see the table to the right)
Directivity (see the table to the right)

Power
(W)
0
1
4
9
16
25
36
49
64
81

Height
(m/ft)
3/10
6/20
12/40
24/80
49/160
98/320
195/640
390/1280
780/2560
1561/5120

Gain
(dB)
0
1
2
3
4
5
6
7
8
9

Directivity
(deg)
Omni-direction
45º NE
90º E
135º SE
180º S
225º SW
270º W
315º NW
360º N
—

GPS/D-PRS data— Object
Command: 20 03 01, 20 03 02
q~o

!0 !1

!2 ~ !6

!7 ~ @2

@3 ~ @6

@7 @8

@9 ~ #1

#2 ~ #8

#9 $0 $1

0 1XX ••• XXXXXXXX ••• XXXX ••• XXXX ••• XXXXXXXX ••• XXX X ••• XXXXXXXX

Data number

$2

$3 ~ %1

%2

XXXX ••• XXXX

q ~ o: Call sign/SSID

			

*9 ASCII characters (A–Z, 0–9, /, -, space)

			

*2 ASCII characters (00h–EFh)

			

*y: Year, m: Month, d: Day, H: Hour, M: Minute,
S: Second

Data

!0, !1: Symbol

0
1
2
3
4
5
6
7
8
9

!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @6: Altitude (0.1 meter steps)
@7, @8: Course (1 degree steps)
@9 ~ #1: Speed (0.1 km/h steps)
#2 ~ #8: Date (UTC: yyyymmddHHMMSS)

#9:		
Power (see the table to the right)
$0:		
Height (see the table to the right)
$1:		
Gain (see the table to the right)
$2:		
Directivity (see the table to the right)
$3 ~ %1: Name
			

%2:		

*9 ASCII characters (00h–EFh)

Type (1=Live, 0=Killed)

10-24

Power
(W)
0
1
4
9
16
25
36
49
64
81

Height
(m/ft)
3/10
6/20
12/40
24/80
49/160
98/320
195/640
390/1280
780/2560
1561/5120

Gain
(dB)
0
1
2
3
4
5
6
7
8
9

Directivity
(deg)
Omni-direction
45º NE
90º E
135º SE
180º S
225º SW
270º W
315º NW
360º N
—
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Remote jack (CI-V) information (Continued)
GPS/D-PRS data— Item
Command: 20 03 01, 20 03 02
q~o

!0 !1

!2 ~ !6

!7 ~ @2

@3 ~ @6

@7 @8

@9 ~ #1

#2 #3 #4

0 2XX ••• XXXXXXXX ••• XXXX ••• XXXX ••• XXXXXXXX ••• XXXXXXXX

Data number

#6 ~ $4

#5

$5

XXXX ••• XXXX

q ~ o: Call sign/SSID
			

*9 ASCII characters (A–Z, 0–9, /, -, space)

			

*2 ASCII characters (00h–EFh)

			

*9 ASCII characters (00h–EFh)

Data

!0, !1: Symbol

0
1
2
3
4
5
6
7
8
9

!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @6: Altitude (0.1 meter steps)
@7, @8: Course (1 degree steps)
@9 ~ #1: Speed (0.1 km/h steps)
#2:		
Power (see the table to the right)
Height (see the table to the right)
#3:		
Gain (see the table to the right)
#4:		
#5:		
Directivity (see the table to the right)
#6 ~ $4: Name
$5:		

Power
(W)
0
1
4
9
16
25
36
49
64
81

Height
(m/ft)
3/10
6/20
12/40
24/80
49/160
98/320
195/640
390/1280
780/2560
1561/5120

Gain
(dB)
0
1
2
3
4
5
6
7
8
9

Directivity
(deg)
Omni-direction
45º NE
90º E
135º SE
180º S
225º SW
270º W
315º NW
360º N
—

Type (1=Live, 0=Killed)

GPS/D-PRS data— Weather
Command: 20 03 01, 20 03 02
q~o

!0 !1

!2 ~ !6

!7 ~ @2

@3 ~ @9

#0 #1 #2 #3 #4 #5

#6 ~ #8

#9 $0 $1

0 3XX ••• XXXXXXXX ••• XXXX ••• XXXX ••• XXXXXXXXXXXX XXX X ••• XXXXXXXX

Data number

$2 $3 $4 $5 $6

$7 ~ $9

XXXXXXXXXXXX ••• XX

q ~ o: Call sign/SSID

			

*9 ASCII characters (A–Z, 0–9, /, -, space)

			

*2 ASCII characters (00h–EFh)

			

*y: Year, m: Month, d: Day, H: Hour, M: Minute,
S: Second

!0 ~ !1: Symbol

!2 ~ !6: Latitude (ddºmm.mmm format)
!7 ~ @2: Longitude (dddºmm.mmm format)
@3 ~ @9: Date (UTC: yyyymmddHHMMSS)

#0, #1: Wind direction (1 degree steps)
#2, #3: Wind speed (0.1 m/s steps)
#4, #5: Gust speed (0.1 m/s steps)
#6 ~ #7: Temperature (0.1ç steps)
#8		 :
Temperature (0=+ degree, 1=– degree)
#9, $0: Rainfall (0.1 mm steps)
$1, $2: Rainfall (24 hours) (0.1 mm steps)
$3, $4: Rainfall (Midnight) (0.1 mm steps)
$5, $6: Humidity (1% steps)
$7 ~ $9: Barometric pressure (0.1 hPa steps)
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Remote jack (CI-V) information (Continued)
GPS/D-PRS message
Command: 20 04 01, 20 04 02

DV TX data, DV RX data (transceive)
Command: 22 00, 22 01 01
q ~ #0

!0 ~ %2

q~o

X X •••••••••••••••• X X

X X ••• X X X X ••• X X

Variable

Variable

q ~ #0: Tx, data Rx data (Up to 30 Byte)

q ~ o: Call sign/SSID
			
*9 ASCII characters (A ~ Z, 0 ~ 9, /, -, space)
!0 ~ %2: Message
			

			

*Up to 43 ASCII characters (00h–EFh)

*“FA” to “FF” are entered after converted to “FF 0A”
to “FF 0F” automatically. Up to 60 Byte data can
be entered in this case.

MY position data
Command: 23 00
q~t

y ~ !1

!2 ~ !5

!6 !7

!8 ~ @0

@1 ~ @7

XX ••• XXXX ••• XXXX ••• XXXXXXXX ••• XXX X ••• XX

q ~ t: Latitude (ddºmm.mmm format)
y ~ !1: Longitude (dddºmm.mmm format)
!2 ~ !5: Altitude (0.1 meter steps)
!6, !7: Course (1 degree steps)
!8 ~ @0: Speed (0.1 km/h steps)
@1 ~ @7: Date (UTC: yyyymmddHHMMSS)
			

*y: Year, m: Month, d: Day, H: Hour, M: Minute,
S: Second

Manually entered position data
Command: 23 02
q~t

y ~ !1

!2 ~ !5

X X ••• X X X X ••• X X X X ••• X X

q ~ t: Latitude (ddºmm.mmm format)
y ~ !1: Longitude (dddºmm.mmm format)
!2 ~ !5: Altitude (0.1 meter steps)

1 2 3 4 5 6 7 8 9 10 11 12* 13* 14* 15*

10 degree digit：0 ~ 9
1 degree digit：0 ~ 9
10 minute digit: 0 ~ 5
1 minute digit: 0～9
0.1 minute digit: 0 ~ 9
0.01 minute digit: 0 ~ 9
0.001 minute digit: 0 ~ 9
0 (Fixed)
0 (Fixed)
South latitude=0/North latitude=1
0 (Fixed)
100 degree digit：0 ~ 1
10 degree digit：0 ~ 9
1 degree digit：0 ~ 9
10 minute digit: 0 ~ 5
1 minute digit: 0 ~ 9
0.1 minute digit: 0 ~ 9
0.01 minute digit: 0 ~ 9
0.001 minute digit: 0 ~ 9
0 (Fixed)
0 (Fixed)
West longitude=0/East longitude=1
10000 meter digit：0 ~ 1
1000 meter digit：0 ~ 9
100 meter digit：0 ~ 9
10 meter digit：0 ~ 9
1 meter digit：0 ~ 9
0.1 meter digit：0 ~ 9
0 (Fixed)
+=0/‒=1

X X X X X X X 0 0 X 0 X X X X X X X X 0 0 X X X X X X X 0 X

Latitude

Longitude

Altitude

* “FF” in all 4-byte characters stands for no altitude data
sending or receiving.
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OPTIONS

Options
Microphone/Speaker
HM-154
HM-207S
HM-209
HM-232
OPC-440
OPC-647
SP-30
SP-35
SP-35L

*Approximate

About the free download software
You can download each manual and guide from the
Icom website.
http://www.icom.co.jp/world/support/
Before using, read each manual and guide, and use
it according to the instructions.

hand microphone
hand microphone (remote-control)
noise canceling microphone
hand microphone (simple)
mic extension cable: 5 m (16.4 ft)*
mic extension cable: 2.5 m (8.2 ft)*
external speaker:
2.8 m (9.1 ft)*
external speaker:
2 m (6.5 ft)*
external speaker:
6 m (19.6 ft)*

LL Informatio
••To use to the software, the following items are
required.
CS-4100

Software

RS-MS1A
RS-MS1I
RS-MS3A
RS-MS3W

cloning software
CS-4100
RS-MS1A
Android™ application
RS-MS1I
iOS™ application
RS-MS3W	
terminal mode/access point mode
software:
For Windows
RS-MS3A	
terminal mode/access point mode
application:
For Android™ devices
OPC-2350LU data cable:
USB type
OPC-478UC cloning cable: USB type

••To add or expand a function, or to improve
the performance, the software version may be
upgraded. Before you update your software
version, see the instructions and cautions
described on the Icom website.
••To use the RS-MS3W or RS-MS3A, see “About
the DV Gateway function” that can be downloaded
from the Icom website.

Bluetooth
UT-137
VS-3

microSD card
OPC-2350LU
OPC-478UC
UT-137
UT-137
OPC-2350LU
OPC-2350LU

Bluetooth® unit
Bluetooth® headset

Others
controller bracket
MBA-8
MBF-1
mounting base: MBA-8 is required
MBF-4
mobile bracket
OPC-345
dc power cable
OPC-589
mic adaptor cable
OPC-1156
controller extension cable:
				
3.5 m (11.4 ft)

Icom is not responsible for the destruction, damage
to, or performance of any Icom or non-Icom
equipment, if the malfunction is because of:
••Force majeure, including, but not limited to, fires,
earthquakes, storms, floods, lightning, other
natural disasters, disturbances, riots, war, or
radioactive contamination.
••The use of Icom transceivers with any equipment
that is not manufactured or approved by Icom.
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Bluetooth® OPERATION

Bluetooth® operations

Turning ON the Bluetooth®
function

If you install the optional UT-137 Bluetooth® unit in
the transceiver, you can connect to other Bluetooth
devices.
In this section, the ID-4100A/E with the UT-137 is
described as simply the “transceiver.”

Bluetooth Set > Bluetooth
1. Push [MENU].
2. R
 otate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

You can connect other devices to the transceiver.
Icom Headset
When you connect the VS-3 Bluetooth® headset to the
transceiver, you can wirelessly transmit and receive.
The VS-3 has a [PTT] switch, so you can transmit in
the same way as using the transceiver’s [PTT] switch.
The VOX function can also be used, so you can select
transmit and receive by using your voice through the
headset to switch between TX and RX.
You can assign a function to the keys on the side
panel of the VS-3 to remotely operate the transceiver.

3. Select “Bluetooth,” then push [ï].
		

4. Select “ON,” then push [ï].
		

Android™ device
When you connect an Android device to the
transceiver, you can use the extended D-STAR
functions with the RS-MS1A (freeware Android
application).

5. Push [MENU].

••Returns to the standby screen.

iOS™ device
When you connect an iOS device to the transceiver,
you can use the extended D-STAR functions with the
RS-MS1I (freeware iOS application).

IMPORTANT: The Bluetooth communication range
may vary, depending on the environment in which
the device operates. Microwave ovens or Wireless
LAN may cause an interference.
In that case, stop using those devices or increase
the space between the Bluetooth device and the
other devices.
This Bluetooth device has a range of use. If the
communication is unstable, use the device within the
range.

LLThe communication range of Bluetooth is approximately
10 meters (32.8 feet).

Headset device

Optional VS-3
(Bluetooth Headset)

UT-137

Bluetooth
Transceiver with
the Bluetooth unit

Android device,
iOS device, or
Bluetooth Low
Energy device
(third party)

Data device
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Connecting to a Bluetooth® headset
You can connect the optional Bluetooth headset to the
transceiver.
Step 1. Selecting the pairing mode of the headset.
See the instruction manual of the headset to select
the pairing mode.
Step 2. Searching for the headset

		 Pairing List
		

(Transceiver)

Device name
(“ICOM” indicate the Icom headset.)

Bluetooth Set > Pairing/Connect
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

Displayed while connecting
Headset icon

8. Push [MENU].

••Returns to the standby screen.
LLWhile connected to a Bluetooth device, the Bluetooth
icon is displayed.

		

3. Select “Pairing/Connect,” then push [ï].
		

4. S
 elect “Device Search,” then push [ï].
		

Displayed

TIP:
••When you turn ON the transceiver with “Auto
Connect” set to ON, the transceiver automatically
connects to the last paired device. (Default: ON)
(Bluetooth Set > Auto Connect)
After connecting, the following dialog is displayed.
		

5. Select “Search Headset,” then push [ï].
		

••Displays the usable headsets in the pairing list.
(Example: ICOM BT-002)

6. Select “ICOM BT-002,” then push [ï].
		

••When the transceiver cannot find a connectable
headset, and “No Device Found” is displayed on
the screen, push [QUICK], then select “Re-search”
to search again for a headset.
		

••The confirmation dialog “Connect?” is displayed.

7. Select <YES>, then push [ï].
		

Push [QUICK]
••Connects to the headset.
••After the connecting to the headset, “
in the pairing list.

” is displayed

12-3
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VOX function
The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional VS-3
or a third party’s Bluetooth headset.

If the transceiver does not connect to a Bluetooth
headset, you cannot use the VOX function, even if
the “VOX” item is set to ON.
Be sure to check the Bluetooth connection between
the transceiver and the headset before using the
VOX function.

Depending on the headset, the VOX function may be
disabled because of the differences in microphones.

DDUsing the VOX function

DDSetting the VOX level

Bluetooth Set > Headset Set > VOX > VOX

Bluetooth Set > Headset Set > VOX > VOX Level

1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

1. Push [MENU].
2. R
 otate [DIAL] to select “Bluetooth Set,” then push
[ï].
 elect “Headset Set,” then push [ï].
3. S
4. Select “VOX,” then push [ï].
5. S
 elect “VOX Level,” then push [ï].
		

3. Select “Headset Set,” then push [ï].
		

6. While speaking into the headset microphone,
rotate [DIAL] to adjust the VOX level.
		

4. S
 elect “VOX,” then push [ï].
		

••Displays “VOX” when the TX level audio is input.
LLThe VOX level can be adjusted between 1
(minimum) and 10 (maximum), or turned OFF.
(Default: 5)
LLHigher values make the VOX function more sensitive
to your voice.

5. Select “VOX,” then push [ï].
		

6. Select “ON,” then push [ï].
		

7. Push [MENU].

••Returns to the standby screen.
LL Informatio
••If the S-meter does not display the output power level,
and the transceiver does not transmit, adjust the VOX
delay time in the Menu screen.
(Bluetooth Set > Headset Set > VOX > VOX Delay)
••When the VOX function is ON, you can adjust the
VOX level by pushing [+] or [–] on the VS-3 while
transmitting.
••When the VOX function is ON, you can adjust the
VOX level by rotating [DIAL] while transmitting.

7. Push [MENU].

••Returns to the standby screen.
••Displays “V.”

		

NOTE: We recommend that you set the microphone
gain on the MENU screen or the headset, before
setting the VOX level.
(Function > MIC Gain)

NOTE: While receiving a signal or sounding a beep,
the transceiver does not switch to transmit by your
voice.
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VOX function (Continued)

DDVOX-related settings

You can set the “VOX Delay” and “VOX Time-Out
Timer” on the MENU screen.
VOX Delay

Bluetooth Set > Headset Set > VOX > VOX Delay
The VOX delay is the amount of time the transmitter
stays ON after you stop speaking. It enables for
normal pauses in speaking. (p. 9-70)
VOX Time-Out Timer

Bluetooth Set > Headset Set > VOX >
VOX Time-Out Timer
The VOX Time-Out Timer prevents accidental
prolonged transmission. (p. 9-70)
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Other settings of the headset
DDAF Output

DDHeadset Function Select

Bluetooth Set > Headset Set > AF Output

Bluetooth Set > Headset Set >
Headset Function Select

1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

3. Select “Headset Set,” then push [ï].
		

3. Select “Headset Set,” then push [ï].
		

4. S
 elect “AF Output,” then push [ï].
		

4. Select “Headset Function Select,” then push [ï].
		

5. Select “Headset & Speaker,” then push [ï].
		

5. Select an option, then push [ï].
		

6. Push [MENU].

6. Push [MENU].

Select the AF Output device
If “AF Output” is set to “Headset & Speaker,” you can
hear audio from both a connected Bluetooth headset
and the transceiver’s speaker.

Select the PTT and microphone combination
when either a Bluetooth headset or the transceiver
microphone are used.

••Returns to the standby screen.
LLAudio is heard from both the connected Bluetooth
headset and the transceiver’s speaker.

••Returns to the standby screen.

NOTE:
••When you select “PTT,” turn OFF the VOX function.
••DO NOT select “PTT” when you use only the
Bluetooth headset.
Using the Bluetooth headset
as a microphone
(Select “Microphone”)
Voice from
the Bluetooth
headset

Transmitting from the
microphone

12-6

Using the Bluetooth headset
as a PTT
(Select “PTT”)
Voice from the
microphone

Transmitting from the
Bluetooth headset
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Other settings of the headset (Continued)

DDAbout the Icom headset (VS-3)

You can set the detailed settings of the optional VS-3
Bluetooth headset.
Also, you can assign a key function to [PLAY], [FWD],
and [RWD] on the VS-3’s “Custom Key” screen.

[FWD]
[PLAY]

Power Save screen
The Power Save function temporarily disconnects the
Bluetooth connection if no communication or operation
is performed for 120 seconds. (p. 9-70)
The Power Save function is disabled when the VOX
function is ON.

[RWD]
Optional VS-3
Bluetooth headset

One-Touch PTT screen
The One-Touch PTT function enables you to select
transmission and reception by pushing [PTT].

“Custom Key” screen

PTT Beep screen
Set the beep to sound when you push [PTT] on the
VS-3. (p. 9-70)
Custom Key Beep screen
Set the beep to sound when you push [PLAY], [FWD]
or [RWD] on the VS-3. (p. 9-70)
Custom key screen
You can assign a key function to [PLAY], [FWD] and
[RWD] on the VS-3. (p. 9-71)
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Downloading the RS-MS1A from the Google Play store
The RS-MS1A is a freeware application for Android
devices.
With the RS-MS1A, you can use the extended
D-STAR functions to exchange pictures or messages,
or display the received D-PRS station data on a map
application.
To use the RS-MS1A, download it from the Google™
Play store installed in your Android device.

DDRequired items

DDDownload procedures

LL Informatio
••Some function may not work correctly, depending
on the application installed in your Android device or
memory capability, even if you use one of the above
products.
••See the instruction manual for details of the
operation or account setting of the Android device.
••The screen shot in this manual may differ, depending
on your device’s OS or its version.

5. Tap “RS-MS1A.”

Android™ device
You can use the RS-MS1A with devices that have
Android 4.0 or later installed.
The RS-MS1A has been tested with the Android
4.x.x, 5.x.x, and 6.x.x. (As of April 2017)

1. Turn ON your Android device.
2. Tap “Play Store.”
3. Enter “RS-MS1A” in the “Search Google Play”
field.
4. Tap “ .”
••Displays “RS-MS1A” in the application list.

••Displays the introduction screen of the RS-MS1A.

6. Tap <INSTALL>.
7. Tap <ACCEPT> in the “App permissions” window.
••Installation starts.
••After finishing the installation, the RS-MS1A icon is
displayed on the screen.

RS-MS1A icon
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Downloading the RS-MS1I from the Apple App store
The RS-MS1I is a freeware application for iOS
devices.
With the RS-MS1I, you can use the extended D-STAR
functions to exchange pictures or messages, or
display the received D-PRS station data on a map
application.
To use the RS-MS1I, download it from the Apple App
store installed in your iOS device.

DDRequired items

iOS device
You can use the RS-MS1I with the iPhone or iPad that
have iOS 8.0.1 or later installed.
LL Informatio
••Some function may not work correctly, depending
on the application installed in your iOS device or
memory capability, even if you use one of the above
products.
••See the instruction manual for details of the
operation or account setting of the iOS device.
••The screen shot in this manual may differ, depending
on your device’s OS or its version.

DDDownload procedures

1.
2.
3.
4.

Turn ON your iOS device.
Tap “App Store.”
Tap “ .”
E
 nter “RS-MS1I” in the search field.

••Displays “RS-MS1I” in the application list.

5. Tap “RS-MS1I.”

••Displays the introduction screen of the RS-MS1I.

6. Tap <GET>.
7. Tap <INSTALL>.

••Installation starts.
••After finishing the installation, the RS-MS1I icon is
displayed on the screen.

RS-MS1I icon
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Connecting to an Android™ device
Before connecting to an Android™ device, you must
pair with it.
••How to pair (see below)
••How to connect (p. 12-11)

DDPairing with an Android™ device

This section describes how to pair with an Android
device.
NOTE: Depending on the device, you may not be
able to pair with the Bluetooth device.
Step 3. Sending a pairing request to the
transceiver
(Android device)
Select the displayed UT-137’s name to send a pairing
request.

Step 1. Entering the pairing reception mode
(Transceiver)
Bluetooth Set > <<Pairing Reception>>
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

••The Android device starts to send a pairing request.
••The Android device displays the “To pair with: ICOM BT003. Make sure it is showing this passkey: MMMMM”
dialog.

 tep 4. Receiving a pairing request (Transceiver)
S
1. When the transceiver receives a pairing request,
confirm the displayed passkey is the same as
yours, and then, push [ï].
		

3. Select “<<Pairing Reception>>,” then push [ï].
		

Turn ON Bluetooth with your Android device
within the displayed period of time.
When the time runs out, the transceiver exits
the Pairing reception mode.

••Pairing starts.

2. Select “Pairing/Connect,” then push [ï].

Step 2. Turning ON Bluetooth
(Android device)
Turn ON Bluetooth with your Android device.

••The Android device displays the UT-137 Bluetooth® unit
name.
LLSee the instruction manual of the Android device for
details.
LLYou can confirm the UT-137’s name on the BLUETOOTH
DEVICE INFORMATION screen.
(Default: ICOM BT-003) (p. 9-72)

Pairing list
 fter the pairing is complete, the Android
A
device name is displayed on the pairing list.

NOTE: When you pair with the third party’s data
device, entering a PIN code or passkey may be
required. See the instruction manual of the data
device for details to enter a PIN code or passkey.
12-10
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Connecting to an Android™ device (Continued)

DDConnection

This section describes how to connect to the
transceiver from an Android device.
TIP: To connect to the Android device from the
transceiver:
When the RS-MS1A is started on the Android
device, you can connect to the device from the
transceiver.

Step 1. Preparing for the connection (Transceiver)
Function > CI-V > CI-V Transceive
Set “CI-V Transceive” to ON to control the transceiver
and the RS-MS1A with CI-V commands.
Step 2. Starting the RS-MS1A
Tap the RS-MS1A to start.

(Android device)

Bluetooth Set > Pairing/Connect
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then
push [ï].
3. Select “Pairing/Connect,” then push [ï].
4. Select the Android device name displayed in the
pairing list, then push [ï].
5. Select <YES>, then push [ï].

LLSee page 12-8 for details on downloading the RS-MS1A.

		

RS-MS1A icon

••Displays “MMM Connecting...”
(“MMM” is the Bluetooth name of the Android

Step 3. Connecting to the transceiver

(Android device)
®
Tap the UT-137 Bluetooth unit name displayed on the
RS-MS1A.

device.)

LL“ ” is displayed to the left of the Android device
name.

••Starts to connect.
LLWhen your call sign has not been entered in the
transceiver, you should enter in before you connect.
LLAfter the connection has succeeded, the transceiver
displays “MMM Connected,” and the Bluetooth icon is
displayed.
Displayed

LLOn the PAIRING/CONNECT screen, “
the left of the Android device name.

NOTE: If you cannot connect, check that the same
CI-V address is set between the transceiver and the
RS-MS1A.
You can see the CI-V setting as described below:
Transceiver
“CI-V Address” in the Menu screen.
(Function > CI-V > CI-V Address) (Default: 9A)
RS-MS1A:
“Application Setting”  “CI-V setting”
(Default: Transceiver[9A])

” is displayed to

Device name
Displayed while connecting
Data device icon
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Connecting to an iOS™ device
Before connecting to an iOS device, you must pair
with it.
••How to pair (see below)

NOTE: Before connecting, check the following items
are correctly set.
••Set “CI-V Transceive” to “ON.”

LLSee page 12-13 to connect to the paired device.

(Function > CI-V > CI-V Transceive)

••Set “Serialport Function” to “CI-V (Echo Back OFF).”
(Bluetooth Set > Data Device Set > Serialport Function)

••Set the same CI-V address between the transceiver
and the RS-MS1I.
Transceiver:
“CI-V Address” in the MENU screen
(Function > CI-V > CI-V Address) (Default: 9A)
RS-MS1I:
“Application Setting”  “CI-V address”
(Default: Transceiver[9A])

DDPairing with an iOS™ device
NOTE: Depending on the device, you may not be
able to pair with the Bluetooth device.
(iOS device)
Step 1. Starting the RS-MS1I
1. Turn ON Bluetooth with your iOS device.

Step 3. Sending a pairing request to the
transceiver
(iOS device)
1. On the RS-MS1I, tap “Scan.”

LLSee the instruction manual of the iOS device for
details.

••The device displays the UT-137 Bluetooth® unit name.
LLYou can confirm the UT-137’s name on the
BLUETOOTH DEVICE INFORMATION screen.
(Default: ICOM BT-003) (p. 9-72)

2. Tap the RS-MS1I icon to start.

LLSee page 12-9 for details on downloading the RS-MS1A.

		

2. T
 ap the displayed UT-137’s name to send a
pairing request.

RS-MS1I icon

••The iOS device starts to send a pairing request.
LLWhen your call sign has not been entered in the
transceiver, you should enter in before you connect.
LLAfter the connection has succeeded, the iOS device
displays “Bluetooth connected to ICOM BT-003.”

••Displays the pairing device list.

Step 2. Entering the pairing reception mode
(Transceiver)

LLAbout the transceiver’s display
After the connection has succeeded, the transceiver
displays “MMM Connected.” and the Bluetooth icon
is displayed.
(“MMM” is the Bluetooth name of the iOS device.)

Bluetooth Set > <<Pairing Reception>>
1. Push [MENU].
2. R
 otate [DIAL] to select “Bluetooth Set,” then push [ï].
		

Displayed

3. Select “<<Pairing Reception>>,” then push [ï].
		
On the PAIRING/CONNECT screen, “ ” is displayed
to the left of the iOS device name.
(Bluetooth Set > Pairing/Connect)

Device name
Displayed while connecting

Turn ON Bluetooth with your iOS device within the
displayed period of time. When the time runs out,
the transceiver exits the Pairing reception mode.

Data device icon
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Connecting to an iOS™ device (Continued)

DDConnection

This section describes how to connect to the paired
transceiver from an iOS device.

TIP: To connect to the iOS device from the
transceiver:
When the RS-MS1I is started on the iOS device,
you can connect to the device from the transceiver.

1. Tap the RS-MS1I icon to start.
		

Bluetooth Set > Pairing/Connect

RS-MS1I icon

1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then
push [ï].
3. Select “Pairing/Connect,” then push [ï].
4. Select the iOS device name displayed in the
pairing list, then push [ï].
5. Select <YES>, then push [ï].

2. Tap “Other.”
3. Tap “Bluetooth Connection.”
4. T
 ap the displayed UT-137’s name to connect.

••The iOS device starts to connect to the transceiver.
LLWhen your call sign has not been entered in the
transceiver, you should enter in before you connect.
LLAfter the connection has succeeded, the iOS device
displays “Bluetooth connected to ICOM BT-003.”

••Displays “MMM Connecting...”
(“MMM” is the Bluetooth name of the iOS

device.)

LL“

LLAbout the transceiver’s display
After the connection has succeeded, the transceiver
displays “MMM Connected.” and the Bluetooth icon
is displayed.
(“MMM” is the Bluetooth name of the iOS device.)

” is displayed to the left of the iOS device name.

NOTE: If you cannot connect, check that the same
CI-V address is set between the transceiver and the
RS-MS1I.
You can see the CI-V setting as described below:
Transceiver
“CI-V Address” in the Menu screen.
(Function > CI-V > CI-V Address) (Default: 9A)
RS-MS1I:
“Application Setting”  “CI-V address”
(Default: Transceiver[9A])

Displayed

On the PAIRING/CONNECT screen, “ ” is displayed
to the left of the iOS device name.
(Bluetooth Set > Pairing/Connect)

Device name
Displayed while connecting
Data device icon
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Disconnecting from a Bluetooth® device
There are 3 ways to disconnect from a Bluetooth
device (headset device or data device).
••Turn OFF a headset
••Turn OFF the Bluetooth on a data device

LLSee the instruction manual of the headset or a data
device for details.

Or, you can disconnect from a Bluetooth device
without canceling the pairing, as described below.
Bluetooth Set > Pairing/Connect
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

3. Select “Pairing/Connect,” then push [ï].
		

4. Select the Bluetooth device, then push [ï].
		

••The confirmation dialog “Disconnect?” is displayed.

5. Select <YES>, then push [ï].
		

“ ” disappears
••The transceiver disconnects from the Bluetooth
device, and “ ” disappears from the list. However, the
transceiver is still paired with the device.
LLWhen you select the unconnected device
displayed in the pairing list, the transceiver displays
“Connect?.” To connect to the device, select <YES>.
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Deleting a Bluetooth® device from the pairing list
You can delete a Bluetooth device from the pairing list.
Before deleting a connected Bluetooth device,
disconnect it.
Bluetooth Set > Pairing/Connect
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

3. Select “Pairing/Connect,” then push [ï].
		

4. Select the Bluetooth device, then push [QUICK].
		

5. Select “Delete,” then push [ï].
		

••The confirmation dialog “Delete?” is displayed.

6. Select <YES>, then push [ï].
		

••Deletes the selected device from the pairing list.

TIP: To connect to the deleted device again, you
must first pair with it again.
Pairing with a headset:
p. 12-3
Pairing with an Android device: p. 12-10
Pairing with an iOS device:
p. 12-12
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Editing the installed Bluetooth® unit name
You can edit the Bluetooth unit name. After initializing
the unit, the edited name remains.
Bluetooth Set > Bluetooth Device Information
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

3. Select “Bluetooth Device Information,” then push
[ï].
		

••Displays the BLUETOOTH DEVICE INFO screen.

4. Push [QUICK].
5. Select “Edit Name,” then push [ï].
		

••Enters the unit name entry mode.

6. Enter a name of up to 8 characters*.
(Example: ICOM BT-003 A)
		

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * +
, - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
LLSee “Entering and editing text” for details. (p. iv)
		 *Except for “ICOM BT-.”

7. After entering, push [ï].
••Sets the edited name.
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Initializing the installed Bluetooth® unit
You can initialize the installed UT-137 Bluetooth® unit.
You should initialize the unit if you have trouble during
Bluetooth operation.
When you do a partial reset or all reset, the Bluetooth
settings returns to their factory defaults. However,
the device name and pairing/connection information
remain.
Bluetooth Set > Initialize Bluetooth Device
1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[ï].
		

3. Select “Initialize Bluetooth Device,” then push [ï].
		

••The confirmation dialog “Initialize Bluetooth Device?”
is displayed.

4. Select <YES>, then push [ï].
		

••Resets the installed UT-137’s settings to their factory
defaults, and returns to the standby display.
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The maximum number of paired devices
You can pair 3 types of the Bluetooth devices:
Headset, Data device, and Low Energy device.
Up to 7 Bluetooth devices can be paired with the UT137. However, you cannot pair with 7 headsets only, 7
data devices only, or 7 Low Energy devices only.*
* Either headsets or Android devices are maximum 4
devices, and the combination is 5 devices in total.
* Bluetooth Low Energy devices are maximum 2 devices.

Displays the paired Bluetooth device
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General
DDAbout updating the firmware

DDChecking the firmware version

You can update the ID-4100A/E’s firmware using a
microSD card. Updating the firmware can add new
functions or improve performance parameters.

You can check the firmware version on the MENU
screen.
Others > Information > Version

You can download the latest firmware from the Icom
website.
http://www.icom.co.jp/world/index.html

1. Push [MENU].
2. Rotate [DIAL] to select “Others,” then push [ï].
		

DDCautions

••CAUTION: NEVER turn OFF the transceiver
while updating the firmware. If you turn OFF the
transceiver, or if a power failure occurs while
updating, the transceiver firmware may be damaged
and you may have to send the transceiver back
to the nearest Icom distributor for repair. This type
of repair is out of warranty, even if the transceiver
warranty period is still valid.
••We recommend that you backup all the transceiver’s
data to a microSD card or to a PC before starting the
firmware update. Settings and/or memory contents
may be lost or returned to their default settings when
the firmware is updated.
••You are responsible for the the results after updating
the firmware.

3. Select “Information,” then push [ï].
		

4. Select “Version,” then push [ï].
		

••The firmware version is displayed.

DDItem requirement

••PC
••microSD card
••microSD card slot or a memory card reader
NOTE: Before using a microSD card, format it with
the transceiver.

LLFormatting a card erases all its data. Before formatting
any used card, back up its data onto your PC.
LLSee the Basic manual for details.
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Updating the firmware
8. Right-click the downloaded firmware folder (zip
format).
9. Click “Extract All...”
		

These instructions are based on Microsoft® Windows®
10.
Step 1. Downloading the firmware file
1. Access the following URL.
http://www.icom.co.jp/world/index.html
2. Click <Support>.
		

Click

10. S
 elect the location where you want to create the
unzipped folder, then click <Extract>.
(Example: Desktop)
		

Click

3. Click the “Firmware Updates/Software
Downloads” link.
		

Click
••After unzipping, a folder is created in the specified
location.
LLIn the “4100E_MM*” folder, “4100E_MM*.dat” is
created.
* “MM” represents the release number.

Click

4. C
 lick the firmware file link in the ID-4100A/E
group.
5. Read “Regarding this Download Service”
carefully, and then click <Agree>.
		

Step 2: Inserting the microSD card into a PC
NOTE: To use the microSD card with the transceiver,
format the card, even preformatted microSD cards
for PCs or other uses. See Basic manual section 7
for details.

Click

6. Click <Save as>.
		

1. T
 urn OFF the transceiver, then remove the
microSD card.
2. Insert it into the microSD card drive or a memory
card reader* on your PC.

Click

7. S
 elect the location where you want to save the
firmware, and then click <Save>.
(Example: Desktop)
		

		 *User supplied.

PC
Transceiver

microSD
card

To the memory
card reader

Click
••The file starts downloading.
LLThe firmware and the firm utility are compressed in a
“zip” format folder.

☞☞Continued on the next page.
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Updating the firmware (Continued)
Step 3. Copy the downloaded firmware data
1. Double-click the created folder.
(Example: 4100E101).
2. Copy the downloaded firmware data into the
ID-4100 folder on a microSD card.
(Example: 4100E101.dat).
		

4. C
 arefully read all the displayed precautions.
After you read and agree with all the precautions,
select <YES>, then push [ï].
		

Click

Step 4: Removing the microSD card
Turn OFF the transceiver, then remove the microSD
card from your PC, and insert it into the transceiver’s
slot.
PC

Transceiver

microSD
card

From the memory
card reader
LLRotate [DIAL] to scroll the screen.
LLTo cancel the updating, select <NO>.

5. Select the Firmware, then push [ï].
(Example: 4100E101).
		

Step 5: Updating the firmware
CAUTION: NEVER turn OFF the transceiver while
updating the firmware.
If you turn OFF the transceiver, or if a power failure
occurs while updating, the transceiver firmware
may be damaged and you may have to send the
transceiver back to the nearest Icom distributor for
repair. This type of repair is out of warranty, even if
the transceiver warranty period is still valid.

••The final confirmation screen is displayed.

☞☞Continued on the next page.

SD Card > Firmware Update
1. Push [MENU].
2. Rotate [DIAL] to select “SD Card,” then push [ï].
		

3. Select “Firmware Update,” then push [ï].
		

••The firmware update agreement screen is displayed.
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Updating the firmware (Continued)
6. Carefully read all the displayed precautions.
After you read and agree with all them, select
<YES>, then push [ï].
		

••The updating starts.
LL Informatio
••To cancel the updating, select <NO>.
••The transceiver reads the firmware file from the
microSD card and writes it to the main CPU, sub CPU,
DSP, and the controller CPU.
••Downloading and loading status are displayed in the
dialogs.

7. T
 he firmware updating has completed, the
transceiver will automatically restart. And then,
returns to the standby screen.

TIP:
••T
 o check the firmware version after the updating,
see “Checking the firmware version” for details.
(p. 13-2)
••T
 o delete the firmware file on the microSD
card, push [QUICK], then select “Delete” on the
FIRMWARE UPDATE screen.

13-5

Previous view

INDEX
Number

C

1750 Hz tone burst...................................................8-3

Call CH...................................................................9-17
Selecting................................................................1-4
Call Sign....................................................... 9-41, 4-31
Received call signs..............................................4-19
My Call Sign.........................................................9-47
Your (destination) call sign
Deleting.............................................................4-44
Entering.............................................................4-43
CI-V ...................................................................10-19
CI-V Address........................................................9-60
CI-V Baud Rate....................................................9-60
CI-V Bluetooth→REMOTE Transceive Address..9-61
CI-V information.................................................10-19
CI-V Transceive...................................................9-61
Cloning function....................................................10-14
Clone Mode..........................................................9-73
Comment.................................... 9-26, 9-28, 9-31, 9-34
Course.......................................................... 9-29, 9-32
Custom Key............................................................9-71
Custom Key Beep..................................................9-70

A
Access Point Mode.................................................9-67
Active band.............................................................9-60
AF Output...............................................................9-69
Alarm
Alarm Area (Group)..............................................9-39
Alarm Area (RX/Memory).....................................9-39
Alarm Select.........................................................9-39
All Reset..................................................... 9-73, 10-18
Alphabet.................................................................9-51
Altitude...................................................................9-27
Attenuator function.................................................10-3
Auto Connect..........................................................9-69
Auto Dimmer
Auto Dimmer........................................................9-62
Auto Dimmer Cancel (DV RX).............................9-62
Auto Dimmer Cancel (PTT)..................................9-62
Auto Dimmer Timer..............................................9-62
Auto Power OFF.....................................................9-67
Auto Repeater................................................ 9-57, 8-5
Auto Reply..............................................................9-48
Automatic DV detection..........................................4-23
Automatic Reply function........................................4-24
Auto Position Reply function................................4-26
Recording an Auto Reply message......................4-25

D
Data Extension.................................... 9-27, 9-29, 9-32
Data Speed............................................................9-60
Data Type..................................................... 9-28, 9-31
Date .................................................. 9-54, 9-67, 9-68
DIAL SPEECH........................................................9-51
Dial Speed-UP........................................................9-57
Digital Code............................................................9-16
Digital Monitor........................................................9-49
Digital Repeater Set...............................................9-49
Directivity............................................. 9-27, 9-30, 9-33
Display Language...................................................9-64
Display Unit
Altitude/Distance..................................................9-64
Barometric............................................................9-64
Latitude/Longitude...............................................9-64
Rainfall.................................................................9-64
Speed...................................................................9-64
Temperature.........................................................9-64
Wind Speed.........................................................9-64
DR scan....................................................................4-5
Skip setting..........................................................4-40
D-STAR operation....................................................4-1
Data communication............................................4-27
DV Fast Data function..........................................4-28
Digital squelch functions......................................4-29
EMR........................................................... 4-22, 9-50
“FROM” (Access repeater) setting.........................4-3
Message operation..............................................4-17
Repeater list.........................................................4-32
“TO” (Destination) setting.......................................4-8

B
Band Edge Beep....................................................9-66
Band Scope function..............................................10-4
Sweep operation..................................................10-4
Bank Link................................................................9-18
Barometric..............................................................9-64
Beep Level.............................................................9-66
BK .....................................................................9-50
BK mode communication.....................................4-21
Bluetooth...................................................... 9-69, 12-1
Connecting.................................... 12-3, 12-10, 12-12
Deleting..............................................................12-15
Disconnecting....................................................12-14
Initializing................................................. 9-72, 12-17
Paring...................................................................9-69
RS-MS1A.............................................................12-8
RS-MS1I..............................................................12-9
Setting..................................................................9-69
VOX function.............................................. 9-70, 12-4
Bluetooth Device Information.................................9-72
Brightness..............................................................9-62
Busy Lockout..........................................................9-60

I

Previous view

INDEX

D (Continued)

GPS operation..........................................................5-1
Compass Direction...............................................5-10
Grid Locator...........................................................5-9
D-PRS data..........................................................5-13
Item........................................................... 5-7, 5-17
Object........................................................ 5-7, 5-17
Position (Base).......................................... 5-6, 5-15
Position (Mobile)........................................ 5-6, 5-15
Weather..................................................... 5-8, 5-21
NMEA data...........................................................5-25
NMEA..................................................................5-8
GPS message...................................................5-26
GPS data sentence...........................................5-25
GPS Out (To DATA jack).........................................9-24
GPS Position..........................................................9-36
Displaying..............................................................5-3
Receiving...............................................................5-2
Saving..................................................................5-10
GPS Select.............................................................9-24
GPS Sentence........................................................9-35
GPS Time Correct..................................................9-67
GPS TX Mode........................................................9-24

DTCS
DTCS Code..........................................................9-16
DTCS Polarity......................................................9-16
DTCS squelch operation....................................10-12
DTMF Memory.............................................. 9-53, 10-8
DTMF code..........................................................10-8
DTMF Speed............................................ 9-53, 10-10
Transmitting.........................................................10-9
Duplex operation......................................................8-4
Duplex direction.....................................................8-4
Frequency offset....................................................8-4
DV Auto Detect.......................................................9-49
DV Auto Reply........................................................9-22
DV Data TX............................................................9-48
DV Gateway
Access Point Mode..............................................9-67
Terminal Mode.....................................................9-67
E
EMR ........................................................... 4-22, 9-50
EMR AF Level........................................................9-50
Export.....................................................................9-68

H
Headset Function Select.............................. 9-69, 12-6
AF Output.............................................................12-6
Height.................................................. 9-27, 9-30, 9-33
Home channel function...........................................10-7
Home CH Beep.......................................... 9-66, 10-7
Operation.............................................................10-7
Setting..................................................................10-7

F
Fan Control.............................................................9-57
Fast Data................................................................9-49
File Split..................................................................9-21
Firmware Update....................................................9-68
Firmware version....................................................13-2
FM Repeater operation............................................8-2
Format....................................................................9-68

I
Import.....................................................................9-68
Initialize Bluetooth Device......................................9-72
Item Name..............................................................9-31

G
Gain .................................................. 9-27, 9-30, 9-33
GPS Auto TX................................................ 5-38, 9-40
GPS Data Speed....................................................9-49
GPS Information (Sky view screen)..............5-11, 9-36
GPS Logger............................................................9-40
GPS Memory................................................ 5-27, 9-38
Adding..................................................................5-27
Changing................................................................5-9
Deleting................................................................5-30
GPS alarm...........................................................5-32
Group name, Entering..........................................5-30
GPS Message........................................................9-35
GPS Logger function..............................................5-34
GPS record interval.................................... 5-34, 9-40
GPS record sentence................................. 5-35, 9-40
Viewing the log data on a PC Map.......................5-36

K
Key Backlight Brightness........................................9-62
Key Backlight Color................................................9-62
Key-Touch Beep.....................................................9-66
L
Latitude/Longitude..................................................9-64
LCD Backlight Brightness.......................................9-62
LCD Backlight Color...............................................9-62
LCD Contrast..........................................................9-63
Load Setting...........................................................9-68

II

Previous view

INDEX

M

P

Manage Memory screen...........................................1-3
Memory Bank...........................................................1-8
Assigning a memory channel..................................1-8
Bank name, Entering...........................................1-11
Selecting the Memory Bank mode.........................1-9
Writing....................................................................1-9
Memory CH............................................................9-17
Clearing................................................................1-12
Content..................................................................1-2
Copying.......................................................... 1-6, 1-7
Selecting................................................................1-4
Writing....................................................................1-5
Overwriting.............................................................1-6
Memory name
Entering................................................................1-10
Memory name display..........................................1-12
MENU screen...........................................................9-1
Menu items and Default settings............................9-3
Operation...............................................................9-2
Selecting a Menu item...........................................9-2
Message operation.................................................4-17
Deleting................................................................4-18
Entering................................................................4-17
Transmitting.........................................................4-17
MIC Gain...................................................... 9-60, 10-3
microSD card............................................................6-1
Backup........................................................... 6-6, 6-7
Exporting a CSV format file....................................6-9
Importing a CSV format file....................................6-8
Loading..................................................................6-5
Saving............................................ 6-2, 6-3, 6-4, 9-68
MODE SPEECH.....................................................9-51
My Call Sign...........................................................9-47

Paring
Paring/Connect....................................................9-69
Paring Reception.................................................9-69
Partial Reset............................................... 9-73, 10-18
Pause Timer...........................................................9-18
Play Files................................................................9-21
Position......................................................... 9-29, 9-32
Manual Position...................................................9-24
Power.................................................. 9-27, 9-30, 9-33
Power OFF (With No Controller)............................9-61
Power Save............................................................9-70
Priority watch............................................................3-1
Canceling...............................................................3-2
Starting...................................................................3-2
Program Link..........................................................9-19
Program Scan Edge...............................................9-18
Program Skip..........................................................9-18
PTT Auto REC........................................................9-22
PTT Beep...............................................................9-70
PTT Lock................................................................9-60
Q
QSO Log................................................................9-54
R
Rainfall...................................................................9-64
REC Mode..............................................................9-21
Record....................................................................9-23
Record Interval.......................................................9-40
Record Sentence....................................................9-40
REC Start...............................................................9-21
Reflector
Linking..................................................................4-14
Reflector Echo Testing.........................................4-15
Requesting repeater information..........................4-16
Unlinking..............................................................4-15
Using....................................................................4-13
Remote control (CI-V) information........................10-19
Remote MIC Key....................................................9-57
Repeater detail screen...........................................4-42
Repeater List................................................ 4-32, 9-45
Adding..................................................................4-39
Deleting................................................................4-37
Editing..................................................................4-37
Entering................................................................4-33
Repeater Tone........................................................9-16
Repeat Time...........................................................9-23
Reply Position Display............................................9-63
Resetting..............................................................10-18
All Reset................................................... 9-73, 10-18
Partial Reset............................................ 9-73, 10-18
Resume Timer........................................................9-18

N
Near Repeater Search function................................4-6
Night Time operation
Night Time End....................................................9-62
Night Time Setting................................................9-62
Night Time Start...................................................9-62
O
Object Name..........................................................9-28
Off band indication....................................................8-5
Offset frequency.....................................................9-16
One-Touch PTT......................................................9-70
One-Touch PTT (Remote MIC)...............................9-60
Opening Message..................................................9-64
Options...................................................................11-2

III

Previous view

INDEX

R (Continued)

Standby Beep.........................................................9-66
Symbol....................................... 9-24, 9-28, 9-31, 9-34
Symbol list..............................................................9-25
System Language..................................................9-64

RF meter.................................................................10-2
RS-MS1A................................................................12-8
RS-MS1I.................................................................12-9
RX Bass.................................................................9-48
RX Bass Boost.......................................................9-48
RX Call Sign...........................................................9-63
RX Call Sign SPEECH...........................................9-51
RX>CS SPEECH....................................................9-51
RX History..............................................................9-42
RX History Log.......................................................9-54
RX Position Display................................................9-63
RX Position Display Timer......................................9-63
RX Position Indicator..............................................9-63
RX REC Condition..................................................9-21
RX Record (RPT)...................................................9-49
RX Treble...............................................................9-48

T
Temperature...........................................................9-64
Temporary Skip Timer............................................9-18
Terminal Mode........................................................9-67
Text entry.................................................................... iv
TIME .....................................................................9-67
Time-Out Timer.......................................................9-60
Time Stamp......................................... 9-26, 9-30, 9-34
Tone Burst..............................................................9-16
Tone squelch operation........................................10-11
Transmit power levels.............................................10-2
TSQL Freq..............................................................9-16
TX
.....................................................................9-23
TX Bass..................................................................9-48
TX Call Sign...........................................................9-63
TX Delay (PTT).......................................................9-49
TX Format...............................................................9-24
TX History.................................................................4-7
TX Message...........................................................9-47
TX Monitor..............................................................9-23
TX Treble................................................................9-48

S
Save Setting...........................................................9-68
Scan .......................................................................2-1
Bank Link.............................................................9-18
[DIAL] operation.....................................................2-3
Duplex (DUP) scan................................................2-2
Memory Bank scan................................................2-7
Memory scan.........................................................2-6
Pause Timer.........................................................9-18
Receive mode during a scan.................................2-3
Resume Timer......................................................9-18
Scan edges, Entering.............................................2-9
Scan Stop Beep........................................... 2-3, 9-66
Skip
Skip channel........................................................2-8
Skip frequency.....................................................2-5
Temporary Skip timer................................ 2-3, 9-18
Squelch setting......................................................2-3
Tone scan...............................................................2-2
Tuning step for a VFO scan...................................2-3
VFO mode scan.....................................................2-4
Scope AF Output....................................................9-66
Scroll Speed...........................................................9-63
SD Card Info...........................................................9-68
Separator/Decimal........................................ 9-54, 9-68
Serialport Function.................................................9-72
Skip Time................................................................9-22
Speech
SPEECH Language.............................................9-51
SPEECH Level.....................................................9-52
SPEECH Speed...................................................9-52
Speed.................................................. 9-29, 9-32, 9-64
Squelch/ATT Select................................................9-57
Squelch Delay.............................................. 9-57, 10-2
SSID ......................................... 9-26, 9-30, 9-33, 9-34

U
Unmount.................................................................9-68
Unproto Address.....................................................9-24
Updating the firmware............................................13-1
Firmware version.................................................13-2
Up/Down MIC Key..................................................9-57
UTC Offset..............................................................9-67
V
Version...................................................................9-73
Voice memory...........................................................7-1
Changing the QSO recorder settings.....................7-4
Deleting an Audio File............................................7-5
Deleting an Audio Folder........................................7-5
File information......................................................7-6
Memory capacity (microSD card)...........................7-7
Play Files.............................................................9-21
Playing back...........................................................7-3
On the PC............................................................7-8
Recording...............................................................7-2
REC Mode...........................................................9-21
REC Start.............................................................9-21

IV

Previous view

INDEX

V (Continued)
Voice TX function....................................................10-5
Changing the voice TX settings...........................10-6
Recording.............................................................10-5
Transmitting.........................................................10-6
Record.................................................................9-23
Repeat Time.........................................................9-23
Voltage...................................................................9-73
Voltage (Power ON)...............................................9-64
VOX
VOX function.............................................. 9-70, 12-4
VOX Delay................................................. 9-70, 12-5
VOX Level.................................................. 9-70, 12-4
VOX Time-Out Timer.................................. 9-70, 12-5
W
Weather channel operation..................................10-13
Weather alert function........................................10-13
Weather station transmission.................................5-23
Wind Speed............................................................9-64
Y
Your Call Sign.........................................................9-45

V

A-7367-3EX
© 2017 Icom Inc.

1-1-32 Kamiminami, Hirano-ku, Osaka 547-0003, Japan

